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PREFACE FOR DIGITAL LITERACY FOUNDATION 
Day by day, the world is constantly evolving in all areas. in that, we observe that the field 

of digital technology has grown significantly and has played a necessary and important role in 
the lives of humanity. We can communicate with each other easily, quickly, and efficiently, 
even at the other end of the earth. We can get a lot of entertainment through modern electronic 
systems connected to the Internet.  Complicated, time-consuming tasks are handled quickly, 
efficiently, and qualitatively. We can also gain a wealth of knowledge through learning in 
artificial classrooms without the need for face-to-face meetings between teachers and students. 
Most of the workforce is facilitated by artificial intelligence, which includes robots. 

Dear all teachers and trainees! To adapt to the world's "4.0" technology era and to achieve 
the goal of digital education set by the Ministry of Education, Youth, and Sports, teachers and 
trainees must have knowledge of digital literacy in addition to the skills they already have. It 
does not require teachers and trainees to have a high level of knowledge in this field, but at 
least a basic level that can be used in the career path. This knowledge can help strengthen the 
quality, quantity, and speed up the work of teachers and trainees in large part. 

What I have noticed is that all the documents related to the field of digital technology in 
our national language are not yet rich and lacking. Most of the documents are in foreign 
languages, which is why some scholars who do not have knowledge of foreign languages can't 
understand the contents of those documents. 

According to UNESCO, "Digital literacy" refers to the ability to use digital technology 
and tools to find, use, manage, evaluate, create, and share information securely and accurately. 
The book "Digital Literacy Foundation" was written specifically for teachers and 
trainees interested in learning about digital literacy. The content of this book focuses on the 
basic knowledge that needs to be used in daily work. They are: 

• Computer usage and maintenance knowledge. 
• Computer administration software to prepare documents for teaching and 

managing students, presenting. 
• Software for electronic communication and online file transfer. 
• Distance learning software and creating artificial classrooms. 
• Cloud storage services to store files online. 
• Evaluate media content, and create content for media. 
• Ethics and security in the use of digital technology. 

Dear all teachers and trainees! Mistakes will inevitably occur in this book. Spelling, 
grammar, and technical vocabulary are often flawed. Pleas Forgive me. I appreciate any 
feedback from all of you. I sincerely hope that this book will be useful and will help develop 
the capacity of digital teachers for all teachers and trainees. 
 

Author 
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ICT for Education 
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Introduction: 
Using a computer is very important in the digital age. To improve your work, you need to 
know some basic computer applications. After completing this lesson, you will be able to: 

Ø Learn the basics of computers 
Ø Copy and move files 
Ø Use computers to organize files and folders 

In this lesson, you will learn the following: 

I. The Basics of Computers 

II. The Computer Operating System 

III. File Management 

Using Computer in Basic 

Lesson 1 
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Lesson 1 Using Computer in Basic 
I. Learning About Computers 
1. What is Computer? 

Computers are everywhere. During a typical day, you might use your phone to message 
a friend about meeting for lunch while listening to music as you walk to class. Although you 
might not realize it, you also use a computer to withdraw cash from an automated teller machine 
(ATM), change the temperature setting on a home thermostat, and turn on cruise control while 
driving a car. 

 

Depending on your job, you probably use computers to take a diner’s order at a 
restaurant, process a sale, or control a robot on a factory floor. Overall, computers assist you in 
most parts of your daily life. They play a central role in worldwide communications, 
entertainment, education, commerce, and other business activities. Computers have been 
around since the late 1940s when they were massive, special-purpose machines with names 
such as UNIVAC and ENIAC and were designed for use by the military and government. These 
early computers took hours to complete a calculation, occupied small buildings or entire city 
blocks, and cost millions of dollars. Today’s smartphones have more processing power than a 
UNIVAC, cost less than any of its components, and fit in the palm of your hand. The future 
promises innovations such as wearable computers, using human thought as input, and 
computer-controlled micro-robots that treat and possibly cure cancer. 

 

But what exactly is a computer? What does it do? Understanding what a computer is 
and how it works can help you to appreciate and use computers more effectively.  

A computer is an electronic device that receives data (input), processes, stores data, 
and produces a result (output). Data is a collection of raw, unprocessed facts, including text, 
numbers, sound, images, and video. All basic computers have four functions: input, storage, 
processing, and output. 
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2. Personal Computer 
In this lesson, we will focus on the most commonly used computers at home and in the 

office personal computers. Personal computers are those computers that one person 
commonly uses to assist with work and communication when needed. There are two types of 
personal computers: desktop computers and laptops. 

• Desktop Computer: A personal computer for regular use at home or at the office in 
one place on the desktop. It cannot be used anywhere, because it is large, has separate 
parts and needs regular electricity. 

• Laptop: You can take a small, lightweight personal computer with you. Laptops only 
need to be plugged in occasionally because they have a battery for their power supply. 
It would be best if you charged the battery fully. 

 

2. 4 Main Part of Computers 
A computer has four main components: 

• System Unit 

• Monitor 

• Keyboard 

• Mouse 

 

System Unit: is the most important part of a computer. It is like the brain. It does all 
the tasks that we want the computer to do. It also controls all the other parts, like the Monitor, 
Keyboard, and Mouse. These parts must be connected to the System Unit to work. In the 
system Unit the most important components, such as the Motherboard, CPU, Hard Drive, 
RAM, and Graphic Card (GPU) are stored. 

Monitor: A monitor looks like a TV screen. The CPU uses the monitor to show us 
information processing in the system unit. The front portion of the monitor is called the screen 
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or display. A monitor is connected to the system unit by VGA, HDMI, DVI cable via VGA, 
HDMI, or DVI port. 

 Keyboard: The keyboard is made of several small buttons called keys. Each key has 
a number, letter, or word written on it. Just as you use a pencil to write on paper, you can use 
a keyboard to write with a computer. You can also use the keyboard to control your computer. 
Also, the keyboard is connected to the system unit by a USB cable via a USB port. 

Mouse: A mouse is used to point at items shown on the monitor to open, select a 
menu, or control something. The mouse usually has two or three buttons and a small wheel 
between the buttons. The mouse is connected to the system unit by a USB cable via a USB 
port. 

3. Turning a Computer On and Off 
To turn on your computer, make sure your computer is connected to a desktop 

computer. Laptops need to have enough battery power. 

The desktop computer has a power button on the system tray. You need to press this 
button and wait a little bit for the computer to start up before you can use it. 

On laptops, the turn-on is the same, but you have to find the power button on the 
computer. It can be located on the top left or right of the keyboard. 

 

Contrary to the turn-on process, you cannot turn off the computer via the power 
button. If you do this, your computer will soon be prone to crashes or malfunctions. To shut 
down your computer correctly and safely, follow these steps: 

Ø It is best if you make sure that all the programs running on your computer are closed. 
To know if an application is closed, you must observe the taskbar. If any program is 
running, please close it first. 

Ø Drag the mouse pointer and click the Start button. 
Ø Choose Shutdown 
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II. The Computer Operating System 
1. Operating System User Interface 

The four main components studied above are called hardware. Compatible computers 
depend on an operating system called software. Software is the operating system that controls 
the entire operation of a computer. It makes the computer hardware interconnected. 

a. Desktop 
The desktop of a computer (not to be confused with “desktop”) is the first image you 

see on your computer screen (monitor) when the computer is turned on. It is the starting point 
to use the computer. Desks (icons and buttons) represent a computer’s objects and functions. 
You can “touch” these items with the mouse to control them. 

 

b. Icons and Buttons 
Icons are thumbnails that represent objects or applications. When an icon is on the 

desktop or in a folder, it always has its name next to the image of that icon (filename or 
folder). Icons are objects in a computer that mark files, folders, or programs. 

 

c. Using the Mouse 
Buttons are located on the screen or window of a program with a specific function in 

the computer program, and we can use them by controlling the mouse to click on them. 

 

The white arrow icon on the desktop is called a mouse pointer. It is used to control a 
computer to do something. It moves around the screen while you move the mouse on the table 
with your hand. 

To click, hold down the left mouse button only once with your finger and release it 
immediately. You hover the mouse pointer over an icon or anywhere you want to control it to 
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do something. You click on an icon with the mouse to select it, and hold it to control the icon. 
Clicking on a button will activate the function of that button. 

To right-click, right-click on the mouse and release immediately. Normally, when you 
click the mouse, it will display a menu with various functions related to the location or object 
you clicked, and you can click the mouse to control any function. 

To long press and drag is one of the many computer functions. Holding and dragging 
an object is like holding something on the desktop with your hand to move it. To do this, you 
must hover the mouse pointer over the object you want to select and then hold down the left 
mouse button (click on it as you hold it). You can then move the mouse without releasing the 
left mouse button. The object you clicked on will move to the same position as the mouse you 
moved (by moving your mouse). When you release the left mouse button, the object is 
dropped at the point where the mouse pointer stops. 

  When you want to do a task or change one of the objects in the computer, you must 
select it first so that the computer knows which object to work with. To select an object, click 
on it. To select more than one object, you must hold down the mouse where there are no 
objects or icons, then drag the desired objects across the screen. All objects will be selected 
when the mouse is released. 

To double-click a mouse, immediately double-click the left mouse button and 
immediately release your hand from the left mouse button. Hovering the mouse over an object 
and double-clicking on it will activate the thing. If that is the case, it will open. If it is a text 
file, the computer will look for a program compatible with that text file and open it in that 
program. If it is a folder, the computer will open the folder in a window. 

d. Window of Application 
An application window is a box on 

the screen that displays the contents of an 
open folder or object, including some buttons 
or menus that can be used to control a 
function. We can open multiple windows on 
the desktop at the same time. The windows 
can be stacked on top of each other. Not all 
open windows are fully visible at once. The 
window can be resized or closed. If more 
than one window is open on your computer, 

one of those windows is the active window (the window we are working on), which is in front 
of the other windows with a full view of the screen. If you click on another window, the new 
window will reactivate and display its entire contents on the net. When you want to stop using 
a window, you can close it by simply hovering your mouse over it and pressing the left mouse 
button. 

When we work with computers, sometimes, for convenience, we have to open 
multiple windows on the desktop for any programs that we need. For windows that we do not 
want to close but want to save for later use, we can minimize that window (Minimize). The 
window will no longer appear on the desktop and will be minimized, displaying only its name 
in the taskbar (bottom bar of the computer screen). We can open it again by clicking on the 
name in the toolbar. When we click on the name of the minimized application on the taskbar, 
it will open the maximized application (its original size on the desktop or full screen). All 
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windows have buttons to maximize, minimize, or close (most are on the right side of Enabled, 
but these apps are minimized on this bar. 

The following is a snapshot of the taskbar of the three different systems currently in 
use: 

III. File Management 
To work productively with a computer, you must know how to organize and find files. 

This lesson explains how to use Windows tools to manage files. You’ll learn how to navigate 

the Windows file structure and change settings for viewing files. You’ll also learn how to copy, 

move, delete, and rename files. To make sure you can find the files you need, you’ll also create 

shortcuts and search for files. Finally, you’ll identify file types, so you are prepared for what 

happens when you open a file. 

 

1. Understanding How Windows Stores Files 
A file is a collection of data stored together. A report document, a photo of your pet, a 

recording of your favorite band singing “Happy Birthday,” and a video demonstrating how to 

bake a cake from scratch are all examples of data files. You store files in folders, containers for 

related files, and on drives, which are storage devices. You use folders to organize your files 

on a drive.  

Drives contain certain types of disks, which are storage media, including removable 

media and hard disks. Removable media are disks you insert or attach to a computer, such as 

USB drives (also called flash drives and thumb drives) and digital video discs (DVDs). The 

term hard disk refers to a disk installed in the system unit that can economically store many 

gigabytes of data. 

Before your computer can access a removable disk, you must insert the disk into a drive. 

A hard disk is housed inside the computer, so you don’t need to insert a hard disk before a 

computer can access it. An external hard disk is in a removable drive that you can attach to your 

computer.  

Windows names the drives on the computer by assigning each a drive letter. The hard 

drive containing the operating system is called drive C by default. The remaining drives can 

have any other letter from D to Z but are usually assigned in the order that the movements were 

installed on the computer. For example, the DVD drive might be drive D, and USB drives might 

be drive E, F, and G. 

By convention, Windows includes a colon (:) after each drive letter. For example, your 

hard drive might be named Local Disk (C:). Windows stores thousands of files in many folders 
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on your computer’s hard disk. These are system files that Windows needs to display the Start 

screen and desktop, access drives, and perform other operating system tasks. Windows 

organizes the folders and files in a structure or hierarchy called a file system to keep the system 

stable and find files quickly. At the top of the file, the system is the root directory, which is 

where Windows stores folders and essential files that it needs when you turn on the computer. 

These folders contain other folders, also called subfolders, in which you can store your files. 

 

Although you can access almost any folder on your computer, including the root 

directory, you should store your documents, music, videos, and other files in subfolders, not in 

the root directory or other folders containing system files. Most operating systems, including 

Windows, limit your access to critical files and folders in the root directory so you cannot 

inadvertently corrupt the file system. 

 

2. Using File Explorer 
Most operating systems include a file management tool you use to organize your files. 

File Explorer displays the contents of your computer, using icons to represent drives, folders, 

and files. You use File Explorer to display files and folders, navigate the Windows file system, 

and perform other file management tasks. 
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When you start File Explorer, it opens to show folders, devices, and drives on your 

computer, as in Figure ##. Windows provides four folders for your files: Documents, Music, 

Pictures, and Videos. The Desktop folder provides access to system resources such as the 

Recycle Bin, which you use later in this lesson when deleting files. The Downloads folder is 

for files you download or copy from the Internet and other networks. Devices and drives include 

the drives installed in your computer and any appliances or industries attached to your 

computer. 

 

3. Managing Files 
Managing files involves tasks that help you find files when you need them. These tasks 

include organizing the files into folders, deleting unnecessary files, and naming or renaming 

files so you can easily recognize their contents. To manage files, you group similar files in a 

folder, preferably a subfolder in one of the Windows default folders, such as Pictures for 

graphics and Documents for text files. You should divide the files into subfolders depending 

on the purpose or subject matter of the files and organize the subfolders from the top down. For 

example, a Courses folder might be a subfolder in the Documents folder. Within the Courses 

folder, there is a subfolder for each course you are taking, similar to the organization in the 

Figure below. 
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Windows only creates default folders on the hard drive, not removable media. If you 

are working with files on removable media, such as a USB drive, you can use folders stored in 

the root directory of the removable drive. For example, instead of using the Courses folder 

stored in the Documents folder on Local Disk (C:), you could use the Courses folder stored on 

Removable Disk (E:).  

Do not store your files in the root directory of the hard disk, a folder containing system 

files (usually named Windows), or a folder containing software files (any folder in the Program 

Files or Program Files (x86) folder). Windows expects to find system files and the files for 

specific applications within certain folders. If you reorganize or change these folders, Windows 

can’t locate these crucial files to start the applications stored in those folders. 

 

4. Folders 
The folder is an icon on a computer screen that can access a directory containing related 

files or documents. Before you organize files, you must create folders to have the files. You use 

File Explorer to create folders. (You use applications to create files.)  

When you create a folder, you give it a name, preferably one that describes its contents. 

A folder name can have up to 255 characters. Any character is allowed, except / \ : *? “ < > and 

. . 
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5. Copying and Moving Files and Folders 
To organize files into folders, you can copy or move the files. Reproducing places a 

duplicate of a file in a new location that you specify, the destination folder. Moving removes a 

file from its current site and places it in the destination folder. 

6. Deleting Files and Folders 
You should periodically delete files and folders you no longer need to stay organized 

and reduce the clutter on your disks. You delete a file or folder in File Explorer by deleting its 

icon. When you delete a file from a hard disk, Windows removes the file from the folder but 

stores the file contents in the Recycle Bin. The Recycle Bin is an area on your hard disk that 

holds deleted files until you remove them permanently. When you delete a folder from the hard 

disk, it and all its files are stored in the Recycle Bin. Suppose you change your mind and want 

to retrieve a deleted file or folder? In that case, you can double-click the Recycle Bin icon on 

the desktop to display deleted files in File Explorer, right-click the file or folder you want to 

retrieve, and then click Restore on the shortcut menu. However, after you empty the Recycle 

Bin, you can no longer recover its files. 

 

7. Renaming Files 
Like folder names, filenames should reflect the contents of the file. The central part of 

a filename can have up to 255 characters, which is plenty of characters for a descriptive 

filename. You should be able to recognize the contents of a file by looking at the filename. You 

can use spaces and certain punctuation symbols in your filenames, but not the signs / \ : *? “ < 

> or | because these characters have special meanings in Windows. 

Keep the following guidelines in mind as you name files: 

ü Use descriptive names: Avoid names that might make sense now but could cause 

confusion later, such as MyFile or Info. Use filenames that are long enough to be 

meaningful but short enough to be read easily on the screen. 

ü Do not change the file extension: If you change the file extension when naming a file, 

Windows might not be able to find a program that can open it. 

ü Follow a pattern: If possible, use a consistent naming scheme that is clear to you. For 

example, if you store many assignments in the same folder, the first assignment file 

could be named Assignment01, the next Assignment02, and so on. 

Be sure to give your files meaningful names that will help you remember their purpose and 

contents. The easiest way to rename a file is to use the Rename command on the file’s shortcut 

menu. You can also use the Rename button in the Organize group on the Home tab. 
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8. Creating Shortcuts 
In Windows, a shortcut is an icon or tile that provides a quick way to act, such as opening 

a folder or a file. You can create shortcuts in two places: on the Start screen and the desktop. If 

you often use a folder soon after you sign in to Windows, you can add or pin the folder to the 

Start screen, where it appears as a tile. Instead of displaying the desktop, starting File Explorer, 

and then navigating to the folder you want, you can click the folder’s tile on the Start screen to 

immediately open the folder on the desktop. 

You can pin folders on the hard disk to the Start screen but not on removable media 

such as a USB drive. Before pining the Backgrounds folder to the Start screen, copy it to the 

Pictures folder on your hard disk. 

 

9. File Types 
A computer can contain three 

categories: system files, application files, and 

data files. System files are those necessary for 

running the operating system. They usually 

are found in the root directory of a personal 

computer and the Windows folder of a 

Windows computer. On a Mac, system files 

are stored in the System folder. Linux computers keep system files in a folder named sys. An 

application file is part of an application, such as a word-processing application, and is necessary 

for running the software. These files are transferred to your computer when you install the 

application. A data file is one you create when working with an application, such as a document 

you write and format when working with Microsoft Word. Many system and application files 

are executable, meaning they can perform tasks automatically when you open them. In contrast, 

data files display data such as text or images or play a sound, music, or video.  

Recall that a file extension identifies the file type. It also identifies the broader category 

to which the file belongs. The system file category has the fewest file types. System files often 

have attributes set so they cannot be edited or deleted because those files are critical to computer 

operation. (A file attribute is a file detail or setting that can be turned on or off.) System files 

come only as part of the operating system or software. Similarly, application files come only as 

part of the software. Do not move, edit, or delete system or application files unless a computer 

expert gives you specific instructions.  
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On the other hand, data files are designed for you to create, edit, and manage. You can 

learn valuable information about a file from the information listed in the Type column of File 

Explorer in the Details view or from its file extension. For example, suppose you have two files 

named Get Organized, as shown in Figure 3–17. 

 

Note: Do not open the file by double-clicking it unless you receive an executable file (one with 

an extension such as .exe) from a trusted source. Doing so could trigger a virus or malware on 

your computer with harmful results. 

File Explorer identifies one of the files as a Microsoft Word Document. This file type 

has a .docx extension. File Explorer identifies the other file as a PNG file, a graphics file. This 

file type has a .png attachment. Though the main parts of these filenames are identical, the file 

types distinguish them as different files. The file extension also helps Windows identify what 

application should open the file. For example, if you double-click a file named Class Notes.docx 

in File Explorer, Microsoft Word opens it so you can edit it. If the Type column in File Explorer 

includes the name of an application, that indicates the application is installed on your computer 

and is available for opening. (If something is wrong with the file—if you change the file 

extension, the application probably cannot open the file.) For some file types, especially media 

files such as graphics, audio, and video, Windows does not identify an application but lists the 

file extension in the Type column of File Explorer. These file types are not associated with a 

specific application, making it difficult to predict what happens when you double-click the files. 

Double-clicking a png file, for example, might open an application that only lets you view the 

picture or one that enables you to edit it. When you need to specify an application to open a 

file, you can right-click the file, point to Open with on the shortcut menu, and then click the 

name of the application you want to use. You should be able to recognize common file types 

and their file extensions, so you know which files to avoid (system and application files) and to 
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identify applications you can use to open files. Table 3–3 lists typical file types by category and 

specifies their file extensions and associated operating system or application. 
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• A computer is an electronic device that receives data (input), processes data, stores 
data, and produces a result (output). Data is a collection of raw, unprocessed facts, 
including text, numbers, sound, images, and video. All basic computers consist of 
four functions: input, storage, processing, and output. 

• There are two types of personal computers: desktop computers and laptops. 
§ Desktop Computer: A personal computer for regular use at home or the 

office in one place on the desktop. It cannot be used anywhere, because it is 
large, has separate parts and needs regular electricity. 

§ Laptop: A small, lightweight personal computer that you can take with you. 
Laptops do not need to be plugged in regularly because they use a battery for 
their power supply. You just need to fully charge the battery. 

• A computer has four main components: 
§ System Unit 
§ Monitor 
§ Keyboard 
§ Mouse 

• A file is a collection of data stored together. 
• A folder is an icon on a computer screen that can be used to access a directory 

containing related files or documents. 

Summary 

 

1. What is a computer? 

2. What is IPOS of a computer? Please describe. 

3. What is personal computer? How many types are there? Please describe. 

4. What are the four main parts of a computer? Please describe. 

5. Describe how to turn on/off a computer. 

6. Describe how to copy and move files. 

Questions 
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1. Starting Up with Windows and How to Use the mouse. 

Turn on your computer by clicking the Open button on the system tray. When the 

desktop appears, each member of each group performs the following tasks: 

• Observe on the desktop. Mark any object as an icon. Count the number of icons 

available on the desktop.  

• Use the mouse and move it on the desktop. Click the mouse button on each icon 

to select it.  

• Move one of the icons to the center of the screen by long-pressing and dragging 

it.  

• Select more than one icon by holding down the mouse and dragging it across 

the desired icon location.  

• Move all selected icons simultaneously by clicking on one of the selected icons 

and dragging them to the desired location (all icons will be moved). 

• Reset all moved icons Back. 

2. Create folder 

A. Please create a folder name: “Lesson1 Using Computer in basic” in D drive by 

doing the following: 

• Open File Explorer 

• Navigate to where you want to create the new folder, and click New 

Folder. 

  

• Type the name of your folder, and press Enter. 

Exercises 
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Objectives: 
v Learn about OpenOffice.org Khmer 
v Install OpenOffice correctly 
v Compare OpenOffice.org kmer to other Office applications 

 

When you have finished this lesson, you will have learned the following: 

I. What is OpenOffice Khmer? 
II. OpenOffice Components 

III. Comparaing OpenOffice to MS Office 
IV. Installating OpenOffice 

Intro to OpenOffice.org Khmer 

Lesson 2 
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Lesson 2 Intro to OpenOffice.org Khmer 
I. What is OpenOffice? 
Khmer Office Software (OpenOffice.org) is suitable for your office work. 

Khmer Office Software (OpenOffice.org) has the following advantages: 

• No license fee: All users can use the full Khmer office software and distribute it for 

free. 

• Open source: You can distribute, copy or edit this software. 

• Cross Platform: This program can run on any system, such as Microsoft Windows, 

Linux, Linux, or macOS. 

• Multilingual support: It has a multilingual user interface. 

 

II. OpenOffice.org Component 
The Khmer Office program includes components such as: 

1. OpenOffice.org Writer 
The writer is a program to create letters, books, reports, newspapers, advertisements, 

and many other documents. You can add graphics or design text to your needs. Manuscripts 

can export documents in various formats, such as HTML, XHTML, PDF, and Microsoft 

Word. 
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2. OpenOffice.org Calc  
Calc is a program specializing in arithmetic and data analysis skills and creating charts 

for data. It also includes many formulas for financial work, statistics, mathematics, etc. 

 

3. OpenOffice.org Impress 
Impress offers a variety of presentation tools such as special effects, custom animations, 

transitions, slides and drawing tools, etc. In Slide Show, you can animate text or audio, 

images, and videos. 
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4. OpenOffice.org Draw 
Draw is a program that contains vector drawing tools that can draw shapes of various 

formats, such as diagrams, 3D flow charts (3D), and calligraphy. It has a smart connection 

line to connect to your points. With Draw, you can create your photo gallery and add it to 

your gallery. 

 

5. OpenOffice.org Base 
Base is a program for managing data. With OpenOffice.org Base, you can create and edit 

tables, forms, questions, or reports. 

 

6. OpenOffice.org Math Editor 
Math is a program for editing the formulas, fractions, or equations of the Khmer office 

program OpenOffice.org (Ooo). You can use this program to write complex equations, 

including special characters and symbols that are not in the standard font, and you can also 

use it to write mathematical formulas. 
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III. Comparation OpenOffice to Ms. Office 
Khmer office software OpenOffice.org is very similar to Microsoft Office software. The 

following table compares the identical components of these two programs: 

Function  OpenOffice.org Microsoft Office 

Word-processing  OpenOffice.org Writer Microsoft Word 

Spread sheet OpenOffice.org Calc Microsoft Excel 

Presentation  OpenOffice.org Impress Microsoft Power Point 

Database OpenOffice.org Base Microsoft Access 

Paint OpenOffice.org Draw None 

Math OpenOffice.org Math Microsoft Equation 

 

IV. OpenOffice.org Installation 
 Below you will find step-by-step instructions to download and install Apache 

OpenOffice 4. x versions on your system. 

1. Review the System Requirements for Apache OpenOffice use. 
Your computer needs these resources as a minimum to run Apache OpenOffice 4. x versions: 

ü Windows 7, Windows 8, Windows 10, Windows 11 

ü 256 Mbytes RAM (512 MB RAM recommended) 

ü At least 650 Mbytes available disk space for a default install (including a JRE) via 

download. After installing and deleting temporary installation files, Apache 

OpenOffice will use approximately 440 Mbytes of disk space 

ü 1024 x 768 or higher resolution with at least 256 colors 
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2. Download Apache OpenOffice 
Ø Go to the OpenOffice website: https://www.openoffice.org/download/ or scan the QR 

code 

Ø Select your operating system, language, and version 

Ø Click the Download full installation button 

 

Ø Your file will be downloaded  

 

Ø Go to the Download folder in the file and explore 

Ø Right-click on the Open office file  

Ø Chose Run as Administrator 

 

Ø When the message prompt appears, click the Yes button 
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Ø Click “Next” 

  

Ø Click “Unpack” 

 

Ø When Unpack is successful, click the “Next” button 
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Ø Chose “Anyone who uses this computer (all users)” 

 

Ø Chose “Typical” and click “Next” 

 

Ø Check “Create a start link on the desktop” 

Ø Click the “Install” button 
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Ø Wait for the Installation process to finish 

 

Ø When the Installation process is finished, click on the “Finish” button. 
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• Khmer Office Software (OpenOffice.org) has the following advantages: 
§ No license fee: All users have the right to use the full Khmer office software 

and distribute it for free. 
§ Open source: You are free to distribute, copy or edit this software. 
§ Cross Platform: This program can run on any system such as Microsoft 

Windows, Linux, or MacOS. 
§ Multilingual support: It has a multilingual user interface. 

• The Khmer Office program includes components such as: 
§ OpenOffice Writer 
§ OpenOffice Calc 
§ OpenOffice Impress 
§ OpenOffice Draw 
§ OpenOffice Math 
§ OpenOffice Base 

Summary 

 

1. What is OpenOffice.org Khmer? 

2. What is the advantage of OpenOffice? 

3. How many components of OpenOffice are there? Please describe each component. 

4. Compare Open Office and MS Office 

5. Describe how to download and install OpenOffice. 

Questions 



 

 
 

Introduction: 
This chapter covers the basics of working with text in Writer. You will learn about Writer’s menus, 
toolbars, and other topics covered in Lesson 1, Introducing Writer. 

Objectives: 
v A 
v B 
v C 

When you have finished this lesson, you will have learned how to: 

ü Discover the Writer window 
ü Zoom in and out 
ü Find icons on the formatting bar 
ü Align paragraphs 
ü Move the cursor with the mouse 
ü Select text with the mouse 
ü Rename the font, font size, and bold italics, and underline one layer, etc. 

Introduction to Open Office Writer 

Lesson 3 
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Lesson 3 Introduction to Open Office Writer 
I. Writer 

Writer is an OpenOffice.org article editor. Currently, many different programs can be 
used to create text files of different types. Writer is an important program that can help you to 
create text documents as it allows you to create an exciting text file with images and various 
formatting settings. 

With a writer, you can easily create text documents such as letters, brochures, schedules, 
certificates, price lists, questionnaires, exercise manuals, and lessons, etc. In addition, the 
manuscript also provides many other functions that allow you to create complex documents, 
such as writing projects, proposals, reports, and resumes, books, etc. These documents are 
multi-page, which may require page numbers, chapters, graphics, and tables of contents, etc. 

    

 

II. Opening a Writer Application 
Like you start other programs, you can open the OpenOffice Start Center or the Writer 

component from the operating system menu. When OpenOffice was installed on your computer, 
a menu entry for each element was usually added to the system menu.  

 
Ø Click Star menu 

Ø Type Calc 
Ø Chose Calc Icon 
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Note: When you open the first manuscript on the program’s title bar, the word “untitled” 
means the file Opened does not have a title or has not been saved before. 
 

III. Parts of the Main Writer Window 
 To efficiently use the program, you need to understand the user interface (User 
Interface) of the computer program. Usually, each program always has a point of 
Interface such as a title bar, menu bar, standard bar, format bar, and many more toolbars 
as indicated below: 

 
 

1. Title Bar 
The Title bar is located at the top of the Writer window. It shows the file name of the 

current document. When the document still needs to be named, the document name will 
appear as Untitled X, where X is a number. Untitled documents are numbered in the order in 
which they are created. 

 

2. Menu Bar 
 The Menu bar is located just below the Title bar in Windows and Linux and at the top 
of the screen in macOS. When you select one of the menus, a submenu drops down to show 
further options, including: 

• Commands that directly cause an action, such as Close or Save, in the File menu. 
• Commands that open dialogs. Three dots indicate the following command: Find... in 

the Edit menu. 
• Commands that open further submenus. These are characterized by a right-pointing 

arrow following a command, such as Toolbars and Zoom, in the View menu. Moving 
the cursor onto one of these items causes its submenu to open.  

 
3. Scroll bar 

There are two scroll bars: a horizontal scroll bar and a vertical scroll bar. We use these 
to view and move around files. 



Lesson 3 Introduction to Open Office Writer Part 1: ICT Basic 

27 

4. Sidebar 
The Sidebar usually is open by default on the right side of the Writer window, as shown 

in Figure 1. Select View > Sidebar on the Menu bar to display it if necessary. The Sidebar also 
has a Hide/Show icon, as shown in Figure 2. When the Sidebar is closed, it can be opened by 
clicking this icon, which will be on the far-right side of the window. 

The Writer Sidebar contains four decks by default: Properties, Styles and Formatting, 
Gallery, and Navigator. Each deck can be opened by clicking its corresponding icon on the Tab 
bar to the right of the sidebar. 

Each deck consists of a title bar and one or more content panels. A panel is like a 
combination of a toolbar and dialog. Toolbars and Sidebar panels share many functions. For 
example, the icons for making text bold or italic exist in both the Formatting toolbar in the main 
Writer window and the text panel of the Properties deck. 

Some panels contain a More Options button, which opens a dialog with additional 
editing controls. When the dialog is open, the document is locked for other editing. 

To adjust the width of the Sidebar, place the cursor on its left edge. When a double-
headed arrow appears, click and drag to the right or left. When the Properties deck is open, you 
cannot make the Sidebar smaller than a certain width. When any other deck is open, the Sidebar 
can be collapsed to the width of its Tab bar. 
 To undock the Sidebar and make it floating, and to dock a floating Sidebar, use the drop-
down list in the Sidebar Settings above the Tab bar. In the same list, you can use the 
Customization menu to choose which tabs you want to include in the Sidebar. 

 
 
The decks contained in the Sidebar are described below: 
Properties Deck: Contains tools for directly formatting content. 

When text is selected, these panels appear: 
– Text: Modify text properties such as the font name, size, color, weight, or character 

spacing. 
– Paragraph: Modify a paragraph’s alignment, background color, indent, and 

spacing, and toggle numbered or bulleted lists. 
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– Page: Contains tools for directly formatting the page style like Orientation, Margin, 
Size, and Column. 

 

• Caution 
Be aware that by changing the options on the Page, you will change the page style 
in use, modifying not only the current page but all pages using the same page style 
in this document. 

 

Navigator Deck: Browse the document and 
reorganize its content by selecting content 
categories, such as headings, tables, frames, 
images, etc. 

 
 

IV. Toolbars 
Standard bar: Contains many icons such as Open, Save, Print, Copy, Paste, Brush, and 
Format, etc. 

Formatting Bar: Contains various icons related to formatting text, paragraphs, and more. 

Gallery Deck: Shows images and diagrams included in the 
Gallery themes. The Gallery has two sections: the first lists 
the themes by name (Arrows, Bullets, Diagrams, and so on) 
and the second displays the images in the selected theme. 
For more information on using the Gallery to add images to 
a document, create new themes and add your own images. 
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1. Displaying or Hiding Toolbars 
To display or hide toolbars, go to View > Toolbars on the Menu bar, then click the 

toolbar’s name in the drop-down list. An active toolbar shows a check mark beside its name. 
Note that toolbars created from tool palettes are not listed in the View menu. 

To hide a toolbar, go to View > Toolbars on the Menu bar and deselect the toolbar, or 
right-click in a space between the icons on a toolbar and select Close toolbar in the context 
menu. 

 

 

2. Moving Toolbars 
 Dotted handles indicate docked toolbars on the left end (Figure 10). They can be 
undocked and moved to a new docked position or left as a floating toolbar. 

To undock a toolbar: 
Ø Move the mouse pointer over the toolbar handle, the small vertical bar to the left of a 

docked toolbar, as shown in Figure 10.  
Ø Your mouse pointer will be shown as a move pointer. Click the left mouse button and 

drag the toolbar to a new location. 
Ø Release the mouse button. 

 
To move a floating toolbar, click its title bar, drag it to a new floating location, or dock the 
toolbar at the top or bottom of the main window. 

• Note 
You can also dock a floating toolbar by holding down the Ctrl key and double-
clicking on the toolbar’s title bar. 

• Tip 
If the toolbar handle is not displayed, its position is locked. To unlock the toolbar, 
right-click it and then deselect the option Lock Toolbar Position. 
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3. Floating Toolbars 
Writer includes several toolbars whose default settings correspond to the current position of 
the cursor or selection (when toolbars are made active). For example, when the cursor is in a 
table, the Table toolbar appears, and when the cursor is in a numbered or bulleted list, the 
Bullets and Numbering toolbar appears. You can reposition or dock these toolbars described 
in “Error! Reference source not found.” Error! Reference source not found.. 

 
To position a toolbar, do any of the following: 

• Right-click somewhere in the floating toolbar and click Dock Toolbar in the context 
menu. You can reposition the toolbar to a different docked position. 

• Click Dock All Toolbars to dock all floating toolbars. 
• Click Close Toolbar to close the selected toolbar. 

 
4. Customizing Toolbars 
You can customize toolbars in several ways, including choosing which icons are visible and 
locking the position of a docked toolbar. You can also add icons and create new toolbars, as 
described in Chapter 20, Customizing Writer. To access a toolbar’s customization options, right-
click anywhere on the toolbar to open a context menu. 
To show or hide icons defined for the selected toolbar, click Visible Buttons on the context 
menu. Visible icons are indicated by an outline around the icon or by a check mark beside the 
icon (Figure 12), depending on your operating system. Select or deselect icons to hide or show 
them on the toolbar. 
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V. Rulers 
      The horizontal ruler across the top and the vertical ruler on the 
left of the workspace is shown by default. To enable or disable the 
ruler, choose View > Rulers on the Menu bar or Tools > Options 
> OpenOffice Writer > View and click on Ruler. 
 

 
VII. Cursor 

It is a small vertical black line that flashes, which is the starting point for the writer. 
You can move it with the mouse, click on the position you want to move to, or use the arrow 
keys. 

VIII. Status Bar 
The Writer Status bar is located at the bottom of the workspace. It provides information 

about the document and convenient ways to change some document features quickly. It can be 
hidden by deselecting it in the View menu. 

 

 

 
 

• Page Number: This shows the sequence number of the current page, the total number 
of pages in the document, and the current page number (if different from the sequence 
number). For example, if you restarted page numbering at one on the third page, its 
page number is one, and its sequence number is 3. 

• Text Language: Shows the language and localization used for spelling, hyphenation, 
and the thesaurus. It is based on the position of the cursor or the selected text. 

• View Layout: Click the corresponding icon to change between single-page, 
multiple-page, and book layout views (Figure 9). You can edit the document from 
any perspective. Zoom settings interact with the selected view layout and the 
window width to determine how many pages are visible in the document window. 

 
• Zoom: To change the view magnification, drag the Zoom slider, click the + and − 

signs, or right-click the zoom level percent to pop up a list of magnification values 
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from which to choose. Zoom interacts with the selected view layout to determine 
how many pages are visible in the document window. 

 
 

IX. Context (right-click) Menu 
       Context menus provide quick access to many menu 
functions. They are opened by right-clicking on a paragraph, 
graphic, or other object. When a context menu opens, the 
functions or options available will depend on the object that has 
been selected. This can be the easiest way to reach a function, 
especially if you are not sure where the function is located in the 
menus or toolbars. 

 
 

X. Dialogs 
A dialog is a particular type of window. Its purpose is to inform you of something, 

request input from you, or both. It provides controls for you to specify how to act. 
In most cases, you can interact only with the dialog (not the document itself) as long 

as it remains open. When you close the dialog (usually, clicking OK or a similar button saves 
your changes and closes the dialog. Clicking Cancel closes the dialog without saving any 

changes), you can work with the document again. Some dialogues can be left open as you 
work so you can switch back and forth between the dialog and your record. An example of 
this type is the Find & Replace and Insert Table dialog. 
 

XI. Creating a New Document 
You can create a new, blank document in Writer in several ways. If a document is already open 
in OpenOffice, the new document is made in a new window. 
 

1. From the Operating System Menu 
Like you start other programs, you can open the OpenOffice Start Center or the Writer 

component from the operating system menu. When OpenOffice was installed on your computer, 
a menu entry for each element was most likely added to the system menu. On macOS, the 
OpenOffice icon will be in the Applications folder. 
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2. From the Start Center 

When OpenOffice is open but no document is available, the Start Center (Figure 23) is 
shown. Click the Text Document icon to create a new text document. 

 
 

3. From the Menu Bar, Toolbar, or Keyboard 
When Writer is open, you can also start a new Writer document in one of these ways: 

• Press the Ctrl+N keys, or 
• Choose File > New > Text Document on the Menu bar, or 

• Click the New icon on the Standard toolbar. 
 

XII. Opening an Existing Document 
You can open an existing document by following: 

• Click the Open icon   on the Standard toolbar. 
• Or Click File -> Open 
• Or Ctrl + O 

 And then, Open Dialog will appear. Navigate to the folder you want, select the file, then 
click Open. If a document is already open in OpenOffice, the second document opens in a new 
window.  
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You can reduce the list of files in the Open dialog by selecting the type of file you are 

looking for. For example, if you choose Text documents as the file type, you will only see 
documents Writer can open. This method opens Word (.doc or .docx) files, other formats, and 
OpenDocument (.odt).  

 
 

XIII. Saving a Document 
You can save a document using any of the following commands: 

• Save: use if you are keeping the document, its current filename, and location. 
• Save As: use to create a new document, change the filename and file format, or save 

the file in a different location on your computer. 
 

1. Save Commands 
Do one of the following: 

• Press Ctrl+S. 
• Choose File > Save on the Menu bar. 
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• Click the Save icon  on the Standard toolbar. 
If the file has not been saved previously, a Save As dialog appears after selecting one 

of the above options. Enter the file name, verify the file name type and location, and click 
Save. 

If a previously-saved file is being saved with the same file name, type, and location, 
nothing else must be done. 

 

2. Save As ca Command 
Use this command if you want to save the current version as a new document by 

changing the file name or type or by saving the file in a different location on your computer. 
 Choose File > Save As, or use Ctrl+Shift+S to open a Save As dialog where you can 
change the file name, type, or location and click Save. 

 
ü Save: means to save what we entered after opening this old file. It does not display the 

Save As dialog, which requires a new name for this file, so the Save As dialog is not 
displayed when you select Save. 

ü Save As: means save by requiring us to assign a new name to the old one. The old file 
retains the same name and data format. 

• Note 
OpenOffice uses the term “export” for some file operations involving a change of 
file type, such as PDF. 

 

XIV. Undoing and Redoing Changes 
To undo the most recent change in a document, press Ctrl+Z, choose Edit > Undo on 

the Menu bar, or click the Undo icon on the Standard toolbar. To get a list of all the changes 
that can be undone, click the small triangle to the right of the Undo icon on the Standard 
toolbar. You can select several sequential changes on the list and undo them simultaneously. 
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 After changes have been undone, Redo becomes active. To redo a change, select Edit 
> Redo, press Ctrl+Y or click the Redo icon on the Standard toolbar. As with Undo, click the 
down arrow icon of the combination icon to get a list of the changes that can be restored. 

XV. Closing a Document 
If the document is open and you want to close that document, go to File > Close on the Menu 
bar or click the X on the Title bar. Depending on your operating system, the X may be located 
on either the right or left end of the Title bar. 

 
A message box is displayed if the document has not been saved since the last change. Choose 
whether to save or discard changes. 
 

 
 

XVI. Closing OpenOffice.org 

To close OpenOffice completely, click File > Exit, or close the last open document as 
described in “Closing a document” above. 

If all the documents have been saved, the Writer closes immediately. A warning 
message appears if any documents have been modified but not saved. Follow the “Closing a 
document” procedure to save or discard your changes. 
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Writer is an OpenOffice.org article editor. Currently, there are many 
different programs that can be used to create text files of different types. Writer is 
an important program that can help you to create text documents as it allows you 
to create an interesting text file with images and various formatting settings. 

With Writer you can easily create text documents such as letters, brochures, 
schedules, certificates, price lists, questionnaires, exercise manuals, lessons, etc. In 
addition, the manuscript also provides many other functions that allow you to create 
complex documents, such as writing projects, proposals, reports, resumes, books, 
etc. These documents are multi-page, which may require page numbers, chapters, 
graphics, and a table of contents. 

Summary 

 

1. What is Writer? 

2. What sidebar? 

3. What is a tools bar? 

4. Describe how to create a new document. 

5. Describe the difference between save and save as. 

Questions 

 

1. Open the Writer program and save it in your Documents folder as: Lesson 1. 

Exercises 
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Objectives: 
v Define the meaning of Khmer Unicode and Its Advantage 

v Type Khmer Unicode correctly  

v Use Khmer Unicode in daily life  

When you have finished this lesson, you will have learned: 

I. What Khmer Unicode Is 
II. The difference Between Old and Khmer Unicode Font 

III. Keyboard Layout and Unicode Typing 
IV. How to Type Khmer Unicode 

 

Khmer Unicode 

 Lesson 4 
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Lesson 4 Khmer Unicode 

I. Definition 

You already know that the writer program is a program that specializes in administrative 

matters such as writing letters, writing essays, etc. So, to make it easier to write Khmer text on 

the computer, you will learn how to type Khmer Unicode in this chapter. Before learning how 

to type Khmer Unicode, you need to understand Khmer Unicode first. 

Unicode is a universal encoding scheme for typing and text that defines a consistent, 

multilingual encoding method that can exchange text data internationally and lay the foundation 

for universal software. Unicode is not just another font but a new international standard for the 

Khmer language and the Royal Government of Cambodia. Computers around the world will 

understand Khmer when using Khmer Unicode fonts. Older fonts will be forgotten in the next 

few years, and all text will be in Unicode. All Unicode fonts have the same encoding and 

meaning when an article is typed. The Unicode font can be converted to other Unicode fonts, 

and the text will remain in the correct format. For example, text typed in the KhmerOS System 

will be visible to other machines that do not have the KhmerOS System fonts but have Unicode. 

What are the applicable Khmer codes? 

ü Khmer Unicode designs computer fonts (rounded corners, plain fonts ...) 

ü You can use Khmer Unicode to type Khmer text faster (spelling) 

ü Can display various information on websites that use Khmer Unicode 

ü You can find information online in Khmer through Google or Wikipedia (Khmer)  

ü Use Khmer Unicode to communicate in Khmer via email and chat 

ü Using Khmer Unicode allows you to sort Khmer letters alphabetically 

ü Using Khmer Unicode can check the spelling of Khmer words correctly 

Khmer Unicode is being introduced in many government institutions, schools, NGOs, and 

private companies in Cambodia. 

II. Differences Between Old and Unicode Fonts 

If you have used the old Khmer fonts (Lemon, Battambang, ABC, etc.) before, you need 

a little time to get used to the new fonts (Unicode fonts). But this should only require two or 

three days. In a very short time, you will be able to type faster. The main point is that you can 

type in spelling (“type in spelling” is not correct), not from left to right, as you write by hand. 
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One of the most important differences between the old typing style and Unicode modes 

is that when using new fonts, there is a key on the keyboard to represent each vowel, including 

េ◌ៀ េ◌ឿ េ◌ េ◌ េ◌ ◌ា◌ំ េ◌◌ះ etc. In Unicode, you can type all at once, as in Khmer, meaning there 

is no need to type in parts. For example, if you wanted to type words with older fonts, you 

would have to type: 

េ◌ +  ល  + ◌ី  But with the new font, you have to type:   ល + េ◌ 

In the example above, you will see that the keys are different, and you have to type the 

letters first and then type the vowels as you spell. ( ល ...េ◌ ) ។ 

The most unusual thing about this new typing mode is that the leg is no longer embedded 

in the keyboard. So, to type a letter, you have to use two different keys: a key indicates that the 

next letter is the letter foot, and then the standard key for that letter. For example, to write the 

word " កតី " you need to type: ក + ◌្ + ដ + ◌ី 

This is a way to increase typing speed because you do not have to remember all the 

literal feet on the keyboard. These are just some of the examples that introduce you to new ways 

of typing. We will now look at things in detail step by step, starting with understanding the 

Khmer characters. 

III. Keyboard Layout and Unicode Typing 

1. How to Use the Keyboard to Type Unicode 

Typing Khmer Unicode differs from using old Khmer fonts. We must first change the 

keyboard’s language before we can type Khmer Unicode. We can find out what language our 

keyboard uses by looking at the bottom right corner of your computer monitor screen. 

If you see ENG, which is short for English,  your computer uses an English keyboard, 

so all the keys you type will appear in English characters. 

If you see ែខមរ, it means that your computer is using a Khmer keyboard, so all the keys you 

type will appear in Khmer characters. 

 

2. How to Change the Keyboard to the Khmer Keyboard 

• Control the mouse pointer, click on the ENG letter, and select ែខមរ. or 
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• Press Shift and Alt keys simultaneously: Each time you press them, the keyboard 

changes immediately. If the keyboard is currently in English (ENG), it will switch to 

Khmer (ែខមរ), and if it is currently in a Khmer keyboard setting, it will switch to English. 

។ 

          

 

3. Learning the Keys 

 

 

Take a look at the Khmer Unicode keyboard layout. Example: Key R

 

• The letters, vowels, and punctuation at the bottom of the key are typed simply by 

pressing the key. For example: To order a letter រ, press R, the standard key. 

• The letters, vowels, and signs in the upper right are typed by pressing the shift key with 

that key. Example: To order a letter ឬ, press the Shift key + R. 

• Some letters that are not often used or some full vowels are placed in the upper left of 

the key and are greyed out by pressing the Alt Gr key. For example: To type a letter ឫ, 

press the Shift key (Al Gr) + R 
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IV. How to Type Khmer Unicode 

To type text using Khmer Unicode, you must type in the order of spelling, not writing 

from left to right. And the computer will arrange the letters in the correct order. 

ក. How to type consonants in combination with vowels 

It is best if you type in in the order of spelling, such as េល 

ល + េ◌   Is not  េ◌ + ល  +  ◌ី  

All words must be in this order. The syllables must be typed according to a general rule. 

Consonants + Subscript + Vowels + Signs 

For the Khmer spelling, the consonants and vowels are used the same way, so the 

consonants in this document refer to either consonants or independent vowels. 

Vowels are always typed behind the letter, even if written in front, behind, above, or 

below. The computer will place it in the correct position. Vowels with two parts, such as េ◌, 

are also typed after consonants. ៖ 

ល + ◌ិ  -> លិ 

គ + េ◌ -> េគ 

ន + េ◌ -> េន 

ល + េ◌ -> េល 

If the syllable has any alphabetical foot, that foot is typed behind the main letter but in 

front (if any). 

 

1. How to Type Consonant Subscript 

You should also note that the alphabet is not available on the keyboard as in previous 

fonts (Lemon, ABC, or other fonts) because in Unicode the consonant subscript and the main 
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consonant are used with the same keys. To signal that the next letter is a consonant subscript, 

the J key (◌្) is typed before the main consonant ។ 

 

Example: 

ច + ត + ◌្ + ត -> ចតត  

ស + ◌្ + រ + ◌ី -> រសី 

ស + ◌្ + រ + ែ◌ -> ែរស 

For a two-subscript syllable, you must type both subscripts in the order of the spelling, 

and a (◌្) sign must precede each subscript: 

ស + ◌្ + ត + ◌្ + រ + ◌ី -> រសតី 

Make sure you do not type the រ subscript before the other subscript. Adhere to the 

spelling sequence and do not type the consonant subscript behind the vowel. 

2. Special Case for Consonants 

There are some cases where some characters are represented by more than one shape 

depending on the different letters around them, in the case of the letter ប followed by ◌ា vowel. 

In previous fonts, it was necessary to have a unique character for this case, but in Unicode, you 

must type the normal key for the letter ប. When you type ◌ា, the computer will immediately 

change the shape of the letter ប. 

ប + -> ប  

The same goes for the letter ញ. You do not have to worry about the appearance of letters 

or subscripts ◌ញ. If you type correctly, a correct letter will appear: 
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ទ + ◌ា + ញ -> ទញ  

ស + ញ + ◌្ + ញ + ◌ា -> សញញ   

ខ + ◌្ + ញ + ◌ុ◌ំ -> ខញុ ំ 

ប + ញ + ◌្ + ច + េ◌ + ញ -> បេញចញ  

Don’t type ព + ◌ា instead of ញ. 

3. Special Case for Vowels 

There are several vowels that, although present on the keyboard, represents two different 

characters (they have no direct characters in Unicode): 

◌ា◌ំ   ◌ុ◌ំ   ◌ុ◌ះ   េ◌◌ះ   និង   េ◌◌ះ  

You can type these vowels directly with the keyboard keys, but if you want to delete 

them, you have to press the backspace key (<-) twice ។ 

In contrast, there is a vowel with the following two parts (split vowel): 

េ◌   េ◌ឿ   េ◌ៀ   េ◌   និង   េ◌ 

They are typed with a single key and erased by the backspace key.  

Other vowels not on the keyboard require double typing. For example: 

ក + ែ◌ + ◌ះ -> ែកះ 

 

4. Sign for Changing Consonant Sound  

Sometimes a character is called a letter changer, which changes the vowel sounds 

accompanying a letter. These are two characters: 

- A wavy line () changes the vowel sound that accompanies the voiceless consonant to 

the voiced consonant. It is used with a voiceless consonant that is not equivalent to any voice 

consonant. These are: 
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ស   ហ   អ  និង  ប  

-Mouse teeth (◌៉) are used to change the vowel sound that accompanies the voiced 

consonant to the voiceless consonant. It is used with a voiced consonant that is not equivalent 

to any voiceless consonant. These are: 

ង   ញ   ម   យ   រ   និង   វ  

The exception (◌៉) is also used with the letter ប to change its sound from ប to ប.៉ 

Consonantal characters are usually typed after the letter and subscript but must be typed in front 

of the vowel. Components with a sign for change consonant sounds are in the following order: 

Consonants + Subscript + Sign for change consonant sound + Vowels + Sign 

For example:  

យ + ◌៉ + ◌ា + ក -> យ៉ក  

ប + ◌៉ + េ◌ + ង + ប + ◌៉ + េ◌◌ះ -> េបង៉េប៉ះ  

ក + រ◌ + ◌ុ + ម + ហ + ◌៊ + ◌ុ + ន -> រកុមហុ៊ន  

ប + ◌៊ + ◌ុ + ត -> ប៊ុត  

ស + ◌្ + រ + ◌៊ + ◌ុ + ប -> រសុ៊ប  

ម + ◌្ + ហ + ◌៊ + ែ◌ + ត -> ែមហត៊ 

When a sign for a change consonant sound is followed by a vowel located above the 

consonant or by a vowel, the sign for a change consonant sound changes its position 

automatically under the main consonant. Also, it changes its shape to a vowel (◌ុ). And you do 

not have to type ◌ុ. Here are some examples: 

ស + ◌៊ -> ស៊  ស + ◌៊ + ◌ី -> សីុ 

ប + ◌៉ + ◌ី -> បីុ  ប + ន + ◌្ + ស + ◌៊ + ◌ី ->  បនសុ ី
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If you type vowels ◌ុ instead of ◌៊ or ◌៉, you will not be able to type two vowels in a row: 

ស + ◌ុ + ◌ី -> សុ◌ី 

There are three exceptions to the sign for change consonant sound, which does not 

change position even though the vowel is above the letter. The computer will set the correct 

order for the consonant you type. 

•  It will not change shape when the upper vowel is a ◌ំ because the combination of the ◌ំ 

vowel and the body changed to the lower vowel of the sign for a change consonant 

sound can be confused with a ◌ុ◌ំ. The same goes for all vowels that are placed on a 

consonant. If not combined with the sign for change consonant sound characters, the 

sign for change consonant sound characters will remain on the same consonant. 

អ + ◌៊ + ◌ំ -> អ៊ ំ

 

• It will not change shape when the letter ប is used in conjunction with ◌៊ because the 

reader will not know whether the following form represents for ◌៊ or ◌៉ (so if it is 

pronounced as a vowel, it must be changed or if it is pronounced as a consonant, it 

should be replaced ប ៉instead of ប 

ប + ◌៊ + ◌ិ + ក -> ប៊កិ 

 

• When there is one consonant, and one subscript, one of them is ហ. Typing must always 

follow the dictionary of Choun Nath. This is probably because the other consonant in 

the syllable may be the voiced consonant. If the sign for change consonant sound 

characters is changed, it is unclear whether ◌៊ applies to ហ or another consonant. 

អ + ◌្ + ហ + ◌៊ + ◌ិ + ◌ះ : -> អហ៊ះិ 

 

5. Sign 

There are three types of Signs in Khmer that form part of a syllable: 
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• rôbat ( ◌៌ ) ៖ rôbat is a Sanskrit loanword sign and has the same sound as putting the 

letter រ in front of the letter it is above. It is considered different from other signs. rôbat 

is usually typed after the consonant above and the vowel to be typed. A syllable with a 

rôbat (◌៌) cannot have a subscript or a vowel to be placed above a special consonant. 

When using rôbat (◌៌), the syllable must have this form ៖ 

consonant + rôbat (◌៌)  {+ vowel} {+sign}  

For example: 

ព + ណ + ◌៌ -> ពណ៌ 

ស + គ + ◌៌ + ◌ៈ -> សគៈ៌ 

ក + ប + ◌៌ + ◌ូ + រ -> កប៌ូរ 

ក + ◌ា + ប + ◌៌ + ◌ា + ស -> កប៌ស 

ស + ព + ◌៌ + េ◌ + ជ + ◌្ + ញ -> សេពជ៌ជ  

• Other punctuation marks ទណឌ ឃត (◌៍), សំេយគសញញ  (◌័) អសត  (◌៏) កកបទ ( ◌៎ ) 

វរិម ( ◌៑ ) និង បនតក ់(◌់) Is placed above the main letter ។ They are usually not used in 

combination with vowels. Still, in cases with vowels, they should be typed after the 

vowel and before the syllable after the syllable.។ When used with a vowel ◌ុ (do not 

confuse it with a ◌៊ or ◌៉). We have the following formula ៖ 

consonant + subscript + sign for change consonant sound + vowel + above sign + 

behind sign  
For example: 

ល + ក + ◌់ -> លក ់ 

ទ + ◌ំ + ព + ◌័ + រ –> ទំពរ័  

ណ + ◌៎ + ◌ះ  -> ណ៎ះ 
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ន + ◌ុ + ◌៎ + ◌ះ -> នុះ៎  

A computer automatically executes two exceptions, but you should also note them 

because sometimes the upper vowel can be combined with a cross, such as ៖ 

អ + ◌ី + ◌៎ + ◌ះ -> អ៎ីះ 

• The combination of ◌ិ + ◌៍ is used for many words. Some previous fonts had such special 

characters. In Unicode, both characters are typed separately, but they can be combined 

correctly, as in the example below. ៖ 

ព + េ◌ + ធ + ◌ិ + ◌៏ -> េពធc 

Technical Note: This is just a technical note. To make it easier to read, we call it a ◌ំ◌ិas 

vowel, but Unicode considers a ◌ំ as a sign, not a vowel. ។ Character ◌ា◌ំ and ◌ុ◌ំ Are formed 

by a combination of vowels ◌ា and ◌ុ with the sign ◌ំ (សញញ  និគគហីត) Both Khmer vowels 

(◌ា◌ំ and ◌ុ ) are available on the keyboard to adapt to Khmer culture, but the keyboard has 

created characters ◌ា or ◌ុ And then the characters ◌ំ. The same goes for vowels ◌ុ េ◌ and េ◌◌ះ 

They are automatically generated by the keyboard, but you have to understand that when we 

press one of these vowels, the keyboard must first create a vowel (◌ុ េ◌ or េ◌) and then a pair 

of small circles (◌ះ).  

• A pair of small circles (‘s) and dots (:) are always placed after the last syllable. They 

can’t be confused with two dots (and a) line (:) 

ក + ែ◌+ ◌ះ -> ែកះ 

6. Punctuation (។ ៕ ៖ ៗ ៙ ៚, “ ?) 
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The Khmer alphabet has punctuation marks such as the period (។). A period used to 

end an entire text or a chapter( ៕ ), two dots (and a) line (៖), duplication sign (ៗ), cock’s eye 

( ៙ ), and a period used at the end of poetic or religious texts ( ៚ ). 

In addition, some punctuation characters are borrowed from Latin letters, such as 

exclamation marks (!), periods (.), double quotations (“), and question marks (?). Dashes are 

used only for cross-sections. Punctuation in the Khmer language is usually separated from the 

words before and after by a space, except when used with an even duplication sign (ៗ). Latin 

punctuation marks are usually not separated by a word in front of them, except when used with 

double quotes (the words after the opening and before the closing double quotation marks are 

not spaces). In Khmer, space is also considered a punctuation mark used to pause speech, not 

to separate words. To type a space, press the SHIFT key and the spacebar at the same time. 

 

7. Combination 

In Unicode fonts, when the ◌ា vowel follows a letter, it changes shape slightly to make 

it more beautiful. If ◌ា vowel is deleted, the letter will be reverted to the original format. Users 

usually do not know how to combine this. They want the text to look pretty good. Please pay 

attention to this point ៖ 

ត + ◌ា -> ត  

You can see the variation of ត hair when combined with the vowel ◌ា.  

Another combination in the Khmer alphabet that also changes shape is between the round វ and 

◌ិ. 

!ទ ូ     វិទូ 
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8. Zero-width Space (ZWSP) 

Words in Khmer are typed consecutively and separated by a punctuation mark. 

Typewriters, Internet browsers, and other text-based programs need to know where to break 

each sentence into new lines. In Western languages that use spaces to separate words, this is 

certainly not a problem, but in Khmer, these programs do not know where to end a comment 

and a new line. 

In most newspapers in Cambodia, line breaks are done manually. The writer has to 

calculate whether the next word can be put in a line together, then they will work on that line 

manually. 

Web pages cannot be used this way because the page format depends on the browser 

window size on the user’s computer and screen resolution. 

The solution to this problem is to include invisible spaces between those words, which 

are just spaces for separating words from one word to another, and to let those programs know 

where to line up, so we cannot see the gap between the words. 

This character is called an invisible space, the most frequently used character in the text 

(100 keystrokes have 16 hidden spaces), so we decided to put the most commonly used 

keystroke on the key. The easiest click is the spacebar. Each time you press the invisible space, 

you will insert a space bar. If you press the spacebar invisibly (without pressing any other key), 

the characters inserted into the text become an invisible space. 

To type a space, you must press the SHIFT key combined with the spacebar. 

Invisible space is used for: 

ü Separation between Khmer words (split words) 

ü Typed after each word 

 

Note: Do not type between សល and េរៀន, because school is the same word for some of the 

following words: រទងរ់ទយ  ដំេណ រករ  រសវរជវ   ករងរ  ទកទ់ង រតឹមរតូវ... 

9. (Non-breakable Space) 
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In any language, there must be syllables, words, and phrases. The right combination of 

these components will form a paragraph of meaningful text. The important thing is to know 

how syllables, words, phrases, and sentences are different. But what makes it stand out? We 

hope you do this by studying Khmer Grammar. At this point, we would like to emphasize only 

the sentences. 

A sentence is a combination of words that is meaningful enough to be heard and ends 

with a punctuation mark, such as (.?....). In the same way, in Western languages, there is an 

ending with a punctuation mark. Still, the difference is that there is no gap between the words 

and the punctuation mark, thus making it easier for the typist to type without a single 

punctuation mark. Which one alone comes to a new line? In particular, in the Khmer language, 

by the grammar rules in writing between sentences, each sentence must be separated by a 

punctuation mark, and spaces must separate the words that follow the punctuation. This makes 

it somewhat tricky for the typist because when the punctuation mark is at the end of the 

paragraph, the spacebar causes the punctuation mark to fall on the new line alone, thus causing 

the text to lose its beauty. To avoid this problem in the computer system, we have created a 

unique key called interconnect. Spacing keys combine the Alt (Gr) key and the Space key. 

Formula: Word + Alternate Key + Invisible Space Key + Punctuation 

Adding a space between a word and a punctuation mark means that you can only see 

the space between the word and the punctuation mark normally, but embed a feature that helps 

keep the word and the punctuation stick together. The words that follow it cannot sign alone. 

This space can also be used with characters other than punctuation, and it retains its original 

character—spaces but no lines in the line.
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• Unicode is a universal encoding scheme for typing and text that defines a 
consistent, multilingual encoding method that can exchange text data 
internationally and lay the foundation for universal software. 

• To type text using Khmer Unicode, you are required to type in the order of 
spelling, not the order of writing from left to right. The computer will 
arrange the letters in the correct order. 

• Zero-width space is used to separate words. 

Summary 

 

1. What is Writer? 

2. What is a sidebar? 

3. What is a tools bar? 

4. Describe how to create a new document. 

5. Describe the difference between save and save as. 

Questions 
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Please write the text below: 

 

Exercises 
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Objectives: 
v Using Writer to format text 
v Formatting a paragraph 
v Creating a letter 

When you have finshed this lesson, you will have learned how to: 

I. Select Text 
II. Copy, Cut, and Paste 

III. Insert Special Characters 
IV. Format Characters 
V. Format a Paragraph  

Text and Paragraph Formatting 

Lesson 5 
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Lesson 5 Text and Paragraph Formatting 
I. Selecting Text 

You can swipe the mouse cursor over text or use multiple clicks to select a word (double-
click), sentence (triple-click), or paragraph (quadruple-click). 
You can also click on the text, press F8 to enter Extending selection mode, and then use the 
arrow keys on your keyboard to select a contiguous text block. Press F8 again after you have 
finished selecting the block of text. 

In addition, you can select non-contiguous items and vertical blocks of text. One way 
to change the selection mode is to use the icon on the Status bar (see Figure 1). When you right-
click the icon, a context menu displays the available options: Standard selection, Extending 
selection (F8), Adding selection (Shift+F8), and Block selection (Ctrl+Shift+F8). Left-clicking 
cycles through these selections. 

 
 

1. Selecting Non-consecutive Items 
To select non-consecutive items (Figure 2) using the mouse in Standard selection mode: 

Ø Select the first piece of text. 
Ø Hold down the Ctrl key and use the mouse to select the next part of the text. 
Ø Repeat as often as needed. 

To select non-consecutive items using the keyboard in Adding selection mode: 
Ø Select the first piece of text. For more information about keyboard selection of text, see 

the topic “Navigating and Selecting with the Keyboard” in the OpenOffice Help (F1). 
Ø Press Shift+F8 to enable Adding selection mode. 
Ø Use the arrow keys to move to the start of the next piece of text to be selected. Hold 

down the Shift key and select the next piece of text. 
Ø Repeat as often as required. 
Now you can work with the selected text (copy, delete, change the style, and so on). After 

finishing your work with the selected text, press Esc to exit Adding selection mode. 

 
 
2. Selecting a Vertical Block of Text 

You can select a vertical block of text that spans through multiple rows using Writer’s 
Block selection mode. Use Edit > Selection Mode > Block Area, or press Alt+Shift+F8, or 
click the Selection icon in the status bar and select Block selection in the list. Now you can 
highlight the selection using a mouse or keyboard, as shown in Figure 3. 
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II. Copying, Cutting, and Pasting Text 

You can copy or move text within or between documents by dragging or using menu 
selections, icons, or keyboard shortcuts. You can copy text from other sources, such as web 
pages, and paste it into a Writer document. 
 

1. Copying 
ü Select text, and click the Copy icon  on the standard bar. And insert the cursor at the 

paste-in point and click on the Paste icon  to paste.  
ü Select text, and hold down the Ctrl key while dragging. The text retains the formatting 

it had before pulling. 
ü Use Ctrl + C to Copy and Ctrl + V to paste 

2. Cutting 

ü Select text, and click the Cut icon  on the standard bar. And insert the cursor at 
the paste-in point and click on the Paste icon  to paste 

ü use Ctrl + X to cut Ctrl + V to paste.  
When you paste text, the result depends on the source of the text and how you paste it. If 

you click the Paste button, the pasted text keeps its original formatting (such as bold or italics). 
Text pasted from websites and other sources may be placed automatically into frames or tables 
as part of the format when you paste. 

To make the pasted text inherit the paragraph style at the insertion point: 
ü Choose Edit > Paste Special, or 
ü Click the arrow on the combination Paste button, or 
ü Press Ctrl+Shift+V 
ü Then select Unformatted text in the resulting menu. 
You can also press Ctrl+Alt+Shift+V, which pastes unformatted text directly. 

The choices on the Paste Special menu vary depending on the text’s origin and formatting (or 
another object) to be pasted. Figure 4 shows an example with text on the clipboard. 
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III. Inserting Special Characters 
A unique character is one not found on a basic English keyboard. For example, © ¾ æ ç Ł ñ ö 
ø ¢ are all special characters. 
To insert one or more special characters, place the cursor in the position where you want the 
characters to appear. Then do the following: 

• Click Insert > Special Character to open the Special Characters dialog (Figure 8). 
Double-click the characters (from any font or mixture of fonts) you wish to insert in 
order. They appear in the document as you select them. The selected characters are 
added to the Recent Characters list on the lower left of the dialogue. 

 

• Tips 
To view details of a character, single-click it. Details are shown on the right, along 
with its numerical code. 

To insert a character and leave the dialogue open, double-click the character. To 
insert a character and close the dialogue, click it and then click the Insert button. 

Different fonts include different special characters. If you are still looking for a particular 
special character you want, try changing the Font selection. 

 
IV. Formatting Characters 
1. Change Font Name 

Generally, a document can have multiple font name types. These fonts include Khmer 
OS Muol, Khmer OS, Khmer OS Moul Pali and Khmer OS Moul Pali, and many others. In the 
body of the administrative letter, they usually use the usual Khmer OS System or Khmer OS 
Battambang, and the national motto is usually in the Khmer font. OS Moul or Khmer OS Moul 
Light Other fonts depend on the user’s design. 

Available Khmer Unicode Font Styles: 

Khmer OS មូ៉តអកសរយូនីកូដែខមរ 

Khmer OS Battambang ម៉ូតអកសរយូនីកូដែខមរ	
Khmer OS Bokor មូ៉តអកសរយូនីកូដែខមរ 

Khmer OS Content ម៉ូតអកសរយូនីកូដែខមរ 
Khmer OS Fasthand ម៉ូតអកសរយូនកីដូែខ មរ 
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Khmer OS Freehand ម៉ូតអកសរយនីូកដូែខ មរ 

Khmer OS Metal Chrieng មូ៉តអកសរយូនីកូដែខមរ 

Khmer OS Muol ម៉តូអកសរយនីូកដូែខមរ 
Khmer OS Muol Light មូ៉តអកសរយនីូកដូែខមរ 
Khmer OS Pali ម៉តូអកសរយនីូកដូែខមរ 

Khmer OS Siemreap មូ៉តអកសរយូនីកូដែខមរ 

 
Method: 

Ø Select text 
Ø Drag the mouse to the font name on the Formatting 

toolbar or the font name box on the sidebar 
Ø Choose your font name. 

 

2. Change Font Size 
By default, the most commonly used font size with Khmer Unicode is 12. You can also 

resize the font as small or large as you like. When writing an administrative letter, it is common 
to use an 11 or 12 font size for the body of the letter. 

Method: 

Ø Select text 
Ø Drag the mouse to the font size box on the Formatting toolbar or the font 

size box on the sidebar 
Ø Choose your font size. 

 

3. Bold, Italic, and Underline 
Method: 

Ø Select text 
Ø Drag the mouse to the Bold , Italic  , and Underlined  icons on the Formatting 

toolbar on the sidebar 

B=Bold          I= Italic ,          U=Underline 

Note: To remove bold, italic, or underscore text, select the text and click the bold italic icon 
again. 
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4. Change Font Color 
Ø Select text 
Ø Drag the mouse to the font color icon on the Formatting 

toolbar or the font size box on the sidebar 
Ø Choose color 

 

 

 

 

V. Formatting Paragraph 
1. Text Alignment 

A paragraph is a text you type, starting with the characters you typed until you press the 
Enter key. So, pressing the Enter key means that the line breaks into a new paragraph. By 
default, when you type text, the left-aligned paragraph is set. You can customize the paragraph 
alignment via the icons on the Formatting Bar. 

Method: 

Ø Position the cursor where the paragraph you want to align 
Ø Select the Alignment icon on the Formatting bar 

• Align left  (Ctrl+L) 
• Center alignment  (Ctrl+E) 
• Align right (Ctrl+R) 
• Align justified  (Ctrl+J) 

2. Bullet 
Method: 

Ø Position the cursor where you want to insert 
a bullet in the paragraph 

Ø Click bullet on/off (Shift+F12) 
 

To choose more types of Bullets.  

Ø Click format menu 
Ø Choose bullet and numbering 
Ø Choose bullets tab 
Ø Choose bullet type 
Ø Click OK button 

• Align left  (Ctrl+L) 
• Center alignment  (Ctrl+E) 
• Align right (Ctrl+R) 
• Align justified  (Ctrl+J) 
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3. Numbering  
Method: 

Ø Position the cursor where you want to insert 
the numbering in the paragraph 

Ø Click numbering on/off (F12) 

To choose more types of numbering: 

Ø Click format menu 
Ø Choose bullet and numbering 
Ø Choose numbering tab 
Ø Choose numbering type 
Ø Click OK button 

 

 

4. Paragraph Indentation 
Paragraph indentation is the movement of text in or out of the text border to the first 

line or all text of a paragraph, left or right. The following will explain how to use the three 
triangle icons on a horizontal line to indent a paragraph. 

 

Method: 

1. Prey Veng 
2. Svay Reing  
3. Kompung Cham 
4. Takoe 
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Ø Hold down the mouse pointer to any triangle icon on the line. 
Ø Drag in or out at the distance you want. You will then see different indentation changes 

for the three types of triangles. 

Example: Set the following paragraph indentation: 

Ø The left triangle above the entrance distance of 1.5 cm. 
Ø Pull the bottom left triangle to a distance of 1 cm. 
Ø Pull the right triangle to a distance of 2 cm. 

 

But using a triangle icon, you need to know the exact value entered in the paragraph. So 
you can do the following. 

For example, you have the following three paragraphs inserted. You want to indent the 
second paragraph line where the left paragraph (before the text) is 1 cm. And the notable 
paragraph (after the text) is 2.5 cm. 

Ø Position the cursor in the paragraph that you want to format. E.g., second paragraph. 

 

Ø Enter the value of 1.00 cm. In the 
box before the text (same as using 
the lower left triangle on the line) 

Ø Enter the value of 2.50 cm. In the 
box after the text (same as using the 
right triangle on the line) 

Ø The first line: indicates a paragraph 
to the first line (same as using the 
upper left triangle) 

Ø Click OK button 
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5. Spacing Between Paragraphs 
Generally, a document can have multiple paragraphs. By default, each paragraph is 

contiguous, with no gaps at all. 
Therefore, to determine the spacing 
between each paragraph, you need to 
do the following: 

Ø Place the cursor in the 
paragraph where you want to 
set the spacing. E.g., place the 
cursor in the second paragraph 

Ø Choose Menu Format 
Ø Choose Paragraph 
Ø Select the Inline and Spacing tabs. In the space above the paragraph and below the 

paragraph 
Ø Above Paragraph: Sets the space value between the paragraph you hover the cursor 

over and the above paragraph on it. 
Ø Below Paragraph: Sets the amount of space between the paragraph where you hover 

the cursor over and the bottom paragraph. 
Ø Click the OK button 

 

 Or you can use the icon on the sidebar. 
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6. Spacing Between Lines in a Paragraph 
For example, you want to set the spacing between “1.5 lines” in the paragraph where you 
place the cursor. 

How to apply 

Ø Place the cursor in the paragraph 
where you want to set the line 
spacing 

Ø Choose Menu Format -> 
Paragraph 

Ø Select the Inline and Spacing 
tabs. Set the line spacing as in the 
box below: 

Ø Select line spacing 
Ø Click the OK button 

 

 

7. Positioning Tab Stops on Horizontal Lines 
The tab stop is set on the horizontal line and positions the cursor when you press the tab 

key. This tab stop is handy, allowing you to align the text evenly to the left, right, center, or 
decimal point. To set tab stops, follow these steps: 

Ø The tab stop types are: 
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 Align left 

 Align right 

 Center alignment 

 Align the decimals 

Ø Control the mouse pointer, click anywhere on the line 
Example:  1. Select the Left Tab Stop icon -> then click on positions 3 and 5 on the 

horizontal line. 
2. Select the Center Tab Stop icon -> and then right-click on position 12 

on the horizontal line. 
Ø Press the Tab key to move the cursor to the defined tab position 

 

 

 

VI. Default Formatting 
For formatted text, you can make it the default format. For example, if you have the text 

"ជតិ សសន រពះមហកសរត "in the following format, and you want to make it the default format, 
you can do as follows: 

Ø Insert formatted text 
Ø Select the text you want to set as the default format 
Ø Choose Menu Format -> Default Format 
Ø Or press Ctrl + M 

             

 

VII. Copy Text Format (Painting Format) 
In writing, you can copy one text format to paste into another text without formatting, 

with no re-texting. 

How to apply: 

Ø Place the cursor in a paragraph or any formatted word. 
Ø Click the Formatting Brush icon  on the Standard bar. 
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Ø Left-click on an unformatted text by holding down the mouse. 
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• You can swipe the mouse cursor over text or use multiple clicks to select a 
word (double-click), sentence (triple-click), or paragraph (quadruple-click). 

• You can also click on the text, press F8 to enter Extending selection mode, 
and then use the arrow keys on your keyboard to select a contiguous text 
block. Press F8 again after you have finished selecting the block of text. 

• In addition, you can select non-contiguous items and vertical blocks of text. 
One way to change the selection mode is to use the icon on the Status bar 
When you right-click the icon, a context menu displays the available 
options: Standard selection, extending selection (F8), Adding selection 
(Shift+F8), and Block selection (Ctrl+Shift+F8). Left-clicking cycles 
through these selections. 

Summary 

 

1. How many text selection types are there? Describe them. 

2. Describe the icon functions you have learned about in the Formatting Bar. 

3. What do you need to know to format an article? Describe how to format 

the text, giving examples you want to illustrate. 

4. Describe how to make bullets and numbers. Find examples to illustrate 

bullets and numbers. 

Questions 
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1.  Open the Writer application. 

2. Create an invitation in the following format. 

3. Save this file as “Invitation.” 

4. Close the application. 

 

Exercises 
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Writer provides a function for you to create data tables to manage your various tasks related 
to tables. Tables consisting of rows and columns form cells that allow you to enter numeric 
or alphanumeric data for any task. We can structure information into tables, such as study 
schedules. At the end of this lesson you will able to: 

ü Learning how to create a table 
ü Creating a table 
ü Using a table to organize data 

When you have finished this lesson, you will have learned: 

I. How to Create a Table 
II. Table Formating 

Table 

Lesson 6 
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Lesson 6 Table 
I. Creating a Table 

To create a table, you need technical skills related to tables, such as how to insert 
tables, edit tables, insert rows/delete columns, rows/columns, select a table, and format the 
table. 

Before creating a table, you need to know the number of rows and rows of data tables 
you want to create. You then need to place the cursor at any location on the sheet where you 
want to create the table. 

Method: 

Ø Choose Table menu 
Ø Choose Insert 
Ø Choose Table (Ctrl + F12) 
• Columns: To determine the number 

of columns of the table to be 
created. E.g., 3 

• Row: To determine the number of rows of the table to be created. E.g., 2 
Ø Click the OK button 
Ø You will then see a table created as follows: 

   
   

 

1. Moving the Cursor in a Table 
You can use the mouse or keyboard to move the cursor to any cell in the table. 

• Apply via mouse: 
Ø Control the mouse pointer by clicking on any cell you want to move. 

• Apply via keyboard: 
Ø Place the cursor in a cell and press the Tab key: to move the cursor to the right 

one cell at a time 
ü Press the Shift + Tab key: to move the cursor from right to left one cell at a time 
ü Press the down arrow key (↓): to move the cursor down one cell at a time 
ü Press the up arrow key (↓) (not up arrow): to move the cursor up one cell at a time  
ü Press Enter: to indent text in a cell 

 

2. Inserting Text in a Table 
You can enter text in a table using the keyboard. 

Ø Place the cursor in any cell where you want to insert text. Enter the text you want 
using the keyboard. E.g., please enter the following text: 
 

Name Sex Age 
SAN PHUN Male 27 
SAM AT SIV HONG Female 26 
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3. Adding Columns 
You can edit the inserted table, such as adding a new column, deleting a column, 

adding a row, deleting a row, inserting a cell, deleting a cell, inserting a cell, splitting cells, 
splitting tables, and so on. 

Example: You want to add two columns after the last column of the following legend: 

Method: 

Ø Place the cursor in any column where the new column will be next to or in front of the 
column where you place the cursor 

Ø Choose Table Menu 
Ø Choose Insert 
Ø Choose Columns 
Ø Enter the number of columns you want 
Ø Select the location where you want to display 

the new column, e.g. After 
Ø Click the OK button 

Name Sex Age   
SAN PHUN Male 27   
SAM AT SIV HONG Female 26   

 

4. Adding Row 
When you want to add a new row to the table you entered, you can do the following: 

Ø Place the cursor in the row where the new row 
will be next or previous 

Ø Choose Table Menu -> Insert -> Rows. 
Ø Enter the number of rows you want 
Ø Select the location to display the new row 
Ø Click the OK button 

Then two new rows will appear, as shown below: 

Name Sex Age   
SAN PHUN Male 27   
SAM AT SIV HONG Female 26   
     
     

 

5. Deleting Columns and Rows 
To delete a column in a table, follow these steps: 

Ø Place the cursor in the column where you want to delete the column 

Name Sex Age Address Phone 
SAN PHUN Male 27 Prey Veng 0987654321 
SAM AT SIV HONG Female 26 Prey Veng 0123456789 
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Ø Choose Table Menu 
Ø Choose Delete 
Ø Choose Columns 

 

To delete a row in a table, follow these steps: 

Ø Position the cursor in the row where you want to 
delete the row 

Ø Choose Table Menu 
Ø Choose Delete 
Ø Choose Rows 

6. Deleting a Table 
To delete a table, follow these steps: 

Ø Position the cursor in the column or row where you 
want to delete the table 

Ø Choose Table Menu 
Ø Choose Delete 
Ø Choose Table 

II. Table Formatting 
1. Selecting Tables, Rows, Columns 

Table selection is helpful for formatting text, inserting cells, and copying text or 
formulas in cells. There are many selections, such as table selection, row selection, column 
selection, and cell selection. This section will explain to you all the selections in the table. 

Cell Selection: 

Ø Place the cursor in the cell you want to select 
Ø Choose Table Menu 
Ø Choose Select 
Ø Choose Cells 

Name Sex Age 
SAN PHUN Male 27 
SAM AT SIV HONG Female 26 

 

Row Selection: 

Ø Place the cursor in any cell of the row that you want to select 
Ø Choose Table Menu 
Ø Choose Select 
Ø Choose Rows 

Name Sex Age 
SAN PHUN Male 27 
SAM AT SIV HONG Female 26 

 

Column Selection: 
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Ø Place the cursor in any cell of the column you want to select 
Ø Choose Table Menu 
Ø Choose Select 
Ø Choose Columns 

Name Sex Age 
SAN PHUN Male 27 
SAM AT SIV HONG Female 26 

 

2. Changing Width and Row Height of a Column 
You can zoom in or out on any column width and row height in the table. 

Ø Drag the mouse pointer to the right vertical line of the column you are zooming in or 
out on. 

Name Sex Age Address 
SAN PHUN Male 27  
SAM AT SIV HONG Female 26  

 
Ø Hold down the mouse button (left) and drag it to the size you want. 

Note: Changing the row height is the same as changing the column width; change the column 
to the row. 

3. Merging Cells 
In a table, you can merge multiple cells into a single cell. This means you want two or 

more of the selected cells to be one. You can merge cells only if you select more than one. 

How to apply to merge two selected cells into a single cell: 

Ø Select the cells that you want to merge (more than one). E.g., as follows: 

Name Sex Age   
SAN PHUN Male 27   
SAM AT SIV HONG Female 26   

 

Ø Choose Table Menu  
Ø Choose Merge Cells 

Name Sex Age  
SAN PHUN Male 27   
SAM AT SIV HONG Female 26   

 

4. Split Cell 
Splitting a cell means splitting one cell into multiple cells. So when splitting cells, you 

do not need to select two or more cells. You place the cursor in the cell you want to split. 
Then follow the steps below: 

Horizontal Cell Split: 

n 
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Ø Place the cursor in the cell you want to split 
Ø Choose Table Menu 
Ø Choose Split Cells 
Ø Select the number of cells to be divided by the 

partition. Do you want to split this cell into two or 
more cells by the number you set? 

Ø Select Horizontal Orientation 
Ø Click the OK button 

 

Vertical Cell Split: 

The same as in with the horizontal cell split, but this 
one is chosen vertically in direction. 

 

 

 

 

5. Aligning Text in Cells 
In the cell, you can align the text in two ways: horizontally or vertically. 

Align Text Horizontally: 

Ø Select the cell that contains the text you want to align 
Ø Drag the mouse pointer, click the alignment icon on the format bar 

 

Align Text Vertically: 

Ø Select the cell that contains the text you want to align 
Ø Right click the selected cell 
Ø Choose Select Cell 
Ø Choose Center. 

You will then see the text in the selected cell aligned to the 
center of the column, as shown in the image below: 

Name Sex Score 
Math Khmer Literature 

 

6. Cell Background Color 
In the table, you can color the area of the cell to make the table you created look 

interesting. 



Lesson 6 Table Part 1: ICT Basic 

71 

Method: 

Ø Select the cell for which you want to 
color it 

Ø Choose Table Menu 
Ø Choose Table Properties 
Ø Select Background tab 
Ø Choose your favorite color 
Ø Click the OK button 

Note: To remove the color you applied to any 
cell, you need to: 

Ø Select the cell in which you set the background color. 
Ø In the Background tab, select No Fill. 

7. Discovering Table Bars 
In Writer, the program provides a bar that can define various table characteristics, 

called the table bar. After you have inserted a table, a table bar will appear when you place the 
cursor at any position in the table. For users to set different attributes for this created table: 

 

1) Table 
2) Line style 
3) Line color 
4) Border 
5) Background color 
6) Merge cell 
7) Spit cell 
8) Top aligns 
9) Center aligns 
10) Bottom aligns 
11) Insert row 
12) Insert column 
13) Table properties 
14) SUM 

8. Table Border 
By default, when inserting a table for the first time, you may notice that the table has a 

single normal frame. In case you want the table to display different frame types, you need to 
do the following: 

Method: 
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Ø Select the cell for which you want to 
define the frame type. 

Ø Choose Table Menu 
Ø Choose Table Properties 
Ø Select the Frames tab 
Ø Choose a line style 
Ø Drag mouse click (click mouse and 

drag?) on line layout by default or user-
defined 

Ø Click the OK button 
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Before creating a table, you need to know the number of rows and the rows of 
data tables you want to create. You then need to place the cursor at any location 
on the sheet where you want to create the table. 

Method: 

Ø Choose Table menu 
Ø Choose Insert 
Ø Choose Table (Ctrl + F12) 
• Columns: To determine the number of columns of the table to be 

created. E.g., 3 
• Row: To determine the number of rows of the table to be created. E.g., 

2 

Summary 

 

1. Explain the table. 

2. What tasks can you use the table for? 

3. Can you calculate the numerical values in the spreadsheet program? 

4. Create a chart about student score management. 

Questions 
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Create a text file in the following format: 

 

Exercises 
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In most text documents, the observer sees images inserted to enhance the text or explain 
something. One, like the textbook you are reading, you see pictures inserted to explain 
something. Images in a computer can be scanned through a scanner, inserted through a 
removable storage device, or from memory. You are downloading from the Internet. Etc. At 
the end of this lesson you will be able to: 

ü Learn the method to add a picture and drawing an object in a document  
ü Adding a picture and formatting it 
ü Using a picture to enhance the text or explain something 

When you have finished this lesson, you will have learned how to: 

I. Create a Document Using a Picture 
II. Insert a Special Character 

III. Draw an Object 

Picture and Drawing Object 

Lesson 7 
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Lesson 7 Picture and Drawing Object 
I. Creating a Document with a Picture 
1. Insert Picture 
 Some pictures are included in the text to enhance or explain. You must have those 
images on your computer to insert images into a text. 

Method: 

Ø Position the cursor where you want to insert the image or any position in that 
paragraph. 

Ø Choose Insert menu 
Ø Choose Image 
Ø Choose From File 
Ø Select an image location. 
Ø Choose your favorite image. 

 

Ø Click Open button 
Ø You will then see the selected image inserted at the top position of the selected 

paragraph. 

 

 

 

2. Change Picture Size 
After you insert the image into the text, you can resize it to your liking. 

Method: 
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Ø Select an image by clicking on the image 
Ø Move the mouse pointer over any of the four corners of the image until a double-

pointed arrow (n) is displayed. 
Ø Hold down the mouse and drag it to the size you want. 

 

Note: To resize the image to the default width and height ratio, hold down the Shift key while 
you start. Download this image. 

 

3. Learn About the Picture Bar 
 When you click on the image you entered, you see an image bar appear. This bar lets 
you set various features for the picture, such as setting filters, adjusting brightness, making 
transparency, setting colors, and adjusting to gray, white/black. Flip the image horizontally or 
vertically. 

 

4. Aligning Images to Pages 
 For images you have already inserted, you can align them to the left or right of the 
page or the center of the page without dragging them with the mouse. Aligning with the 
mouse pulls to the center or leftmost position of the page, you will not be sure that the image 
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you are carrying will be in the center or leftmost of the page. Therefore, to be accurate in 
aligning or moving the image to the center or left of the page, you need to do the following: 

Ø Right-click the image you want to align. 
Ø Choose Alignment 
Ø Choose Left or Center or Right 

 

 

 

5. Wrapping Text Around an Image 
After you insert an image into the text, you can make the text around the image or the 

image above or below the text or the text separated. Out of the picture and wrap the best text 
with the image. 

For example, you want to best wrap the text with the image you entered above. 

Method: 

Ø Select image 
Ø Choose Menu Format 
Ø Choose Image 
Ø Select the wrap tab 
Ø Choose the type of wrap you 

prefer, E.g., Optimal 
Ø Click the OK button 

 

Or .... 

Ø Right-click on the image -> select 
wrap 

Ø Choose your preferred wrap type 
Ø No wrap: Text separated from 

images 
Ø Page wrap: Text around the image 
Ø Optimal page wrap: text on either 

side of the image 
Ø Wrap Through: Image above text 
Ø In the background: the picture 

below the text 

 

6. Setting Spacing from Image to Text 
After wrapping the best text for the image, you observe the text and the image next to 

each other. Therefore, to determine the gap between the image and the text, you need to do 
the following: 

Ø Select image 
Ø Choose Menu Format -> Image 
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Ø Select the wrap tab 
Ø In the gap, enter the value of the desired spacing 
Ø E.g., Straight right insert 0.50 cm. 

 

 

7. Adding Captions to Images 
In most textbooks, captions are added to the image to explain or identify the image 

type or to refer to the image. Image number caption period. 

Method: 

Ø Select image 
Ø Choose Insert menu -> Title 
Ø Enter an image title in the Title box 
Ø Select None in the Category box 
Ø Click the OK button 

 

 

II. Insert Special Characters 
Special characters are various symbols that characterize a character. This means that 

you can format it just like a character. The Leaf application provides a function for you to 
enter this special character. Entering special characters means you can enter as many special 
characters as you need at once. 

How to enter a special character: 
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Ø Choose Insert menu -> Special Characters 
Ø Select a font name in the Fonts dialog to change the Special Characters  

 

 

You can control the mouse pointer to select your favorite characters if you want to 
insert multiple special characters at once. It would be best if you often looked at the bottom of 
the special character box at the character:@@@&??? which is the output location of the 
special character you Selected. You can delete it by clicking the delete button and re-selecting 
it. 

 

 

III. Drawing an Object 
You can use the icons on the drawing bar to draw different drawing objects on your 

text. 

How to draw a drawing object: 

Ø Control the mouse pointer to select any drawing object on 
the drawing bar. 

Ø Click your favorite drawing object. E.g., a Smiling face 
Ø Hold down the mouse pointer at the point where you want 

to start drawing. 
Ø  Then drag to another location according to the size you 

want. 
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1. Properties of Drawing Objects 
 Below is a bar to define object properties, such as line style, arrow style, line width, 
color line, and style line/fill. Etc. 

 

How to apply to fill a drawing object: 

Ø Select the drawing object that you drew. 
Ø Control the mouse pointer, and select any properties that you want to place. 

 

 

2. Drawing Bar 
On the drawing bar, there are many drawing objects that you can choose to meet your 

work needs. There is a down arrow to the right of some drawing objects on the drawing bar. 
You see many other drawing objects when you click the mouse on this arrow. 

 

C. Insert text to drawing Object 

How to apply: 

Ø Draw an object. 
Ø Double-click the drawing object -> Enter the desired text. 

Or ... 
Ø Select the drawing object for which you want to insert text. 
Ø Press the Enter key 
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• In most text documents, the observer sees images inserted to enhance the 
text or explain something. For example, in the textbook you are reading, 
you see pictures inserted to explain something. Images in a computer can 
be scanned through a scanner, inserted through a removable storage device, 
or from memory, ones you’ve downloaded from the Internet, etc. 

Summary 

 

1. Describe how to insert an image into a text file and define text wrapping 

around the image. 

2. Describe how to draw an object into a text file. 

Questions 
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1. Please create the file text below: 

1. Wrap: Optimal wrap 

2. Spacing: 0.20 cm 

 

2. Draw diagram  

 

Exercises 
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Objective: 

ü Learn how to format page layout 
ü Define footer, header and coloum 
ü Printing file correctly 

When you have finished this lesson, you will have learned: 

I. Page Formating 
II. Columns 

III. Headers and Footers 
IV. Footnotes 
V. Tab Stop 

VI. Printing 

Page Layout and Printing  

Lesson 8 
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Lesson 8 Page Layout and Printing 
I. Page Formatting 
1. Page Margin 

Page formatting includes paper formatting, page 
orientation, and page margins. You can set it in the 
following ways:  

Margins: The margins are the blank spaces that line a 
document's top, bottom, left, and right sides. They are 
important because they help make a document look neat and 
professional. 

Set Margins: this means setting your worksheet’s page 
margins in the writer program. 

Method: 

Ø Choose Format Menu 
Ø Choose Page 
Ø Choose Page Tab 

 

 

 

Ø On the margin section, insert the margin value 
Ø Click OK button 

2. Page Size 
Set Page Size: This means setting the page size in the writer program, such as A3, A4, A5, 
Letter, and Legal. Etc. 

Method:  

Ø Choose Format menu 
Ø Choose Page Tab 
Ø Choose Page size on the format box 
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Ø Click OK button 

 

3. Page Orientation 
Page orientation is the direction of the page. Two types of orientation are: 

• Portrait 
• Landscape 

Method: 

Ø Choose Format menu 
Ø Choose Page Tab 
Ø Choose Orientation 
Ø Click OK Button 

 
 

II. Columns 
 In this section, you will learn more about some of the methods involved in inserting 
column layouts and using page styles, such as inserting a New page, column layout, 
header/footer and formatting, and so on. 

1. Add a New Page 
 You can add one or more new pages in the document when your article is more than 
one Page. The new page will be under the current page where the cursor is. 
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Method: 

Ø Place the cursor at the end of the document 
Ø Choose Insert menu 
Ø Manual Break 
Ø Select Page Break in type 
Ø Click the OK button 

Or 

Ø Place the cursor at the end of the document 
Ø Press the shortcut key Ctrl + Enter 

Note: In the Separation dialog, you see three options: 

• Line break: Move the cursor into a new line in the same paragraph (or press Shift + 
Enter) 

• Column break: to move the cursor into a new column Or you can press the shortcut 
keys Ctrl + Shift + Enter 

2. Insert Column 
 If you read an article in a newspaper or magazine, 
you will see that the article is written in a column layout. 
The manuscript also provides a function that allows you 
to insert layouts, format, and delete columns. 

Method: 

Ø Position the cursor where you want to insert the 
column 

Ø Choose Insert menu -> section 
Ø Select the Columns tab 
Ø Select the number of columns 

you want to insert 
Ø Uncheck Distribute content 

evenly across all columns: 
When checked, the text you 
typed will pass into the second column. Automatically when you finish a row in the 
first column. If unchecked, the text you typed will only appear in the first column 
unless you break the column. The text in the second column 

Ø Press the Insert button 

You will then see a two-column layout as shown below: 
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3. Inserting Text in the First Column Layout: 
Ø Move the cursor to the first column layout and type the following text: 

 

The two columns above are contiguous, making the typed text look contiguous. As if 
you needed to divide the columns. So, to make the two columns a little bit apart, you need to 
edit the column in the following way: 

Example: You want to set the distance between the two columns to 0.50 cm. 

Ø Place cursor in any column 
Ø Choose Menu Format -> Columns 
Ø Spacing: Enter the value you want. E.g., 0.50 cm. 

 

Ø Click OK button 

You will see two columns have a spacing of 0.50 CM: 
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4. Separator Line Between Columns: 
To place a line between two columns, do the 
following: 

Ø Place cursor in any column 
Ø Choose Menu Format -> Columns 
Ø At the Separator line: Select the type of line 

you want to divide between the two columns 
Ø Click the OK button 

 

 

5. Deleting a Column Layout: 
To delete a column layout or normalize text, do the following: 

Ø Place cursor in a column layout 
Ø Choose Menu Format -> Sections 
Ø Select the volume you want to delete 
Ø Click the Remove button 

 

Ø Click Remove Button 

III. Header and Footer 
 The header is the part of the header used to write the text so that it appears on every 
page. The footer is part of the footer for writing text to appear on every page below. 

1. Insert Header 
Method: 

Ø Choose Insert menu -> Header -> Default (default is page style) 
Ø Please include the following header text: 

 



Lesson 8 Page Layout and Printing Part 1: ICT Basic 

88 

 

 

2. Insert Footer 
Ø Choose Insert menu -> Footer -> Default (default is page style) 
Ø Enter the text you want. 

 

 

3. Header and Footer Formatting 
Header or footer formatting includes framing, background color, spacing, height 

setting, and more. 

Example: You want to place a line under the header or footer text or color the background: 

Ø Choose Format Menu -> Page 
Ø Select the header tab 
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Ø Click More… Button 
Ø Choose a line style 

 

Ø Select the location where you want to place the frame. To place a line under the header 
text, control the mouse pointer, and click below at the user-defined 

Ø Click the OK button 

 

 

4. Insert Page Number 
To include page numbers and page numbers in the footer, do the following: 

Ø Position the cursor in the footer or header where you want the page number to appear 
Ø Choose Insert menu -> Fields -> Page Numbers. 

 

Ø Position the cursor where you want to enter the number of pages 
Ø Choose Insert menu -> Fields -> Number of pages. 
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IV. Footnote 
When you insert a footnote into a word or phrase, you need to make an explanatory note 

of that footnote at the location. The selector is at the end of the footnote or the end of the 
document. Footnotes will appear in lowercase (power). This is useful when you want to explain 
a word or phrase in Your article to readers. 

How to apply a footnote: 

Ø Position the cursor where you want to place the 
footnote. 

Ø Choose Insert -> Footnotes / Endnotes ... 

On Numbering section 

• Automatic: For inserting footnotes in automatic sequence. 
• Characters: Enter a footnote or click the ... button to select various symbols as 

footnotes. 

On type section: 

• Footnotes: When you select it, the footnote 
description will appear at the end of the 
footnote page. 

• Endnotes: An annotation of footnotes will 
appear at the end of your document. 

Ø Click the OK button 

 

 

Insert footnote annotation 

 

 

1. Formatting Footnotes into Khmer Numbers 
You can not use font conversion to 

convert to Khmer numerals. Therefore, to 
make this entered footnote a Khmer 
number, you need to do the following: 

Ø Choose Tools Menu 
Ø Choose Footnotes/Endnote 
Ø Select the footnote or endnote tab 

according to your settings when you 
enter the footnote. 

Ø Drag the mouse pointer, right-click 
the numbering box 

Ø Select the Native Numbering 
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V. Defining Tab Stops by Filling in Characters 
You've already learned how to set tab stops using the tab stop icon on horizontal lines. 

. But the tab stop setting with the tab stop symbol on the line does not automatically fill in the 
characters or dashes. Therefore, to define a tab stop with a character fill, you need to follow 
the steps below. 

Example: Set tab stops as shown below: 

Chapter1 ................................................................................................................. 1 

Lesson1 .................................................................................................................. 2 

How to apply: Step 1 

Ø Position the cursor where 
you want to set the tab stop. 

Ø Choose Menu Format 
Ø Choose Paragraph 
Ø Select a tab 
Ø Set the tab stop value at the 

position: 16.00 cm. 
Ø Select type: Right 
Ø Select the sign or character 

you want to fill in, such as: 
Ø Note: Do not fill in 

characters 
Ø ......: When you press the tab 

key, it will display this sign. 
Ø Click New button 
Ø Click the OK button 

Step 2: 

Enter the word "Chapter 1" and press the Tab key. Then you will see the cursor move to 
the 16 cm position along with filling in the characters with dashes (.......).\ 
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VI. Printing 
1. Print Preview 

Generally, before printing a document, you should look at the page to know what 
format the document you are going to print is. To preview this page, follow these steps: 

Ø Choose File -> Page Preview 
Ø Or click the page preview icon on the standard 

bar 

 

 

 

Ø Use the arrow keys or the arrow icon on the preview bar to move from page to page. 

Note: You can not edit your file while on the preview page. To print your document, click the 
Print File icon  to set print options. 

2. Print Settings 
Before printing a document, make sure that the document you created is correct or 

organized. To avoid misprints, you should preview the page. 

How to apply: 

Ø Choose File menu -> Print or press the shortcut keys Ctrl + P 
Ø Select a printer name in the Printers dialog box. 
Ø Define print queues for copies and ranges 
Ø All pages: Print the entire document All pages 
Ø Pages: Print by page defined in the Page dialog 

Example: 1-5: Print pages 1 to 5. 7;11-15: Print pages 7 and pages 11 to 15 
Ø Click the OK button 
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• Page formatting includes paper formatting, page orientation, and page 
margins. You can set it in the following ways:  

• Margins:  margins are the blank spaces that line the top, bottom, and left 
and right sides of a document. They are important because they help make 
a document look neat and professional. 

• Set margins: means setting the page margins of your worksheet in the writer 
program. 

• The header is the part of the header that is used to write the text so that it 
appears on every top of the page. The footer is part of the footer for writing 
text to appear on every page below. 

Summary 

 

1. Describe how to set margins. 

2. Describe how apply columns. 

3. What are the benefits of inserting a header or footer? 

4. Explain how to convert page numbers to Khmer numbers. 

Questions 
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A. Please write text below: 

1. Create a letter that contains indentation, paragraphs, pictures, and tab 

stops on horizontal lines. 

2. Set tab stops to create a text file as follows: 

Note: Margin: 2 cm all side 

 

Exercises 
 



Lesson 8 Page Layout and Printing Part 1: ICT Basic 

96 

 

B. Create file in below format: 

1. Margin: 2 cm all sides 

2. Paper size: A4 

 

Exercises 
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In this lesson you will learn about how to create inventory in your class by using Apache 

OpenOffice Calc which is related to the following calculation: 

ü Use Apache OpenOffice Calc for creating inventory and calculation. 

ü Format the Calc spreadsheet to make it more interesting and use calculating 

addition such as (+) Sum, (-) Minus, (*) Multiply, and (/) Dividing. 

In this lesson you will learn the following: 

I. The Open Office Calc Application 

II. Calc Interface 

III. Inserting and Editing Data 

IV. Data Type 

V. Operator 

Introduction to OpenOffice Calc 

 Lesson 9 
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Lesson 9 Introduction to OpenOffice Calc 
I. What is Apache OpenOffice Calc 

Apache Open Office Calc is a spreadsheet program that facilitates calculations and tasks 

related to tables, such as lists. Income, expenses, payroll, staff, student scores, billing, and 

graphic design, etc. Arithmetic software is not used to type a simple text like a spreadsheet 

program but to analyze complex numbers and manage data. 

 

 

II. Starting Apache OpenOffice Calc 

To start using Apache OpenOffice Calc, 

follow some steps below: 

Ø Click on the Start button 

Ø Type Calc 

Ø Select OpenOffice.org Calc 

 

III. Discover the Calc Window 

To easily use Calc software, you need to know 

the main components of the program as follows: 
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IV. Discover Column, Row, Cell, and Cell Range 

In each tab of the arithmetic program, you see rows, columns, cells, and cell ranges that 

you need to understand to manage tasks in tab sheets easily. 

• Row is a horizontal row with a representative number at the end of the row from 1 to 

65536. 

• Column is a vertical row with letters at the head of columns A to IV (256) 

• Cells are intersected between rows and columns, forming cells. 

• Cell range is a set of cells you select from two or more cells. 

   

                    

 

V. Cell Address 

The cell address combines a column header name and a row number name (A1). It is not 

the combination of row number and column name (1A). 

To view cell addresses and data in the cell, you need to move the mouse pointer to click on a 

cell, and it will display the cell address where the cell pointer (boldest cell) is located. In the 

name box, display the data contained in that cell in the input range of the formula bar. 
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• Name Box: A box to display the name of the 

cell address where the cell cursor is located and can 

move the cell cursor to the cell position. Whichever one 

you want to search for, enter the cell address identifier 

in the name box and press the enter key. 

• Function Box: A place to display data or formulas that you have entered in a cell. 

   

 

VI. Move Cell Address 

There are two ways to move the cell address: 

1. Moving by Using the Mouse: 

Ø Control the mouse pointer to locate the cell you want to move. The cell cursor will 

then move to the cell of your choice. 

2. Moving by Using Arrow Keys 

Ø Use Arrow Keys: to move the cell cursor left, right, up, and down one cell at a time. 

Ø Press the Enter Key: to move the cell cursor down one cell at a time 

Ø Press the Tab Key: to move the cell cursor one cell at a time.                    

 

VII. Insert and Editing Data 

1. Insert Data 

To enter data, select the cell location in which you want to enter the data and click enter 

data through the board. After entering the data, you can: 

Ø Press the Tab Key: to move the cell cursor one cell at a time. 

Ø Press the Enter Key: to move the cell cursor down one cell at a time. 

   Example: Enter data in the following table: 

                        

 

Name box 



Lesson 9 Introduction to OpenOffice Calc Part 1: ICT Basic 

100 

 

The data you enter in the number is on the right side of the cell. The text input is on 

the left side of the cell. 

 

2. Editing Data 

For data that you have already entered, you can edit it by doing the following: 

• Move the cell cursor to any cell you want to edit. 

• Double-click the cell you want to edit or press the F2 key. Or drag the mouse pointer, click 

on the input line of the formula bar, and edit. 

 
• You can edit all the data in a cell by moving the cell cursor to that cell and 

inserting a new one. 

• After editing the data, you can not use the arrow keys to move the cell cursor. 

You need to press the Tab key or Enter ) to move the cell pointer. 

 

VIII. Deleting Data 

To delete data entered in a cell, you need to apply the following: 

Ø Select the cell that contains the data you want to delete. 

Ø Then press the Delete key. 

Then a content deletion box will appear as shown on the right: 

Ø Select which type of option you want to delete 

• Delete all: Delete all data types and formatting in the selected cell. 

• Text: Delete only data types as letters 

• Number: Delete only the data type as a number 

• Formula: Delete only any numeric value from the formula calculation 

• Comment: Delete only comments in the cell 

• Format: Delete only cell format and data format 

• Object: Delete only object word art that you have selected   

Ø Click Ok 
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IX. Cell Data Types 

You can identify the data types entered in the cells below: 

• Text: any character-type data will be aligned to the left of the cell. 

• Number 

• Date 

• Time 

• Formula 

 

X. Changing Column Width and Row Height 

You can change the column width or row height to suit the font size of the data you enter 

in the cell by following these steps: 

1. Changing Column Width: 

Ø Move the mouse pointer over the vertical line 

to the right of the column heading that you 

want to resize until the mouse pointer appears 

as a forward arrow.   

Ø Hold down the mouse and drag it left or right to the desired size. 

 

2. Changing Row Height 

Ø Move the mouse pointer over the horizontal 

column below the heading of the row you 

want to resize until the double-faced arrow is 

displayed  

Ø Hold down the left mouse button and drag the 

mouse up or down to the desired size. 

 

XI. Insert the New Column and Row 

In Calc, you can add rows or columns anywhere in the sheet. Sometimes you skip a name 

or something in the list. You do not need to delete everything and retype it. You add a row or 

column at the location you skipped. 

 

 

 All of this data will be aligned to the right of the cell 
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1. Insert a New Column  

To insert a new column, follow these steps: 

Ø Place the cell cursor at the location of the column you want to insert 

Ø Choose Insert menu → Columns 

Or … 
Ø Right-click the column heading at the location you want to insert. 
Ø Select Insert Columns 

 

        

 

 

2. Insert New Row 

To insert a new row, follow these steps: 

Ø Place the cell cursor at the location of the row you want to insert 

Ø Choose Insert menu → Row 
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XII. Operator 

Calculations in OpenOffice Calc are more accurate and precise than manual calculations. 

In this lesson, we will give you some calculations using mathematical operations such as Sum 

(+) Minus (-), Multiply (* ), Divide (/), and so on. 

 

All calculations in arithmetic applications must always start with an equal sign (=). 

 

1. Calculation Numbers 

Have you ever used a calculator? Calculating using real numbers in the Calc program is 

the same as using a calculator. Add an equal sign (=) in front of that calculation. Ex: =9+6+5 

(+): =number + number+…+numberÃ (*): =number * number*…*numberÃ 

(-): =number – number-…-numberÃ (/): =number / number/…/numberÃ 

 

Example: Calculate using a real number by taking 10 plus 20. 

What is the result? In cell A1 enter = 10 + 20 Ã 

How to apply: 

Ø Select cell A1 to write a formula 

Ø  Enter equal sign (=) 

Ø  Enter 10 + 20 and press Enter key 

Ø It will then display the results you calculated         

 

2. Calculation by Using the Cell Address 

Example: Calculate the total score using the cell address containing the numeric value to be 

calculated as follows:  

How to apply: 

Ø Select cell E3 

Ø Enter =C3+D3 

Ø Enter key 
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• Apache Open Office Calc is a spreadsheet program that facilitates calcula-
tions and tasks related to tables, such as lists. Income, expenses, payroll, 
staff, student scores, billing, and graphic design, etc. Arithmetic software is 
not used for typing simple text like a spreadsheet program. Rather, it is used 
for analyzing complex numbers and managing data 

• Row Is a horizontal row with a representative number at the end of the row 
from 1 to 65536. 

• Column is a vertical row with letters at the head of columns A to IV (256) 
• Cells are intersected between rows and columns, forming cells. 
• Cell range is a set of cells you select from two or more cells. 
• The cell address combines a column header name and a row number name 

(A1). It is not a combination of row number and column name (1A) 
• All calculations in arithmetic applications must always start with an equal 

sign (=). 

Summary 

 
1. What is OpenOffice Writer? 

2. What is a cell address? How do we move the cell address to cell Z2500? 

3. How many columns and rows are there in the OpenOffice Writer? 

4. What do you need to do to calculate an operation? Give examples. 

5. Which operator priority is applied first to calculate an operator? 

6. Create a table on student score management for Khmer language computer 

programs (manuscripts, arithmetic, exhibitions, internet, and email). What 

field names (table headers) do you need to create? And which field do you 

need to create to do the calculation? 

Questions 
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The classroom has desks, chairs, books, various objects, and computer 

equipment. Sometimes monitoring everything in a classroom is difficult. What 

are some ways you can keep those inventories in your classroom? One way is 

to use a computer to create a classroom inventory. 

1. Create an inventory of furniture and fixtures in your classroom. See 

the example below: 

 

2. If working with a partner, discuss the following questions with them. 

Writing or sketching your ideas on paper is helpful. 

• What furniture, equipment, books, and objects do you have in your 

classroom? How can you organize similar objects into groups? 

• How much is each item worth? 

• What information can help you identify each specific object type? Do your 

electronics have an ID number? 

3. Save this file as “Class 6A Inventory” in your folder. 

4. Close the application. 

Exercises 
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In this lesson you will learn how to create a document related to the student score 

management table and be able to use Calc software. 

ü Know the basic cell format 

ü Manage data in cell 

ü Know the basic functions 

You will learn more about the following: 

I. Selecting Cells 

II. Resizing all Columns and Rows 

III. Inserting Columns and Rows 

IV. Delete Cells, Rows and Columns 

V. Inserting Auto Numbering 

VI. Formatting Ttext 

VII. Merging Cells 

VIII. Using the Sum and Average Formulas 

 

Formatting Row, Column, Text, and Formula 

 Lesson 10 
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Lesson 10 Formatting Row, Column, Text, and Formula  
I. Selecting Cells by Using Mouse 

  To format a cell or data in a cell, you must first select that cell. Using the mouse is 

a quick way to select cells by pressing the mouse pointer, or whichever way you want. 

 1. Selecting Multiple Cells 

To select multiple cells in a row, do the following: 

Ø Hold down the mouse pointer to the location of the cell 

you want to start, select and hold (ed start from cell A2) 

Ø Drag the mouse to the next cell to the point  you want 

to stop selecting (e.g., stop at cell F2) 

 

Example: Select a cell in the following table: 

 

 

 

 

 

 2. Select Multiple Cells Separately 

 To select multiple cells separately, you need to do the following: 

Ø Control the mouse pointer, click on the cell you want to start selecting 

Ø Hold down the (Ctrl) Key  

Ø Control the mouse pointer and click on the location of the cells you want to add 

Ø Release the Ctrl key. 

 Example: Try to select a numeric value of points less than 50 in the table.  

 
 4. Selecting All Cells 
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If you want to select an entire sheet, you have to control the mouse pointer first. Then click 

on the top left corner of the sheet (header name Column A and above the row header name 1), 

or click Ctrl + A 

 
 

5. Selecting Columns 

To select columns, follow as below:  

Ø Select the mouse pointer on the head of columns (e.g., column C) 

 

 

If you want to select multiple columns, left-click on the column heading you 

want to start selecting and drag left or right according to the number of columns 

you want, and then release the left mouse button. 

 

6. Select Rows 

 To select a row, you need to: 

Ø Control the mouse pointer 

Ø Click on the header row you want to select (e.g., column 2) 

Ø Or... press the shortcut key: 

      Shift + Space 

 

 

If you want to select multiple rows, click the heading of the row you want to 

start, select and hold, and then drag up or down. Below is the number of rows 

you want to select. 

 

7. Select Sheet 

If you are already working on one worksheet, you can switch to working on another 

worksheet by following these steps: 

Ø Control the mouse pointer, click on any tab you want to select (e.g., Sheet w) 

 

II. Resizing All Columns Evenly 
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In the previous lesson, you learned how to resize columns or rows, but for this lesson, we 

will teach you how to resize all columns to the same size. 

How to apply a change in the width of all columns equally: 

• Select the entire sheet or press the shortcut key Ctrl + A 

• Resize any column. All columns will resize to the one you changed. 

              
                      

 

Resolving all rows equally applies to resizing columns. You need to select all the 

rows and resize any rows, and all the rows will resize accordingly. 

 

III. Insert More Columns and More Rows 

You can insert multiple endings or slides at once. 

1. Insert More Columns 

To insert multiple columns at once, follow these steps: 

Ø Select the cell in the column location 

that you want to insert. 

Ø Choose Insert Menu → Columns. 

 

 

 

 

 

 Or... you can insert a new column as follows: 

Ø Select the column where you want to insert the new column 

Ø Right-click the selected column heading → Select Insert Columns 

 

 

A1:AMJ1048576 A1:AMJ1048576 
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Example: Enter the following physics and chemistry scores and subtract the result 

from the old total and mean scores, and you will Recalculate it later. 

     

 

 

 

2. Insert Multiple Rows 

 To insert multiple rows at once, follow these steps: 

Ø Select the cell in the location of the 

rows that you want to insert. (e.g., 

Cell A4:A5) 

Ø Choose Insert Menu → rows 

 
Example    Insert a new data record in the newly inserted row. Re-number and add a new record 

in the new row. 
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IV. Deleting Columns and Rows 

1. Deleting Columns 

 If you want to delete a column, you need to do the following: 

Ø Select columns that you want to delete 

Ø Chose to Edit menu → Delete 

 
 

 

 

 

 

 

 

 

2. Delete Rows 

If you want to delete a column, you need to do the following: 

Ø Select the number of rows that you want to delete 

Ø Chose Edit menu →  Delete 

 

V. Auto Numbering 

To enter automatic numbering, you need to do the following: 

Ø Enter the numeric value that you want to start. E.g., Type 1 in cell A3) 

Ø Select cell A3 (take the mouse pointer, and click on cell A3) 
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Ø Hold the mouse pointer until the plus sign (+) is displayed. 

Ø Hold down the mouse and drag the mouse to another location until you get the desired 

end value. 

 

                                           
 

 

VI. Formatting Text in Cells 

  In Calc, you can also format 

text, such as renaming fonts, 

changing font sizes, aligning text in 

cells and changing font colors, as in 

the manuscript program. 

 You can use the icons on the Formatting bar to format text in the following cells: 

 
  

Ø Change Font Name: Click on the right arrow in the Font Name box 

Ø Change Font Size: Control the mouse pointer, and click the right arrow button in the 

Font Size box. 

The text of the selected cell will be displayed as follows: 
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Ø Remove/Bold/Italics, Underline and Align.  Control the mouse pointer, click on the 

bold italic icon, and underline the following: 

Bold: Use to make text bold 

Italics: Use to make text italics 

Underline: Use to underline the text 

Alignment: Align text left, right, center and justify as you want 

 

VII. Merge Cells 

 You can merge multiple cells into a single cell by following these steps: 

 

Ø Select the cells you want to merge 

Ø Click on the merge icon  

 

 

 

 

 

 

 

 

 

VIII. Insert Border 

 If you want to frame a cell, you must do the following: 
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Ø Select the cell range in which you want to add a border 

Ø Click on the border icon  

Ø Select types of border you want 

 

 

 

 

 

IX. Using SUM  

You have already learned about calculations using operators, but this method is only 

possible if you have a little data. So, to make it easier to calculate the sum quickly, you need to 

use the SUM () formula, as shown in the example below: 

Ø Select the cell that wants to use the formula 

Ø Click on the sum icon ∑ to create an auto sum 

Ø Click on the OK icon    or press Enter Key. 

 

 
X. SUM Formula 

SUM is a formula for calculating the sum of all numbers in a cell range. 

Formula: =SUM(number1; number2; ...) 

Numbe1; Number2; … can be: 

• Value =SUM(70;50;80) result is 200 

• Cell Address =SUM(C3;D3;E3) result is 200 

• Cell Address Range =SUM(C3:E3) result is 200 
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XI. Using AVERAGE Formula 

AVERAGE is a formula for calculating the mean values in a cell range. 

Formula: =AVERAGE(number1; number2; ...) 

Number1; number2;... can be 

• Value =AVERAGE(70;59;80) result is 66,67 

• Cell Address =AVERAGE(C3;D3;E3) result is 66,67 

• Cell Address Range =AVERAGE(C3:E3) result is 66,67 

 

 Operators and Formula Names: 

Operators and 

Formula Name 
Purpose Example 

= All formulas must start with an equal sign (=)  

+ Perform a sum operation between values =3+5 

- Perform subtraction operations between values =A1-B1 

* 
Perform multiplication operations between 

values 
=B1*2 

/ Perform a value division operation =A1/C2 

SUM Calculates the sum of all values in a cell range =SUM(A1:A3) 

AVERAGE 
Calculates the average of all values in a cell 

range 

=AVERAGE(A2,B1,

C3) 
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• SUM is a formula for calculating the sum of all numbers in a cell range. 
Formula: =SUM(number1; number2; ...) 
§ Numbe1; Number2; … can be: 
§ Value =SUM(70;50;80) result is 200 
§ Cell Address =SUM(C3;D3;E3) result is 200 
§ Cell Address Range =SUM(C3:E3) result is 200 

• AVERAGE is a formula for calculating the mean values in a cell range. 
Formula: =AVERAGE(number1; number2; ...) Number1; number2;... can 
be 
§ Value =AVERAGE(70;59;80) result is 66,67 
§ Cell Address =AVERAGE(C3;D3;E3) result is 66,67 
§ Cell Address Range =AVERAGE(C3:E3) result is 66,67 

Summary 

 
1. Explain how to resize all columns evenly? 

2. How do you enter automatic numbering? E.g., 1 2 3 4 5 6 7 8 9 10 11 12 

13 14 15 

3. How do you insert multiple rows and columns? 

4. Write the following formula correctly and describe the function of each 

formula: 

a. SUM 

b. AVERAGE 

Questions 
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The following is the monthly score of a high school student. The Office of Student 

Affairs requires that the student score manager enter each subject’s score and calculate 

the “total score” and “average” as below: 

• Total score: Sum of the three subject scores: “Khmer” + “Mathematics” + 

“Physics” 

• Average: The average of the three subject scores. 

 

Exercises 
 



1 

After you finish this lesson, you will be able to: 

ü Edit sheets, such as renaming sheets, inserting new sheets, deleting sheets 

ü Format cells, such as framing cells, text alignment, text effects, and numeric 

formatting 

In this lesson, you will learn the following: 

I. Sheet Management 

II. Number Formatting  

Sheet and Number Format 

 Lesson 11 
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Lesson 11 Sheet and Number Format 
I. Rename Sheet 

You can rename the worksheet to make it easier to identify the data types in the worksheet. 

You can rename a worksheet in the following ways: 

Ø Select the sheet tab you want to rename 

Ø Choose Menu Format -> Sheet -> Rename … 

Ø Enter a new name in the Name box 

Ø Click the OK button 

Or ... 

Ø Right-click the sheet you want to rename and select Rename Sheet. 

Ø The sheet renaming box will then appear as shown below: 

 

             
 

II. Insert New Sheet 

 If you want to insert a new sheet in a spreadsheet, follow these steps: 

Ø Choose Insert menu -> Sheet ... 

• Location: To select a new sheet location to insert 

• Sheets: To determine the number of new sheets 

you want to insert 

Ø Click the OK button 

 

III. Delete Sheet 

You can delete a sheet from a spreadsheet by 

following these steps: 

Ø Select which sheet you want to delete 

Ø Choose Edit menu -> Sheet -> Delete. 

Ø Or right-click on the selected sheet  

Ø Select Delete Sheet ... 
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Ø The following box will then appear: 

Click the Yes button to delete 

     

 

 

 

IV. Number Formatting 

Number formatting involves fonts, effects, text, alignment and text orientation, cell 

borders, cell background settings and cell protection. In the Number tab, you can define the 

number format you want in “User Defined”. 

The number format settings are as follows: 

• Preceded by Zero (001) 

• Number in Khmer (១២៣) 

• Percentage (12.95%) 

• Riel (១.២៣៤៛) Dollar ($ 1,234,00) 

• Date (Friday, December 31, 1999) 

 

1. Vertical Text Alignment 

To align text in any part of a column in a cell, follow these steps: 

Ø Select the cells where you 

want to align the text 

Ø Choose Menu Format – Cells 

The Cell Format dialog box will then 

appear as shown below: 

Ø Select the Alignment tab 

Ø In the Vertical Cell Formatting dialog, select Center 

Or ... 
Ø Choose a format menu 
Ø Select alignment 
Ø Select center 

 E.g. 
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2. Text Orientation 

You can orient the text to any number of angles or degrees by doing the following: 

Ø Select the cells for which you want to orient the 

text 

Ø Choose Menu Format -> Cells 

The Cell Format dialog box will then appear as 

shown below:  

Ø Select the Alignment tab 

Ø Enter the number of angles in the Degree box 

Ø At the reference edge, select the text extension 

in the cell in the third box. The text’s rotation is unrelated to the cell border. 

Ø Click the OK button. 

              

 

 

 

 

3. Cell Border 

To create a table, you need to frame the data cells that you entered in that cell. 

How to apply the placing of your selected cell borders: 

Ø Select the cells you want to border 

  

 

 

Center column 
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Ø Choose Menu Format -> Cells 

The Cell Format dialog box will then appear as shown 

on the right. 

Ø Select the Borders tab and make settings: 

✔ Line style 

✔ Select a border location in the Default dialog 

✔ Or you can set it yourself in the user settings 

box 

✔ Line color 

Ø Click button OK 

 
 

4. Formatting Numbers into Khmer Numbers 

In Writer, you cannot use font renaming to convert numbers to Khmer. In Khmer, you need to 

define the following cell format: 

Ø Select the cell whose number you want to format in Khmer 

Ø Choose Menu Format -> Cells 

The Cell Format dialog box will then appear as shown below: 

Ø Select the Number tab in the 

Define Cell Format dialog 

box: 

• In the Type dialog box 

• In the Format dialog, select 

the format in Khmer 

numbers (e.g., ១២៣៤). 

Ø Select Language: ែខមរ and Click OK 
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In the format number box, you can see: [NatNum1] 0 

• [NatNum1]: To make it display the number format in the cell as a Khmer number 

• 0: Represents the numeric value entered in the cell 

 
 

5. Formatting Numbers in Khmer Currency 

The numbers you enter in the cell can be formatted in Khmer or other currencies as 

follows: 

Ø Select the cell whose number you want to format 

Ø Choose Menu Format -> Cells 

Ø Select the Currency Select Number tab 

Ø In the Format dialog, select your preferred format type (e.g., 1.234 ៛) 

Ø In the Language box, select Khmer 

 
 Example: Format the table as follows: 
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In the Language box, if you select a different language, the Format dialog will 

display the currency of that language or country. 

 

6. Entering Date 

For every date entry in Writer, you must enter the date first. So the number you enter first 

is the acknowledgment as a day cannot exceed 31, and the month cannot exceed 1. 

Date representation characters are: 

• dd: Represents the day as a two-digit number 

• mm: Represents the month as a two-digit number 

• yyyy: Represents the year as a four-digit number 

 

7. Date Formatting 

To set the date format, follow these steps: 

Ø Select the cells that you want to format 

the numbers to date. 

Ø Choose Menu Format -> Cells 

Ø Select the Number tab, and select the 

date. 

Ø In the Format dialog, select any of your 

preferred date formats  

Ø Click the OK button 

                
 

8. Time Format Settings 

To set the time format, follow these steps: 

• Select the cells in which you want to format the 

numbers to time 

• Choose Menu Format -> Cells 

• Select the Number tab, select the time 

• In the Format dialog, select any format that you 
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prefer. 

• Click the OK button 

Example: When you enter 1:35:20, the result is displayed as 01:35:20 AM. 

 

9. User-defined Formatting 

Symbols for user-defined format numbers: 

• #,##0: Sign for separating thousands. Example: 1,234,567 

• ???,??0.0??: Used for decimal floating point. Example: 1234.00 

• “Rie”: to set the default display of “Rie” letters or numbers in “...” 

• # : Represents the numeric value entered in the cell. 

• Example: Set #. ## 0.00 “Riels” -> When entering 4000, it will display the result 

• 4.000,00 Riels 

• : Represents the least numeric value or number of digits. 

• Example: Set 0000 → Input 12 → Output 0012 

 

 

• If using the # sign, when entering zero (0) - the result will be displayed empty. 

Example: Set # Riel - When entering 0 - the result will show Riel 

• Set # Riel - Enter time 0 - The result will show Riel 

 

User-defined Format: 

You can configure the data manually by 

following these steps: 

Ø Select the cell or cell range that you want to 

format. 

Ø Choose Menu Format → Cells 

Ø Enter format number [NatNum1] 0 points 

Ø Click the OK button 

 

 

Try to apply the following results: 
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Here are some formatting sample 

Formatting code Insert in cell Display 

[NatNum1]0000 1 ០០០១ 

00-00000 12 00-00012 

[NatNum1]OI-0000# 12 OI-០០០១២ 

#.### or #.## or #.# 12345 12.345 

#,000 
12 12,000 

12,5 12,500 

#.###,00 12500 12.500,00 

#.###,00 េរៀល 12500 12.500,00 េរៀល 

#.###,00 “Riels” 12500 12.500,00 Riels 

អរតរបក ់$1=#.##,00 េរៀល 4150 អរតរបក ់$1=4.150,00 េរៀល 

[NatNum1]$1=#.##,00 “Riels” 4150 $១=៤.១៥០,០០ Riels 

[NatNum1][Blue]$1= #.###,00 ៛ 4500 $១=៤.៥០០,០០ ៛ 

[Red]ពនធ = #,00 % 12,5 ពនធ = 12,50 % (ពណ៌រកហម) 

“Benefit=”#% 12,5 Benefit=12,5% 

[Red][<0]#.##;[Blue]#.## ឬ 

[Blue]#.##;[Red]-#.## 

1234 1.234 (ពណ៌េខៀវ) 

-1234 -1.234 (ពណ៌រកហម) 

DDDD/MMMM-DD/YYYY 12/08/05 ៃថងសុរក/សីហ-12/2005 

HH:MM:SS AM/PM 
01:25:15 01:25:15 រពឹក 

13:25:15 01:25:15 លង ច 

 

 

The format you define will be displayed directly by the user. So you can use 

this predefined format later. 

To display the number format in Khmer, you must always put [NatNum1] in 

front of the number format you have defined. E.g. [NatNum1] #. ## 0.00 
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• Number formatting involves fonts, effects, text, alignment and text orienta-
tion, cell borders, cell background settings, and cell protection. In the number 
tab, you can define the number format you want in “User Defined”. 
§ The number format settings are as follows: 
§ Preceded by Zero (001) 
§ Number in Khmer (១២៣) 

§ Percentage (12.95%) 
§ Riel (១.២៣៤៛) Dollar ($ 1,234,00) 

§ Date (Friday, December 31, 1999) 

Summary 

 
1. Tell us how to edit a sheet, such as renaming a sheet, inserting a new sheet, 

and deleting a sheet. 

2. Tell us how to place a cell frame and color the cell surface. 

3. Tell us how to format numbers in Khmer currency. 

4. Tell us how to make user-defined formatting. 

Questions 
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Write the number format to define the following: 

Input Number Output Formatting Number 

1 ០០១ [NatNum1]000 

5678 ៥.៦៧៨,០០ េរៀល ? 

1234.5 $1,234.50 ? 

4000 $1 = 4.000,00 Riel ? 

15 15 Cases ? 

12 12.00% ? 

06/07/22 Tuesday, June 07,2022 ? 

 

Exercises 
 



 

1 

After you learn this lesson, you will be able to: 

ü Use MIN, MAX, COUNT, COUNTA 

ü Use NOW, YEARS, MONTHS, DAYS 

ü Define the difference between Relative and Absolute cell address 

ü Calc formulas RANK and use absolute and reference cell address 

In this lesson, you will learn the following: 

I. The Basic Function 

II. Cell Address 

Basic Function and Cell Address 

 Lesson 12 
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Lesson 12 Basic Function and Cell Address 
I. MIN, MAX, COUNT, and COUNTA 

This lesson will explain to you how to use some of the following formulas: ៖ 

•  MIN ៖ A formula calculates the smallest value in a range. 

 Formula៖   

=MIN(value1; value2; ...) 

 Suppose that in cells B1: B5 there are values 19,24,23,21,22 respectively 

 = MIN (19; 24; 23; 21; 22) Result 19 or = MIN (B1: B5) Result 19 

 

•  MAX ៖ A formula calculates the biggest value in a range. 

 Formula៖     

=MAX(value1; value2; ...) 

 Suppose that in cells B1: B5 there are values 19,24,23,21,22 respectively 

 = MAX (19; 24; 23; 21; 22) Result 24 or = MAX (B1: B5) Result 24 

 

•  COUNT ៖ Used to count values as numbers. 

 Formula៖     

=COUNT( value1; value2; ...) 

 Suppose = COUNT (2; 4; 6; “eight”). The result shows that the number of numeric values is 3. 

 

•  COUNTA ៖ Used to count values in numbers and letters (all). 

 Formula៖     

=COUNTA( value1; value2; ...) 

Suppose = COUNTA (2; 4; 6; “eight”). The result shows that the number of numeric and 

alphanumeric values is 4. 

• Example: Find the highest score and the lowest score in the table below: 
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II. NOW, YEARS, MONTHS, DAYS 

•  NOW ៖ A formula used to display the current date and time by computer settings. 

  Formula 

=NOW() 

Suppose៖   - This time is June 28, 2022, at 1:39 pm. 

    - When you enter = NOW () Result 06/28/22 01:39 PM 

•  YEARS ៖ A formula for calculating the years between two dates. 

  Formula 

=YEARS(start date ;end date ;mode) 

 

✔ Start date: The first date or before the end date. E.g., 07/12/94 

✔ End Date: The second date or after the start date. E.g., 06/28/22 

✔ mode: 0 or 1 

– If number 1: The calculation only takes the end year minus the beginning year. 

E.g., 2022 - 1994 = 28 

– If set to 0: The calculation is to take the end date and subtract the start date by 

taking both the day and the month. If a month or a day is missing, it will not 

be enough. The result will be 27 on the above date. 

 Suppose: = YEARS (“1994-07-12”; “2022-06-28”; 1) then the result shows 28 = 2022 - 1994 

Note៖ 

 

-To calculate a formula, you need to know the elements or arguments contained 

in that formula. What does a formula need to be able to be calculated? So you 

need to know about this to make it 

easier to use the formula. 

- If you need to remember, you can 

use the Function Wizard to find the formula you want to know. 
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•  MONTHS: A formula calculates the number of months between two dates. 

  Formula៖     

=MONTHS(start date ;end date ;mode) 

  Suppose: = MONTHS (“2022-04-28”; “2022-06-28”; 1) then the result shows 2 = 06-04 

 

•  DAYS ៖ A formula used to calculate the number of days between two dates. 

  Formula៖  

=DAYS( end date ; start date) 

 Suppose:  = DAYS (“2022-06-28”; “2022-04-28”) returns 61 days. 

   = DAYS (“2022-03-02”; “2022-06-28”), the result returns -118 days. 

 

Note៖ 

 

 

• If the If end date is placed before the start date, the result will be negative. 

Perform the following exercises: 

   
 

III. Reference Cell Address 

 The reference cell address is a common cell address that is commonly used to calculate 
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formulas. E.g., in cell B13, enter the operator = B4-B11 (B4 & B11 as reference cell addresses, 

meaning that it takes a value from the cell address B4 & B11 used in the calculation). 

The main problem with arithmetic software is that you need to understand how to use it. 

Reference cell address: It is divided into two types, the Relative Reference Cell Address, and 

the Absolute Reference Cell Address. 

You already know the cell address and cell range address on a spreadsheet in OpenOffice.org 

Calc. Now you will learn more about using absolute reference cell addresses. 

Note៖ 

 

Reference means taking the cell address that contains the value calculated from the 

other cells used in the calculation. Therefore, the cell address used in this 

calculation is the reference cell address. 

 

1. Relative Reference (A1) 

 Relative Reference is a regular cell address 

(default cell address) used to calculate formulas in 

a cell and relates to copying that formula to another 

cell location where the cell address changes after 

copying. 

For example, when we copy a formula from 

cell address C1 containing the formula, the sum 

between cell addresses A1 and B1 (= A1 + B1) is 

placed in cell C3. You will see that the formula you 

copied in cell C3 varies according to the location of the same cell, and the copied formula is = A3 + 

B3. 

After you copy the formula from C1 to C3, we see that the output and the address of the copied 

cell vary according to the cell position as each with the copied formula. 

How to create a contact cell address in a formula or operation: 

Ø Drag the mouse pointer to click on any cell address you want to make a relative reference. 

  Example: Click on cell addresses A1 and B1 (A1 & B1 are relative reference addresses). 

Or, 

Ø Enter the name of the reference cell for use in a formula directly via the keyboard. E.g., B3 

 

2. Absolute Reference (E.g., $A$1) 

Absolute Reference always provides the same address (invariably) even if we copy a formula 

that uses this absolute cell address to any cell location. But you need to define a cell address as an 

absolute reference. 

Copy 
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How to create an absolute reference in a formula or operation: 

Ø Select a cell address or a range of reference cells (default) (e.g., A1) 

Ø Then press Shift + F4, you will get $A$1 

        or... 

Ø Enter a cell address in the keyboard with a dollar sign ($) in front of the column header 

name and row name of the address of that cell. E.g., enter $B$1 

 

 Example: Calculate a formula in cell C1 

using the absolute reference cell address 

($A$1 &  $B$1) as follows: 

 

Ø Then copy the formula from cell C1 = $A$1 + $B$1 into cell C3 

     

 We see that the copied result is unchanged because we bind the above address as 

absolute addresses ($A$1 & $B$1). 

 

 

         
 

• Copy formula from D1 to D3 ->  Relative Reference: changed result by cell 

• Copy formula from E1 to E3 -> Absolute Reference: unchanged result (constant) 

Relative and Absolute Reference Cell Address: 

ចមលង 

click (Shift) + F4 

Result Absolute Reference 
Absolute Reference 

Absolute Reference Relative Reference 
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✔ Relative Reference Address ៖ The copied results change. 

 
✔ Absolute Reference Address ៖ The copied results do not change. 

  
 

Perform the following exercises: 
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Help: 

• In cell B8 enter the formula =A8*$A$4 

• In cell C8 enter the formula =A8*$B$4 

• In cell F8 enter the formula =E8/$B$4 

• In cell G8 enter the formula =E8/$C$4 

 

 

 

 

IV. Formula RANK 

RANK: To find a rank, compare the values in the cell range. 

 Formula:    

=RANK(number; data; type) 

• Number: The value we want to find in order in the data or list of numbers. 

• Data: A data range or list of numbers to be compared. 

• Type: This is a number that determines how it is sorted. The number can be 0 or 1. 

• 0: Sort big to small. The largest price is ranked No. 1 

• 1: Sort small to large. The smallest price is ranked No. 1 

Example: Find the value of a value in the range of the average cell: 
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135 

 

 

• Unicode is a universal encoding scheme for typing and text that defines a consistent, 
multilingual encoding method that can exchange text data internationally and lay the 
foundation for universal software. 

• To type text using Khmer Unicode, you need to type in the order of spelling, not the 
order of writing from left to right. And the computer will arrange the letters in the 
correct order. 

• Zero-width space used to separate word. 

Summary 

 
1. What is the RANK formula used for? Write a RANK formula. 

2. What is the DAYS formula used for? Write a DAYS formula. 

3. What is the difference between a relative cell address and an absolute cell address? 

4. What is the difference between COUNT and COUNTA formulas? 

5. What is the difference between MIN and MAX formulas? 

Questions 
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Format the data entry table and do the calculations in the “Total Score”, “Average”, “Low 

Score”, “High Score”, and “Rank” fields. As follows: 

• For the Total Score Field: Calculate the sum between the scores of the three subjects. 

• For Average Field: Calculate the average between the scores of the three subjects. 

• For the Low Score Field: Find the lowest score of each student. 

• For the High Score Field: Find the highest score of each student. 

• For the Ranking Field: Find the student’s ranking according to the order of the average 

they get in order from small to large. 

 

Exercises 
 



1 

Objective: 

ü Define formulas related to combining text (CONCATENATE) 

ü Define formulas for finding the remainder of a division operation (MOD) 

ü Define rounding formulas (INT) and other formulas that have conditions in the 

formula 

ü Define logical function 

In this lesson you will learn more about the following formulas: 

I. Combining Text (CONCATENATE) 

II. INT and MOD 

III. COUNTIF 

IV. IF 

Function 

 Lesson 13 
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Lesson 13 Function 

I. Formula Related to Combining Text (CONCATENATE) 
•  CONCATENATE: This is the function for combining multiple text elements into one. 

  Syntax: 

=CONCATENATE (text1; text2; ...) 

    Or 

=text1 & text & … 

 Suppose you want to combine text elements 

in cells A3 (េខង) and B3 (ពិសិដឋ) put into cell 

C3. What should you do? In the cell C3, you 

should write the formula 

=CONCATENATE(A3;"-"; B3), then the result 

will be shown េខង-ពិសិដឋ, or you can write 

another way =A3&"-"&B3. 

 

II. INT and MOD Function 
INT: This is a function for rounding the value of a decimal number to an integer. 

Syntax: 

=INT(Number) 

• If number: As a positive decimal, the number will be rounded to an integer. 

• If number:  As a negative number, complete the integer and complete 1 if the last 

digit is greater than 5. 

     Example =INT (5,8) Result: 5 

      =INT (-5,8) Result: -6 

      =INT (5/2) the result is shown 2 because 5/2=2.5 

•  MOD: for calculating to find the remainder of a division operation. 

Syntax: 

=MOD(division 

representative(operands); divisor) 

   Example 1: =MOD(5;2) the result is shown as 1 because 5/2 = 2  and will show the 

remainder is 1. 
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   Example 2: Calculate on cell E3 “in dollars” និង on cell F3 “Remaining Riel” 

Rounding the number of fields in “in dollars”. 

 

III. COUNTIF Function 
 

COUNTIF ៖ This formula is used for counterarguments that match a given condition. 

Formula: 

=COUNTIF(range; criteria) 

 

• Range: A range of cells containing data to be counted. 

• Criteria: A condition to be searched to count in a cell range. 

Example: To calculate the value in the table in the cell F4, you should write formulas as below:  

=COUNTIF($C$3:$C$10;E4) 

or=COUNTIF($C$3:$C$10;"&សី")  

on cell F5, write formulas as: 

=COUNTIF($C$3:$C$10;E5) 

or   =COUNTIF($C$3:$C$10;"&ប*ស") 

 

 

 

With conditions, you can use symbols = (equal  to) > (greater than) >= (greater 

than or equal to) <= (less than or equal to)  < (less to)  <> (not equal to). Ex. 

=COUNTIF(A3:A10;"<=5") 

 

 III. IF Function 
IF:  Used to discuss or test any logical value. If the test is “true” it will throw a “consistent 

value” but if the test is “false” it will throw an “opposite value”.  

Syntax: 
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 =IF(logical_test; [value_if_true]; 

[value_if_false]) 

✔  Using Nested Ifs: 

=IF(logical_test; [value_if_true]; IF(logical_test; 

[value_if_true]; ...; 

 [value_if_false]) 

 

• logical_test:  Any value or expression that may be true or false. 

• value_if_true: This is the value displayed when the test is true. 

• value_if_false: The value to be displayed when the test is false. 

 Example 1: Try adding the following 

formula ៖ 

 =IF(2<5;"value is true";"value is false") the 

result is shown  "value is true" 

=IF(2<5;"value is false";"value is true") the result is shown "value is false" 

 =IF(5<>2+3;1;0) the result is shown 0 

 =IF(5=2+3;1;0)  the result is shown 1 

 

 Example 2: Calculate on the cell through the following condition ៖ 

Pass/Fail: On cell G5 =IF(G3<50;"Fail";"Pass") 

• Rank ៖ On cell H5 =RANK(G3;$G$3:$G$6) 

• Mention I5 ៖ 

=IF(G3<50;"F";IF(G3<65;"E";IF(G3<75;"D";IF(G3<85;"C";IF(G3<95;"B

";"A"))))) 

With conditions for Mention below: 

if the average < 50, Mention: “F” 

if the average < 65, Mention: “E” 

if the average < 75, Mention: “D” 

  

• if average < 85, Mention: “C” 

if the average < 95, Mention: “B” 

   Opposite to above the conditions is mentioned “A” 
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• CONCATENATE: This is the function for combining multiple text elements 
into one. Syntax: =CONCATENATE (text1; text2; ...) 

• INT: This is a function for rounding the value of a decimal number to an integer. 
Syntax: =INT(Number) 

• IF:  Used to discuss or test any logical value. If the test is “true” it will throw a 
“consistent value” but if the test is “false” it will throw an “opposite value”. 
Syntax: =IF(logical_test; [value_if_true]; [value_if_false]) 

Summary 

 
1. What is the COUNTIF() formula used for? What does this formula look 

like? 

2. What is the formula IF() used for? What does this formula look like? 

3. What is the MOD() formula used for? What does this formula look like? 

4. What is the formula CONCATENATE() used for? What does this formula 

look like? 

5. What is the INT() formula used for? What does this formula look like? 

6. What is the COUNTIF() and IF() formula used for? What does this formula 

look like? 

Questions 
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 Please create a table by entering data and calculating in the columns “Full name”, 

“Age”, “Each type of dollar bill ($)” and “Pay 5% tax” and calculate the “Number of male 

employees”, “Number of female employees”, “Maximum of salary employee”, and 

“Minimum of salary employee”. 

 

Exercises 
 



 

 

Objectives: 
ü Define the function NETWORKDAYS 

ü Define the function Wizards 

ü Define the function SUMIF 

ü Define the function Absolute addressing of row and column 

ü Define the function HOUR MINUTE SECOND 

In this lesson you will learn about: 

I. NETWORKDAYS Function 

II. Function Wizard 

III. SUMIF 

IV. Absolute Address 

Absolute Row and Column Cell Address 

 Lesson 14 
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Lesson 14 Absolute Row and Column Cell Address 

I. NETWORKDAYS 
 
NETWORKDAYS: A formula used to calculate the number of working days between two dates, 
excluding weekends (Saturday and Sundays) and the holidays you have set. 
  Syntax: 

=NETWORKDAYS(startdate; enddate; holidays) 
 

• Start date: A date that represents the start date 
• End date: A date that represents the end date. 
• Holidays: An optional range of one or more dates to exclude from the working calendar, 

such as state and federal holidays and floating holidays 

Example: Find the number of working days of employees in the following table 
Ø Enter Cell F2 = NETWORKDAYS(C2;D2;$A$2:$A$7) 
Ø Then you will see the result is 19 (without thinking of holidays and weekends) 

    
 

II. Function Wizards 
In OpenOffice Calc, you can use the Function Wizard to help you write formulas in a cell. It’s 

easy if you forget the arguments or elements to use in the formula. 
How to apply the calculate NETWORKDAYS formulas using the Function Wizard: 

Example: Use the Function Wizard to calculate the number of employees’ working days 
 in the table below 

Ø Enter the cell cursor in the cell where you want to display the result: 

         

Ø Click the Function Wizard icon on the Formula Bar. You will then see a Function Wizard 
dialog appear as follows:     
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Ø Find the NETWORKDAYS formula in the Functions dialog and select this formula 

Ø Click the Next button, then the following screen will appear:  

  

Ø Click the Shrink button   at the start date to select the cells you want to calculate. E.g. 
C2 

 

Ø Press  Max button  to return to the original position after you select cell C2 
Ø The same applies to end dates (D2) and holidays (select cell range A2: A7) 

 

 
 

Ø After the selection is complete, click the OK button to display the results. 
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III. SUMIF 

SUMIF: A formula used to calculate the sum of values corresponding to a given condition. 
  Syntax: 

= SUMIF (range; criteria; range_sum) 
 

• Range: is the value range that contains the criteria in it 

• Criteria: is the value to be given by the search criteria for calculating the sum. 

• Range_Sum: a value range that contains the values to be used to calculate the sum 
according to the criteria. 

 For example, you have the following employee list data table. Calculate the sum of the 
salaries of employees over 30 and under 30. 

   
 
 
IV. Absolute Addressing 

You already learned in the previous lesson about the absolute cell address, which is a type of 
cell address that does not change. Copy or drag to another cell address (sentence fragment). You can 
bind a cell address as an absolute cell address using the shortcut keys Shift + F4 after you Select a 
cell or cell range. 

Absolute cell addresses are divided into two types: rows absolute cell addresses, and columns 
absolute cell addresses. 
 
1. Row Absolute Cell Address (A1) 
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  The row absolute cell address (A1) means that column A is variable, row 1 is constant 
 (unchanged). 

 Example 1: Summarize the values 4, 7 and 6 using the formula = SUM (A $ 1; C1; A2) in cell 
D1. In this formula, you observe that the cell address A $ 1 is lined up as an absolute address.  

Copying the formula from D1 to D3, we see 
that the result cell copied to change because we bind 
the absolute value only row 1 in cell address A1, so 
when copying to row 1, the values remain the same, 
while column A varies from place to place. With the 
copied formula, A2 and C1 change and move 
corresponding to the position of cells A4 (empty) and C3 (empty). 

 
Therefore, the result of our replication is 4 

(the value removed from cell A1 bound to the 
fixed row A $ 1). 

 
Example 2: Calculate the total sum in cell D1 by taking the values in cells A1, B1 and C1 by 

binding the absolute reference address to row 1 of both cells. Three A $ 1 B $ 1 and C $ 1. 

   

 

Select A1 when pressing Shift + F4 once to get $ A $ 1. Press again to get A $ 1. 
Click $ A1 again. Press A1 again. 

 
Example 3: Summarize the values of cells A1, 

B1 and C1 by tying the absolute addresses, rows of 
cells A $ 1, B $ 1 and C $ 1 in the formula = SUM (A 
$ 1: C $ 1) in cell D1 
 
Copy formula from cell D1 to cell D3 

 

Copy formula cell E3 

 

 
2. Column Absolute Cell Address (eg $ A1) 
 

The column absolute address ($ A1) means that column A is constant (unchanged) and row 1 is 
variable. 
Example 1: Apply a sum formula using an absolute reference cell address column. 

Ø In cell B4, enter the formula = SUM ($ B1: $ B3) 
Ø Copy formula from cell B4 to cell D5 
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The formula only changes the row = SUM ($ B2: $ B4), so the result of your copy is 33. 

 
Example 2: Summarize the values of cells B1, B2 

and B3 by tying the absolute addresses of the columns of 
cells $ B1, $ B2 and $ B3 according to the formula = 
SUM ($ B1: $ B3) in cell B4 

 
Copy Formula from Cell B4 to C4 

 
 

•           Copy Formula to Cell D5 

  

Practice the following exercises: 
Calculate the following table according to the SUMIF () formula using the absolute cell address, 

the row and the absolute column address. 
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 Figure 18.4 Weekly import list exercise 

 
Ø Enter this formula = SUMIF ($ B $ 4: $ B $ 15: $ B21; D $ 4: D $ 15) in cell C21 
Ø Hold down the mouse pointer, hold down the mouse, drag to the right cell, and drag down to 

display the result. 
Therefore, to calculate the above exercise using absolute addresses, rows and columns is faster. 

Once calculated, you can drag or copy this formula to other cells to be calculated. 
 
V. Hour, Minute and Second 
HOUR: A formula used to display the numerical value of an hour of time. 
  Syntax: 

=HOUR(Time) 
 

• Time: The value of a time you entered. E.g. 10:35:05 
Example:  = HOUR(NOW ()) returns the current time. 
  = HOUR(C2) returns 10 o’clock if C2 = 10:35:05 
 
MINUTE: A formula used to display the numeric value of a minute of a time. 
  Syntax: 

=MINUTE((Time) 
  

Example:  = MINUTE(NOW ()) returns the current minute 
= MINUTE(C2) returns 35 minutes if C2 = 10:35:0 

 



Lesson 14 Absolute Row and Column Cell Address Part 1: ICT Basic 
 

149 

SECOND:  A formula used to display the numeric value of a minute of a time 
  Syntax 

=SECOND(Time) 
 
Example:  = SECOND(NOW ()) returns the current minute 

= SECOND(C2) returns 05 minutes if C2 = 10:35:05 
 
Practice the following exercises: 

For example, you have an online store with four machines for internet service based on the 
hours and minutes that customers use. In the table below, just enter “start time” and “end time”, 
then the usage time and total value will be displayed automatically. 

 
 
 

 

• NETWORKDAYS: A formula used to calculate the number of working days between 
two dates, excluding weekends (Saturdays and Sundays) and the holidays you have set. 
Syntax: =NETWORKDAYS(startdate; enddate; holidays) 

• SUMIF: A formula used to calculate the sum of values corresponding to a given condi-
tion. 
Syntax: = SUMIF (range; criteria; range_sum) 

• Absolute cell addresses are divided into two types: rows absolute cell addresses, and col-
umns absolute cell addresses. 

§  The row absolute cell address (A1) means that column A is variable, row 1 is 
constant (unchanged). 

§ The column absolute address ($ A1) means that column A is constant (unchanged) 
 and row 1 is variable. 

Summary 
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1. What formula is used to calculate the number of working days? Write the formula cor-

rectly and give examples. 

2. What are the benefits of using the Function Wizard? 

3. What is the SUMIF formula used for? Write the SUMIF formula correctly. 

4. What is the HOUR formula used for? Write the HOUR formula correctly. 

5. What are the types of absolute cell addresses? Explain how we bind the absolute cell 

address. 

Questions 
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Make a budget for the TV sales business in the following format: 
Discuss with your group: 
Prepare a budget based on the business model of selling TVs below and calculate the profit 
after this 4-month period. Save this budget plan in your folder under the name “TV Sales 
Plan” 

 

Exercises 
 



1 

Objectives: 
ü Sorting Data 
ü Data Filter (AutoFilter and StandardFilter) 
ü Printing 

In this lesson you will learn about the following: 
I. Sort Data 

II. Data Filter 
III. Auto Fill 
IV. Headers and Footers 
V. Printing 

Data Management and Printing 

 Lesson 15 



Lesson 15 Data Management and Printing Part 1: ICT Basic 
 

152 

Lesson 15 Data Management and Printing 

I. Sort Data 
Suppose you have a data table like the one on the 

right. In this table, the data you entered is not in the 
Khmer language alphabetical order. Therefore, you can 
sort these data in alphabetical order by following these 
steps: 

Example: Sorts “Last Name” fields in ascending 
order (A → Z) 

 
How to Apply: 

Ø Enter the cursor in the sorted data table 
Ø Choose Data menu -> Sort 

Then you see a sort box appear, as shown below:  
Ø Select the Sort Condition tab 
Ø In the Sort by box, select the Name field 
Ø Choose option Ascending  
Ø Click OK Button 

 
You get the following results: 
 
 

Note: 

 

If the Sort by list does not display the selected 
table’s field names, it 
shows columns 1 and 
2 ... then you Select 
the Options tab - 
Check Range 
Contains column 
labels. 
 

Copy the Sort Result to Another Cell: 
In general, sorting data in a table will apply the result of sorting in this table directly. The dots 

will teach you how to copy the sorting results to a different cell location. 
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How to Apply: 
Ø Choose Data menu -> Sort 

Then you see a sort box appear, as shown below  
Ø Select the Options tab 
Ø Check the Copy results sorted to 
Ø Enter the cell address for which you want to 

copy the result. Example: A20 is the starting 
cell address of the result table 

Ø Click OK button 
 
 
II. AutoFilter 
 

Automatic filtering is used to filter only the records of any 
data you want. For example, in the data table above, you want to 
filter only those who are male (M). 
How to Apply: 

Ø Enter the cursor in the table where you want to auto-filter 
Ø Choose Data menu -> Filter -> Auto filter 
Ø Then you will see the down arrow in every column header 

of the data table. You can click on this arrow to see the data 
types in this column. 

Ø Drag the mouse and click on the down arrow of the “Sex” 
field, then Select “M” (represents male) 

The results will show all males as follows: 
 
 

 

For any filtered field, the down arrow 
appears in blue. To show all records again, 
click the down arrow and select - All - 

 
 
 
 
Remove AutoFilter: 

Once you have filtered the table, only the data you have displayed is displayed. To automatically 
remove the filter to restore the data to the original, please follow the steps below: 

Ø Inserts a cursor into a table that you have automated as filtered 
Ø Select the menu Data -> Filters -> Uncheck the box next to AutoFilter. Then your table 

returns to its original state. 
 
III. Standard Filter 

Standard filters are the same as automatic filters. Still, standard filters allow you to define 
criteria through a maximum of three fields in Data tables using the AND or OR link, and filtered data 
can be copied to another cell location. 

Example: From the table above, extract data with a letter greater than 5 and gender M (male). 
How to Apply to Filter Data According to the Above Conditions: 

Ø Insert the cursor in the table where you want to make a standard filter 

 

 

 រូបភព ១៩.៤ ៖  ករេធវតរមងទិនននយ័ 
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Ø Choose Data menu -> Filter -> Standard filter. A standard filter dialog box appears as 
shown:   

 
 

Ø In the Field name box, click the down arrow, then select the ID (numbering) 
Ø In the Condition box, click the down arrow, then select Condition> = (greater than or equal 

to) 
Ø In the Value box, click the down arrow, then select 5 
Ø In the box below the operator, click the down arrow, then select the AND operator (take only 

the records that meet the conditions. Both of the above means that unless all conditions are 
true, it will only take the existing record). A number greater than 5 and male. It will mean that 
it is filtered. Seals those numbered greater than 5 and all males (M). 

Ø In the box under Name, next row Field, click the down arrow, then select gender 
Ø In the Conditions box, click the down arrow, then select the equal sign (=) 
Ø In the Value box, click the down arrow, then select the letter 
 
If you want to copy the result to another cell location: 
Ø Click button More 

✔ Click Copy Result to... 
✔ In the box below the box Filter criteria, Type $'សនលឹក2'.$E$1 

Or control the mouse pointer, click on the icon    
✔ Control mouse, click on cell E1 
✔ Control the mouse pointer, click on the zoom icon 

back 

✔ Click the OK button 

 
Remove the Standard Filter: 

You have already made a standard filter. If you want to remove a standard filter, follow these 
steps: 

Ø Place the cursor in the standard filter table above 
Ø Choose Data menu -> Filter -> Standard filter. A standard filter dialog box appears as shown: 
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Ø In the Name field, click the down arrow to select None 
Ø Click button OK 

 
 
IV. Auto Serial Fill 
 Serial Fill makes it easy and fast to enter data in series without inserting all serial data in a cell 
range. 

1. Auto Fill Day Serial 
In Calc, you can automatically drag days in series. E.g., you want to 

enter the day’s name into a cell like Sunday, Monday, or Tuesday. 
How to apply to auto serial to the day: 

Ø Enter a start date. E.g., Sunday 
Ø Control the mouse pointer on the handle. (?) 
Ø Hold down the mouse and drag until the desired 

end date. 

Then you will get the result like this >> 
 

 
 
2. Auto Fill Number Series 
For example, you want to drag automatic numbering like this: 1 2 3 4 5 
How to apply the drawing of numbers in series automatically: 

Ø Enter a start number. E.g., 1 
Ø Control the mouse pointer on the handle. (?) 
Ø Hold down the mouse and drag until the value 

Desired end number.                 

  

+ 

ចំណុចទញ 
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Note: 

 

• For dragging the moon (month?) in series, you do not need to type the word 
“month” in front of it. Type, e.g., January, and drag it like a number or a day. 

 
 

 
• For a two-digit suite drag, type the starting number 2 in cell A1 and 4 in cell 

A2 and select drag both cells to the desired number. 
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ទំពរ័ទីមយួ ទំពរ័មុន 

V. Print Preview 
 

The file you have already created needs to be clarified to fit on the correct page. So you can 
preview the page to know the format of the text before printing. 
How to apply to preview the page: 

Control the mouse pointer, click on the icon Preview page on a standard bar 

   
 
You will then see a preview page showing the following: 
 
 
 

 
 

 រូប$ព ១៩.១០ ៖ *រេម-លទំព័រ2មុន មុនេ5ះពុម7 

 
• Previous Page: To return to the previous page one by one. 
• Next Page: To return to the next page one by one. 
• First Page: To return to the first page of the displayed document. 
• Last Page: To return to the last page of the displayed document. 
• Zoom In: To enlarge the displayed page. 
• Zoom out: To minimize the displayed page. 
• Full Screen (Ctrl + Shift + J): To zoom the page displayed to full screen. 
• Format Page: Opens the Page Styles dialog to define settings related to page formats, 

such as pages (margin format, layout settings), primary background border, that the 
footer and the sheet, as shown below: 

ទំពរ័បនទ ប ់ ទំពរ័ចុងេរកយ 

ពរងីក រតឡបេ់ទទិដឋភពធមមត េពញេអរកង ់

បរងួម 
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VI. Setting Header and Footer 
Header Define is the header setting that will display all 
the document pages. 
How to apply to insert a header: 
Select the Header tab in the Page Styles dialog. Or ... 

Ø Choose Menu Format -> Page ... 
Ø Choose Header tab 
Ø Click Open header 
Ø Click the On button 

Click More to frame and background to headers. A 
border/background dialog box appears as shown. 
 

Ø Choose Border 
Ø Choose any icon under Default 
Ø Select which line style you want to place 
Ø Click OK button 
 
 
 
 

 
✔ Click the Edit ... button to edit the header contents. A header box appears as shown 
below: (Enter the header text as in the three boxes below): 
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Ø Click OK button 
Ø Click OK button 

Note: 

 

For how to place a footer, as well as how to place a header, you select the footer 
tab, then follow the same procedure. 

 
 
VII. Print Preview Row and Column Headings 

To set headings, rows, and columns when printing, do the following: 
Select a sheet tab in the Page Styles dialog 

 
 រូប$ព ១៩.១៤ ៖ *រកំណត់ឲ>ប?@ ញកBលជួរេដក និងជួរឈរេពលេ5ះពុម7 

Ø Check on the check box Rows and 
Columns header box: Print, showing 
both the existing row and column 
headings on all pages when printing. 
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• Automatic filtering only filters the records of any data you want. 
• You can short form ascending  
• Standard filters are the same as automatic filters. Still, standard filters allow you to define 

criteria through a maximum of three fields in Data tables using the AND or OR link, and 
filtered data can be copied to another cell location. 

• Serial Fill makes it easy and fast to enter data in a series without inserting all serial data in 
a cell range. 

• You may not be sure that the file you have already created will fit correctly on the page. 
So you can preview the page to determine the proper formatting of the text before printing. 

Summary 

1. How do you sort a data table’s “Name” fields in ascending order? 
2. What are the benefits of filtering data? How do you apply an automatic filter. 
3. What is the difference between auto and standard filters? 
4. How do you define headers and footers in Calc? 
5. How do you print something displaying the name of the row header and column header? 

Questions 
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Practices the following exercises: 
1. Create a data table as follows. 
2. Sort the names of employees in ascending order. 
3. Sort the gender and salary fields in ascending order. 
4. Use automatic filters to filter out female and male computer instructors. 
5. Use standardization to recruit male computer instructors with a salary of more than $ 

200. 
6. Get a female employee born in Phnom Penh with a salary of less than $ 150. 

 

Exercises 
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Objectives: 
 

ü Define interface of Impress 
ü Creating blank slide 
ü Saving a presentation file 
ü  

In this lesson you will learn how to create slides and format text as follows: 
 

I. Introduction to OpenOffice.org Impress 
II. Creating a First Presentation 

III. Slide Layout Selection 
IV. Formatting Text and Paragraphs 
V. Full Screen Slide Show 

Introduction to OpenOffice.org Impress 

 Lesson 16 
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Lesson 16 Introduction to OpenOffice.org Impress 

I. Opening OpenOffice.org Impress Program 
Impress is OpenOffice.org’s slide show (presentations) program. You can create slides that 

contain many different elements, including text, bulleted and numbered lists, tables, charts, clip art, 
and a wide range of graphic objects. Impress includes a spelling checker, a thesaurus, prepackaged 
text styles, and attractive background styles. 

To open an Impress program, you can follow the steps below: 
Ø Click Start button 
Ø Choose All Programs 
Ø Choose OpenOffice.org 4 
Ø Choose OpenOffice.org Impress 

 

II. Creating a New Presentation 
When you create a presentation, you can select the type of presentation, such as a blank 

presentation or an existing presentation template for your slides. 
 
1. Creating an Empty Presentation 
 

You can create a presentation that has 
nothing on it. This just means you are starting 
from an empty slide. When you first open the 
Impress, you will see a display wizard box 
appear as shown on the right: 

• Select a category, Empty Presentation 

• Click the Create button 
2. Opening Presentation from a Template 
 

Create slides based on existing templates in this 
Impress. 
How to apply: 

Ø Choose From Template 
Ø Select an existing template type 
Ø Select the presentation format of the 

selected template 
Ø Click Create button 
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3. Opening an Existing Presentation 
You can open a previously saved presentation for further use or editing via the Presentation 

Wizard dialog below. 
 

 
Ø Select the name of a file you have recently 
opened, or click the Open button to select the file 
you want to open from your computer. 
Ø Click the Create button. 
 
 
 
 
 

 

III. Main Impress Window 

 

IV. Discover Slide Layouts 
On the right side of the program window, you see a task pane containing a layout tab 

with multiple slide layouts for you to choose from to create slides for your presentation. 
1. Slide layout selection 

You can select a slide layout 
with a title and an existing text box for 
you to enter text 

How to apply៖ 

Ø Select the Layout tab in the tasks 
pane 

Ø Control the mouse pointer, click on 
any slide you like 

 
 
 

  

Line bars and fillers 
Show bar 

 

 

សល បរពិលសល យ 

ទិដឋភពបងហ ញសល យ 

Drawing bar 

សល បរពិលភរកិចច 
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2. Inserting Text in Slides 
After selecting a slide layout, you can insert text into the slide by simply clicking the mouse 

pointer on the desired text box and inserting textual content into it. For example៖ 

     
 
3. Discover the Text Formatting Bar 

You can format the text you have entered into various formats using the icons on the 
format bar as follows: 

 
 

 
4. Renaming Fonts and Sizes 

• Select the text whose font you want to 
change. 

• Click the arrow next to the Font Name icon on the formatting bar. 
• Choose a preferred Font name 

Example: KhmerOS Moul Light 
• Right-click the font size and select 48 

 
 
5. Text Formatting and Paragraph Alignment 

To modify the font effect, you need to apply the 
following: 

Ø Select the text you want to format 
Ø Click on the icon on the format bar, such as: 

• Bold icon  : For bolding text. If you 
want to remove the bold text, you need to 
click on the bold icon again. 

• Italic icon  : For italics. If you want to 
remove the italics, you must click on the 
italics icon again. 

• Underline icon  : For underlining the 
selected text. Click this icon again to 
undo the bottom line. 

• Left align icon   : For aligning text in the text box. 
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6. Bullet and Numbering 
You can click on Icon Bullet and Numbering 

on the formatting bar to place bullets and numbering. 
How to apply: 

Ø Place the cursor on the text that you want to 
place bullet or number, or select the 
paragraph where you want to place them 

Ø Click on Bullet and Numbering 

 

You can use the Tab key to move 
ahead of the dot, but place the 
cursor at the beginning of the line. 

 
 
How to apply to change bullet type or numbering: 

Ø Place the cursor in the text you want to change the 
point type 

Ø Click on the icon         Bullet and Numbering 
on the bullets and numbering bar 

 
 
 
 
 
 
 
 
 
 

V. Inserting a New Slide 
  To insert a new slide, follow these steps: 

Ø Choose Insert menu -> Slide ... 
Ø Or right-click a slide in the slide pane -> Select a new 

slide 
 

 

VI. Full-screen Slideshow 
To show a full-screen slide, do the following: 

Ø Click on the icon Slideshow on the display bar 
Ø Or select Menu Slide Show -> Slide Show 

Or press the F5 or F9 on the keyboard. 
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Press the Esc key to exit the full-screen slide show. 

 
 

VII. Closing the Presentation File 
How to apply: 

Ø Choose File menu -> Close 
Close the file using the shortcut keys: 

Ø Press Ctrl + W 
Ø Press Ctrl + F4 

 
 
 
 
 

VIII. Closing the Program 
To close Impress, you need to: 

Ø Choose File menu -> Exit. Or click the Close button
on the title bar. 

 
Use shortcut keys: 

Ø Press (Alt) + F4 
Ø Press (Ctrl) + Q 
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• Impress is OpenOffice.org’s slide show (presentations) program. You can create slides that 
contain many different elements, including text, bulleted and numbered lists, tables, charts, 
clip art, and a wide range of graphic objects. Impress includes a spelling checker, a  
thesaurus, prepackaged text styles, and attractive background styles. 

Summary 

1. What is the Impress program (OpenOffice.org Impress)? 
2. Describe how to insert a new slide. 
3. How do we show a full-screen slide show? 
4. How do we get out of a slide show? 

Questions 
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 In the classroom, you need to create a presentation consisting of five slides that 
introduce yourself and your future goals. 

1. Open the Impress program (OpenOffice.org Impress) 

2. Create a slide and set the format as follows: 

 
Slide 1 

 
Slide 2 

 
Slide 3 

 
Slide 4 

 
Slide 5 

 

 

Exercises 
 



 

Objectives: 
In this lesson you will be able to create slides that can add animation 
to objects or text and can use the Writer program  
to do the following: 

I. Copy, Cut and Past 
II. Rename Slides, Delete Slides 

III. Hide Slide Show 
IV. Insert, Edit, Move, Resize Text Boxes  
V. Insert Shape Automatically 

VI. Add, Change, Remove, Animate Objects or Text in Slides 
 

Drawing Object and Animation 

 Lesson 17 
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Lesson 17 Drawing Object and Animation 

I. Copy, Cut, and Past 
Copying, cutting, and pasting slides are the same as any other program. Copying and 

cutting is one way to get more new slides with the same format and style. 
 

 
1. Copy Slides 

If you want an identical slide, you do not need to redesign 
it. You can just copy it. The original slide you copied will not be 
lost or modified after copying. 
How to copy a slide: 

Ø Right-click on any slide you want to copy. 
Ø Choose Copy 

After copying, you need to paste the slides to show the slides 
you copied. 

 
 
Ø How to paste a copied slide: 
Ø Right-click on any slide you want to copy. 
Ø Choose Paste 

 
2. Cut Slides 

You can cut slides from one presentation file to another. But if you do not have to cut the 
slides from one place to another in the same document, you can move it by holding down the 
slide and dragging it to another location. 
How to cut slides: 

Ø Cutting a slide is the same as copying one. Right-click on the slide you want to cut → 
choose Cut 

After cutting, you’ll notice that the cut slide disappears, so you can retrieve or show the cut 
slide again by pasting it in the same way as copying it. 
 

Note ៖ 

 

If you want to copy multiple slides, you must 
first select those slides. Hold down the Shift 
key to select multiple slides in a row. Or hold 
down the Ctrl key to select multiple separate 
slides. 
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II. Rename Slides 
By default, each slide in the slide panel is like Slides 

1 and 2 ... You can rename these slides. 
To rename a slide, do the following: 

Ø Right-click on any slide you want to rename. 
Ø Choose Rename Slide 
Ø You will then see a box Rename Slide as shown 

below: 

 
 

Ø Enter the name of the new slide you want to put in the Name box. 
Ø Click Ok 

 
III. Delete Slides 
To delete a slide, follow these steps: 

Ø Select the slide you want to delete 
Ø Right-click the slide you want to delete → Choose 

Delete 
 
 

Note: 

 

To return immediately after deletion, 
you can select the Edit menu → Undo 
or press the shortcut key + Z 

 
IV. Hide Slide Show 

Hiding a slide hides the display only when you show the slide in Full-screen mode. It 
does not make this slide disappear. 
How to hide a slide: 

Ø Select the slide you want to hide from the display 
Ø Right-click on the selected slide → Choose Hide Slide. 

 
V. Using the Text Box 
1. Inserting text boxes in slides 
You can insert text anywhere in the slide using 
the Text icon on the drawing bar. 

Ø Click on Text  
Ø Hover over the slide at the point where you want to insert text →Then, left-click and 

drag to the desired size. 
Example ៖ Create a text box and enter text like this: >> 
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2. Text Editing and Formatting 
You can edit and resize text in text boxes contained in slides, such as renaming fonts, 

resizing fonts changing the color, and so on. 
How to edit the text in a text box: 

Ø Double-click the text box you want to edit–> Use the arrow keys to move the cursor to 
the position you want to edit → Then make adjustments suiting your needs. 

  
 
3. Moving Text Boxes 

You have already learned about moving a drawing object or text box in OpenOffice.org 
Writer. This lesson will remind you 
again about moving the text box by 
doing the following: 

Ø Click the text box and then
hover the mouse pointer 
over the edge of the text box 
until it displays four front 
arrow keys.  

Ø Hold down the mouse and drag this text box to the desired location. 
 
4. Resizing Text Boxes 
To resize a text box, follow these steps: 

Ø Click on the text box you want to resize 
Ø Place the mouse pointer over any of the 

handles on the text box until the mouse pointer 
becomes a double-faced arrow, as shown in the 
image on the right 

Ø Hold down the mouse and drag the text box to the size you want. 
 
VI. Insert Shape Automatically or Draw Objects 

 You’ve already learned from this Writer about automatic shapes or drawing objects. You 
can use drawing objects to design a 
presentation or create various graphic 
formats as needed. 

There are many types of 
drawing objects that you can use on 
the drawing bar. Some drawing objects you notice have an arrow to the right of it, and when 
you click on this arrow, it will show many other sets of drawing objects. 
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សួសដី!  

 
You can define the lines and other fillings of the drawing objects you have drawn as 

follows: 
 

   

   
Try drawing the following drawing objects: 
 
 
 
 
 
 
 
 

 

You can insert text in an AutoFormat or drawing object by double-clicking the 
drawing object. 
Or ... select the drawing object and press the Enter key. 

 
VII. Adding Animation to an Object or Text 

You can add animations to objects or text in your slides. The Impress program offers a 
variety of animations for you to choose from. 
How to apply animation to an object in a slide: 

Ø Select the object or text that you want to animate. If you want to add animation to 
multiple objects or text, select them by holding down the Shift key and the mouse 
pointer on the object to be selected. 

Ø Choose Slide Show Menu - Custom Animation 
Or click the Custom Animation tab in the task panel 

Ø Click the Add button in the Custom Animation tab. You will then see a box appear as 
follows: 
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In the Custom Animation dialog 
Ø Choose your favorite type of movement. E.g., Fly-In 
Ø Click OK button 

 

 
1. Animation Change 

To change the animation of an added object or text, do the following: 

Ø Select the animated object or text you want to change or modify 
Ø Click the Change button in the Custom Animation tab 

 
You can select different animation types from the Fly-In or Fly-out or Exit tab or animation 
paths in the Custom animation dialog: 

Ø Click the OK button. 
 
2. Removing Animated Objects or Text 

To remove an object or text animation, follow 
these steps: 

Ø Select the object or text you want to animate 
Ø Click the Remove button in the Custom 

Animation tab 
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1. Do you need to cut slides from one place to another in the same document? Why 
or why not? 

2. Explain how to rename, delete, and hide slides. 
3. Why is the slide hidden? 
4. Explain how to add animations, change animations, and remove animations from 

an object. 

Questions 

In the classroom, you are required to present your favorite hobby and the reasons it is 
your favorite one to all your classmates. 

1. Opening of Impress 

2. Create a slide with the following format: 

 

3. Fill in the blanks (….) of your information. 

4. Apply Fly-in animation. 

Exercises 



 

Objectives: 
ü Set slide transition animation 

ü Insert table and edit table 

In this lesson you will learn the following: 

I. Slide Background Color 

II. Learning the Tab of the Slide Show View 

III. Transition 

IV. Table 

Table and Transition 

 Lesson 18 
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Lesson 18 Table and Transition 

I. Sliding Background Color 
You can apply various slide colors in the show, such as gradients, stripes, and images. 

How to apply a color to a slide: 
Ø Select the slide you want to 

color the background of 
Ø Choose Menu Format -> Pages 
Ø Select the Background tab 
Ø Select the filling you prefer 

E.g., Gradient 
Ø Choose a preferred gradient 
Ø Click the OK button 

 
 

ü Click the Yes button: The selected color will apply to all slides. 
ü Click the No button: The selected color will only apply to your selected slide. 

 

II. Learn About Each Tab of the Slide Show View 
When you open an exhibition program, you’ll notice a slide show in the middle of the 

program window with five tabs: simple outline, layout, print, and slide sorting tool. 

Learn about each of the following aspects: 

• Normal: The most frequently used important aspects for designing slides, formatting, 
inserting text, inserting animations, inserting charts, and so on. 
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• Outline: A view for displaying the title of each slide and the outline of the lesson you 
created. 

 
 

• Print Layout: To determine the number of slides to be printed per page, in the 
settings, you can set 1, 2, 3, 4, and 6 slides. 

      
 

• Slide Sorter: A view where you can change the position of the slides you want to sort. 
 
 
 
 
 
 
 

 
 Figure 23.8: Slide sorter view 
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III. Slide Transition 
Slide transition is the movement of a slide that must be moved 

from one slide to another. By default, slides do not move. Therefore, 
to animate or set the slide transition, you need to do the following: 

Ø Chose Menu Slide → Slide transition 

Note 

 

To undo a slide transition, you need to: 

 Select the slide that defines the transition 

 Select No Transitions in the Slide 
Transitions tab. 

 
In the Transitions Slide tab, you can modify the transitions as 

follows: 
• Speed: Set the speed at which the slide moves. 
• Sound: Set the sound when the slide moves. 

On the forward slide, you can set the slide transition movement forward to practice៖ 

• Mouse click: The slide transition will go forward 
when you click the mouse or click Enter 

• Automatic play: You can set the number of seconds 
for the slide to move forward automatically 
according to the set number of minutes. 

You can then try pressing the slide transitions button: 
• Apply to all slides button: to apply slide transitions 

selected to all slides in the document. 
• Play Button: View the slide transitions in the Show 

Program window for a slide show. 
• Slide show button: For a slide show, see the 

transitions in full screen. 

 

For animated slides, the observer sees a sign at the bottom of 
the slide. 

 
 
 

 



Lesson 18 Table and Transition Part 1: ICT Basic 

178 

IV. Inserting Tables in Slides 
We can also insert a simple table in the slide in case we want to use data or organize 

information as a Table structure in slides. For regular tables, you 
can enter this way faster than through spreadsheets. 
How to apply a table insert 

Ø Chose Menu insert → table 

  
Ø Determines the number of columns and the number of 

rows to insert 
Ø Click the OK button, and you will see an empty table 

created as follows: 
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1. When a slide pane does not appear in the slide show, what do you do to show it? 
2. What is the function of each tab of the slide show? 
3. Describe how to assign a slide transition to an object. How do you get rid of slide 

transitions? 
4. How do you insert a table with 3 columns and 5 rows in a slide? 

Questions 

You will be required to create a presentation on your first-semester transcript report 
for three major subjects (Mathematics, Khmer, and Physics) for all the students in your 
class. 

1. Open the Impress 

2. Create a slide with the following format by inserting the following spreadsheet: 

 

3.  Animate the slide title (move it at any pace you like). 
4. Set the slide transition to “split vertically”. Set the “fast” speed and the “beam” sound 
and set the slide to 5 seconds automatically. 
5. Give this presentation to your classmates. 
6. Save this presentation as “First Semester Grade 10A Results” in your folder. 
7. Close the application. 

Exercises 
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CHAPTER 3 

Internet and Online Communication 
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Introduction: 
Each day millions of people use the Internet and the World Wide Web at work, at home, and while 
traveling. Anyone with access to the Internet can connect to and communicate with other Internet 
users anywhere in the world. At the end of this lesson, you will be able to: 

ü Define the Internet and the Web. 
ü Categorize websites 
ü Define data usage and how it is calculated 

When you have finished this lesson, you will have learned: 

I. Information Regarding the Internet and the Web 
II. Connecting to the Internet 

III. Downloading and Uploading Data 
IV. Categorizing Websites 

 

Introduction to the Internet 

Lesson 19 
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Lesson 19 Introduction to the Internet 
I. Definition of the Internet and the Web 

Many people use the terms Internet and Web interchangeably. In reality, they are not 
the same. The Internet can exist without the Web, but the Web cannot exist without the Internet. 
The Internet (often referred to as the Net) is a huge global interconnection of computer networks 
worldwide. The World Wide Web (often referred to as the Web and abbreviated as WWW or 
W3) is a worldwide collection of interconnected documents (Web pages) and other resources. 

1. Web Site 
A Website is a Web page, or a collection of related Web pages located on the Web. The pages 
within the Web site can contain text, images, and multimedia elements such as audio, video, 
and animation. Hyperlinks (often referred to as links) are an essential part of the Web because 
they automatically connect you to another part of the same Web page or another Web page. A 
Web page link can be a word, a phrase, or a graphic.  

2. Web Page 
A web page is a document, commonly written in HTML, that is viewed in an Internet browser. 
A web page can be accessed by entering a URL address into a browser’s address bar. A web 
page may contain text, graphics, and hyperlinks to other web pages and files. 

A web page is often used to provide information to viewers, including pictures or videos 
to help illustrate important topics. A web page may also be used as a method to sell products or 
services to viewers. Multiple web pages make up a website, like our Computer Hope website. 

3. Home Page 
A home page is the main web page of a website. The term may also refer to the start page shown 
in a web browser when the application first opens. 

4. Hypertext Mark-up Language (HTML) 
HTML is the main mark-up language used to create Web pages. HTML defines the format and 
layout of a Web document. Just as most filenames include an extension to identify that file type 
(such as .docx for a Word document or .jpg for a graphical file), the Web page file often consists 
of a file extension to indicate the file type. For example, the extension may be .html or .shtml. 
SHTML is an HTML file that includes special commands for the server to process. 

5. Hyperlink 
Alternatively referred to as a link and web link, a hyperlink is an icon, graphic, or text that links 
to another file or object. The World Wide Web comprises hyperlinks linking trillions of pages 
and files to one another. Hyperlinks allow web pages to connect to other web pages. Without 
them, you would need to know the URL (Uniform Resource Locator) for every page on the 
Internet. For example, you likely got to this page from a hyperlink and didn’t type 
“https://elearning.moeys.gov.kh/course/view.php?id=122” into your browser address bar. 

6. URL 
The Uniform Resource Locator (URL) (often referred to as a Web address) identifies the unique 
IP address. URL addresses are presented in alphanumeric form because it describes the resource 
and makes it easier to remember (such as https://elearning.moeys.gov.kh). However, the URL 
is a set of four numbers separated by periods (such as 212.987.12.3), and the Domain Name 
System (DNS) translates the alphanumerical address to a numeric address. 
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7. Domain 
A domain is a group of computers and devices on a network that are administered as a unit with 
common rules and procedures. All devices sharing a common part of the IP address are said to 
be in the same domain. The domain name provides an online identity (such as an organization 
or company name). If your Web site has lots information to organize, you can create a 
subdomain, a domain that is part of a larger domain and dependent on the larger domain. A 
subdomain is like a folder under your root directory. 

Every Web site domain name also ends with a two- or three-letter extension that 
identifies the domain type or country of origin. There are various domain types, and each type 
has its own basic rules, such as the type of characters and the minimum and the maximum 
number of characters. Some of the most common domain types are described in the Table 
below: 

Extension Description of Domain Type 
.com Commercial; associated with 

business/commercial and personal Web 
sites; most popular 

.edu Education; associated with educational 
institutions 

.gov Government 

.info Information; both commercial and 
personal sites; unrestricted domain 

.net Network; initially intended to be used only 
for network providers; recommended for 
companies involved in Internet 
infrastructure; widely used. 

.org Organization; mostly associated with non-
profit organizations 

 

Domain types and extensions are also assigned to a specific country. For example, 
Cambodia uses .kh, and Korea uses .kr, Japan uses .jp, and Thailand uses .th. Accredited 
registrars manage the registrations of domain names. Once the domain name is registered, a 
Web hosting service makes the Web site accessible via the WWW. 

A URL always includes a protocol, the domain name, and the domain type or a country 
code. As shown in the Figure below, after the single forward slash /, the URL may also include 
a resource ID that provides the file’s name and any directories or subdirectories under which 
the file is stored on the specified computer. The domain name is the most easily recognized part 
of the URL. 
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8. Web Browser 
A Web Browser is a software application you use to view and retrieve documents from the 
Web and to display the documents in a readable format. Browser software (such as Microsoft 
Internet Explorer, Safari, Google Chrome, and Mozilla Firefox) sends a message to a Web 
server to retrieve a requested Web page. For example, when you enter a URL in your browser, 
you send an HTTP command to the Web server to tell it to locate and transmit the requested 
Web page. The browser then extracts the HTML code to display the page. 

II. Connecting to the Internet 
In homes, the common methods of Internet access include dial-up, broadband, satellite, 3G/4G 
technology for cell phones and Wi-Fi. Wi-Fi uses radio waves to provide wireless high-speed 
Internet and network connections. When you are away from the office or home, you can use 
Wi-Fi hotspots to connect to the Internet. A hotspot provides Wi-Fi network access (usually 
Internet access) to a small area for wireless-enabled devices such as laptops, tablets, and 
smartphones. 

1. SPI (Internet Service Provider) 

An Internet service provider (ISP) is an organization or company that provides connectivity to 
the Internet through a telecommunications line or wireless system. Its service is primarily to 
provide a connection to the Internet. Different types of Internet connections provide a range of 
options. Be prepared to balance the features you want, such as connection speed and reliability, 
with the cost and availability of the options. For example, a dial-up connection is the least 
expensive type of Internet connection, but it is also the slowest. Broadband connections such 
as cable modems and digital subscriber lines (DSL) offer a high bandwidth, which refers to the 
amount of data that can be transmitted. Broadband connections can transmit multiple 
information channels over a single link, carrying video, voice, and computer data 
simultaneously and much faster. 

After contracting an ISP, you must install some telecommunications software. This 
software enables your computer to connect to another computer. Your ISP or online service 
company provides this software, or most likely, you will be able to use software already 
installed on your computer. Most new computers are set up for a wireless connection. 

2. Hotspot 

Access to the hotspot services may be free to all, free to customers only, or fee-based. You may 
need a password to complete the connection. A hotspot can be limited to a confined location, 
such as a restaurant, or it can be more widespread and cover a large area, such as a school 
campus. 

Web browser 
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III. Web Browser 
The web browser is an application software to explore the www (World Wide Web). It 

provides an interface between the server and the client and requests from the server for web 
documents and services. It works as a compiler to render HTML, which is used to design a 
webpage. Whenever we search for anything online, the browser loads a web page written in 
HTML, including text, links, images, and other items such as style sheets and JavaScript 
functions. Google Chrome, Microsoft Edge, Mozilla Firefox, and Safari are examples of web 
browsers. 

Some of the most-used web browsers are Google Chrome, Mozilla Firefox, Microsoft 
Edge, Safari, etc.  

Google Chrome is the world’s most used web browser. In 77% of devices, Google 
Chrome is used. Google developed this browser in 2008 for Microsoft Windows. Later it was 
used in macOS, Linux, Android, and iOS operating systems. It is a very reliable browser and is 
available in 47 languages. The installation process of Google Chrome is very easy and free for 
everyone.  

Mozilla Firefox, also known as the Firefox browser, was developed by the Mozilla 
Foundation and the Mozilla Corporation in 2002. It is available on Linux, Microsoft Windows, 
Android, and iOS operating systems. In the Linux system, Mozilla Firefox is the default 
installed browser. 

IV. Downloading and Uploading Data 
Many ISPs, especially for mobile devices, include a monthly data usage allowance, and 

if you exceed the limit for your plan, you may pay an extra fee. Therefore, it is important that 
you understand how data usage occurs and how it is calculated. Almost every time you access 
the Internet, you will download (receive) or upload (send) data. When you browse the Internet, 
visit a Web site, send text messages and email messages, and post pictures on social networks, 
you are using data. Streaming is a technique for transferring data in a steady and continuous 
stream so you can start displaying the data before the transmission is completed. For example, 
you can start watching an online video before the entire file has been transmitted. Even though 
the video file may not be stored on your computer, the data is still downloaded in some form. 

The data is transmitted in packets, and the size of the packet is defined with the 
following terms: 

• bits: the smallest possible unit of information 
• kilobit: 1,000 bits 
• bytes: 8 bits 
• kilobyte: 8 kilobits 
• megabit: 1,000 kilobits 
• megabytes—8 megabits 

Bytes are capitalized when used in acronyms to distinguish them from bits since both 
starts with the letter B. For example, Kb is kilobits, and KB is kilobytes. Mb is megabits, and 
MB is megabytes. So, how big are the files typically accessed on the Internet? The following is 
a list of commonly accessed files and a typical size for each. Of course, file sizes vary depending 
on the amount of content, the format, the resolution, and the level of quality. 

• 1 text email message ~ 75 KB 
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• 1-page PDF file ~ 948 KB 
• Photo ~ 1.5 MB 
• Web page ~ 1.5 MB 
• 1 music track ~ 5 MB 
• 30 minutes of gaming ~ 25–75 MB 
• 10-minute video ~ 100–200 MB 

Internet connection speeds are usually measured in seconds. Kbps (kilobits per second) 
usually refers to dial-up and low-speed DSL connections. Mbps (megabits per second) is the 
most common unit of speed used. Generally, ISP services offer different download and upload 
speeds. For example, a service plan may offer a download speed of up to 30 Mbps and an upload 
speed of 4 Mbps. There are differences in download and upload speeds because most Internet 
connections are asymmetric, meaning the bandwidth capacity for downloading data differs 
from the capacity for uploading data. For personal use, the average user downloads much more 
than they upload, so the speed differences are acceptable. However, businesses often upload 
significant amounts of data, so they subscribe to a higher-level service that speeds up faster 
uploading. 

Even if you have a high-speed Internet connection, there are times when the transmission 
of data is very slow. Several factors reduce the speed of your Internet connection. 

• As mentioned earlier, the connection type is a major factor. 
• At peak times, popular Web sites can become overwhelmed with users. As more data is 

requested and sent, more bandwidth is used simultaneously. Likewise, home networks 
are often slow when multiple users are connected to the Internet using multiple 
browsers. Network administrators for corporate networks monitor Internet use and try 
to keep employees from downloading large files during peak hours. 

• Wireless Internet connections can be slowed down because devices interfere with the 
wireless signal. Household appliances such as microwaves, cable TV wires, or a 
neighbor’s wireless network can interfere with your network signal. 

• Internet speeds can also be slowed down because of outdated equipment or equipment 
not configured properly for optimal performance. 

V. Categorizing Web Sites 
There is a vast amount of information available on the World Wide Web. Web sites can 

be categorized, each with a different purpose and type of information. The following list 
provides an overview of some types of Web sites available. 

Commercial 

Also known as an e-commerce site, a commercial site sells or promotes products or 
services. Almost every business today has a commercial Web site. Many of these Web sites 
also provide options to purchase products or services online. 

 Academic 

Most educational facilities, elementary to university level and the public to private, have 
a Web site. Most higher education Web sites provide online registration, courses, and other 
options. Many research facilities and private and public companies also provide online training 
for their employees. 

 Organizational 
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Examples include Web sites of non-profit organizations such as zoos and advocacy groups such 
as wildlife and clean air supporters. 

Governmental 

Most local, state, regional, and national governments have numerous Web sites. For instance, 
a medium-sized city could have several Web sites for employment, news of the day, parks and 
recreation, local services, utilities, visitor’s guide, customer service, and other public 
announcement sites. 

 International 

Internet marketing of a product or service sometimes requires that Web sites be hosted in other 
countries. Each country has unique search engines which use different mathematical 
algorithms. Web page text also needs to be translated into the country’s language. Values and 
customs vary, so an effective Web site in one country may not work in other countries. Finally, 
local agencies most likely have a better understanding of the population and search engine 
optimization related to that population. 

 Search Sites 

A search engine is a software program used for online searching. Hundreds of search engines 
have been developed to find information on the Internet. Each search engine may work 
differently, but most share common search features. For example, all search engines support 
keyword searches. 

Membership Sites 

Some Web sites, such as those used for email services and e-commerce, require you to register 
before access to the Web site is allowed. Then to access restricted content or use the services, 
you must enter a user ID and a password. When you see the letter “S” after “HTTP” in the URL, 
it confirms that it is a secure Web site. Verifying that the Web address begins with https:// 
before entering personal information would be best. 

Online applications: Also known as Web apps, these online applications host programs you can 
access with your Web browser. When using a Web app, the browser functions as a client. You 
interact with the software through your browser. Some applications allow you to store data on 
your local computer, while others store your data and information on its servers. The Cloud is 
a good example. You can create documents online, edit the documents from anywhere, and 
share your documents in real-time for no charge. 

Portal 

A portal is a Web site that features useful content but also contains links to other sites. 
You can use a portal as your home page. For example, MSN.com is a portal that includes links 
to Web sites for news, sports, entertainment, the Bing search engine, etc. 

Geographic imaging: Mapping and geographic imaging Web sites use technology to change the 
imagery of the Earth’s surface into valuable information. This information is used by 
geographical information systems (GIS) to capture, store, analyze, and manage images. Google 
Earth is one example of this type of Web site. 

 Wiki 
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A wiki is a collaborative Web site that people can use to add, edit, remove, and organize Web 
page content. Wikipedia is a popular online wiki. 

VI. Addressing Web Site Issues 
The Internet and browsers aren’t without their problems. Web sites might not be 

displayed for several reasons. 

When you enter a Web site address and receive a “Page not found” message, the Web 
site might display a “404 error,” which you receive because a) the page was moved, b) an old 
index is still maintained in a search engine, or c) you made a typing error when entering the 
Web site address. Sometimes, the Web site is temporarily unavailable because the server is 
offline or the site is being updated. 

A Web page may load slowly because of heavy server traffic or because the page may 
contain a large number of images. A garbled or offset page could result from several issues, 
such as the rendering technique used by the browser. If you are using a recent browser, such 
as Internet Explorer 11, you can use the Compatibility View command to try to display the 
Web page using older settings. 

Pop-up ads can also be an annoyance. Advertisers place these ads on Web sites and 
they pop up in the middle of a page to call attention to its content. Internet Explorer contains a 
pop-up blocker that limits most pop-ups. By default, the pop-up blocker is enabled. You can 
customize the settings to allow pop-ups from specific Web sites. 

Internet security is essential. Each time you connect to the Internet, there is the risk of 
unauthorized parties accessing sensitive resources. And you are vulnerable to viruses and 
other malicious code. If a password does not protect a wireless connection, anyone with a 
wireless router and within the range of the signal can use the connection to browse the 
Internet. However, you might be sharing much more than Internet access. Once they access 
your wireless connection, they can also access your data. Encryption methods used by routers 
protect against unauthorized access. Older devices might be programmed to connect using 
WEP (Wired Equivalent Privacy Protocol). Still, newer devices are likely programmed to use 
WPA (Wi-Fi Protected Access) or WPA-2, improved encryption methods. 

Other forms of security management are gateways and firewalls. A gateway is a 
computer or dedicated hardware device that connects a LAN (Local Area Network) to another 
network, typically the Internet or a WAN (Wide Area Network). A firewall blocks 
unauthorized network access within its LAN or to and from the WAN. Network 
administrators and information security experts configure the firewall to ensure that only 
authorized protocols, applications, users, etc., are allowed access to critical data within the 
network. Antivirus apps help protect against viruses, and antimalware apps help protect 
against malware. All of these functions need to work together for optimal performance and 
security. 

Some antivirus software programs include firewall protection. You need only one 
firewall app running on your PC. Windows Firewall comes with Windows, and it is turned on 
by default. It would be best to turn Windows Firewall off only if another firewall is turned on. 

To customize the settings for compatibility viewing, blocking pop-ups, and turning on 
the firewall, you must switch to Desktop or Private modes. 
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VII. Get Started with Chrome Browser 

 

1. Search in Chrome 
Use the address bar like a search box to look for content. You can also search for a specific 
word or phrase on a web page. 

A. Search the web: 

• Open Chrome browser and enter your search in the address bar. 
• Click a result or press Enter. 

B. Search a web page: 

• Open a webpage in Chrome browser. 
• At the top right, click More and then Find. Or, use the keyboard shortcut Ctrl + f 

(Windows, Linux, and Chrome OS) or ⌘ + f (Mac). 
• At the top right, in the search bar, enter your search term. 
• Press Enter. Matches are highlighted on the page. 

 

2. Open New Tabs or Windows 
• In the Chrome browser, at the top right, click More and then New Tab or New 

Window. 
• (Optional) To move a tab: 
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• Drag it outside the existing window or into a new window. 
• Drag it to a different position in the window. 

 

3. Using Apps 
You can run Google Workspace apps from the Chrome browser, such as Google Docs, 
Sheets, and Slides. 

• Open an app: 
• In Chrome browser, open a new tab. 
• Choose an option: 
• At the top right, click the App Launcher  and then click the app you want to open. 
• In the address bar, enter chrome://apps and press Enter. Then, click the app you want 

to open. 

 

4. Downloading Files 

To save a file or image on your computer or device, download it. The file saves in your 
default download location. 

• In the Chrome browser, go to the webpage where you want to download the file. 
• For most files, click the download link or right-click the file and select Save as. 
• Sometimes, how you save a file depends on the file type: 

§ Images—Right-click the image and select Save Image As. 

§ Videos—Point to the video. Click Download . If this action isn’t available, 
the video’s owner or hosting site doesn’t allow downloads. 

§ PDFs—Right-click the file and select Save Link As. 

§ Webpages—At the top right, click More More Tools Save Page As. 

• Downloads appear at the bottom of the Chrome browser window. Click the download 
to open it. 



Lesson 19 Introduction to the Internet Part 1: ICT Basic 
 

189 

• (Optional) To find a downloaded file on your computer, click the Down arrow 

Show in Folder or More Show in Finder, next to the filename. You can also see 
downloaded files on your Downloads page. 

 

5. Printing Files 
You can print from your computer or mobile device with the Chrome browser. 

• In Chrome browser, open the page, image, or file you want to print. 
• Choose an option: 

§ On a computer—Click More -> Print. Or, use the keyboard 
shortcut Ctrl + p (Windows & Linux) or ⌘ + p (Mac). 

§ On a mobile device—Click More->Share->Print. 

• Select the destination and change any print settings you want. 
• Click Print. 
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• The Internet, the World Wide Web, and Web browsers have their terminology. 

• There are several methods for connecting to the Internet, and different types of 

Internet connections provide a range of (range of what?) 

• Almost every time you access the Internet, you are using data. The data is transmitted 

in packets, and the size of the packet is defined in bits and bytes. 

• Websites can be organized into categories, each with a different purpose and type of 

information. 

• Once you connect to the Internet, you need a Web browser to display Web pages. 

Basic elements exist in all browsers, and most browsers use universal symbols. 

• A browser tracks websites you have visited and temporarily stores data you access 

on the Web. 

• Internet security is essential. Each time you connect to the Internet, there is the risk 

of unauthorized parties accessing sensitive resources. 

Summary 

 

1. What is the Internet? What are the differences between the Internet and the Web? 

2. What is a Website, Webpage, Home Page, and URL? 

3. What is the extension’s purpose for a website’s domain name? 

4. What domain type is associated with commercial/business Websites? 

5. What is the purpose of a wiki website? 

Questions 



Lesson 19 Introduction to the Internet Part 1: ICT Basic 
 

191 

 

 

1. Discover content on the internet. 

a. Open web browser 

b. Go to eleaning.moyes.gov.kh 

c. Navigate this website. 

d. Describe what contents are on this website. Tell your class. 

e. Download any content related to your subject. 

Exercises 
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Introduction: 
Email (Electronic mail) is a way to send and receive messages across the Internet. At the end of 
this lesson, you will be able to: 

ü Create an Email account 
ü Send and receive Email 
ü Work with Email settings 

When you have finished this lesson, you will know: 

I. What Email Is 
II. How to Create an Email Account 

III. How to Send Email 

Using Email 

Lesson 17 
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Lesson 20 Using Email 
I. Introduction to Email 

Email (Electronic mail) is a way to send and receive messages across the Internet. 
It’s similar to traditional mail but has some key differences. To better understand what Email 
is all about, look at the infographic below and consider how you might benefit from its use. 

 

 

2. Understanding Email Addresses 

To receive Emails, you will need an Email account and an Email address. Also, if 
you want to send Emails to other people, you will need to obtain their Email addresses. It’s 
important to learn how to write Email addresses correctly because you need to enter them 
exactly right to ensure your Emails are delivered to the right person. 

Email addresses are always written in a standard format, including a username, the 
@ (at) symbol, and the Email provider’s domain. 

The Username is the name you choose to identify yourself. 

 

The Email Provider is the website that hosts your email account. 
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Some businesses and organizations use Email addresses with their website domain. 

 

3. Gmail 

Gmail (pronounced Gee-mail) is a free Web-based Email service that provides users 
with a gigabyte of storage for messages and the ability to search for specific messages. With 
Gmail, your Email is stored safely in the cloud. You can get messages from any computer 
or device with a web browser. You can join or start a video meeting in Google Meet right 
from Gmail. Add Google Chat to your Gmail inbox and get all the features of Chat directly 
in Gmail. You can also quickly organize and find important Emails and read and draft 
Emails without an internet connection. 

A Google Account gives you access to many Google products. With a Google Account, 
you can do things like: 

P Send and receive Emails using Gmail 
P Use Google Products in Google Workspace 
P Find your new favorite video on YouTube 
P Download apps from Google Play 

 
II. Set up Gmail for Google Workspace 
1. Creating Email 
You can create a Gmail account by doing the following: 

Ø Go to the Google Account sign-in page. 
Ø Click Create account. 
Ø Enter your name. 
Ø In the “Username” field, enter a username. 
Ø Enter and confirm your password. 

Tip: When you enter your password on a mobile device, the first letter isn’t case-
sensitive. 

Ø Click Next. 
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Ø It will show Verify your information. This is an optional step. You can fill in your 
information like phone number and recovery Email address. But we recommend 
filling in this information because it is easy to recover your password if you forget 
it and it makes your account more secure. 

Ø Enter your birthday and select your gender. 

 

Ø Click Next. 
Ø Verify your phone number page will appear 
Ø Click Send Button 

 

Ø Google will send a 6-digit verification number to your phone 
Ø Check your SMS and fill in the 6-digit number 
Ø Click verify button 
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Ø Click Yes, I’m in 

 

Ø When the Privacy and Terms page appears, scroll to the bottom and click on both 
checkboxes to agree with terms and privacy. 

Ø And then click Create Account. 

 

Ø Now, your Gmail account has been created successfully. Welcome pages appear 

 

Ø Click on the Google app button at the top left 
Ø Choose Gmail 
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Ø Now you can access your Email page. 

 

 

2. Email UI 

 

1) Compose: For sending Email 
2) Menu: Shows a menu that you can navigate and manage your mail with, such as: 

• Inbox: lists Emails sent to you. 
• Draft: a place where unsent messages are kept. 
• Sent: list all Emails you sent to others 
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• Spam: the place where unsolicited advertising or promotional messages are 
kept. Typically, this type of message is sent to many users for advertising, 
phishing, spreading malware, etc. 

• Trash: lists all mail you deleted. 
3) Searching bar: you can search your mail with this bar 
4) Setting: setting features in your Email 
5) App box: shows all apps that you can use with your Email 
6) Account: manage your account  

 

III. Start Sending Mail 
1. Sending Email 
To send an Email, please do the following: 

Ø Click on Compose 
Ø Compose Email page will appear 

 

• To: Persons directly involved in the content of the message. 
• Subject: Title of the mail that will be first displayed to the receivers. The title 

should be short and explicit enough to summarize the topic. 
• Message body: You type the content of your Email in this part of the screen. 

Ø Click Send button. 

2. Reply and Forward 
The Email offers choices to reply and forward 

• Reply: when your Email goes to a single person, either the person who sent the 
original Email or the person who sent the last message in the thread you’re 
responding to.  

• Reply to all: when you respond to everyone on the thread. Other recipients will 
see a message you Reply All to, whether they’re in the “To” or “Cc” fields. To, 
and reply all, forward to, forward all 

• Forward: you can transfer the received Email to someone not included as a 
receiver in the original mail. When you reply to/forward a message, the entire 
content of the initial mail appears by default. Removing some parts of the 
original message is possible if you don’t want. 

Replying to or Forwarding an Email: 
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Ø To respond to a single Email or the last Email in a thread, click Reply  . 
Ø To respond to an Email within a thread, click Reply all . 
Ø To forward a single Email or the last Email in a thread, click Forward  . 
Ø To deliver an Email within a thread, click More Forward. 
Ø To see the previous Email in a thread, click Show trimmed content . 

Ø To forward an entire conversation, at the top, click More Forward all. 
Ø To use a Smart Reply, click a suggested reply at the bottom of the Email. You can 

then edit the Email before sending it. 

 

 

3. Sending with Attached File 
When you want to attach a file with your Emails, such as a PDF file, Open office file, 

Video, or Music file, please do the following: 

Ø Click on attach file icon on Compose mail page 
Ø Navigate to the file on your computer 
Ø Choose the file you want to attach 
Ø Click open 

Note: Attached file supports only 25MB. Attachments larger than 25MB will be 
automatically uploaded to Google Drive. A download link will be included in your Emails. 

 

4. Email Signature 
An Email signature is a block of text automatically inserted into the end of an 

Email message you send. Generally, a signature is used to provide the recipient with your 
name, Email address, business contact information, and website. 

 To add an Email signature, do the following: 
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Ø Click settings 
Ø Click see all settings 

 

Ø In general, tap scroll down and find the signature. 

 

Ø Click create new, and create your name in the Name new signature box.  

 

Ø Fill in your information. 

 

Ø Click save. 

 

5. Download the Attachment File From the Email 
To download the attached file, do the following: 

• Click on Email 
• Drag the mouse to the attached file 
• Click on the download button 
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• Gmail (pronounced Gee-mail) is a free Web-based Email service that provides users with 
a gigabyte of storage for messages and the ability to search for specific messages. With 
Gmail, your email is stored safely in the cloud. You can get messages from any computer 
or device with a web browser. You can join or start a video meeting in Google Meet right 
from Gmail. Add Google Chat to your Gmail inbox and get all the features of Chat 
directly in Gmail. You can also quickly organize and find important emails and read and 
draft emails without an internet connection. 

• A Google Account gives you access to many Google products. With a Google Account, 
you can do things like: 
§ Send and receive email using Gmail 
§ Use Google Products in Google Workspace 
§ Find your new favorite video on YouTube 
§ Download apps from Google Play 

Summary 

1. What is Email? 
2. Describe the advantage of Email. 
3. What is the Username and email provider? 
4. Name four email providers that you know of. 
5. When you create a Gmail account, why do you need to fill in a phone number or Email 

recovery address? 

Questions 
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Sending Email: 
 

1. Open the Web browser and log in to your Gmail account 

2. Send an Email to a friend in class  

Exercises 
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CHAPTER  4 

Cloud Technology 
And  

Google Workspace 
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Introduction: 
Storing data safely is important. Sometimes storing data in a local device is unsafe when viruses 
attack your device. A new kind of technology is Could data storage. You can keep your data on 
the cloud and access it anywhere when connected to the internet. At the end of this lesson, you 
will be able to: 

ü Understand Cloud technology 
ü Classify the types of Cloud technology 
ü Know the pros and cons of Cloud storage 
ü  

When you have finished this lesson, you will know: 

I. What Cloud Technology Is 
II. The Types of Cloud Technology 

III. The Pros and Cons of Cloud Technology 
IV. Cloud Storage 

 

Cloud Technology 

Lesson 21 
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Lesson 21 Cloud Technology 
I. What is Cloud Computing? 

Cloud computing delivers computing services, including servers, storage, 
databases, networking, software, analytics, and intelligence over the Internet (“the cloud”), 
to offer faster innovation, flexible resources, and economies of scale. You typically pay 
only for cloud services you use, helping you lower your operating costs, run your 
infrastructure more efficiently, and scale as your business needs change. 

 

II. Types of Cloud Computing 
Not all clouds are the same, and not one type of cloud computing is suitable for 

everyone. Several models, types, and services have evolved to help offer the right solution 
for your needs. 

First, you need to determine the type of cloud deployment, or cloud computing 
architecture, that your cloud services will be implemented on. There are three different 
ways to deploy cloud services: on a public cloud, private cloud, hybrid cloud and 
Community Cloud. 

 

1. Public Cloud 

Public clouds are owned and operated by a third-party cloud service provider, 
which delivers their computing resources, like servers and storage, over the Internet. With 
a public cloud, all hardware, software, and other supporting infrastructure is owned and 
managed by the cloud provider. You access these services and manage your account using 
a web browser. Learn more about the public cloud. Google Cloud Platform, Amazon Web 
Services, and Microsoft Azure are examples of a public clouds. 
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Pros: 

Easy to manage. It eliminates the need for you and your team to regularly attend to the 

maintenance of the system. 

Cost. The way services are billed is that you pay for what you use, and then regulate when it 

needed. 

Reliability and performance. There is no limit to the number of users. And the location of 

users is independent because its services are delivered through the internet. 

Cons: 

Control. In the event of a failed cloud platform, you would not be able to maintain continuity of 

operations. 

Security. Your data is shared for big number of users. 

 

2. Private Cloud 

A private cloud refers to cloud computing resources used exclusively by a single 
business or organization. A private cloud can be physically located in the company’s on-
site data center. Some companies also pay third-party service providers to host their private 
cloud. A private cloud is one in which the services and infrastructure are maintained on a 
private network. 

 

Pros: 
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Control. Fewer people having access to the admin tools and configuration of your private cloud 

will give you more control. 

Customization. If you have a compelling reason to develop a new feature, you can easily 

deploy it in-house. 

Security. You can easily integrate as many security services as your business needs. Two-factor 

Authentication is easily the most secure method of cloud security.  

Cons: 

Team. To take advantage of the power of the private cloud, you need the right skills of 

developers, security experts, DevOps and etc.  

Cost. Most companies can't afford to set up their own cloud infrastructure. Even with the most 

advanced technology, the cost of running a private cloud is still expensive. 

 

3. Hybrid Cloud 

Hybrid clouds combine public and private clouds, bound together by technology 
that allows data and applications to be shared. By allowing data and applications to move 
between private and public clouds, a hybrid cloud gives your business greater flexibility 
and deployment options. It helps optimize your existing infrastructure, security, and 
compliance.  

 

Pros: 

Flexibility. One of the best features of the cloud type is that it's very flexible. You can select the 

parts of it that you would like to integrate into your solution. 

Scalability. You can regulate the functionality with the demand of users.  
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Cons: 

Data silos. They are the places where all of your collected data lies. Having the proper 

separation of these silos can help ensure that all of your data is properly allocated. 

Cost. Hybrid cloud delivery models are not as expensive as they may seem, but they are also 

prone to spending too much. There is a risk of spending too much if you choose incorrect cloud 

services. 

4. Community cloud 

This deployment model supports multi-organizations sharing a common cloud environment. 

For example, universities share computing resources with the police force. Access to a 

community cloud environment is typically restricted to unauthorized members. 

 

Pros: 

Cost. Cost. It is cost-effective because of sharing the cloud with several organizations or 

communities. 

Collaboration. It is suitable to share resources, infrastructure, and other features among various 

organizations and members. 

Cons: 

Limitations. There is a fixed amount of data storage is shared among all members. Also, not 

every organization is suitable to use it. 

Security. Security features are better than public cloud but are not good as private capabilities. 
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III. Advantages and Disadvantages of Cloud Computing 
1. Advantages 

The first advantage of cloud computing is its simplicity. To use a cloud-based 
backup, you must install a client program and start using it. In the past, you would have to 
install software, connect to external hard drives, physically secure the drives, duplicate the 
backup storage in case it got damaged, etc. Today, the backup company performs all these 
steps. All you need to do is be connected to the Internet. It’s the same for saving your 
documents with dropbox.com or sharing your photos through iCloud. 

The second advantage is the up-front cost. You can enjoy an enterprise-level 
service for a relatively small subscription fee. If you were to purchase the servers yourself, 
it would be a much higher up-front cost. If you no longer want the service, you aren’t stuck 
with costly hardware or telecommunications investments. You can simply stop using the 
service. 

The third advantage is the ubiquitous availability. If you use Google Drive, you 
upload your file once. Google Drive stores it for you and allows you to access it through 
the browser as often as you wish. Later, you can access the same file on your phone. 
Finally, at your friend’s house, you can use their computer to access the file under your 
Google Drive account. The service follows you wherever you are with an Internet 
connection. 

2. Disadvantages 

The first disadvantage of cloud computing is sustainability. If you use Google Docs 
as your main company document management system, you become dependent on Google. 
While Google is a strong company, some cloud companies go out of business. Your 
business may suffer when your provider is no longer there. You may even lose data or 
business. 

The second concern is privacy. If you store your business documents with Google, 
does Google read them or use them? Many companies will provide legal agreements 
reassuring customers that they keep the data private. Since the data is out of your control, 
this remains a concern. 

The third concern is security. Since you have to transmit the data to the cloud 
provider, a strong layer of protection is required. While the Internet today is generally 
secure, the base for this security is RSA encryption. New types of computers, quantum 
computers, are believed to hack RSA encryption easily. If this technology becomes 
available to consumers, HTTPS sites and cloud services will be vulnerable to attacks. 

 

IV. What is Cloud Storage? 
Cloud Storage is the technology that allows you to save files in storage and then 

access those files via the Cloud. Let’s break down this definition. First, storage is the 
computer’s ability to save files and other resources for later use. When you restart a 
computer, the files still available after the computer turns back on are saved and read from 
storage. Such storage commonly consists of a hard drive, a USB Flash drive, or another 
type of drive. 
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Because local data drives can be damaged or stolen, an idea was developed to use 
data drives over a network as storage. This allows the drives to be secured in a data center 
and backed up automatically. Initially, network storage required fast local networks 
(LAN), but today we have a ubiquitous Internet network. 

The second part of Cloud Storage, the Cloud, represents the Internet. Any service, 
including storage, available over the Internet is called a Cloud Service. If you use Gmail, it 
is email in the Cloud. If you use Apple Music, that’s music in the Cloud. 

 

V. Benefits and Disadvantages 
1. Benefits of Cloud Storage: 

ü High availability of storage: Enterprise-level providers handle protection against 
hardware failure, performance problems, and data corruption. 

ü Backup: Data backup and replication are done behind the scenes for the storage 
user. Several disaster recovery strategies protect data, making it more resilient. 

ü Portability: Files saved in Cloud Storage are available on PCs, phones, and tablets, 
anywhere and anytime. Data saved once is available anywhere the Internet is 
available. 

 

2. Disadvantages of Cloud Storage: 

ü Concerns with the stability of providers: All businesses have a risk of going out of 
business. Your data stored in the Cloud may be at risk. 

ü Security concerns: While Cloud Storage can be secure, the Internet adds to the 
level of risk. 

ü Cost: While small amounts of disk space in the Cloud can be inexpensive, large 
amounts can be costly. 

ü Performance concerns: The storage itself is often optimized and tuned well by 
specialized Cloud providers. However, when the user’s access to the Internet is 
limited, the overall experience and perception of the storage will be negative. Over 
a slow Internet connection, Cloud Storage will be slow as well. 
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• Cloud computing delivers computing services, including servers, storage, 
databases, networking, software, analytics, and intelligence over the Internet (“the 
cloud”) to offer faster innovation, flexible resources, and economies of scale. 

• There are three different ways to deploy cloud services: on a public cloud, private 
cloud, or hybrid cloud. 

• Cloud Storage is the technology that allows you to save files in storage and then 
access those files via the Cloud. 

Summary 

 

1. What is Cloud computing? 

2. How many types of Cloud Computing are there? Describe them. 

3. Describe the pros and cons of Cloud Computing. 

4. What is Cloud Storage? 

5. Describe the pros and cons of Cloud Storage. 

Questions 

• Use the Internet to research types of popular Cloud Storage. Provide 

the below information: 

o Cloud Storage Service name. 

o Cloud Storage Provider (Company). 

o Date released. 

o Amount of free capacity storage. 

Exercises 
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Introduction: 
In the previous lesson, you learned about cloud technology and cloud storage. This lesson 

will cover a cloud storage service provided by Google called Google Drive. At the end 

of this lesson, you will be able to: 

ü Understand Google Drive. 

ü Store data and share data using Google Drive. 

ü Use Google Drive to store data in daily life. 

When you have finished this lesson, you will know how to: 

I. Use G Drive 

II. Upload and Store Data 

III. View Data in G Drive 

IV. Organize Files 

V. Share and Collaborate in G drive 

Storing Data in Google Drive 

Lesson 22 
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Lesson 22 Storing Data in Google Drive 
I. Intro to Google Drive 

Google Drive is a free cloud-based storage service that enables users to store and 

access files online. The service syncs stored documents, photos, and more across the user’s 

devices, including mobile devices, tablets, and PCs. 

Google Drive integrates with the company’s other services and systems, including 

Google Docs, Gmail, Android, Chrome, YouTube, Google Analytics, and Google+. Google 

Drive competes with Microsoft OneDrive, Apple iCloud, Box, Dropbox, and SugarSync. 

 

1. G Drive Account Type 

Google offers different types of accounts for different kinds of users. There are two 

primary types of accounts that provide completely separate services:  

• Personal Account: You can use 15GB of storage with a personal account. If you 

want more storage, you need to purchase it. 

• Organization Account: You can store your limited or unlimited data depending on 

whether your organization or company purchases google service for you. For 

example, if you use a google account provided by MoEYS, you will get unlimited 

storage on your drive. 

2. Login to G Drive 

To login to your google drive account, do the following: 

Ø Open Web browser  

Ø Login to your Gmail account 

Ø Click on the google app 

Ø Chose Drive 
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Ø Google drive home page will appear in a new tab of your browser. 

 

II. Uploading and Storing Data on the Web 

To upload data to the drive, do the following: 

Ø Click  New -> File upload or Folder upload, 

 

Ø And then, choose the file or folder you want to upload. 
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Ø Click Open. 

If you’re using the latest version of Chrome or Firefox, you can drag files directly from 

your computer to the Drive page on your browser. 
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If you upload a file that matches the name of an existing file, Drive will add it as a 

new version instead of creating a duplicate. To see the previous version of that file, you 

can manage versions. 

When you see Upload complete, your files have uploaded successfully and can be 

accessed in any browser or device that has Drive installed. 

 

III. View the File 

1. Preview and Download Stored Files on the Web 

To take a quick look at a Drive file, right-click it and select Preview. 

In the overlay, you can: 

• Scroll down or up in your file. 

• Click Left arrow  or Right arrow  to see the previous or next file in Drive. 

• Open your file to edit it. 

• Click Add comment  to comment on non-Google files. 

• Print your non-Google file. 

• Click Download  to download your file. 

• Click More  to share, move, rename a file, and more. 

 

To save a file to access later, download it one of the following ways: 

• From the preview screen, click Download . 

• From Drive, select a file, click More , and Download . 

 

2. Open File 

To open the file, do the following: 
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Ø Open Drive. 

Ø Double-click the file you want to open. 

 

Ø The file will open in a new tab. 

 

3. Delete File 

Removing a file moves it to Trash: 

• If you own the file, moving it to Trash removes it from your My Drive view. The 

file is permanently deleted after 30 days in the Trash. If you share the file, those 

people can still see it until it’s deleted. 

• If you don’t own the file (for example, if it’s been shared with you), moving it to 

Trash removes it from your My Drive view but doesn’t delete it. Only the owner 

can delete the file. 

Note: Removed files you own are moved to Trash in Drive and still count towards your 

total storage until you permanently delete them on the web. 

 

Method: 



Lesson 22 Storing Data in Google Drive Part 1: ICT Basic 

215 

Ø Select the files or folders you want to remove and click Remove . 

Ø (Optional) To delete files permanently, do one of the following: 

• When in Trash, select a file and click Delete forever. 

• To permanently delete all your Trash files, click Trash and select Empty 

trash. 

 
 

4. Restore Deleted File 

If you change your mind after deleting a file or folder, you can restore it to Drive. 

Whether you delete it from Drive on the web or your computer in Drive for desktop, you 

restore it the same way. 

Ø Open Drive. 

Ø Click Trash . 

 
Ø Select the files you want to restore and click Restore . 
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IV. Organize Files in Drive 

1. Create Folder 

To Create a folder, do the following: 

Any new folders you create in your computer’s Drive for desktop folders or in Drive 

on the web automatically appear on your devices so that you’re organized everywhere. 

Ø Open Drive. 

Ø Click  New -> Folder. 

 

Ø Name your folder 

Ø Click Create 
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2. Move the File to the Folder 

Move a file to a folder in My Drive: 

Ø Select the file. 

Ø Click More  -> Move to . 

Ø Select the folder and click Move. 

 

You can also drag files and folders to a folder in My Drive on the left. 

 

V. Share and Collaborate in My Drive 

After you share Google Drive files or folders, you can work on them with teammates. 
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1. Share a File or Folder with Specific People and Set Access Levels: 

Ø Select the file you want to share. 

Ø Click Share or Share . 

 
Ø Enter the email address you want to share.  

Ø To decide what role people will have on your file, select Viewer, Commenter, 

or Editor. 

 
Ø Choose to notify people. 

• If you want to notify people that you shared an item with them, check 

the box next to Notify people. If you inform people, each email address you 

enter will be included in the email. 

• If you don’t want to notify people, uncheck the box. 

Ø Click Send or Share. 

1. Allow General Access to a File: 

You can choose if your file should be available to anyone or restricted to only those with 

access. If you allow access to anyone with the link, your folder won’t restrict who can access 

it. 

Ø Select the file you want to share. 

Ø Click Share or Share . 
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Ø Under “General access”, click the Down arrow . 

Ø Choose who can access the file. 

• Restricted: Only people with access can open the link. 

• Anyone with the link: Anyone on the internet with the link can view it. 

 

Tip: If you use your Google account for work or school, you can only share files and folders 

with a specific audience, like your department. You might see a description of each 

audience when you hover over the group name. 

Ø To decide what role people will have with your file, select Viewer, Commenter, 

or Editor. 

Ø Click Done. 
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• Google Drive is a free cloud-based storage service that enables users to store and 

access files online. The service syncs stored documents, photos, and more across 

the user’s devices, including mobile devices, tablets, and PCs. 

• Google offers different types of accounts to different types of users. There are 

two primary types of accounts that provide completely separate services:  

o Personal Account: You can use 15GB of storage data with a personal 

account. If you want more storage, you need to purchase it. 

o Organization Account: You can store your limited or unlimited data  

depending on whether your organization or company purchases google 

service for you. If you use a google account provided by MoEYS, you will 

get unlimited storage on your drive 

• After you share Google Drive files or folders, you can work on them with 

teammates. 

Summary 

 

1. What is Google Drive? How many types of google accounts types are there? 

2. Describe how to upload files and folders. 

3. How many types of permission are there when you share your drive? 

4. Describe each permission. 

5. In the General access Setting, describe: “Restricted” and “Anyone with the link.” 

Questions 

1. Upload and share a folder: 

a. Create a folder named: “share with teacher” 

b. Upload any file to your computer. 

c. Share this folder with your teacher. 

Exercises 
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Introduction: 
You learned about OpenOffice in the previous chapter. This lesson will teach you about 

Google Workspace for Administration, another Office program that runs in a web 

browser. It is very similar to OpenOffice. At the end of this lesson, you will be able to: 

ü Discover Google Workspace for Administration 

ü Use Google docs, slides, and sheets to work in administration. 

ü Use Google Workspace to improve your working process. 

When you have finished this lesson, you will know how to: 

I. Use Google Docs 

II. Use Google Sheets 

III. Use Google Slides 
 

Google Workspace for Administration 

Lesson 23 
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Lesson 23 Google Workspace for Administration 
I. Google Docs 

1. What Can You Do with Docs? 

Google Docs is a free, web-based word processor offered by Google as part of its 

complete Office suite that Google uses to compete with Microsoft Office. The other main 

services included in the cloud-based suite are Sheets (Excel) and Slides (PowerPoint). 

Google Docs is available on all devices and platforms. All you need is an internet 

connection and a web browser (or, in the case of mobile, the applicable apps). Google does 

the rest and handles the heavy lifting while running the software in the cloud. 

Docs support several different file types, including .doc, .docx .txt, .rtf, and .odt, 

making it easy to view and convert Microsoft Office files directly from Google Drive. 

And since Docs is an online word processor, you can share and collaborate with 

multiple people on the same document, track revisions, make changes and suggestions in 

real time. 

 

2. Create Files 

The first thing you’ll need to do before you can use 

Google Docs is sign up for a Google account (an 

@gmail account). You use an Email account to log in.  

To create a new document, do the following: 

Ø Login to google docs 

Ø Click on blank 

Ø Google docs workspace will be appear 
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3. Edit and Format a Document 

Edit a document, change how it looks, and work in it much as you did in your old 

program. Google Docs automatically saves every change you make. 

A. Add and Edit Text 

Rename your document: 

Ø At the top of the page, click Untitled document, enter a new title, and click OK. 

 

Add or edit text: 

Ø Just click on the page and start typing. 

 

B. Customize your Document 

Depending on what you want to change, choose an option: 

• To customize margins, page color, and orientation, click File and then Page setup. 
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• To customize text, images, tables, and more, use the toolbar options. 

Note: Some options only appear for certain types of content, such as tables or images. 

 

Undo or redo your last changes or print your 

document. 

 

Check spelling and grammar. 

 

Copy formatting from any text and apply it to 

another selection of text. 

 

Change the style, font, or font size. 

 

Make text bold, in italics, underlined, or 

change the text color. 

 

Add or change the text highlight color. 

 

Insert a link, comment, or image. 

 

Change the text alignment. 

 

Change the line spacing or add a checklist, 

bullets, or numbers. 

 

Change the text indentation. 

 

Remove text formatting. 

Table and image options 

 

Add background color to a table or change the 

border color, width, or style. 

 

Crop an image. 

Image options… Change the color, transparency, brightness, or 

contrast. 

Replace image  Replace an existing image with a new one. 

 

C. Add Pictures, Links, Tables, and More 

The Insert menu lets you add different features to your document. Here are the 

highlights: 
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• Image—Insert an image from your 

computer, the web, Drive, and 

more. 

• Table—Select the number of 

columns and rows to create a table. 

• Drawing—Create shapes, pictures, 

and diagrams in your document. 

• Link—Add a link to another page, 

header, or bookmark in the same 

document. 

• Bookmark—Add shortcuts to specific places within your document. 

• Table of Contents—Create an auto-generated table of contents that links to each 

heading in your document with a heading style applied. 

 

D. Create Page Columns 

You can organize your text in columns if you’re working on an academic paper or another 

large document. 

Ø Click Format and then Columns. 

Ø Select the number of columns 

you want. 

Ø (Optional) To adjust the spacing 

or add lines between columns, 

click Format, Columns, and 

More options. 

Ø Click Apply. 

 

4. Share and Collaborate on Files 

A. Share a File or Folder with Specific People: 

Ø Select the file you want to share. 

Ø Click Share or Share . 

Ø Enter the email address or Google group you want to share with. 
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Ø To decide what role people will have on your file, select Viewer, Commenter, 

or Editor. 

Ø Choose to notify people. 

o If you want to notify people that you shared an item with them, check 

the box next to Notify people. If you notify people, each email address you 

enter will be included in the email. 

o If you don’t want to notify people, uncheck the box. 

Ø Click Send or Share. 

 

B. Allow General Access to a File: 

You can choose if your file should be available to anyone or restricted to only those 

with access. If you allow access to anyone with the link, your folder won’t restrict who can 

access it. 

Ø Select the file you want to share. 

Ø Click Share or Share . 

Ø Under “General access”, click the Down arrow . 

Ø Choose who can access the file. 

Tip: If you use your Google account for work or school, you can only share files and folders 

with a specific audience, like your department. You might see a description of each 

audience when you hover over the group name. 

Ø To decide what role people will have with your file, select Viewer, Commenter, 

or Editor. 

Ø Click Done. 
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5. Print and Download Files 

A. Print Your File 

To print your file, click File and then Print or 

click Print. 

For documents and presentations: In the 

preview, you can scroll through your 

document on the right or choose print options 

on the left. 

For spreadsheets: You can choose which 

sheets to print, what features to include, and which layout you want. 

 

B. Download Versions in Other Formats 

To download your file so other programs can open it, click File Download and choose one 

of the following formats: 

Docs Slides Sheets 

Microsoft Word (.docx) 

OpenDocument Format 

(.odt) 

Rich Text Format (.rtf) 

Adobe PDF (.pdf) 

Text file (.txt) 

Web page (.html, zipped) 

Microsoft PowerPoint 

(.pptx) 

ODP (.odp) 

Text file (.txt) 

Adobe PDF (.pdf) 

JPEG (.jpg) 

PNG (.png) 

Scalable Vector Graphics 

(.svg) 

Microsoft Excel (.xlsx) 

OpenDocument format 

(.ods) 

Adobe PDF (.pdf) 

Comma-separated values 

(.csv) 

Tab-separated values (.tsv) 

Web page (.zip)     
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C. Make a Copy 

Copying a file is useful for creating templates. For example, if you write many proposals, 

you can make copies of one proposal and then update each document for a new project 

without having to format it again. 

 

Make a Copy of Your Document: 

Ø Click File and then Make a copy. 

Ø (Optional) You can rename the copy, change where you save it in Drive, and share 

it with the same collaborators. 

 

 

II. Google Sheets 

With Google Sheets, you can create and edit spreadsheets directly in your web 

browser with no special software is required. Multiple people can work simultaneously, you 

can see people’s changes as they make them, and every change is saved automatically. 

The first thing you’ll need to do before you can 

use Google Docs is sign up for a Google account (an 

@gmail account). You use an Email account to log in.  

To create a new document, do the following: 

Ø Login to google docs 

Ø Click on blank 

Ø Google docs workspace will be appear 
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1. Enter and Edit Your Data 

• Rename your spreadsheet: Click Untitled spreadsheet and enter a new name. 

 

 

• Enter text or data: Click a cell and enter text. 

 

• Insert more items: Click Insert and add charts, images, drawings, functions, notes, 

and more. 
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2. Customize Your Spreadsheet 

Select cells in your spreadsheet and then format them using the toolbar options. 

 

Undo or redo your last changes or print your spreadsheet. 

 

Copy formatting from any text and apply it to another selection 

of text. 

 

Format your data as currency or a percentage, change decimal 

places, and more. 

 

Change font or font size. 

 

Make text bold or in italics, strikethrough text, or change the text 

color. 

 

Add or change the color of cells. 

 

Add or edit cell borders. 

 

Merge cells. 

 

Change the text alignment, how the text wraps, or rotate the text. 

 

Insert links, comments, or charts. 

 

Filter your data. 

 

Add functions. 

 

3. Work with Rows, Columns, and Cells 

Add Rows, Columns, and Cells: 

Ø Select the row, column, or cell near where you want to add your new entry. 

Ø Right-click the highlighted row, column, or cell Insert and choose where to insert 

the new entry. 

Delete, Clear, or Hide Rows and Columns: Right-click the row number or column letter 

and choose Delete, Clear, or Hide. 

Delete Cells: Select the cells and right-click Delete cells, Shift left or Shift up. 

Move Rows or Columns: Select the row number or column letter and drag it to a new 

location. 
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Move Cells: 

Ø Select the cells. 

Ø Point your cursor to the top of the selected cells until a hand appears. 

Ø Drag the cells to a new location. 

Group Rows or Columns: 

Ø Select the rows or columns.  

Ø Click Data Group rows or Group columns. 

Freeze Header Rows and Columns: Keep a row or column in the same place as you scroll 

through your spreadsheet. On the menu bar, click View Freeze and choose an option. 

 

4. Work with Multiple Sheets 

A. Add a sheet: 

• At the bottom of your spreadsheet, click Add sheet  to add 

another sheet. 

B. Delete or Copy a Sheet: 

Ø Open the sheet. 

Ø At the bottom of your spreadsheet, click the Down arrow on 

the sheet’s tab. 

Ø Select Delete or Duplicate. 

 

5. Add Formulas and Functions 
Use a formula 

Ø Open a spreadsheet. 

Ø Type an equal sign (=) in a cell and type in the function you want to use.  

Note: You may see suggested formulas and ranges based on your data. 

Ø A function help box will be visible throughout the editing process to provide a 

definition of the function, its syntax, and an example for reference. If you need more 
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information, click the “Learn more” link at the bottom of the help box to open a full 

article. 

Tip: You might get suggestions to help you complete formulas with the relevant functions. 

You can accept or reject these suggestions. 

To turn suggestions on or off, click on Tools  Enable formula suggestions. 

 

III. Google Slides 

Create and present professional pitch decks, project presentations, training modules, 

and more. With Google Slides, you can build presentations right in your web browser with 

no special software is required. Even better, multiple people can work on slides at the same 

time, you can see people’s changes as they make them, and every change is automatically 

saved. Create a new file in Slide, the same as docs and sheet. 
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1. Add Content to Your Presentation 

A. Choose a Theme and Layout 

When you create a presentation, you can choose 

a theme to give all your slides the same background and 

text styles for a consistent look and feel. 

To add a different theme to your presentation, 

click Import theme. 

To change your presentation’s layout, 

click Layout and select an option. Or, at the bottom, 

click Explore  and choose a suggested format. 

 

B. Add and Edit Content 

Rename Your Presentation—Click Untitled presentation and enter a new name. 

Add images—Click Insert Image to 

add images from your computer, the 

web, Google Drive, and more. You can 

also move, delete, or resize images. 

Add text—Click Insert Text box to 

add new text boxes. Then, click a text 

box to enter text. You can move, delete, 

or re-size text boxes. You can also 

change how the text fits in a box. 

Add Videos, Shapes, Charts, and More—Click Insert to add videos, figures, charts, slide 

numbers, and other features to your presentation. You can also move, delete, or re-size these 

inserted features. 

Add Speaker Notes—Use speaker notes to keep track of your talking points for each slide. 

In the presentation editor, speaker notes appear beneath the current slides. Your speaker 

notes show in a separate window when you present your slides.  
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C. Customize Your Slides 

Depending on what you want to change, choose an option: 

• To change the size of your slides, click File Page setup. 

• To customize slides, text, images, and more, use the toolbar options. 

Note: Some options only appear for certain types of content, such as text, images, or slides. 

 

Create a new slide. 

 

Undo or redo your last changes or print your slides. 

 

Copy formatting from any text and apply it to another selection 

of text. 

 

Zoom in or out. 

 

Select an item on your slide. 

 

Add a text box, image, shape, or line. 

 

Add or change the color of an area. 

 

Change the color, weight, or style of a border. 

 

Change the font or font size. 

 

Make text bold, in italics, or underlined, or change the font color 

or text highlight color. 

 

Insert links or comments. 

 

Change the text alignment. 

 

Change the line spacing or add numbers or bullets. 

 

Change the text indentation. 

 

Remove text formatting. 

Image options 

 

Crop an image. 

 

Reset an image to its original format. 

Replace image  Replace an existing image with a new one. 
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D. Create and Arrange Slides 

Ø New Slide—Click New slide in the toolbar. Click the Down arrow to choose a 

layout for the new slide. 

Ø Move Slide—Drag the slides to a different position in the presentation. To move 

several slides at once, Ctrl + click multiple slides before dragging them. 

Ø Delete Slide—Right-click the slide and select Delete. 

Ø Duplicate Slide—Right-click the slides in the sidebar and choose Duplicate slide. 

 

 

 

 

Ø Google Docs is a free, web-based word processor offered by Google as part of its 
complete office suite that Google uses to compete with Microsoft Office. The 
other main services included in the cloud-based suite are Sheets (Excel) and 
Slides (PowerPoint). 

Ø With Google Sheets, you can create and edit spreadsheets directly in your web 
browser with no special software required. Multiple people can work 
simultaneously, you can see people’s changes as they make them, and every 
change is saved automatically. 

Ø With Google Slides, create and present professional pitch decks, project 
presentations, training modules, and more. With Google Slides, you can build 
presentations right in your web browser with no special software required. 

Summary 

 

1. What are Google docs, Google Sheets, and Google Slides? 

2. Describe how to create a new file in Google docs. 

3. Describe how to share and collaborate on files in Docs, Sheet, or Slide. 

4. Describe how to download the file docs to the OpenOffice Writer file. 

5. Describe how to download the file Sheets to the OpenOffice Calc file. 

Questions 



Lesson 24 Online Survey Tools Part 1: ICT Basic 

1 

Introduction: 

Survey tools are online tools that can electronically collect answers or responses to 

questions from a target audience. They feature a variety of question types, including 

multiple-choice, ranking, open-ended, and many others. This lesson will show you how 

to use Google Forms as a survey tool. At the end of this lesson, you will be able to: 

ü Create survey forms and quizzes 

ü Edit and format forms 

ü Share forms and collect information 

When you have finished this lesson, you will be able to: 

I. Create New Forms 

II. Create Different Question Types 

III. Edit Forms 

IV. Make Forms as Quizzes 

V. Share Forms and Collect Information 

Online Survey Tools 

Lesson 24 
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Lesson 24 Online Survey Tools 
I. Introduction to Google Forms 

Google Forms is a survey administration software included as part of the free, web-
based Google Workspace suite offered by Google. It's easy to use and one of the simplest 
ways to collect data. With forms, you can: 

ü Surveys 
ü Plan events 
ü Manage registrations 
ü Create a quizzes 

 

II. Set Up New Forms or Quizzes 
To set up your google forms, do the following: 

Ø Open Web browser  
Ø Log in to your Gmail account 
Ø Click on the google app 
Ø Chose Forms 

 

Ø Google forms home page will appear in a new tab of your browser. 

 

 

1. Creating New Forms 
To create new forms, do the following: 

• Click Blank  . 
• A new form will open. 
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III. Question Types 
When you create a form, you can add different types of questions, such as: 

ü Short answer 
ü Paragraph 
ü Multiple choice 
ü Checkboxes 
ü Linear scale 
ü Multiple choice grid and more. 

You can add more titles, descriptions, and media files and divide the form into multiple 
sections. 

2. Short Answer:  
People can write answers in a few words. You can set rules that people have to follow. 
 
3. Paragraph: 

• People can write long answers over one or more paragraphs 
• You can set rules that people have to follow. 

 
4. Choose From a List 
Options you add to questions in forms are case-sensitive.  
Multiple choice:  

• People can choose between a set of options.  
• People can only choose one option.  
• You can include "Other" as an option, and people can type a short answer.  
• Based on a person’s answers, you can send them to a specific form section. 

 
Checkboxes: 

• People can choose between a set of options. 
• People can choose more than one option. 
• You can include "Other" as an option, and people can type a short answer. 
• Based on a person’s answers, you can send them to a specific section of the form 
• You can set rules that people have to follow. 
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Dropdown: 
• People can choose between a set of options. 
• People can only choose one option. 
• Based on a person’s answers, you can send them to a specific form section. 

 
5. Upload Files 
File Upload: 
People can upload files as a response to a question: 

• Uploaded files will use Google Drive storage space for the survey owner. Learn how 
to clear Google Drive space and increase storage. 

• Uploaded files will be stored in a new folder. 
• You can choose the maximum file size that people can upload. 
• You can specify which file types of people can upload. 
• To fill out this question, respondents must be signed into a Google Account. 

Important: You won't be able to use this question If the form is stored in a shared drive or 
if your administrator turns on Data Loss Prevention. 
 
6. Choose From a Grid 
Linear Scale: 

• People can rate your question on a scale. 
• Your scale can start at 0 or 1. 
• Your scale can end on a whole number from 2 to 10. 
• You can set a label for each end of the scale. 

 
Multiple Choice Grid: 

• You can create a grid where people can select one answer per row. 
• To limit people to one choice per column, click More at the bottom right of the 

question . 
• To shuffle the row order, click More at the bottom right of the question . 

 
Checkbox Grid: 

• You can create a grid where people can select one or more answers per row. 
• To limit people to one choice per column, click More at the bottom right of the 

question . 
• To shuffle the row order, click More at the bottom right of the question . 

 
7. Select a Date and Time 
Date: 

• People can fill out any date in this box. 
• To include the year or time, click More at the bottom right of the question . 

Time: 
• People can fill out the time or duration. 
• To switch between time or duration, click More at the bottom right of the 

question . 
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IV. Edit Your Form 
After you've created a form, you can add and edit up to 300 pieces of content, like 

questions, descriptions, images, and videos. To organize your form by topic, you can add 
up to 75 sections. 
 
1. Add Questions, Headers and Sections 
Add a Question 

Ø Open a form in Google Forms. 
Ø Click Add . 
Ø To the right of the question title, choose the type of question you want. 
Ø Type the possible responses to your question. To prevent people from not 

answering, turn on Required. 
 
2. Add an Image or Video 
Add an Image or Video to a Question or Answer. 
You can add an image to a question or an answer for multiple-choice or checkbox questions. 

Ø In Google Forms, open a form. 
Ø Click a question or answer. 
Ø To the right, click Add image . 
Ø Upload or choose an image. 
Ø Click Select. 

 
Add an Image or Video on Its Own 
You can add an image or YouTube video to your form. You can’t add videos to questions, 
but you can place them before or after a question. 

Ø In Google Forms, open a form. 
Ø To add an image, click Add image . To add a video, click Add Video . 
Ø Choose your image or video and click Select. 

 
3. Add a Section 
Sections can make your form easier to read and complete. 

Ø In Google Forms, open a form. 
Ø Click Add Section . 
Ø Name the new section. 

 
4. Duplicate a Question, Image, or Section 
Questions or Images 

Ø Click a question or image. 
Ø Click Duplicate . 

Sections 
Ø Click a section header. 
Ø Click More . 
Ø Click the Duplicate Section. 

 
5. Reuse Questions From Previous Forms 

Ø In Google Forms, open a form. 
Ø At the right, click Add question  Import questions . 
Ø Click the form with the questions you want to import Select. 
Ø On the right, click the box next to each question you want to add. 
Ø Click Import questions. 
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6. Delete or Edit Items 
To edit a question, header, or description, click the text you want to change. 
 
Questions or Images 

Ø Click a question or image. 
Ø Click Delete . 
 

Section 
Ø Click a section header. 
Ø Click More . 
Ø Click the Delete section. 

 
7. Reorder a Section 

Ø If you have more than one section, you can change the order. 
Ø At the top right of any section, click More . 
Ø Click the Move section. 
Ø To move a section, click Up  or Down . 

 
Undo an Action 

Ø If you want to undo a recent change: 
Ø At the top right of your form, click Undo . 

 
8. Randomly Order Questions and Answers 

You can have questions and answers appear differently for everyone who fills out 
your form. 
Note: Questions and answers will only be shuffled once per email address. Ensure each 
address is entered separately and not sent to a Google Group. 
 
Shuffle Question Order 
Important: If you want your questions to appear in a specific order, you should not shuffle 
your questions. 

Ø At the top of the form, click Settings. 
Ø Next to “Presentation,” click the Down arrow . 
Ø Under “Form presentation,” turn on the Shuffle question order. 

 
Shuffle Answer Choices 
You can shuffle answers to multiple-choice, checkbox, and drop-down questions. 

Ø Click the question you want to shuffle answers for. 
Ø In the bottom right, click More . 
Ø Click the Shuffle option order. 

 
V. Make Form a Quiz 
To make the form a quiz, do the following 

Ø Select Setting on the form tab 
Ø Select Make this a quiz 
Ø and then choose whether to show the results immediately after the form is 

submitted or later once you review the answers. If you choose the latter, your form 
will need to require respondents to sign in with their Google account.  
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You can then show missed and correct answers and a value for each option if you'd 
like. 

With that enabled, you'll see a new Answer Key button on the bottom left of each 
question. Click it, then select the correct answer for the question. You can optionally add 
answer feedback both for correct and incorrect answers. 

 

Note: quizzes only work with multiple choice, checkbox, and dropdown questions. 

 

VI. Share the Form and Collect Responses 
1. Share Form 
Click the Send button in the top-right to share the form via email or social networks, copy 
a link, or get an embed code to add it to your site. 
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With the link, you can either copy a full-length link or get a shortened goo.gl/forms/ link to 
share more easily on social networks. The embed option includes width and height options 
to fit the form within your site's design. 

2. View and Manage to Form Responses 
View Responses 

View Responses by Question 

Ø Open a form in Google Forms. 
Ø At the top of the form, click Responses. 
Ø Click Summary. 

 

View Responses from the Person 

 See answers by the person or, if you allowed people to submit the form more than once, by 
submission. 

Ø Open a form in Google Forms. 
Ø At the top of the form, click Responses. 
Ø Click Individual. 
Ø To move between responses, click Previous  or Next . 

Note: Click the Down arrow to select from a list of responses . 

 

View All Responses in a Spreadsheet 

Quickly see all responses in a spreadsheet. 

Ø Open a form in Google Forms. 
Ø At the top of the form, click Responses. 
Ø At the top right, click Create Spreadsheet . 

Important: If you’ve shared a form with a collaborator, they may also have access to the 
form’s linked spreadsheet. If you want to remove a collaborator, you'll have to remove 
them from the form and the spreadsheet separately. 
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• Google Forms is a survey administration software included as part of the free, 
web-based Google Workspace suite offered by Google. It’s easy to use and one 
of the simplest ways to collect data. With the form you can: 

o Take surveys 
o Plan events 
o Manage registrations 
o Create quizzes 

• When you create a form, you can add different types of questions, such as: 
o Short answers 
o Paragraphs 
o Multiple choice 
o Checkboxes 
o Linear scale 
o Multiple choice and checkbox grid 
o File upload 
o Date and time 

Summary 

 

1. What is an online survey tool? 

2. What is Google Form? 

3. Describe each question type of Google Form. 

4. How many questions types can you create with the quiz? 

5. Where can you download form data to a spreadsheet file? 

Questions 
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1. Create a form as the following: 

 

 

 

 

Exercises 
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2. Create a form for the exam: 

a. Select your major. 

b. Create a form for the exam with your major. 

c. Each question should include: 

i. Short answer 

ii. Multiple choice 

iii. Check box 

iv. Drop down 

v. Multiple choice grid 

vi. Check box grid 

d. Add required type if needed. 

Exercises 
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Media and Information Literacy 

CHAPTER 5 
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Introduction: 
Finding and getting correct information is significant. This lesson will cover the new term 
“Media and Information Literacy”. At the end of this lesson, you will be able to: 

• Define the meaning of MIL 
• Classify the type of MIL and MIL element 
• Understand the advantages of MIL 

When you have finished this lesson, you understand: 

I. MIL 
II. Why We Use MIL 

III. The 5 Elements of MIL 

Media and Information Literacy 

Lesson 25 
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Lesson 25 Media and Information Literacy 
I. What is Media and Information Literacy? 

“Literacy” is the ability to read and write. “Media and information literacy” (MIL) 

is the ability to use many types of media safely, wisely, and responsibly. MIL is a set of 

competencies that enables a person to access media, analyze media content, create new 

media messages, reflect on existing media content, and take action with media. Media and 

information literate people can better understand complex announcements from newspapers, 

books, radio, television, billboards, websites, social media, and all other forms of media. 

They can better recognize disinformation, know how to verify information, and can produce 

media messages themselves. 

 
 

II. The Importance of Media and Information Literacy 

Media literacy is essential because it helps people understand the messages that are 

being communicated to them. With so many sources of information today, media literacy 

can help people identify reliable sources and filter through the noise to get to the truth. 

 

1. Inherent Media Bias 

Media literacy can help people recognize biases in the media and how they may 

affect their perception of an event or issue. For example, a conservative news outlet might 

only cover terrorist attacks to make people afraid. That same media organization may also 

use emotional language to make readers feel negatively toward refugees and immigrants 

coming into their country. On the other hand, a progressive news site may promote equality 

for all genders or highlight how poverty affects minority communities. By recognizing those 

biases, we can decide how to respond to these sometimes-emotive topics rationally. 

 

2. Media Literacy as an Educational Tool 

Media literacy can also be used to learn about new ideas, cultures, and perspectives 

that may not have been previously considered. Understanding media may help you do better 
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at school or work (e.g., writing a persuasive essay). Media literacy can also help people 

decide what they want to learn more about to fill in the gaps in knowledge the traditional 

media may have left out. 

 

3. Taking Charge 

The more aware we are of what’s happening around us in our communities, schools, 

and workplaces, the better equipped we’ll be to create change. For example, we can use the 

media we consume to inform ourselves about what’s happening in our nation and world. The 

more aware we are of how certain groups are underrepresented or misrepresented by 

mainstream media, the more will be the impetus for these groups to take charge of their 

representation through social media platforms like Twitter and blogs. 

 

4. Critical Thinking 

Learning to analyze media critically provides students with skills they need when 

entering college or starting their careers. A student who has mastered media literacy skills 

may comprehend a news article and understand how the reporter is framing it, read between 

the lines of social media posts for bias or intent, and spot an advertisement from afar on TV. 

Media literacy is a skill that has been a part of the curriculum for decades, but its 

importance is at an all-time high. Not only does it allow students to analyze media in their 

lives and communities critically, but it also prepares them for college or careers. 

Media and information literacy can help people: 

• Develop critical thinking skills  

• Understand how media messages shape our culture and society  

• Identify targeted marketing strategies  

• Recognize what the media maker wants us to believe or do  

• Name the techniques of persuasion used  

• Advocate for changes to the media system  

• Recognize bias, disinformation, and lies  

• Discover the parts of the story that are not being told  

• Evaluate media messages based on our own experiences, skills, beliefs, and values  

• Create and distribute our own media messages 

 

III. The 5 Elements of Media and Information Literacy 

1. Access 
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 Access is the first step in media and information literacy, and it focuses on learning 

to find and understand media messages and how to use media technology. With this skill, 

you will learn how to find and share accurate information relevant to what you want to see. 

Access is a unique feature of the media, requiring an individual to use different media skills. 

For example, to find information on the Internet, you must be proficient in technology. You 

need to know which keywords are right for typing into search engines and which source 

URLs should be clicked on.  

People must gain the skills and ability to use all kinds of media. It is impossible to be an 

expert at using every technological tool and dealing with every type of content. The objective 

is having better access to online tools, information, and software to make sense of media and 

use information. 

 

2. Analyze 

Analyzing information is the second step in media and information literacy. Someone skilled 

at analysis can interpret and evaluate various forms of print and non-print messages, such as 

photos, texts, news, videos, or video games. Trainees must be guided to develop strategies 

for interpreting, evaluating, and analyzing print media, like books and newspapers, along 

with visual media, like video and photography, audio media, like radio and music, and digital 

media, like video games, websites, and social media. 

People with analytical skills must consider the medium’s author, purpose, point of view, and 

message. This is key to understanding what assumptions certain messages are built upon and 

how they are constructed. Trainees must also learn how important it is to consider a 

message’s target audience, quality, authenticity, and credibility. They also should understand 

the message’s potential effects or consequences. 

 

3. Create 

 Creation, the third step in media and information literacy, involves trainees learning 

to create their own media messages. These can be anything from a text, a drawing, or a 

collage to social media posts, photos, videos, or multimedia products. The type of messages 

they create depends on their access to specific media technologies and their production skills. 

Previously, media messages were created using only pens, pencils, and paper. Today, we 

can use digital devices such as computers or smartphones to produce text, audio, images, 

music, video, podcasts, digital blogs, websites, animation, and computer games. You can 

create media messages in this way to express your thoughts and ideas or share your 

knowledge and experience with the public. But you need to be able to express ideas and 
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creativity to share digital media. Sharing what we have created helps us be more confident 

in expressing our opinions and sharing our work. Creating a good media message requires 

the participation and cooperation of each other because each of us has different abilities and 

talents. 

 

 

 

4. Reflect 

 Reflection is the fourth step in media and information literacy. Improving this skill 

requires critical thinking, knowledge about media, and considering one’s everyday media 

experience. When we reflect, we think about the impact that media messages and 

technologies have on the individual and society. On a personal level, we may use media to 

communicate, entertain, or get information. On the level of organization, media messages 

influence public discussions and perceptions. In addition, shared media experiences help 

shape a generation’s identity or society.  

 Personal media habits and online activities affect people’s identity, self-esteem, and 

relationships. 

 

5. Take Action 

 Taking action is the fifth and final step in MIL education and builds on all the 

previously trained competencies. The idea behind taking action is that trainees use the media 

to achieve specific goals. For instance, they could create a social media campaign to raise 

awareness about environmental protection.  The concept of becoming active is included in 

MIL education because trainees must take what they have learned inside the classroom out 

into the world where they can impact society. Ideally, training should connect the classroom 

to local, national, or global social and political issues trainees care about. Community 

members can use their newly acquired knowledge and skills to work individually and with 

others to make their voices heard on a larger scale. In doing so, they can improve the lives 

of their families and the situations in their hometowns, schools, universities, communities, 

and the world. 
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• “Media and Information Literacy” (MIL) is the ability to use many types of 
media safely, wisely, and responsibly. MIL is a set of competencies that enables 
a person to access media, analyze media content, create new media messages, 
reflect on existing media content, and take action with media. Media and 
information literate people can better understand complex announcements from 
newspapers, books, radio, television, billboards, websites, social media, and all 
other forms of media. They can better recognize disinformation, know how to 
verify information, and can produce media messages themselves. 

• Media and information literacy can help people: 

o Develop critical thinking skills  

o Understand how media messages shape our culture and society  

o Identify targeted marketing strategies  

o Recognize what the media maker wants us to believe or do  

o Name the techniques of persuasion used  

o Advocate for changes to the media system  

o Recognize bias, disinformation, and lies  

o Discover the parts of the story that are not being told  

o Evaluate media messages based on our own experiences, skills, beliefs, 

and values  

o Create and distribute our own media messages 

• Five elements of media and information literacy 

o Access 

o Analyze 

o Create 

o Reflect 

o Take action 

Summary 
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1. What is “Literacy”? 

2. What is MIL?  

3. Why is MIL important? 

4. How can MIL can help you? 

5. What are the five elements of MIL? Describe each element. 

Questions 
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Introduction: 
In today’s world, getting in touch with regular updates is necessary. No matter what the field is, 
one must know the important facts. In this case, the media is the only way to help us. A person 
can learn the most relevant and needed news through the media. At the end of this lesson you will 
be able to: 

• Define the meaning of media 
• Classify the types of media 
• Define the form and characteristics of media 
• Define the core concepts of media 

When you have finished this lesson, you will understand: 

I. Media 
II. The Forms and Characteristics of Media 

III. The Difference Between Traditional and New Media 
IV. Five Core Concepts of Media. 

Media 

Lesson 26 
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Lesson 26 Media 

I. Understanding Media 
1. What is a Medium? 

The term medium can be defined in several different ways. According to 

dictionary.com, a medium is “one of the means or channels of general communication, 

information, or entertainment in society, such as newspaper, radio, or television”. A medium 

is used to transport messages between people. These messages aren’t shared directly face-

to-face but indirectly via a letter, a radio program, an email, or a billboard. In these 

exchanges, the messages are encoded by the person sending them (the media maker or 

makers) and decoded by those receiving the message (the audience). These messages are 

referred to as media messages. 

 
 

II. Forms and Characteristics of Media 
The emergence of media began with the development of written languages. For the 

first time, people were able to write down and copy a message over and over again. They 

could share these messages with others far away or who lived years, decades, or centuries 

later. Different forms of non-electronic print media are used to this day:  

– Bulletins and notices  

– Newspapers and magazines  

– Letters  

– Books  

– Comics  

In the 20th century, media technology developed rapidly. Broadcast media like radio 

and TV were perfected and became ubiquitous. Movies went from silent and black-and-
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white to sound and color. Since the start of the 21st century, computers and digitalization 

have enabled new media technologies and experiences. Examples of electronic and non-print 

media include:  

– Radio – 

 Television  

– Cinema  

– Computers (CD-ROM, USB flash drive)  

– Video games  

– Email  

– Audio recordings  

– Mobile phones 

– E-books 

There are many ways to categorize media. For instance, we can distinguish between 

broadcast media designed to reach a large audience (radio, TV) and print media (books, 

billboards, newspapers). We can differentiate between one-way communication (e.g., print 

and broadcast media) and two-way communication (e.g., social media), where there is a 

direct interaction between the sender of the media message and its receiver. You could also 

categorize media into four types: print, visual, sound, and digital.  

– Print: books, newspapers, magazines 

– Visual: movies, television, photographs, drawings 

– Sound: radio, recorded music, CDs, MP3 audio files 

– Digital: internet, email, video games, social media 

All these categories only serve as a rough orientation since many media forms and 

technologies are fluid. They can spill over into other categories. For instance, radio is a one-

way broadcast medium, but call-in programs add elements of two-way communication. 

 

1. Newspapers and Magazines 

Traditionally, newspapers and magazines 

were printed media, but nowadays, many are 

published electronically on the internet. Funding 

for newspapers and magazines often comes from 

companies, interest groups, private individuals, 

and sometimes the state. Media makers include 

print and photojournalists, editors-in-chief, 

typesetters, designers, printers, and (online) 
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programmers. They use headlines, written text, different font sizes and colors, drawings, 

caricatures, and photographs to express their messages. Most print media are published 

regularly and frequently: daily, weekly, or monthly. Their frequent publishing schedules 

allow them to report on current stories and events and provide background information. 

Newspapers and magazines generate income through subscriptions, direct sales, and 

advertisements. Newspaper and magazine owners, who spend money to finance the medium, 

often want to influence the selection of topics and steer the direction of editorial viewpoints. 

 

2. Books 

Traditionally, books are a printed 

medium, but nowadays, some are also 

published as e-books, which can be read 

on a tablet, computer, or e-book reader. 

Funding for books often comes from 

publishers and companies. Media makers 

include authors, editors, typesetters, 

publishers, and printers or programmers 

(for e-books). They express their messages through the book’s contents, which can consist 

of text and illustrations, but also through the book’s title and cover, composition and design, 

illustrations, and information about the book and author. Books can be categorized according 

to their content, e.g., fiction, non-fiction, guidebooks, or textbooks. The time needed to 

create a book ranges from a few months to many years. Income is generated through the 

book’s sales. To increase sales, many publishers spend money on advertising in newspapers, 

radio, television, posters, and the web. 

 

3. Radio 

 Radio is a non-printed, electronic medium. 

Nowadays, many radio stations also broadcast via 

the internet. Funding for most radio stations comes 

from companies or private individuals. Sometimes 

the state also owns radio stations, and in rare cases, 

even local communities do. Media makers include 

radio journalists, producers, on-air hosts or 

moderators, editors-in-chief, news editors, and 

musicians. A radio station can go on air with just a 
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few people involved, sometimes as few as a moderator, technician, and news editor. Many 

radio programs are pre-produced before broadcasts, and moderators often receive 

introductory texts from journalists to read before their news stories or features are played. 

Media messages are expressed by selecting program content, voices, spoken language, 

music, and sounds and contain (current) information and entertainment. The time needed to 

create a radio broadcast ranges from minutes to weeks or even longer, depending on the 

radio show and the particular topic. The station’s income comes mainly from advertising 

slots it sells. Some radio stations receive funding from their owners or through listener fees. 

Community radio stations often rely on donations. 

 

4. Movies 

 A movie is a non-printed, electronic medium generally 

first shown in public movie theaters or distributed through 

streaming services like Netflix, Amazon Prime Video, or 

Disney+. Later, they are released on DVD or Bluray discs or 

shared through the internet (often illegally). Funding for movies 

is complex. Before a film is made, the author and the director 

look for someone to finance it. The money needed to make a 

movie varies but is often costly.  

Funding can come from private individuals (a producer 

or producers) or large production companies. Often movies are co-financed by television 

stations or big companies in return for product placements in the film (e.g., the hero might 

drive a Mercedes, BMW, or another specific car brand). Hundreds or even thousands of 

people are involved in the production of a movie. They include directors and co-directors, 

authors, actors, camera operators, sound designers, costume makers, location scouts, stunt 

performers, and special effect editors, to name just a few. In movies, the media messages are 

expressed via the genre, story, dramatization, setting, characters, acting, costumes, visual 

feel (brightness or darkness, colors), sound elements (voices, music, sound effects), and 

editing. The time needed to create a movie range from around half a year to several years. 

Films generate revenue through ticket sales, DVD or Blu-ray disc sales, merchandising, and 

fees paid by TV channels for broadcasting rights or by viewers for digital streaming rights. 

To increase ticket sales, moviemakers usually spend money on advertising (cinema trailers, 

posters, television, or online advertisements) to attract the broadest possible audience. 
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5. Television 

 Television is an 

electronic medium. Many 

television shows are also put 

online and can be viewed online. 

Funding for television channels 

comes from the government, 

viewer fees, or companies or 

individuals. In some countries, 

citizens donate money to fund television broadcasters. Media makers include program 

directors, on-air hosts or presenters, television journalists, editors-in-chief, news editors, 

camera operators, sound engineers, video editors, actors, celebrities, politicians, and 

musicians, to name just a few. The selection of program content expresses media messages, 

the program content itself, the choice of hosts or moderators, written and spoken texts, 

visuals, and sound effects. The time necessary to create a television program varies from a 

few hours to a month or more. Most income comes from the sale of advertising slots. In 

some countries, tax money is used to support television channels that the government owns. 

If a company or private individual spends money to fund a television channel, they often 

want to influence the channel’s selection of topics and steer its editorial viewpoints. 

 

6. Video Games 

 Video games are an 

electronic medium. They can be 

played on game consoles, 

computers, and smartphones. 

Depending on a game’s complexity 

and scope, the funding for video 

games comes from the game 

industry and sometimes from 

private programmers or start-ups. 

Media makers include authors, art directors, game designers, programmers, composers, 

sound designers, and more. Media messages are expressed by the genre, setting, story, 

interactive options, the game’s objective, the language used, and the game’s audio and visual 

design. The time needed to create a video game depends on its complexity and the platform 

it is made for and ranges from one day to a few years. Most income comes from selling the 
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game to target audiences, advertisements before or during the game, merchandising and 

selling in-game features. 

 

7. Internet (Computer/Smartphone) 

The internet is an electronic medium. 

It can be accessed using special hardware like 

computers, smartphones, tablet computers, 

game consoles, and e-book readers. The lack 

of specific funding for the internet sets it apart 

from other media. Companies, governments, 

and private individuals own certain websites, 

blogs, and internet platforms that many people 

use, such as YouTube, Facebook, and Google. It is hotly debated whether sites like 

Facebook, Instagram, and YouTube are media or just platforms that provide a service for 

content creators. If they are considered media in their own right, they share the editorial 

responsibility for the content and comments users post. This would increase their 

responsibility for monitoring discussions and deleting offensive posts, hate speech, 

disinformation, or fake profiles. Media makers on the internet include people who provide 

content, programmers, web designers, IT specialists, authors, journalists, and media makers 

from traditional media outlets whose content is reposted on the internet. The interconnection 

of all media content on the internet is called media convergence. Media messages are 

expressed through images, videos, audio, and text, and through their design, style, and 

interactive options. The time necessary to create internet content depends on the content and 

can range from seconds to months. On-screen advertisements generate the most income 

through selling user data. Internet content is usually not posted to generate income but to 

provide information and spread ideas, as well as for self-expression and socializing with 

others. 

 

6. Social media (Computer/Smartphone) 

 Social media are platforms on the internet, thus an electronic medium. Social media 

can be used on computers, tablet computers, and smartphones. Funding for social media 

comes from companies, individuals, or start-ups. The world’s biggest social media platform, 

Facebook, was developed in 2004 by then-20-year-old Mark Zuckerberg and others. It is 

now operated by Facebook, Inc. Media makers include programmers, web designers, and IT 
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specialists who provide the 

platform and billions of 

network users, generally 

individuals, companies, or 

groups of people who produce 

and share content. Media 

messages are expressed mainly 

by text, images, shared links, 

videos, and audio. The time it takes to create content for social media is usually short, 

ranging from a few seconds to a few hours. Income for programming and managing social 

media platforms is generated by selling on-screen advertising and user data to companies, 

institutions, or governments willing to pay for the data. Most users do not earn money with 

their content. Famous bloggers, video bloggers, YouTube stars, and influencers can make 

money through advertising or when companies pay for product placement. The more 

followers these individuals have, the more money they can drive. 

 

III. Traditional and New Media 
A popular way of categorizing media is between traditional or analog media and 

digital or new media. The watershed moment was computerization and digitalization that 

took place at the end of the 20th century, and the beginning of the 21st. Media that existed 

before that time are sometimes referred to as “traditional media”. Those that were invented 

later are called “new media”. Analog media content is printed on paper, recorded on tape, 

film, or a record. It is disseminated as printed material via radio waves or terrestrial TV 

signals. Traditional media include newspapers, books, letters, radio, and TV. These days, 

however, a lot of media content is digital. It can be reproduced and shared electronically 

without losing quality, often through the internet. Media that only evolved thanks to 

digitalization include social media, blogs, and email. 

 

IV. Mass Media and Mass Communication 
Mass media are various media technologies that aim to reach a large audience (such 

as books, newspapers, radio, television, films, recorded music, websites, and 

advertisements). Usually, the messages of a mass medium are one-way: broadcasters or 

publishers create media content like radio or TV programs or books, and the audience 

consumes them without having a chance to interact with the creators.  
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In mass communication, the media makers creating the content are small because 

these media are expensive to produce. They disseminate their media messages to the public 

to achieve specific goals, ranging from making money to fame or gaining influence and 

power. Mass media makers can profit through advertising or by selling the music, films, 

television shows, and video games they have produced. 

 

V. Media Messages 
Media messages are messages that are sent and received via a medium. They can 

include text, images, sound, or video. A media message can contain information, facts, 

experiences, opinions, feelings, thoughts, and impressions on any topic. Media messages are 

created by media maker(s). These can be professional journalists producing radio or TV 

programs or average people sending letters and text messages or posting on social media. 

 
Media messages often use verbal and nonverbal communication. Verbal 

communication means communication through spoken or written words and phrases. Verbal 

statements are made up of both the content and meaning of the terms and how they are used. 

For example, the media message can differ depending on whether the media maker uses long 

or short phrases or if the message uses simple or complicated language with foreign words. 

Non-verbal communication is communicating by sending and receiving messages without 

using words. It relies primarily on visual and auditory messages. These can include a 

person’s facial expressions, tone of voice and gestures, images, music, sound, emoticons 
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such as :-), and emojis. Non-verbal cues can help people interpret media messages: if 

someone smiles while saying something, we understand they are friendly and might even be 

joking. If they frown or shout, we realize that the message is serious and could involve 

conflict. In written media messages like letters, books, and text messages, these non-verbal 

cues are missing. Emoticons and emojis were invented to add an emotional dimension to 

text messages. 

 

VI. The Goals of Media Messages 
Media messages and media products are created for a variety of reasons. They 

inform, entertain, influence public opinion, and help people and companies make money. 

This applies to traditional media like TV or radio, movies or newspapers created by 

professional media makers, and to social media messages posted by ordinary people. Most 

media messages pursue several aims at the same time. The main goal of a TV show, for 

example, is to generate revenue for the TV station and its owners. But further goals may be 

to entertain the public, shape public discussion, or influence how society thinks about 

specific issues. 

When ordinary people post messages on social media, they usually aim to entertain, 

inform, or present a positive image of themselves. Only a small group of “influencers” 

manage to make money with social media messages or affect how others think or feel. 
 

VII. Manipulation of Media Messages 
It is important to recognize that media convey ideological and value-based messages. This 

occurs because the person or company financing a medium is pursuing a specific goal and because 

a media maker’s point of view consciously and unconsciously influences the media messages. 

First, media makers decide which stories are covered and which are not. This means 

the public may never find out about “the other side” of an issue or may never find out about 

the topic at all. 

Second, it is technically possible to manipulate media messages like photos and 

videos. There is a fine line between editing an image to improve its quality with photo editing 

software and running it, and altering an image for other reasons, and thereby changing its 

message, impact, or meaning. Videos can also be manipulated using more advanced tools 

such as facial recognition, algorithms, and artificial intelligence. These forms of controlled 

video messages are known as deep fakes. 

Third, the media use a language of persuasion. Professional media makers have 

studied the tools and means of enhancing the impact of their media messages. Scientists have 

found that media are most potent when they operate emotionally. Music in film or TV scenes 
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is a common way to heighten people’s emotions. Other methods include showing people 

very close up in a photograph, advertisement, or film and providing information in the form 

of a personalized story in a news report, newspaper, or documentary. Some media makers 

will manipulate messages to enhance their emotional impact and draw the audience into an 

article, for example, by using a dramatic headline that is not entirely true. The power of 

emotionalized or sensationalized media messages can also be seen in the rapid spread of 

disinformation on social media. Stories that evoke strong emotions like outrage, disgust, or 

even hatred get more attention and are often widely shared. 
 

VIII. The Five Key Questions to Ask When Analyzing Media Messages 
Media transmit messages shaped by the media makers’ values, ideologies, and 

intentions. The audience needs special analytical skills to identify these underlying value 

systems, motivations, and creeds. That’s why educators should focus on developing trainees’ 

critical thinking skills. Trainees should be encouraged to ask critical questions about media 

messages routinely. 

The Center for Media Literacy (medialit.org) has developed five key questions as a starting 

point for the analysis of any media message or piece: 

1. Who created this message? (Authorship) 
2. What creative techniques are used to attract my attention? (Format) 
3. How might different people understand this message differently from me? (Audience) 
4. What lifestyle, values, and points of view are represented in, or omitted from, this message?

(Content) 
5. Why is this message being sent? (Purpose) 

Answering these five questions can lead to further questions that may result in “aha” 

moments and deeper understanding. 

For example, a follow-up question about authorship could be, “Who else was 

involved in creating this message, and what choices did they make?” For a deeper analysis 

of a message’s format, a question like, “What do I notice about the way the message is 

constructed?” can be helpful. And to better understand how other people might interpret a 

media message differently, one could ask, “How close is the portrayal to my own experience 

or the experiences of others?” A question like, “What is the overall worldview this message 

conveys?” helps analyze its content. One could also ask, “Who profits from this message 

and who pays for it?” to reflect on its purpose critically. 

Practicing the five key questions will deepen one’s understanding of media and 

media messages, especially how and why they are created. Trainees will learn to make 

informed choices about accepting or rejecting explicit and implicit media messages. 
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IX. Five Core Concepts of Media 
The five core concepts of media are directly linked to the five critical questions 

discussed earlier:  

1. Authorship: All media messages are ‘constructed’.  

2. Format: Media messages are constructed using creative language with its own 

rules.  

3. Audience: Different people experience the same media message differently.  

4. Content: Media have embedded values and points of view.  

5. Purpose: Most media are organized to gain profit and or power.  

These concepts sound very abstract at first. Trainees will probably need time to 

understand them. That is why starting with the five key questions is a good idea. Each answer 

to a question or follow-up question will carry the trainees closer to understanding one of the 

key concepts and thinking critically about media. 
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• A medium is “one of the means or channels of general communication, 

information, or entertainment in society, such as newspaper, radio, or television”. 

A medium is used to transport messages between people. 

• You could also categorize media into four types: print, visual, sound, and digital.  

o Print: books, newspapers, magazines 

o Visual: movies, television, photographs, drawings 

o Sound: radio, recorded music, CDs, MP3 audio files 

o Digital: internet, email, video games, social media 

• The watershed moment was computerization and digitalization that took place at 

the end of the 20th century and at the beginning of the 21st. Media that existed 

before that time are sometimes referred to as “traditional media”. Those that were 

invented later are called “new media”. 

• five critical questions as a starting point for the analysis of any media message or 

piece: 

o Who created this message? (Authorship) 

o What creative techniques are used to attract my attention? (Format) 

o How might different people understand this message differently from me? 

(Audience) 

o What lifestyle, values, and points of view are represented in, or omitted 

from, this message? (Content) 

o Why is this message being sent? (Purpose) 

• The five core concepts of media are directly linked to the five critical questions 

discussed earlier:  

1. Authorship: All media messages are ‘constructed’.  

2. Format: Media messages are constructed using creative language with its 

own rules.  

3. Audience: Different people experience the same media message 

differently.  

4. Content: Media have embedded values and points of view.  

5. Purpose: Most media are organized to gain profit and or power. 

 

Summary 
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1. What is media? 

2. What are non-electronic print media and electronic and non-print media? 

3. How many categories of media are there? What are they? 

4. What is the difference between mass media and mass communication? 

5. What is the media message and critical questions to analyze about media? 

6. What are the five core concepts of media? 

Questions 
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Introduction: 
Every day there is news and information shared through the media. That information is both true 
and false. We only have a hard time classifying it if we know MIL. At the end of this lesson, you 
will be able to. 

• Define the meaning of news and information 
• Define misinformation, disinformation, and malformation 
• Evaluate information and news in the media 

When you have finished this lesson, you will understand: 

I. Information 
II. News and Information 

III. Questions News Needs to Answer 
IV. The Ethical Standard of Journalists 
V. Getting Good Information 

VI. Misinformation, Disinformation, and Malformation 
VII. Why Disinformation Spreads Quickly on Social Media 

VIII. How to Evaluate Information (Misinformation, Disinformation) 
IX. The Values of News 

News and Information 

Lesson 27 
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Lesson 27 News and Information 
I. Information 

Information is anything that informs. It includes knowledge obtained through 

research or investigation, factual data, or instructions. Information should be timely, 

accurate, relevant and increase our understanding. Journalists work with information. They 

analyze, verify, and write it in language that is easy to understand to present their audience 

with a balanced perspective on a story. 

 

1. Information Source 

An information source provides information. Documents, speeches, videos, 

websites, photographs, and people are all examples of information sources, as are media like 

newspapers and radio shows. Journalists might use individual sources of information in 

researching a story but are rarely completely neutral. That’s why the journalist must consider 

where the information is coming from, why it is being shared, and to what extent the 

information source can be trusted. Because of this, most journalists work with the “two 

sources” principle to check the authenticity of the information they are dealing with. If two 

sources that are independent of each other provide the same information, it is more likely 

that the information is true. 

 
When considering the neutrality of media as information sources, it is helpful to look 

at who provides the information and who owns and controls the media outlet. Is it owned by 

an entrepreneur, a government, or a private company, or is it independent? The owners of 

private media outlets often have an agenda, such as promoting a political opinion. An 

independent media outlet can also have its agenda, such as supporting a political opinion 

that contrasts with the government’s point of view. It can also be useful to consider what 

motivates an information source. Is the source interested in making money, pushing an 

agenda, or informing the public?  

The rise of social media has made the information landscape more complicated. 

Social media platforms can be quality information sources full of disinformation: rumors, 
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lies, hoaxes, propaganda, and clickbait. Users are confronted with a mix of high and low-

quality information in their newsfeeds and must individually determine the truthfulness of 

every post. For this, they need basic knowledge about how the platforms work and how to 

judge whether a post is likely to be true or false. 

 

II. News and Information 
The word news comes from the word “new”. News is new, important, relevant, or 

interesting information to a specific audience. The information on social media comes from 

various sources: private individuals, groups, and professional media organizations, to name 

just a few. Each of these has a different idea of what is newsworthy, and the quality of what 

they post may differ widely. 

In professional journalism, what counts as news depends on various factors, such as 

the time and location where something happened, the target audience, and an editor or 

reporter’s judgment. For instance, the robbery of a shop in a small village is important news 

for a local newspaper because it is relevant to the local community. But the same story is 

unlikely to be considered newsworthy by the national press or by a reporter in a different 

country. 

 

III. Questions News Needs to Answer 
News in professional media outlets should inform the audience about what 

happened, when and where, and who was involved. A good news article will also explain 

how and why something happened. When looking for the answers to these questions, 

consumers should remember that the answers and the way the news is written might not be 

neutral. For example, reporters might have different opinions about why something 

happened, depending on political opinions, upbringing, circle of friends, etc. They may also 

come up with different answers to the key questions depending on whom they interviewed 

for their news story or how thoroughly they did their research. Good journalists will report 

neutrally and present the different sides of a story. But no one, even the best journalists, is 

completely neutral. Different people often see the same information differently, which can 

be interpreted or presented in various ways. Media messages reflect the values and points of 

view of media makers. 

 

IV. The Ethical Standards of Journalists 
Journalists are responsible for the accuracy of their work. They must conduct 

research and consult various sources to verify their story. Journalists must be objective when 

reporting news and neutrally report the facts. They must inform their readers about where 
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they got their information by attributing it to sources or witnesses, for example. This makes 

their work more transparent and credible. It allows the audience to form opinions by seeing 

where the information came from. Journalists should also strive to present information in a 

way their audience will understand. They should avoid using words that sensationalize or 

evoke strong emotions. They should rather use neutral, factual, and clear language. Finally, 

journalists must consider the effects of their reporting: what will the consequences be for 

their sources or the people they quote? What feelings or reactions will their writing provoke? 

 

V. Importance of Access to Information 
Being informed about what is happening in your community, country, and the world 

is important for understanding society. It also lets you understand how what happens in other 

parts of the world can affect you personally. For instance, if there is a bad harvest in one 

country, the price of certain foods could also increase in your country as people scramble 

for goods. People who are informed can better identify problems in their societies and take 

steps to solve them. 

 

VI. Getting Good Information 
There are many ways to become informed. Reading newspapers and websites, 

listening to the news on the radio, or watching it on TV are good ways to stay informed 

about current affairs. It can be a good idea to look at the news from a few different media 

outlets since they will report differently on some news stories. Or one outlet may choose to 

include news stories that others have ignored. You can also get informed by talking to people 

and reading posts on social media platforms like Facebook or Twitter. This will give you an 

idea of what other people think about what is happening in the news. However, staying 

informed through social media can be difficult because the platforms contain much false 

information, rumors, and gossip. Much of the information on social media comes not from 

professional journalists trained to fact-check and report objectively but from individuals not 

trained as reporters. 

 

VII. Misinformation, Disinformation and Malformation 
When speaking about false or harmful information, we can be more accurate if we 

use the terms misinformation, disinformation, and malformation. UNESCO and many others 

have appealed to journalists, policymakers, and citizens to use these three terms instead of 

“fake news”. UNESCO avoids “fake news” because the expression has become politicized. 

Some people in power are using it to discredit the news industry and undermine reporting 

that they don’t like. 
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Misinformation is information that is false but not intended to harm. Misinformation 

can happen accidentally when journalists do not research accurately or make mistakes in 

their writing, for example, inserting an incorrect date or figure into a story.  

Disinformation is false or partly false information that is deliberately created or 

disseminated with the explicit purpose to harm. Producers of disinformation make up one-

sided stories for political, financial, or ideological reasons, e.g., influencing public opinion 

on certain issues to create public pressure.  

Malformation is information that may be true and factual but that is not meant for 

publication and that is leaked to cause harm, for instance, secret diplomatic documents 

exchanged between a government and its embassies abroad. Other forms of malformation 

published to harm are hate speech and online harassment.  

Social media contains many mis-, dis-, and malformation, and newsfeeds are 

generally a mix of high and low-quality information. It often is hard to tell at first which is 

which. On social media, we must decide for each story whether it is quality information or 

falls into the mis-, dis-, or malformation categories. This phenomenon of an unstructured, 

chaotic information supply is called information disorder. 

 

VIII. How Disinformation Spreads Quickly on Social Media 
In the age of social media, publishing information is not limited to trained 

professionals. Anyone can post and comment on anything. There are neither fact-checkers 

nor editors to verify whether a story is true and whether it is ethical to publish it. So, in 

addition to useful and accurate information, there are a lot of rumors, gossip, lies, half-truths, 

satire, and hate speech. People hear something, get emotionally charged or involved, and 

decide to vent their anger or express their joy by immediately posting or sharing. They often 

publish or share before checking whether the information is true, having been driven by their 

hearts, not their heads, to make something public. When other social media users see these 

highly emotional or sensational stories, they can also get an emotional charge and 

immediately share the content or comment on it. As emotions build, those comments can 

become more and more radical. 

The more interaction a story or post gets, the more “weight” the social network gives 

it, meaning it is much more likely to appear on users’ timelines. So, one small false story or 

allegation with an effective emotional trigger can quickly go viral. It can become an 

avalanche that buries the truth beneath it. 

Some people aware of these mechanisms deliberately produce disinformation to 

make money. They create websites for stories they know people will get worked up about, 
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comment on, and share. The more exposure these stories get, the higher the revenue is from 

online advertisements on these websites and the more money the creators of the 

disinformation make. 

 

VIII. Learning to Evaluate Information (Misinformation, Disinformation) 
As a media consumer, it is important to distinguish between different kinds of content 

to understand the difference between an editorial, for example, and a news article. Editorials 

express the opinion of an individual, often a journalist or editor, and usually include news 

and facts to make their case. Professional media separate editorials from news journalism 

and identify them as opinion pieces so the audience understands. News articles should not 

include the opinions of journalists or editors. So, when analyzing news, consider whether it 

is neutral or contains opinions, who wrote the piece, why they are sharing the information, 

and what other people might think of it. Does it include two sides of the story? Is the audience 

free to form an opinion after hearing the different sides? Or is the journalist suggesting one 

way to interpret the facts? Sometimes what is not reported can be an indicator of 

manipulation. What stories are not covered? What voices are left out? Another sign of 

manipulation or biased reporting can be how much time and space the medium gives a 

certain topic: do the time and space reflect the relevance of the story or are the media 

exaggerating the importance of one topic to divert attention from other issues? 

 

IX. The News Values 

News must be new, relevant, and interesting. News values are a set of criteria media 
makers use to determine how important or newsworthy a story is. They can help journalists 
decide how to report on a topic, for example, whether it is so important that it should fill the 
front page of a newspaper or whether it is of lesser relevance and be presented in a smaller 
column on a page further back in the paper. Some general values help media makers 
determine how newsworthy a story is. However, individual media also have specific news 
values tailored to their audiences.  

• Timeliness: Did the story or event happen? Is it new? Whether a story is new also 
depends on how often media outlets is published or broadcast it. Media like radio, 
TV, and websites can update stories live and around the clock. Other media, like 
newspapers or magazines, only publish once a day or once a week or month. For a 
weekly medium, a story that happened three days ago may still be timely, whereas 
media publishing more frequently will consider it old news.  

• Proximity: Events happening close to the target audience is often the most important 
to them. A fire or an accident in a nearby town is usually more relevant to the target 
audience than a conflict or political crisis on the other side of the world.  

• Impact: The more people are affected, the more important the story is. That’s why 
wars and natural disasters like floods, droughts, and earthquakes are usually big news 
stories.  
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• Consequences: Events that impact many people or cause other significant events are 
newsworthy.  

• Conflict: Conflicts and disagreements disrupt our everyday lives. They often have 
far-reaching consequences and a major impact. They are often considered 
newsworthy.  

• Prominence: Stories involving well-known names are newsworthy. Prominence can 
relate to famous people like politicians or celebrities and well-known companies like 
Microsoft, Mercedes, or Mitsubishi.  

• Novelty: Surprising and unusual stories are interesting because they are out of the 
ordinary. “Dog bites man” isn’t a news story, but “man bites dog” could be.  

• Human Interest: People are interested in people and stories they can relate to 
personally. This can help make stories newsworthy even if they lack other news 
values.  
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• Information is anything that informs. It includes knowledge obtained through 
research or investigation, factual data, or instructions. Information should be 
timely, accurate, and relevant and increase understanding. 

• An information source provides information. Documents, speeches, videos, 
websites, photographs, and people are all examples of information sources, as 
are media like newspapers and radio shows. Journalists might use individual 
sources of information in researching a story but are rarely completely neutral. 

• The word news comes from the word “new”. News is new, important, relevant, 
or interesting information to a specific audience. 

• News in professional media outlets should inform the audience about what 
happened, when and where, and who was involved. A good news article will 
also explain how and why something happened. 

• Journalists must consider the effects of their reporting: what will the 

consequences be for their sources or the people they quote? What feelings or 

reactions will their writing provoke? 

• Misinformation is information that is false but not intended to harm. 

Misinformation can happen accidentally when journalists do not research 

accurately or make mistakes in their writing, for example, inserting an incorrect 

date or figure into a story.  

• Disinformation is false or partly false information that is deliberately created or 

disseminated with the explicit purpose to harm. Producers of disinformation make 

up one-sided stories for political, financial, or ideological reasons, e.g., 

influencing public opinion on certain issues to create public pressure.  

• Malformation is information that may be true and factual, but that is not meant 

for publication. It is leaked to cause harm, for instance, secret diplomatic 

documents exchanged between a government and its embassies abroad. Other 

forms of malformation published to harm are hate speech and online harassment. 

Summary 
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1. What are news and information? 

2. What is an information source? 

3. Why is it important to get enough good information? 

4. What is the difference between misinformation, disinformation, and 

malformation? 

5. Describe the values of news. 

Questions 
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CHAPTER 6 

Digital Literacy and Responsibility  
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Introduction: 
To make life easier, you need the help of various technologies. To use all those technologies, you 
need to have digital literacy. At the end of this lesson, you will be able to: 

ü Define the meaning of digital literacy 
ü Understanding  importance of digital literacy 
ü Understand digital technology 

When you have finished this lesson, you will undersatnd: 

I. Digital Literacy 
II. Examples of Digital Literacy 

III. The Importacnce of Digital Literacy 
IV. The Importacnce of Digital Literacy in Education 

Digital Literacy 

Lesson 28 
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Lesson 28 Digital Literacy 

I. What is Digital Literacy? 
Digital literacy is a new concept that emerged in the 1990s during the Internet 

revolution. The world is now in a new wave of industrial revolution driven by the 

development and spread of digital technology, which we call the Industrial Revolution 4.0. 

With the advent of the Fourth Industrial Revolution, new technologies such as the Internet 

of Things, Artificial Intelligence, and Big Data are being incorporated into everyday life and 

used in almost every sector. 

New technologies are driving rapid changes in the way we live and work. Today, 

employers and the job industry require employees to have digital literacy skills to increase 

productivity and efficiency. According to UNESCO, “digital literacy” refers to the ability 

to use digital technology and tools to find, use, manage, evaluate, create and share 

information securely and accurately, which requires both technical skills and insights to 

improve social and economic activities. 

 
Digital literacy focuses on four key areas: 

• Finding the right information on the Internet 
• Using and sharing information online 
• Understanding the security of technology 
• Creating digital content and sharing it ethically. 

 

II. Digital Literacy Examples 
A digitally literate individual can accomplish a variety of tasks with the use of 

technology. The following are some examples of digital literacy: 

• Sending and receiving emails allows a person to communicate with someone 
instantly. Email and other internet-based text applications allow people to keep in 
contact with others in different time zones, countries, and even hemispheres. 



Lesson 28 Digital Literacy Part 2: Media and Information Literacy 
 

270 

• Using an e-reader to read books and periodicals downloaded from the Internet. E-
readers allow people to consume more information without a physical hard copy of 
a book, journal, or periodical. This can reduce waste as well as increase accessibility 
to information. Electronic versions are often less expensive than physically printed 
versions. 

• Shopping online allows people to peruse inventory without going to the store. Online 
shopping allows people to purchase presents, clothing, household items, and 
anything else online. 

• Digital safety means that digitally literate people understand that passwords and 
personal information should not be shared online. A digitally literate individual 
knows how to protect their personal information online. They can navigate tasks such 
as online shopping, using an e-reader, and sending and receiving email without 
compromising their information to hackers and other online threats. 

 

III. The Importance of Digital Literacy 
According to Datareportal1, at the beginning of 2022, 13.44 million Cambodians were 

Internet users, and 12.60 million were social media users. These data show positive signs of 

technology capture in Cambodia. On the other hand, digital technologies such as smart 

devices, e-commerce, digital payments, e-banking, mobile computing, and online 

information are changing how people work in Cambodia. Therefore, strengthening digital 

literacy skills is very important to enable Cambodia to keep up with the new trends of the 

Fourth Industrial Revolution, the digital economy, and labor market changes. 

Digital literacy is important to establishing your presence in the modern world. 

Lacking the ability to use digital technologies means there will be many things you cannot 

do or access. Possessing digital literacy allows you to improve efficiency, access to things, 

fulfillment, and happiness in your life. 

You gain so many things by ensuring you become digitally literate, and we want to 

shed some light on them. This is a small list, as there are thousands of little ways to improve 

your life by learning digital literacy skills. Read on to learn some basic, everyday ways 

digital literacy can improve your life. 

 

1. Make Connections 

Strengthen communication: Digital literacy skills can help us easily communicate 

online with family, friends, colleagues, and others. At the same time, knowing how to use 

email on some social networks, such as Facebook, Instagram, Telegram, Skype, etc., allows 

us to communicate quickly and easily, no matter how far apart. 

 

 
1 https://datareportal.com/reports/digital-2022-cambodia 
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2. Save Time and Money 

Everyone loves saving money, and when you realize how much time you can save 

on simple daily tasks like shopping, banking, and general errands, you’ll want to get online 

quickly! Online shopping is one of the best ways digital literacies makes your life more 

efficient. Buying items from websites like eBay or Amazon can save you thousands of 

dollars on retail over time and save you hours of driving and shopping, as the items are 

delivered right to your door. 

Booking for travel has also been more challenging than it is now. Many websites, 

such as Home away for property rental, or Expedia for booking hotels and resorts, with a 

collection of all the best travel websites with the lowest prices, can help you get amazing 

travel deals and feel safer while booking. It’s also much easier to compare vacations or 

anything you want to buy online than doing these things in a store or at a travel agency. This 

can help you always get the lowest prices and even track items over time to see when they 

drop in price to buy them at the optimal time. 

 

3. Increased Safety 

When used effectively, becoming digitally literate and understanding good online 

safety practices can help to increase your safety. There and many ways you can protect your 

passwords, and personal information, appear anonymously and do more to protect your 

safety. In addition, if you read a website’s Terms of Use and Privacy Policy, you can easily 

determine what they do to protect your information and what action will be taken if anything 

is compromised. 

There are also many risks associated with using technology, so it’s important to 

ensure that you understand everything you use and that you know how to protect yourself. 

If you take reasonable precautions to protect yourself, getting online can help increase your 

overall safety. 

 

4. Enhancing Learning 

Students with digital literacy skills can improve their homework quality by using 

online resources such as Google search, video tutorials, e-libraries, and email 

correspondence with teachers. Not only from knowledge-based websites and mobile 

applications, but we can also learn for life through the use of websites and mobile 

applications such as Khan Academy, YouTube, Lynda, edX, Coursera, Udemy, and 

Ted.com. 
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5. Increase Job Opportunities 

Nowadays, jobs requiring employees with digital literacy skills are steadily 

increasing and have become necessary, and those with clear digital literacy skills are often 

paid higher salaries. Thus, digital literacy skills can help increase job opportunities and better 

job choices for everyone. 

The traditional method of showing up at a place of business with your resume is no 

longer the standard method for getting a job. Like many other things, employment is moving 

online, and many job applications and resumes are often accepted exclusively online. Many 

businesses set up their online applications or, at the least, require you to submit your resume 

by email. Set up an online professional profile with a website like LinkedIn to get with the 

times. 

 

6. Increase Productivity and Efficiency 

Digital literacy skills allow us to use technology to optimize work individually and 

as a team. At the same time, we can use technologies such as email automation, file 

management systems, human resource management software, data analysis tools, and 

accounting software to streamline work processes, save time and reduce errors to increase 

productivity and efficiency. 

 

7. Increase Sales 

Digital literacy can help businesses increase sales by digitally marketing through 

video advertising, popular web and social media, and email marketing. 

 

8. Contribute to National Economic Growth 

Digital literacy can boost productivity and innovation in almost every sector of the 

economy and society, including manufacturing and services, trade and investment, and 

connecting production chains and value chains at both the regional and global levels. These 

factors show that digital literacy supports national economic growth, especially for 

developing countries. 

 

9. Entertainment 

When you get online, all-you-can-watch television, movies, and videos are at your 

fingertips. You can stream television for a low monthly price with services like Netflix and 

Hulu or watch unlimited videos from users for free on a website like YouTube. You can also 
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find endless entertainment on websites like Buzzfeed or stream music with a service like 

Spotify. 

 

10. Real-time Updates 

Staying up to date with what’s happening in the world is always important, and when 

you need real-time updates on almost anything, the Internet is your place to go. With our 

digital literacy skills, you can quickly and easily access information related to recent events, 

sports news, traffic information, and weather forecasts. Not only that, but digital literacy 

skills can also help us to think critically in evaluating information sources before believing 

or sharing them. 

 

 

11. Create an Online Presence 

Many people caution against putting yourself “out there” online, claiming it can ruin 

your reputation. Though this may be true for those who don’t make smart decisions about 

how they present themselves, creating an online presence can greatly improve aspects of 

your life, especially regarding your personal and professional goals. 

You can create your own website with no coding knowledge using websites like 

Google BlogSpot or WordPress, showcase your photography online with websites like 

Instagram or Flickr, and promote your business on sites like LinkedIn. Putting yourself or 

your business online can increase the number of people who know what you do by 

thousands, even millions. 

 

12. Understand Your Digital Footprint 

You can think of your digital footprint as the trail you leave behind as you begin 

using websites and apps and begin putting yourself out there online. Everything you post 

can be traced, and it never goes away. Understanding how the things you say or post online 

can impact the rest of your life is a key component of digital literacy. The more you use 

websites and apps, the better you understand the trail you’re leaving for others to see. 

 

13. Learn Faster and Teach Others 

The more you start using digital technology, the easier it becomes to learn new 

things. Many websites and apps operate in very similar ways, especially when it comes to 

navigating or distributing information. The more you dive in and try using more devices, 
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websites, and apps, the easier it will become to keep up with the new trends and things you 

need to learn. 

Teaching others how to use devices and technology is also a great way to improve 

learning. When you’re forced to explain how something works or why it functions in a 

certain way, it often requires you to gain a deeper understanding of what you are explaining. 

By simply trying to learn and then trying to help others, you can go from being the person 

who needs to ask someone for help every time you turn on your computer to the person 

everyone calls for help! 

 

14. Become a Digital Citizen 

Becoming a digital citizen means integrating technology into your life, 

understanding how these technologies can be utilized for daily tasks, and how technology 

can improve your life. Similar to improving your digital literacy, a digital citizen can easily 

use technology and the Internet and learn how to make simple daily improvements, 

disseminate content, and be creative. 

 

15. Lifelong Learning 

Committing to lifelong learning is one of the most important components of 

increasing digital literacy. In the digital and tech industries, things are constantly changing. 

There’s no such thing as learning it all. Each day, new revolutionary devices, operating 

systems, websites, apps, gaming consoles, AI, and more are being released, and with them, 

a whole lot more to learn. 

Make sure you keep up with the trends by checking out TechBoomers, so you always 

know how to use the most popular websites and apps and understand how they may impact 

your life. You can also check out other websites with information or online courses that can 

help you keep up with all the skills you need, including Lynda, Wikipedia, Coursera, Udemy, 

and Ted.com. 

 

IV. The importance of Digital Literacy in Education 
As technology advances, the way people study and work continues to change. Learning 

does not just happen in the classroom and by being obedient to the teacher. Today’s students’ 

success depends on their knowledge and skills in the digital world. That is why digital 

literacy is so important for students. 

Students can now take their knowledge with them everywhere, using digital literacy 

skills for effective learning outside the classroom. At home, they have phones, tablets, 
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computers, and other devices that can help them learn, research, and write independently 

wherever and whenever they want. 

Students can also easily communicate with their classmates for homework, review each 

other’s work and make suggestions using technology and digital skills. Doing so can help 

motivate students to perform better and build collaboration between students. Not only that, 

but teachers can also monitor students’ progress and help assess their performance and 

abilities using digital platforms. 

Digital knowledge is important not only in school but also useful for future students. 

Many workplaces require their employees to use information, create new ideas 

collaboratively, and use digital tools such as Internet platforms, social media, and mobile 

devices to communicate with each other. 

 

 

 

 

• According to UNESCO, “digital literacy” refers to the ability to use digital 
technology and tools to find, use, manage, evaluate, create and share 
information securely and accurately, which requires both technical skills and 
insights to improve social and economic activities. 

• Digital literacy focuses on four key areas: 
o Finding the right information on the Internet 
o Using and sharing information online 
o Understanding the security of technology 
o Creating digital content and sharing it ethically. 

• Digital literacy is important to establishing your presence in the modern world. 
Lacking the ability to use digital technologies means that there will be many 
things you cannot do or access. Possessing digital literacy allows you to 
improve efficiency, access to things, fulfillment, and happiness in your life. 

Summary 

1. What is digital literacy? 
2. What are the four keys to digital literacy? 
3. Why is digital literacy important? 
4. Come up with an example of digital literacy. 
5. Why is digital literacy important for education? 

Questions 
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Introduction: 
Commenting on the media is open for everyone. But those expressions are limited. You need to 
know your rights and limitations in expressing your opinions to avoid offending others. At the 
end of this lesson, you will be able to: 

ü Understand freedom of expression 
ü Use your rights and limitations to express yourself 
ü Think before sharing any content on media 

When you have finished this lesson, you will understand: 

I. Accuracy, Thought, and Freedom of Expression 
II. Freedom of Expression 

III. Points to Consider in Expressing, Sharing, and Information 

Personal Ethics and Responsibility in Media 

Lesson 29 
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Lesson 29 Personal Ethics and Responsibility in Media 

I. Accuracy, Thought, and Freedom of Expression 
While the Internet contains much accurate information entered by individuals or 

companies genuinely interested in sharing data, it also incorporates many ideas that can be 

trusted as factual information from advertisers. Informative ideas are posted online by people 

with personal beliefs and are not always shared by others. 

For example, people worldwide have different religious beliefs and believe only their 

religion is right. They spread the word online, believing it to be accurate. But for people of 

other religions or non-religious people, this information is incorrect. In the same way, people 

of different political persuasions will publish information that reflects their views on the 

world or their country according to their perceptions. Even in science, not everyone agrees 

on a particular theory or view. The information disseminated by doctors in Europe is subject 

to specific criteria that may not be accurate for Cambodia due to geographical factors that 

lead to different symptoms. 

Even identical information can be disseminated or presented in various ways to 

create a specific impression on the reader. For example, in an event where it is known that 

there are 100 participants in a group, if the writer wanted to give the impression that only a 

few people participated, he might write, “There are less than 100 people in a small group” 

who showed up to attend. On the other hand, if the writer wanted to show that many people 

were interested in the event, they would write, “Many people showed up, and the room was 

full of at least 100 people.” 

This is why textbooks differ from online information. They are expected to present 

real information about ideas. Internet users must carefully examine all the information they 

read, discovering whether it reflects a fact or just an individual’s point of view. To do this, 

you first need to find the source of information, who the publisher is, and what the 

publisher’s purpose is. This will help you determine whether the information is a collection 

of actual events or just an expression of an individual’s point of view. For an interpretation 

of actual events, experienced internet users often look at different sources of information on 

the Internet for similar information, make comparisons, and form their perceptions of that 

information. This process is called “accuracy verification,” which means setting the bias 

level of information. 

Most websites on the Internet contain information published by private organizations 

or companies. This information is not verified or reviewed by other people. Other websites, 

such as the Wikipedia encyclopedia, allow more people to work on the same piece of 

information and have editors determine the information’s credibility and ensure the 
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information is secure. However, the information on Wikipedia is not entirely accurate. On 

Wikipedia, users can see how many different people have worked on a given piece of 

information and how reliable that information is. 

Internet users must develop their way of determining the accuracy of the information 

on the Internet to determine whether it is true or false. In addition to examining its source, 

they must use their minds and considerations to discover what can and can’t happen or is not 

true. 

 

II. Freedom of Expression 
The constitutions of some democracies, such as Cambodia, are considered countries 

where people have the right to express their opinions, which is an inalienable right. We are 

free to express our opinions on political and religious matters and comment on other matters 

by word of mouth, letter writing, or the Internet. This right is restricted by two other rights 

that all citizens have.  the right not to lie, which leads to defamation, and the right not to be 

insulted. Both of these rights are protected by the laws of the Kingdom of Cambodia and 

will be punished if violated. Restrictions also apply to lies or insults that damage the 

institution’s reputation. 

 
It is essential to know what is allowed for expression and what can become a 

violation of the rights of others, the protection of their appearance, and their dignity. 

It is possible when a person wants to express his opinion about the activities of a 

political party or government, expressing his beliefs about what was done, whether it was 

right or wrong. However, directly accusing an individual or institution of something as a 

crime leads to punishment unless we have eyewitness evidence. For example, we can say 

something is wrong or tell people whether or not to do what we think. These are our ideas, 

and we are free to express them. It is wrong to accuse someone of a crime without evidence, 

such as murder, as that will damage that person’s reputation. 
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Legally, we are responsible for our actions and the information we share, and it is 

our responsibility to ensure that our comments are accurate. In fact, for something others 

have proven to be true, it will inevitably be re-verified before sharing. 

Freedom of expression is the foundation of democracy. It is widely used as a 

powerful tool for defending our ideas. We must learn to use it properly to achieve our goals, 

prove what is true, and be careful about sharing anonymous information. Changing ideas 

without lying or insulting leads to a useful discussion that helps society thrive. 

 

III. Points to Consider Regarding Expression and Sharing Information 
Here are some points you should consider before you comment or share any 

information on the Internet. 

 

1. Be aware of what you are saying: 

In the case of defamation, you are responsible not only for what you say but also for 

what people understand. You are also responsible for publishing defamatory statements 

written by someone, even if their quotes are accurate. You need to determine if your writing 

will affect someone’s reputation. How will the simple or ill-informed person understand the 

meaning of your ad? 

 

2. Say only what you can prove: 

The truth is usually the most important barrier in a defamation suit. Ask yourself 

what evidence you can present in court if someone is questioning you and how you can 

convince them. Do you have a source? Are those sources reliable? Do they have personal 

knowledge? Will they be willing to prove it? If you rely on references, do you have anyone 

who can verify their authenticity? 

 

3. Tell what you do not know: 

This point follows from the above rule. If you are honest with your audience about 

what you do not know and make it clear that you are not accusing anyone, it is difficult for 

the plaintiff to claim that the reader will be more discerning. 

 

4. Be ethical: 

Ethical conduct is the best way to protect yourself from lawsuits. Following 

professional ethics makes you less likely to make defamation-related mistakes. And you may 
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not be susceptible to this type of complaint. If they sue you, you will have something to 

defend yourself with. And even if you have nothing to defend yourself with, the judges and 

jury are likely to sympathize with you, and the damage is likely to be lower than usual. How 

do you act ethically? You need to check the actual information, do not rely on biased sources. 

Do not say more than you know. You can send your critique to the people you are criticizing 

before posting and include their responses in the ad. It must be measured. Be prepared to 

issue corrections and apologize if anything goes wrong. Although this protection may vary, 

it can still be useful for publication issues when the publisher acts responsibly. So, it would 

help if you positioned yourself to take advantage of this self-defence’s possibility. 

 

5. Who are you facing: 

When publishing or sharing information, be aware that some people are more likely 

to sue you than others. For example, politicians, businesspeople, celebrities, and groups of 

people who are important to their lives and have many resources to sue you. You should also 

pay more attention to writing and sharing information about the police and journalists, and 

especially lawyers, because they are an influential group with enough resources to respond 

to you. 

 

• Article 41 of the Constitution of the Kingdom of Cambodia states that Cambodian 
citizens have the right to freedom of expression, freedom of the press, and freedom of 
assembly. Cambodians are free to express their opinions in politics and religion, as well 
as in other matters, by word of mouth, letters, or on the Internet. However, this right is 
restricted by two other rights that all citizens have: the right not to lie, which leads to 
defamation, and the right not to be insulted. 

• Before commenting or sharing any information, consider the following: Know what you 
say. 

• Say only what you can prove, and be open to what you do not know 
• Use the language of expression ethically 
• Know whom you are facing 
• Excessive use of technology will have many negative effects on young people. So young 

people need to know the balance between time spent on social media and time spent on 
privacy and real life. 

Summary 
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1. According to Article 41 of the Constitution of the Kingdom of Cambodia, how 

are the Cambodian people free to express themselves? 

2. What points do you need to consider before commenting and sharing 

information on the Internet? 

3. What does the Constitution of the Kingdom of Cambodia say about expression? 

4. How does the overuse of technology affect you? 

Questions 



Lesson 30 Writing a News Article Part 2: Media and Information Literacy 
 

1 

Content Creation for Digital Media 

CHAPTER 7 
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Introduction: 
News articles are written to inform and educate readers on current affairs/events. They are used 
to provide readers with the information they need/want to know about the world around them. To 
make your news article appealing to readers, you need to write articles proficiently. At the end of 
this lesson, you will be able to: 

ü Define the meaning of news article and classify news 
ü Understand the structure of a writing news article  
ü Write a good news article to publish in the media 

When you have finished this lesson, you understand: 

I. News Articles 
II. Rules for Writing News Articles 

III. The Structure of a News Article 
IV. How to Write a News Article 
V. The Important Points of an Interview 

Writing a News Article 

Lesson 30 
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Lesson 30 Writing a News Article 

I. What is a News Article? 
A news article is a writing format that provides readers with concise and factual 

information. News stories typically report on noteworthy current affairs—including 

legislation, announcements, education, discoveries or research, election results, public 

health, sports, and the arts. 

 
Writing a news article is different from writing other articles or informative pieces 

because news articles present information in a specific way. It’s important to convey all the 

relevant information in a limited word count and concisely give the facts to your target 

audience. Learning how to write a news article can help you find a career in journalism, 

develop your writing skills and help you convey information clearly and concisely. 

 

II. Rules for Writing a News Article 
Whether you’re learning how to write a short news story for a school assignment or 

want to showcase a variety of clips in your writing portfolio, the rules of news writing hold. 

There are three types of news articles: 

• Local: reports on current events of a specific area or community. For example, “Nine 
students drown after river ferry capsizes in Kandal Province”. 

• National: reports on current affairs within a particular country. For example, 
“Cambodia chairing of ASEAN in 2022 leading of top meeting.” 

• International: reports on one or more countries’ social issues or current affairs 
abroad. For example, “North Korea launch many rockets that fall near South Korean 
Island.” 

Regardless of the type of news article you’re writing, it should always include the story’s 

facts, a catchy but informative headline, a summary of events in paragraph form, and 

interview quotes from expert sources or public sentiment about the event. News stories are 

typically written from a third-person point of view while avoiding opinion, speculation, or 

an informal tone. 
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III. Structure of a News Article 
News articles are structured like an inverted pyramid. The most crucial information is 

presented to the reader, followed by additional story details. A news article concludes with 

less important supporting information or a summation of the reporting. 

When it comes to structuring a news article, use an inverted pyramid. Organizing your 

content this way allows you to thoughtfully structure paragraphs: 

• Begin with the most important and timely information 
• Follow those facts with supporting details 
• Conclude with some less important but relevant details, interview quotes, and a 

summary 
The first paragraph of a news article should begin with a topic sentence that concisely 

describes the story’s main point. Placing this sentence at the beginning of a news article 

hooks the reader immediately, so the “lead isn’t buried,” as they say.  

At a traditional newspaper, this practice is described as “writing above the fold,” which 

alludes to the biggest, most pressing news being visible at the top of a folded newspaper. 

 

IV. Writing a News Article 
There are a handful of steps to practice when writing a news story. Here’s how to approach 

it. 

 

1 Gathering Information 

Source the five Ws (sometimes “6 W’s”) about your news topic:  

• Who: Who was involved? 
• What: What happened? 
• Where: Where did it happen? 
• When: When did it happen? 
• Why: Why did it happen? 
• How: How did it happen? 

Lock down a keen understanding of the timeline of events so you can correctly 

summarize the incident or news to your reader. The key is to position yourself as a credible 

and reliable source of information by doing your due diligence as a fact gatherer. 

 

2. Interviewing Subjects 

Consider whom you want to interview for the new article. For example, you might 

interview primary sources, such as a person directly involved in the story.  

Alternatively, secondary sources offer your readers insight from people close to or 

affected by the topic who have unique perspectives. This might be an expert who can offer 
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technical commentary or analysis or an everyday person who can share an anecdote about 

how the topic affected them. 

When interviewing sources, always disclose that you’re a reporter and the topic that 

you’re writing on. 

 

3. Outlining 

Draft an outline for your news article, keeping the inverted-pyramid structure in 

mind. Consider your potential readership and publication to ensure that your writing meets 

the audience’s expectations in terms of complexity.  

For example, if this news article is for a general news publication, your readership 

might include a wider audience than a news article for a specialized publication or 

community. 

Brainstorm a snappy headline that concisely informs readers of the news topic while 

seizing their interest. Gather the most important points from your research and pool them 

into their respective pyramid “buckets.” These buckets should be based on their order of 

importance. 

 

4. Writing 

Get to writing! The paragraphs in a news article should be short, to the point, and 

written in a formal tone. Ensure any statements or opinions are attributed to a credible source 

you’ve vetted.  

 

5. Revising 

Reread your first draft aloud. In addition to looking for obvious typos or grammar 

mistakes, listen for awkward transitions and jarring tenses or perspective shifts. Also, 

consider whether your first draft successfully conveys the purpose of your news story. 

Rework your writing as needed and repeat this step. Don’t forget to proofread your work. 

 

6. Fact-checking 

Strong news stories are built on facts. The entire work is compromised if any 

statement or information is shaky or unsupported. Before publishing a news article, double-

check that all the information you’ve gathered from the beginning is accurate, and validate 

the information your interview sources provided.  
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V. Important Points for Planning an Interview 
Before conducting an interview, journalists should define their information goals: 

What do they want to find out for the audience? Once the goal is set, they can think of 

questions. Each answer should bring them one step closer to reaching the interview goal. At 

the most basic level, there are two forms of questions: closed and open. Closed questions 

can be answered with yes/no, or just one or two words, like a name or a date. Open questions 

are different. They usually start with “why” or “how” and give the interviewee a chance to 

explain the background and give details or a personal opinion. Answers to open questions 

can sometimes be quite long. If journalists want to get straight to the point or are running 

out of time, they often ask closed questions, to which the interviewees have to give short, 

clear answers. Other kinds of closed questions that can prompt short, precise answers are: 

“how many,” “when,” or “where.” Sometimes journalists have to ask follow-up questions 

after the closed questions so the audience can make sense of the short answers. 
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• A news article is a writing format that provides readers with concise and factual 
information. News stories typically report on noteworthy current affairs—
including legislation, announcements, education, discoveries or research, 
election results, public health, sports, and the arts. 

• Whether you’re learning how to write a short news story for a school assignment 

or want to showcase a variety of clips in your writing portfolio, the rules of news 

writing hold. 

• There are three kinds of news articles: Local, National, and International. 

• When structuring a news article, use an inverted pyramid. Organizing your 

content this way allows you to thoughtfully structure paragraphs: 

o Begin with the most important and timely information 
o Follow those facts with supporting details 

o Conclude with less important but relevant details, interview quotes, and a 

summary. 

• Source the five Ws (sometimes “6 W’s”) about your news topic:  

o Who: Who was involved? 
o What: What happened? 
o Where: Where did it happen? 
o When: When did it happen? 
o Why: why did it happen? 
o How: How did it happen? 

Summary 

1. What is a news article? 

2. What is the difference between a news article and a novel? 

3. What are the rules for writing a news article? 

4. How many types of news articles are there? 

5. Why is it important to prepare before an interview?  

Questions 
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Introduction: 
Photos can help give a more specific meaning to an article. Sometimes images can give meaning 
without text. Image production is a necessary skill in the creation of digital content. At the end of 
this lesson, you will be able to: 

ü Define the meaning of the photo 
ü Define the power of photos in media 
ü Take a good picture 
ü Edit a picture 

When you have finished this lesson, you will understand: 

I. Photos 
II. The Difference Between Analog and Digital Photos 

III. What Makes an Image Powerful 
IV. How to Define the Message of a Photo 
V. How to Describe and Interpret a Picture 

VI. Photo Editing 
VII. The Difference Between Editing and Manipulation 

VIII. Photo and Copyright  
IX. Composition Rules for a Photo 
X. The Basics of Digital Editing 

Photography 

Lesson 31 
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Lesson 31 Photography 

I. What is a Photo? 
A photograph is a still image that only contains visual information. It is a record of 

light falling on a subject (a person, object, event, landscape, etc.) Photos can be made using 

a camera, a webcam, or a smartphone. These devices have a lens that lets in light for a certain 

time, typically for a fraction of a second. The light is recorded on the photosensitive material, 

usually an electronic chip. Photos appear in many media, both in print media (newspapers, 

magazines, posters, advertisements) and electronic media (websites, web applications, social 

media). Since the invention of photography in the 19th century, people have loved photos 

because they like to keep them as memories of people and experiences. 

 
 

II. Analog and Digital Photography 
In the 19th and 20th centuries, the light that entered the camera through the lens was 

recorded on light-sensitive material, usually film. The light changed the chemistry of the 

film material: where a lot of light hit the film, the chemical reaction was different than in 

darker parts of the picture, where less light hit the film. These chemical changes in the film’s 

surface formed the recorded image.  

 
Today, most cameras record images electronically on a digital chip. A digital picture 

is made up of millions of small dots called pixels. It’s almost like a mosaic of these tiny dots. 

For each pixel, the camera electronically records how light or dark it is and what color it is. 
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All of these tiny pixels seen together make up the digital image. One characteristic of a 

digital photo is that it can be copied repeatedly without any loss in quality. 

 
 

III. The Power of Images 
Photos deliver visual information, the information we perceive with our eyes. For 

human beings, the visual sense is usually dominant and more significant than hearing, smell, 

or touch. More than 80 percent of the information that reaches our brains is visual 

information. We process visual information like photos and images much faster than text, 

and images can leave strong and lasting impressions. They evoke strong emotions, and 

emotions have a powerful pull on us. 

Social media is impossible to imagine without pictures. Pictures attract people’s 

attention, and social media users often post pictures of themselves (“selfies”), their family, 

and their friends on different platforms. People love to look at photos other users have 

posted. As attention spans grow shorter overall, photos serve as eye-catchers, helping you 

decide whether to scan something or look at it in more detail. 

 

III. Who Defines a Photo’s Message? 
The photographer, the subject, and the viewer determine the message of a photo. The 

photographer can shape how we see a picture by employing certain composition rules.  

The subject, in turn, often evokes a certain feeling or emotion in the viewer. For 

instance, the picture of a starving child usually evokes sympathy and makes viewers sad. 

The viewer also determines the message of a photo because everyone perceives and 

interprets a photo differently. This is due to the individual viewer’s cultural context, 

education, or  

societal norms. 
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IV. Describing and Interpreting Pictures 
For a media literate person, it is important to distinguish between the objective 

description and the subjective interpretation of a photo. When describing a picture, the focus 

is on facts, not on a subjective impression or emotions. Facts that describe a photo can 

include the subject, what colors we see, whether the photo provides a broad overview of a 

scene or event, or if it shows a small detail of something.  

When you interpret a photo, you describe the message you think the picture delivers 

or the emotions it evokes in you. But everyone sees images differently and has associations 

due to their educational background, culture, age, gender, experiences, and interests. That’s 

why everyone interprets a photo and its media messages differently. 

 

V. Photo Editing 
Photo editing is changing the original photo in a postproduction process for a certain 

purpose, e.g., to enhance its impact. You can easily edit a photo taken with a digital camera 

or a smartphone on any computer or smartphone. But photos taken with an analog camera 

can only be edited in a traditional photographer’s darkroom or by scanning them and then 

editing the digital scan. You can crop digital pictures, adjust their brightness, contrast, or 

colors, or save the picture in a reduced image size. You can add a caption or text to your 

photo if you like. To edit digital photos, you need editing software. Most computers and 

smartphones come with some basic photo editing software pre-installed. More elaborate 

editing software can be bought (e.g., Photoshop) or downloaded for free (e.g., GIMP, 

PIXLR, Snapseed). Some photo apps like Instagram have their editing software included. 

 

VI. The Difference Between Editing and Manipulation 
When you edit a digital image, you usually try to improve it by enhancing the 

elements of the original photo that aren’t perfect. For example, you can increase the 

brightness, improve the contrast, add saturation to the image and shift colors, or optimize 

the composition by cropping the picture. However, some modifications can change the story 

the photo tells. For instance, if you decide to crop important people out of the picture, you 

change the picture’s message. Some people would say you are tampering with the image and 

even lying. Digital editing technology makes this kind of falsification very easy. We can 

digitally remove unwanted objects from the image, eliminate imperfections from people’s 

faces, or change the features of their bodies. The person editing the photo can manipulate 

the image to match their imagination. Manipulating an image means consciously or 

unconsciously changing the original message. Photo manipulation is often used to make a 
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product or person look better for commercial or propaganda purposes. Photojournalists 

consider photo manipulation unethical, especially when it is used to deceive the public. 

 

VII. Photographs and Copyright 
You hold the copyright for each photo you take. Those ownership rights mean that 

only you can decide whether to allow your photograph to be reproduced, used as the basis 

for derivative works, and published, transferred, or sold. If others store your photos privately 

on their devices, they are not infringing on your copyright. But if they make your pictures 

available to others or sell them, they violate your copyright. Since technology makes it easy 

to copy and distribute digital photographs, the risk of copyright infringement is high and 

occurs often. If an owner of a photograph learns of a copyright violation, they can sue the 

offenders, who may have to pay a fine. To be on the safe side, you should only publish or 

post photos you have taken or those with a Creative Commons license (CC). You can find 

Creative Commons photos that you can copy, distribute, or edit using the ‘advanced search 

option in search engines like Google or on platforms like Wikimedia and Flickr. You 

normally have to credit the copyright owner when redistributing a CC-licensed photo. The 

specific CC license the photo owner gives determines what you can and cannot do with it. 

 

VIII. Composition Rules for Photos 
Composition rules for photos are guidelines and quality criteria that can help a 

photographer enhance the impact of a photo. Some key composition rules are contrast, 

perspective, field size, and the rule of thirds. 

 

1. Contrast 

Stark differences between dark and light or contrasting colors make shapes and 

contours easy to recognize. Pictures with high contrast work well online because they are 

easy to grasp, even if only seen as thumbnails or on small screens. As a composition rule, 

contrast can also refer to colors that stand in stark contrast to one another (blue >< yellow; 

red >< green) or  highly contrasting shapes that appear on a photo (round shapes >< angular 

shapes or lines). Any such contrast will help make your photo more interesting. 
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2. Rule of Thirds 

Imagine that two vertical and two horizontal lines divide your image into nine equal 

segments. According to the “rule of thirds,” pictures seem more pleasant and interesting if 

key visual elements are positioned approximately where the lines intersect. This adds tension 

to the picture and makes it appear more interesting than if the subject were positioned right 

in the middle of the frame. 

        

        
 

3. Field Size 

The distance between the camera and the object usually determines the camera field 

size. Each field size has a certain purpose: long shots give the viewer much information, like 

where and when an action took place. Close-ups and details direct the viewer’s attention to 

a person’s emotion or a certain object. Slideshows and photo stories are more interesting 

when the pictures have different field sizes. 

 

A. Extreme Long Shot (Extreme Wide Shot) 

This is used to show the subject from a distance or the area where the scene is taking 

place. This type of shot is particularly useful for establishing a scene in terms of time and 

place and a character’s physical or emotional relationship to the environment and elements. 

The character doesn’t necessarily have to be viewable in this shot. 
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B. Long Shot (Wide Shot)   

This shows the subject from top to bottom. For a person, this would be head to toe, 

though not necessarily filling the frame. The character becomes more of a focus than in an 

Extreme Long Shot, but the shot tends to be still dominated by the scenery. This shot often 

sets the scene and our character’s place in it. This can also serve as an Establishing Shot 

instead of an Extreme Long Shot. 

 
 

C. Full Shot   

Frames character from head to toe, with the subject roughly filling the frame. The 

emphasis tends to be more on action and movement rather than a character’s emotional state. 

 
 

D. Medium Long Shot (3/4 Shot) 

Intermediate between Full Shot and Medium Shot. It shows the subject from the 

knees up. 
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E. Medium Shot   

Shows part of the subject in more detail. For a person, a medium shot typically frames 

them from about the waist up. This is one of the most common shots in films, as it focuses 

on a character (or characters) in a scene while still showing some environment. 

 
 

F. Medium Close-Up   

Falls between a Medium Shot and a Close-Up, generally framing the subject from 

the chest or shoulder up. 

 
 

G. Close-Up  

Fills the screen with part of the subject, such as a person’s head/face. Framed this 

tightly, the emotions and reactions of a character dominate the scene. 
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H. Extreme Close Up   

Emphasizes a small area or detail of the subject, such as the eye(s) or mouth. An 

Extreme Close Up of just the eyes is sometimes called an Italian Shot, getting its name from 

Sergio Leone’s Italian-Western films that popularized it. 

 
 

4. Perspective: 

Rather than always shooting from eye level, try photographing from different points 

of view: from above your subject (bird’s eye perspective) or below it (frog perspective). 

Different perspectives have different effects on the viewer. A person who is photographed 

from above looks small and insignificant. A photograph taken at eye level treats them as an 

equal. A photo taken from below could make the person look powerful or dominating. 

 

A. High Angle (Bird’s-eye view) 

The subject is photographed from above eye level. This can have the effect of making 

the subject seem vulnerable, weak, or frightened. 

 
Another high-angle shot that’s taken from directly overhead and from a distance. The 

shot gives the audience a wider view. It is useful for showing direction and that the subject 

is moving, highlighting special relations, or revealing elements outside the boundaries of the 

character’s awareness to the audience. The shot is often taken from a crane or helicopter. 
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B. Eye Level   

The shot was taken with the camera approximately at human eye level, resulting in 

a neutral effect on the audience. 

 
 

C. Low Angle (Frog Perspective) 

The subject is photographed from below eye level. This can have the effect of making 

the subject look powerful, heroic, or dangerous. 

 
 

D. Over-the-Shoulder Shot   

A popular shot is where a subject is shot from behind the shoulder of another, framing 

the subject anywhere from a Medium to a Close-Up. The shoulder, neck, and/or back of the 

head of the subject facing away from the camera remains viewable, making the shot useful 

for showing reactions during conversations. It tends to emphasize the connection between 

two speakers more than the detachment or isolation that results from single shots. 
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E. Two Shot   

A shot in which two subjects appear in the frame. 

 
 

5. Sharpness and Blurring (Focus) 

Before taking a photograph, decide which part of the picture you want in focus. Your 
most important person or object will often be at the center of the picture. Therefore, most 
cameras’ autofocus concentrates on making the picture’s center sharp. But if your main 
subject is off to the side of the picture, there is a way to get that element in focus: if you are 
using a smartphone camera, tap the part of the image on the screen that you want in focus. 
The autofocus will make this part of the picture sharp. Then take a picture. 

 
The focus is often on the center of the image. 

 

6. Light and Color Temperature 

Light determines the effect of the image. Light in blue and gray tones creates a rather 
cold atmosphere. Light in yellow and orange tones conveys a warmer, cozier atmosphere. 
The light is usually warm just after sunrise and before sunset, whereas it is harsher and colder 
at midday. Use light and shadows intentionally. Bright light from the back makes a subject 
look dark, e.g., when a subject is standing in front of a window. In these cases, it may be 
good to use a flash, even in daylight. 
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Afternoon light brings out warm colors and creates a warm atmosphere. 

 

7. Portraits 

Good portraits are more challenging to take than people think. The photographer 
should opt for interesting picture details and encourage the subject to relax. Do not place the 
person in the center of the picture; ensure that they look “into the picture” and not out of the 
frame. 

 

 

8. Movement 

A camera can capture motion. Objects that move quickly in front of the camera can 
appear blurred (e.g., sports), while the static background stays in focus. Another option to 
depict movement is to move the camera with the object as you take the picture. Then the 
fast-moving object stays in focus, but the background is blurred. You can freeze the moving 
object by high shutter speed or by setting your camera to Sports mode. This will lead to the 
background needing to be in focus. 

  

 

9. Depth of Field 

When you take portraits, an out-of-focus background makes a face stand out. With 
newer smartphones or more advanced cameras, you can limit the depth of field by using a 
wide aperture and short shutter speed. This technique can make everything in the background 
that is not the photograph’s subject look blurry or out of focus. 
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10. Patterns 

Patterns can be visually compelling because they suggest harmony and rhythm. 
Things that are harmonious and rhythmic convey a sense of order and peace. Patterns can 
become even more compelling when you break the rhythm, which introduces tension. The 
eye then has a specific focal point to fall upon, followed by a return to the dominant visual 
rhythm. 

  

 

11. Leading Lines 

When we look at a photo, our eye is naturally drawn along lines in the picture. 
Placing lines in your composition can affect how people view the picture. You can pull the 
viewer into the picture towards the subject or take the viewer on a “journey” through the 
scene. Different lines are straight, diagonal, curved, etc., and each can enhance your photo’s 
composition. Diagonal lines can be especially useful in creating drama in your picture. They 
can also add a sense of depth or a feeling of infinity. 

  

 

12. Symmetry 

We are surrounded by symmetry, both natural and artificial. A symmetrical image 
looks the same on one side as on the other. Symmetry creates a feeling of harmony in the 
viewer, but symmetrical compositions can also be boring. Sometimes, tension can be added 
to your picture if the symmetry is broken somewhere. 
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13. Framing 

The world is full of objects that make perfect natural frames, such as trees, branches, 
windows, and doorways. By placing these around the edge of the composition, you help 
isolate the main subject from the outside world. In addition, you can create depth through 
foreground and background. The result is a more focused image, which draws your eye 
naturally to the main point of interest. 

  

 

IX. Digital Editing Basics 
1. Basic Steps in the Digital Photo Editing Process 

When photos are digitally edited, the source image file is changed. This is often 
intended to improve the image. Compressing a picture into smaller format results in a 
digitally edited picture. Here are some terms to use in digital editing photography 

• Import: uploads your photo into the editing software. 
• Crop: redefines the borders of the image. 
• Contrast: changes the intensity of dark and light parts of a picture.  
• Colors and Brightness: turn a photo warmer or colder, brighter or darker 
• Photo Filter: adds special effects to a photo, e.g., makes it look antique 
• Text/Message: adds text such as a headline, caption, or speech bubble to provide 

information or to add humor 
• Resize/Export/Save: creates a reduced file size to export and upload pictures 

 

2. Digital Editing Software 

There are many digital editing software options available online. Many are only 
available in English. If you are using a smartphone, simple touch-ups and edits can be done 
using the phone’s built-in editing features or apps like PIXLR or Snapseed. If you’re editing 
on a desktop or laptop computer, Microsoft Paint is a simple computer graphics software 
included with Microsoft Windows. However, those who want more control over their images 
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should use more advanced photo editing software. Some software is free, but be aware of 
special conditions. Some editing features are only available if the user pays a fee. 

Online Editing Software Digital Editing 

ü Fotor (fotor.com) 
ü PIXLR (pixlr.com) 

Apps for Digital Editing with a Smartphone 

ü Pixlr (Android, iPhone) 
ü Snapseed (Android, iPhone) 
ü PicsArt (Android, iPhone) 
ü PicLab (Android, iPhone) 

 

 

• A photograph is a still image that only contains visual information. It is a record 
of light falling on a subject (a person, object, event, landscape, etc.) Photos can 
be made using a camera, a webcam, or a smartphone. 

• Photos deliver visual information, the information we perceive with our eyes. 
For human beings, the visual sense is usually dominant and more significant 
than hearing, smell, or touch. 

• The photographer, the subject, and the viewer determine the message of a photo. 

The photographer can shape how we see a picture by employing certain 

composition rules.  

• When describing a picture, the focus is on facts, not on a subjective impression 

or emotions. Facts that describe a photo can include the subject, what colors we 

see, whether the photo provides a broad overview of a scene or event, or if it 

shows a small detail of something.  

• When you interpret a photo, you describe the message you think the picture 
delivers or the emotions it evokes in you. But everyone sees images differently 
and has associations due to their educational background, culture, age, gender, 
experiences, and interests. That’s why everyone interprets a photo and its media 
messages differently. 

• Photo editing is changing the original photo in a postproduction process for a 
certain purpose, e.g., to enhance its impact. 

• Manipulating an image means consciously or unconsciously changing the 
original message. Photo manipulation is often used to make a product or person 
look better for commercial or propaganda purposes. Photojournalists consider 
photo manipulation unethical, especially when it is used to deceive the public. 

• Composition rules for photos are guidelines and quality criteria that can help a 

photographer enhance the impact of a photo. Some key composition rules are 

contrast, perspective, field size, and the rule of thirds. 

 

Summary 
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1. What is a photo? 
2. What are analog and digital photos? 
3. What makes an image powerful? Who defines its message? 
4. What are photo editing and photo manipulation? What is the difference? 
5. What are the composition rules? Describe each composition. 

Questions 
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Introduction: 
Media communication uses audio to deliver and transfer information. Audio helps listeners to 
better understanding the information. At the end of the lesson, you will be able to: 

ü Understand audio and sound 
ü Record and edit sound 
ü Share sound to media 

When you have finished this lesson, you will understand: 

I. Audio 
II. Types of Media Using Audio 

III. Vox Pop 
IV. How to Create a Vox Pop 
V. How to Record Audio  

Audio 

Lesson 32 
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Lesson 32 Audio 

I. What is Sound? 
The world is awash in sound. From the quiet rustle of leaves in the breeze to the 

boom of thunder during a raging storm, we are surrounded by sound. The human voice, the 

noise of traffic, a melody produced on a flute or clarinet, and an animal’s cry are all sounds 

we perceive with our ears. The sound is made up of vibrations that travel through the air like 

sound waves. When you beat a drum, the drum skin vibrates, and small changes in air 

pressure occur. Those changes produce sound waves that leave the drum and reach your ear, 

causing your eardrum to vibrate. That, in turn, creates nerve signals that go to your brain, 

which are then interpreted as sound. 

 
 

II. How Sound Becomes Audio 
Sounds are recorded with a microphone that converts sound waves into electronic 

waves, which can then be saved as an audio file. The recorded sounds can be reproduced so 

that you can hear them from speakers that can be as tiny as earphones or as tall as two people 

standing on top of each other. Large speakers produce loud, high-quality sound at concerts 

or public events. Microphones and speakers are integrated into everyday devices like 

smartphones and computers. So, anybody with access to such devices can record sound be 

it voices, music, or the radio, and store it as an audio file. They can then play it back to listen 

to or share it with others. 

 

II. Types of Media Using Audio 
The medium that uses audio the most is radio. But audio also plays an important role 

in other electronic media like television, movies, video clips, and video games. Sound and 

music have become an integral part of media products like movies or video games, and sound 

engineering has become a profession. The people who do this work are called audio 
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engineers or sound engineers. They choose or create sounds and music in movies, videos, or 

TV shows to heighten the perception of reality or enhance moods like anticipation, joy, or 

fear. 

A. Radio 

 Radio is a sound-only mass medium. When people listen to the radio, they only need 

the sense of hearing to understand the media messages consisting of news, reports, 

interviews, or music. Even people who cannot read or write can understand radio content. 

Most people listen to the radio for entertainment and to get up-to-date information. They 

hear that audio thanks to radio waves that transmit radio 

programs. A microphone picks up speech, music, or 

other auditory information, creating a signal sent to a 

transmitter, turning it into a broadcast signal, and sent 

out over the air. Sound waves normally dissipate after 

traveling a few meters. But radio waves that cannot be 

seen, felt, or heard can travel far into the atmosphere. A 

radio antenna picks up this broadcast signal, which the 

radio receiver processes to turn the signal into sound again. The radio listener adjusts a tuner 

to find the frequency of a station. Nowadays, many radio stations have more options than 

just radio waves to get their programs to listeners. Programs can be delivered via cable or 

broadcast on the internet. Websites run by radio stations often contain additional 

information, like articles, pictures, or videos that supplement their audio content. 

Only a few people are needed to create and produce radio broadcasts. Radio programs 

can be broadcast live or pre-recorded. Media makers in radio broadcasting include news  

reporters, producers, radio presenters, news editors, and music editors. 

 The type of programs a radio station broadcasts depends on its aims and objectives. 

Information stations focus on news and talk shows, while entertainment stations mostly play 

music. Typical content types on information stations are news, interviews, reports, and 

public-service announcements. Entertainment stations that mostly play music often focus on 

specific kinds of music, for instance, traditional or folk music, pop, rock, or classical music. 

Programming sometimes includes reports about people in the entertainment industry, like 

singers, musicians, or celebrities. The on-air hosts usually try to be lively and entertaining. 

Many radio stations offer call-in programs during which listeners can call the station and ask 

questions or voice their opinions on air. This allows them to make themselves heard. 
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III. Vox Pop 
A vox pop is a short interview recorded with members of the public. Journalists use 

this format to show a variety of thoughts or opinions regarding a topic. In a regular interview, 

you ask one person several questions. In a vox pop, you ask many people the same question 

to get diverse opinions, outlooks, or experiences. The people you hear in a vox pop are not 

carefully selected experts; ordinary people are chosen randomly. Vox pops are supposed to 

reflect the diversity of personal opinions on a topic of common interest. They can give 

listeners new insights into how others think, recognize the diversity of thought, and show 

multiple facets of a subject. Listeners usually enjoy vox pops because they contain the voices 

of ordinary people like themselves. 

 
 

IV. Creating a Vox Pop 
You should carefully plan a vox pop, but the answers should be spontaneous. First, 

think of a question on a controversial topic that people are talking about and will likely hold 

different opinions about. This way, you are more likely to get various answers for your vox 

pop. Who is affected by this topic, and where can you find these people? Your topic may 

affect a broadly defined group like adults, teens, or children or a clearly defined group such 

as workers from a specific company or industry. Where will you find them? On a city street, 

in a marketplace, in front of a school, factory, or university? Try to develop a single open 

question that will reveal contrasting opinions. When approaching people to talk to, try for 

variety: male, female, old, young. Get your interviewees’ spontaneous reactions to your 

question; don’t rehearse answers with them. Make sure that the answers are clear and 

understandable. When you have recorded 10 to 20 good responses, choose the best ones that 

reflect diverse voices and opinions. Edit them down to short, punchy statements. Edit your 

questions so the listener only hears a series of answers. Mix the order to vary the voices and 

opinions. Start your vox pop with a strong statement and end with a strong one too. 
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V. How to Record Audio 
There are several methods to record audio. You can use a smartphone to record or 

spend large amounts of money on sophisticated microphones and recording equipment. In 
any case, you will need a microphone or mic. This can either be a basic internal mic, like the 
ones built into smartphones, or an external one. External mics must be connected to an audio 
recording device, such as a digital audio recorder, computer, laptop, tablet, or smartphone. 
External mics usually provide better sound quality than built-in versions. For recording 
audio, there is plenty of free, quality software you can use. If you use a laptop or computer, 
a popular free audio recorder and editor is “Audacity.” For smartphones, you can find 
numerous apps for Android, iOS, and Windows. Some are just for recording sound; others 
can also edit audio files. Check for highly rated apps in Google Play or the iTunes App Store 
by typing in “audio recorder” or “audio editor.” Some of the recommended audio apps for 
Android are WavePad Audio, WaveEditor, Editor Free, or Lexis Audio Editor, all of which 
can be used for recording and editing audio. 

 

1. Audio Recording 

Recording audio is easy if you avoid some common mistakes. Here are some basic tips: 

• Choose a quiet environment but avoid empty rooms as they can produce a hollow 
sound and echo. 

• Don’t record in places with much background noise, like traffic, music, or other 
people talking. Background noise can make it difficult for you to edit your recording 
and makes it hard for your listeners to understand what is being said. 

• If you record outside with an external microphone, you can reduce wind noise using 
a mic windscreen. 

• When your interviewees talk, do not encourage them audibly by saying “aha,” “yes,” 
“I see,” or “I agree.” Encourage them silently by nodding, smiling, and maintaining 
eye contact. Verbal encouragement may give your listeners the impression that you 
agree with everything your interviewee says. 

• While recording, don’t move your fingers holding the microphone, as this will make 
sounds that the microphone can pick up. Also, try to avoid making other sounds that 
could end up on tape, like shuffling your feet or coughing. 

• Hold the microphone in the direction of the sound source: near your mouth when you 
ask a question and near the interviewee’s mouth when they answer. 

• The distance between the mouth and the microphone is about 20 cm (almost eight 
inches). You can get closer using an internal microphone, like the microphones built 
into smartphones. 
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• To avoid P-pops, hold the recording device a little off to the side of your mouth, not 
directly in front of it.  

• Always wear earphones or headphones to check the levels and the sound while 
recording. 

• Press the record button a few seconds before asking your first question. Keep 
recording for a short while after the end of the last answer. You can trim the 
beginning and the end of your interview later, but you can never recreate missing 
audio if someone starts speaking before you’ve started recording. 

 

2.  Recording a Vox Pop 

1. Preparing a Vox Pop: Researching and Choosing a Question 

After selecting a suitable topic and researching the basic facts, choosing one question 
may take time and effort. You can ask many questions about any topic, but you must choose 
one key question for a vox pop.  

It should: 

ü Be short, clear, and easy to understand. 
ü Urge people to share personal opinions or experiences. 
ü Be an open question. 
ü Lead to various answers and not just elicit one possible or desirable response. 

 

2.  Approach and Appearance 

The first impression counts. So before you go out and ask strangers to answer your 
question, think about your approach and appearance. Here are some tips: 

ü Be friendly and smile. 
ü Maintain eye contact. Show people that you are genuinely interested in what they are 

saying. Nod and smile when they speak to encourage them. 
ü Do not wear inappropriate clothing. 
ü Look self-confident and optimistic. If you are nervous, try not to show it. 

 

3. Conducting a Vox Pop 

It would help if you kept some things in mind while conducting a vox pop. It helps to take 
notes and check the levels while you record. This will make editing easier. 

Ø Content 
ü Short and clear answers 
ü Different opinions 
ü Different voices (young/old, male/female) 
ü Do not interrupt people; be patient. You can edit the answers later. 

Ø Technical tips 
ü Find a suitable location where you will not pick up too much background noise. 
ü Wear earphones or headphones to check the volume while you record. 
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ü Start recording a few seconds before the answer starts, and keep recording a few 
extra seconds at the end to make editing easier. 

 

4. Editing a Vox Pop 

Select the best answers. Discard the ones that need to be clarified, well-expressed, or 
well-recorded. Make sure you have a mixture of different voices and opinions. Start and end 
with a strong statement. 

 

 

• From the quiet rustle of leaves in the breeze to the boom of thunder during a 
raging storm, we are surrounded by sound. The human voice, the noise of 
traffic, a melody produced on a flute or clarinet, and an animal’s cry are all 
sounds we perceive with our ears. The sound is made up of vibrations that travel 
through the air like sound waves. 

• Sounds are recorded with a microphone that converts sound waves into 
electronic waves, which can then be saved as an audio file. The recorded sounds 
can be reproduced so that you can hear them from speakers that can be as tiny as 
earphones or as tall as two people standing on top of each other. 

• The medium that uses audio the most is radio. But audio also plays an important 
role in other electronic media like television, movies, video clips, and video 
games. Sound and music have become an integral part of media products like 
movies or video games, and sound engineering has become a profession. 

• A vox pop is a short interview recorded with members of the public. Journalists 
use this format to show a variety of thoughts or opinions regarding a topic. In a 
regular interview, you ask one person several questions. In a vox pop, you ask 
many people the same question to get diverse opinions, outlooks, or 
experiences. 

Summary 
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1. What is the difference between audio and sound? 
2. How does sound become audio? 
3. What types of media use audio? 
4. What is vox pop? 
5. Describe how to record and edit a vox pop. 

Questions 
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Introduction: 
Video is an electronic medium for recording, copying, playback, broadcasting, and displaying 
moving visual media. Online video production is booming today. For your content to be 
compelling, you need to learn the techniques for recording and editing videos. At the end of this 
lesson, you will be able to: 

ü Understand video concept 
ü Record and edit video 
ü Use video to express media 

When you have finished this lesson, you will understand: 

I. Videos 
II. Film and Video 

III. Film Genres 
IV. Fiction and Non-fiction 
V. Features of a Video 

VI. Video Sequences and Video Clips 
VII. Frame Rate and Frames per Second(fps) 

VIII. Video Shot Sizes 
IX. Aspect Ratio and Image Resolution 
X. Video Editing, Rough Cut, and Final Cut mean 

XI. Video Rolls 
XII. Vlogs 

XIII. Video Copyright 
XIV. Editing Videos 

Video 

Lesson 33 
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Lesson 33 Video 

I. What is Video? 
Video is a medium that conveys information via a sequence of images and sounds. 

The images we see are called the visual part of the video. The sounds that we hear are the 

auditory part. Thus, video is an audio-visual medium in which images and sound play 

important roles. 

 
A digital camera records video using sensors that generate electronic signals when 

they are struck by light. This image data is stored in the camera or memory card. This 

technology has only been available since the mid-twentieth century. Before then, recordings 

could only be made on film. The very first video cameras were extremely large and 

expensive. These days, technological advances have made video cameras much smaller and 

cheaper. They are now easy to use, even for novices. Since 2003, video cameras have been 

integrated into phones so that anyone with a cell phone or a smartphone can now record their 

videos. 

 

II. The Difference Between Film and Video 
The terms film and video are often used interchangeably because the film, like video, 

conveys moving images and is an audio-visual medium. The difference between film and  

video lies in technology. The film does not record the visual image electronically but 

chemically on light-sensitive material known as celluloid. The film comes in various formats 

(8 mm, 16 mm, 35 mm, 70 mm), each of which offers a different resolution. Production on 

celluloid film is much more expensive than production using video technology since the 

material on celluloid cannot be recorded. The film is a medium that evolved from 
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photography. It was discovered that a series of still images shown in rapid succession created 

the perception of motion. The Lumière Brothers in France created one of the first films in 

1895. It depicts a train rolling into a station. These early films were silent. They had no sound 

because recording and synchronizing sound and visuals were not technically possible until 

the 1920s. The first feature-length “talking picture” or “talkie” was “The Jazz Singer,” 

released in 1927. 

III. Film Genre 
Movies with certain characteristics are grouped into film genres based on one of three 

major aspects: a similar narrative, a similar plot, or a similar mood or atmosphere. Assigning 

films to particular genres helps us discuss and analyze them and recognize and understand 

what kind of films we like and dislike. Not every film can be assigned one particular genre 

since some films combine elements of multiple ones. The most important genres that share 

a similar narrative form include comedies, dramas, and biographies. Movies with similar 

plots are found among the adventure, fantasy, science fiction, western, war, crime or 

whodunit, music, and sports film genres. Genres that share a similar mood or atmosphere 

include action, thriller, horror, romance, and erotic films. 

  

IV. Fiction and Non-fiction 
To be media literate, it is essential to distinguish between fictional and non-fictional 

media content. A fictional film or video depicts something made up, invented, and designed. 

The creator does not necessarily aim to illustrate truth or reality, even if the content is based 

on real-life events. Fiction intends to express something in how the creator perceives it or 

wants to depict it. The creator invents a fictional world. Most movies and music videos 

shown in theaters, on television, or YouTube are fictional. They are scripted, and actors tell 

or act out the story. 
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Non-fiction is the opposite of fiction. Here the creator aims to depict reality and 

illustrate the truth to the best of their ability. The maker of a non-fictional video (such as 

news, a report for a magazine program, or a documentary) is always obligated to depict 

events and the individuals concerned as accurately as possible. However, media can never 

really present reality in its entirety. Media can only offer a glimpse or a segment of it, and 

as a result, ignores or omits other aspects or angles. This means a filmmaker’s choices and 

viewpoint always influence what part of reality is shown and what is left out. 

 

V. Features of Video 
As an audio-visual form, video is a multifaceted medium that can be used for many 

purposes. It can relay news and information and can be found in documentaries, profiles, 

magazine reports, and tutorials. Video is also used to entertain. The entertainment industry 

uses video for movies, TV series, shows, music videos, and much more. 

Videos with non-fiction content can convey to viewers impressions of events, places, 

and people. Videos with fictional content can get viewers caught up in a story, so they 

completely forget the real world. While both video styles have positive aspects, they also 

have less positive ones in that whatever is shown is only a small segment selected by the 

media maker. This can change or even manipulate viewers’ perceptions. 

Although video combines images and sounds, viewers do not perceive the two as 

equal. They are usually more conscious of the images than the sound, whose impact unfurls 

in the subconscious. Media makers are aware of this and sometimes use sounds and music 

to evoke an atmosphere or a certain mood to influence the video’s impact. Slapstick videos, 

for instance, lose much of their comedic effect without all their amusing sounds. With no 

sound, horror movies can lose their eerie atmosphere and feel less scary. 

In the non-fictional field of news, on the other hand, this kind of manipulation 

through sounds and music is not desirable. Only original sounds recorded on the event scene, 

quotes from interviews and the journalist’s narration are used in a news video to convey as 

much authenticity as possible. In the best-case scenario, the images of a news video and its 

sound go hand in hand; they reinforce each other, and both tell the same story. 

Another factor that can make it difficult for viewers to follow and understand a video 

is that the video’s creators determine the playback speed of the images, sounds, and scenes. 

Viewers cannot slow down or speed up the images. For instance, in a movie shown in a 

theater or on television, information may be presented so quickly that viewers miss some of 

it. Viewers can replay a sequence or even the entire video on the internet. 



Lesson 33 Video Part 2: Media and Information Literacy 
 

312 

 

VI. Video Sequence and Video Clip 
A video sequence is a video section that forms a distinct narrative unit due to 

technical elements or content. For instance, an action like frying an egg or making a call 

with a smartphone can be broken down into five or six video shots. Together, these shots are 

from a short sequence that tells one distinct part of the story. Another example is introducing 

a person or a place in a movie through a sequence of shots that go together. Video clips, on 

the other hand, are audio-visual sequences that are often a few minutes long and stand on 

their own. Popular examples of video clips include music videos, video tutorials, product 

reviews, or videos produced by citizen journalists. Video clips are very popular on social 

media. 

 

VII. Frame Rate and Frames per Second (fps) 
The frame rate is the number of single pictures per second shown in sequence in a 

video. If there are 14 to 16 pictures per second, the human brain perceives the action as one 

fluid motion. At slower rates, the brain perceives each image individually. The movements 

become jerky, and the motion seems “stop and go.” The standard frame rates for television 

are 25 frames per second (fps) and 29.97 fps. 

 

VIII. Video Shot Size 
A video shot size is defined by the distance from the camera to the subject. The closer 

the camera is to a subject, the better you can see the details, which means you can see less 

of the surroundings. If the camera is far from the subject, viewers have more of an overview 

of the location or situation. Long, medium and close-ups are the three most widely used shot 

sizes.  

Filmmakers employ a variety of shot sizes to make a video interesting and exciting 

and keep the story’s pace going. The sequence of shot sizes influences viewers’ perceptions 

and emotions as they watch the video. A series of long shots can create a calm feeling, 
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whereas many close-ups or details in a row can be perceived as disturbing, disorienting, 

eerie, or mysterious. 

The five video shot sizes that are most popular are: 

ü Long shot 

ü Medium shot 

ü Close-up 

ü Medium Close-Up   

ü Over the shoulder 

 

IX. Aspect Ratio and Image Resolution 
The aspect ratio is the proportional relationship between an image’s width and 

height. For quite a long time, the standard aspect ratio for television was 4:3. Nowadays, 

16:9 is the standard because it corresponds better to a person’s natural field of vision. The 

evolution of smartphones has also popularized a vertical video format of 9:16. It has become 

the standard for social media stories or status updates because of how people hold their 

smartphones. Users don’t want to flip their phones sideways to watch a video while scrolling 

through their newsfeeds.  

 
The image resolution for videos is measured in pixels. Pixels are the single dots or 

points of color that make up a video image. The greater the number of pixels, the sharper the 

image is. Standards for the internet for 16:9 video are high-definition (HD), with 1280×720 

pixels, and full HD, with 1920×1080 pixels. A higher resolution also means a bigger file 

size. So depending on what the video will be used for, full HD might not be necessary (e.g., 

posting a video on social media). 
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X. Video Editing, Rough Cut, and Final Cut  
Video editing combines separate recorded scenes or shots to create one video. In the 

first step, the rough cut, the individual shots, or scenes are arranged logically, and excessive 

material is deleted. There should be a mix of shot sizes to give the video an interesting 

structure. In the second step, the final cut, the transitions between the separate shots or scenes 

are perfected to ensure one continuous flow of movement. Colors are filtered or altered as 

needed, and text, music, language, and sounds are added. 

 

XI. Video Roll 
1. A-Roll 

A great way to think of A-Roll is media that “tells” the story, such as an interview or 
a news segment. The primary audio and video often consist of one or more people discussing 
a topic or relating a narrative. A-Roll is the driving media in most documentaries, news 
broadcasts, talk shows, and reality shows. Another problem with using the A-Roll media 
alone is that since A-Roll footage is usually of people talking, there are often fumbled lines, 
coughs, sniffles, and stutters that need to be edited out. That’s where B-Roll comes in. 

The clip below is a good example of A-Roll media. The anchor’s monologue drives 
the story from beginning to end while he talks about the importance of having a mobile 
website. 

  
Example of A-roll 

With the A-Roll alone, the story is communicated clearly. The problem is that A-
Roll tends to become extremely boring, making it harder for the audience to remain engaged. 
Remember, the audience is watching the video because they expect to have the story shown 
to them, not just told. 

Another problem with using the A-Roll media alone is that since A-Roll footage is 
usually of people talking, there are often fumbled lines, coughs, sniffles, and stutters that 
need to be edited out. That’s where B-Roll comes in. (repeated) 

 

2. B-Roll 

B-Roll is additional footage used to support the A-Roll visually. Think of it as a video 
that “shows” the story. If the A-Roll narrative talks about residences, the B-Roll might show 
a house. It just needs to complement and, if possible, confirm the story told by the A-Roll 
media. Using B-Roll footage helps break up the monotony of a common A-Roll interview 
shot, making the whole thing much more engaging. 
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B-Roll is also used as a “cutaway.” Cutaways allow an editor to remove parts of the 
A-Roll undetected. In the same way, an editor may use a quick cutaway to combine two 
portions of the A-Roll. Since the audio from the A-Roll usually acts an as a voiceover on top 
of the B-Roll footage, the editor can then cut out or edit parts of the A-Roll audio as needed. 
Cutaways are perfect for when you want to remove a portion of an interview or when an 
interviewee sputters, coughs, or says “um” too often. 

  
Example of B-roll 

The term “B-Roll” tends to make the supportive footage seem secondary and less 
important, but it certainly isn’t. You only have an interview without the supporting footage 
showing the action. The B-Roll footage is really what makes a story come alive. 

For the news segment A-Roll, we would want to capture B-Roll footage of people 
using their phones and tablets to access mobile websites, a few customer interactions, and a 
business transaction. Then we could use those shots to help the anchor show the story more 
visually engagingly. 

Whatever B-Roll footage you choose, make sure each shot supports the narrative 
driven by the A-Roll media.  

Although this is a basic example, you can see how A-Roll and B-Roll are used 
together to tell and show a story. If you’ve ever filmed an interview and used supporting-
action footage to supplement it, then you’ve already used A-Roll and B-Roll together 
properly. When you do, you tell a better story, and telling a better story is what it’s all about 
in the end. 

 

3. A+B Roll 

Using editing software, A-Roll and B-Roll media can be mixed and merged to tell a 
much more engaging story. In this example, we have our B-Roll shown playing over the A-
Roll. It starts with the news anchor in the studio delivering his news segment. Then, while 
the anchor’s audio continues to tell the story, the B-Roll footage is cut in to help support 
what he’s talking about. 

 
Example of A+B-roll 
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XII. Vlog 
A vlog, or a video blog, 

is like a video diary, where a 

person regularly produces and 

publishes video material. 

Unlike a blogger, who 

regularly publishes new texts 

and pictures, a vlogger shares 

material via video, mainly on 

YouTube. Most vloggers share personal experiences and ideas. Their subjects range from 

self-expression to travel reports, from observations and thoughts to well-argued opinions, 

from hobbies such as cooking, sports, and music to social activities or make-up and fashion 

tips. For vloggers, it is important to develop an audience and keep viewers coming back for 

subsequent episodes. To do this, they use a variety of techniques. Vloggers may address 

viewers at eye level and thank them for watching, posting comments and ideas, and 

subscribing to their YouTube channel. At the end of their video, a vlogger may announce 

upcoming episodes or refer viewers to existing ones. Anyone can create a vlog with the 

proper smartphone and an internet connection. But to pursue it seriously, the topics covered 

must be interesting to a potential audience. In addition, a vlogger must commit to posting 

new videos regularly, like being on camera, being comfortable sharing personal thoughts 

and ideas with others, and enjoying building a personal connection with an audience. 

 

 

1. Important Aspects of a Vlog 

A vlog has very clear features that distinguish it from other videos. Normally, just 

one person, the vlogger, stands or sits in front of the camera and speaks into it, addressing 

the viewers. The vlogger looks directly into the camera, intensifying their connection with 

the viewers and giving them the sense that the vlogger is interacting with them. A vlog 

segment is often recorded using only one-shot size, with the camera stationary on a tripod. 

The only thing that moves is the vlogger, who employs gestures and facial expressions to 

emphasize what is being said. A vlog generally lasts from one to around five minutes. A 

simple vlog does not require editing. Some vloggers use jump cuts to grab a viewer’s 

attention. These are abrupt transitions where the shot size remains unchanged from one 

frame to another, but the vlogger is in a different place or position in the subsequent shot. 

This creates the impression of a jump. Some vloggers also complement their videos with 
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texts, links, or images they add during editing. Space for comments below the video 

facilitates interaction between the vlogger and viewers, who provide feedback on the 

vlogger’s work. 

 

2. Tips for Vlog Recording 

A. Language and Text 

It is always important for a vlogger to think about their audience. Please choose an 
appropriate way to talk to your viewers and speak directly to them. It helps to think of an 
individual viewer, a friend. Imagine you are talking to that friend, not to a camera.  

ü Introduction: How do you want to introduce the issue to your viewers? With a 
personal example? With a question? 

ü Middle Section: What additional aspects, questions, or examples do you also want 
to address and when? Do you want to surprise your viewers? How? 

ü Conclusion: How do you want to end your vlog? With a conclusion? An open-ended 
question? Regarding a link, another vlog, or a call to action? 

 

B. Voice, Gestures, and Facial Expressions 

A vlogger can employ various tools to emphasize the text. 

Voice: You can play with your voice and pitch: speak loudly or quietly, and pause 
occasionally. Just make sure you always speak clearly. 

ü Facial Expressions: Look directly into the camera and use facial expressions to 
indicate how you want to get your point across—either seriously or humorously. 

ü Gestures: Use gestures to emphasize what you are saying. 

 

C. Images and Sound 

ü Image: Place the camera or smartphone at eye level. Make sure that the shot shows 
the vlogger from the chest upward and that facial expressions and gestures can be 
seen clearly. 

ü Sound: Since background noise can be disturbing, choose a quiet location where no 
one speaks simultaneously. Do a sound test. 

 

D. Recording 

Turn on the recording device before the vlogger begins speaking. Let it run for about 
five seconds, and then signal the vlogger to start. Hold the device steady. You can place your 
elbows on a table to help steady your hold. Wait five seconds in the end before you stop 
recording. Extra material can always be edited out, but you can never record a moment that 
has already passed. 
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XIII. Video and Copyright 
Copyright applies to all videos uploaded to the internet. This means that a user may 

only upload content for which the user owns the copyright. If, for instance, someone records 

a TV show or sports broadcast shown on television and posts it on YouTube without 

permission, this is a violation of the TV broadcaster’s copyright. If you produce your music 

videos and post them, ensure you respect the musicians’ copyrights and the record labels. 

Producers of video games own the copyrights for game tutorials and Let’s Play videos. 

Given the massive number of videos uploaded to the internet every day, it’s not always easy 

to determine which user has infringed on copyright laws with which video, but it is not 

impossible. Some YouTube users have already been sued for infringing on copyrights. 

That’s why it is essential to post only self-produced video content online or to work with 

Creative Commons (CC) licenses. 
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• Video is a medium that conveys information via a sequence of images and sounds. 

The images we see are called the visual part of the video. The sounds that we hear 

are the auditory part. Thus, video is an audio-visual medium in which images and 

sound play important roles. 

• The terms film and video are often used interchangeably because film, like video, 

conveys moving images and is an audio-visual medium. The difference between 

film and video lies in technology. The film does not record the visual image 

electronically but chemically on light-sensitive material known as celluloid. 

• Film genres are stylistic categories where a particular movie can be placed based 

on the setting, characters, plot, mood, tone, and theme. 

• “Fiction” refers to a film created from the imagination. “Non-fiction” refers to 

films based on fact. 

• A video sequence is a section that forms a distinct narrative unit due to technical 

elements or content. 

• The frame rate is the number of single pictures per second shown in sequence in 

a video. If there are 14 to 16 pictures per second, the human brain perceives the 

action as one fluid motion. At slower rates, the brain perceives each image 

individually. The movements become jerky, and the motion seems “stop and go.” 

The standard frame rates for television are 25 frames per second (fps) and 29.97 

fps. 

• A video shot size is defined by the distance from the camera to the subject. The 

closer the camera is to a subject, the better you can see the details, which means 

you can see less of the surroundings. If the camera is far from the subject, viewers 

have more of an overview of the location or situation. Long, medium and close-

ups are the three most widely used shot sizes.  

• The aspect ratio is the proportional relationship between an image’s width and 

height. For quite a long time, the standard aspect ratio for television was 4:3. 

Nowadays, 16:9 is the standard because it corresponds better to a person’s natural 

field of vision. 

• A-Roll is media that “tells” the story, such as an interview or a news segment. 

The primary audio and video often consist of one or more people discussing a 

topic or relating a narrative. A-Roll is the driving media in most documentaries, 

news broadcasts, talk shows, and reality shows. 

Summary 
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• B-Roll is additional footage used to support the A-Roll visually. Think of it as a 

video that “shows” the story. If the A-Roll narrative talks about residences, the 

B-Roll might show a house. It just needs to complement and, if possible, confirm 

the story told by the A-Roll media. 

• A vlog, or a video blog, is like a video diary, where a person regularly produces 

and publishes video material. 

1. What is the difference between film and video? 

2. What are fiction and non-fiction? 

3. What are video sequence, video clips, and shot size? 

4. What is the difference between frame rate and frames per second? 

5. What are A-roll and B-roll? 

Questions 
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Introduction: 
Email is a more popular and official form of e-mail than any other social network. Writing a 
message is different from saying it orally. It would be best if you learned how to use words to 
understand them easily. At the end of this lesson, you will be able to: 

ü Understanding the ethics of email 
ü Know the type of email 
ü Prepare the message properly before sending 

When you have learned this lesson, you: 

I. Email 
II. Legal value of Email 

III. Email  Privacy 
IV. How to speak in email 
V. Multiple Email recipients 

VI. Part of an email 
VII. Effective communication via email 

VIII. Webmail and Mail Client 
IX. Email attachment 
X. Spam and Virus 

Professional Communications Via Email 

Lesson 34 
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Lesson 34 Professional Communications Via Email 
I. Email 

Email (also known as email) is a means of communication using computers 
connected to the Internet to send messages to each other. In developed economies, email has 
become the essential form of professional communication. 

The email has three main advantages: 

ü When an email is sent to you, your computer will receive the email immediately. 
Suppose the recipient's computer is not yet open or connected to the Internet. The 
sent message will be stored on the Internet (server) until the recipient is connected 
and reads it. 

ü Email can be stored permanently on the user's computer, Internet, or both. It will turn 
into a list of all the information sent and received by the user. Because it is an easy 
way to find information in old emails, this list is very useful for storing other 
information. It is also easy to recover personal and business information. 

ü It can be used with the attached file and allows sending by attaching various files via 
the Internet to any other user. 

The added value of an email is that it is free and can send messages or information 
without limiting the length or number of characters, even if you send it to different countries. 

 
II. Legal value of the email 

It's not the same as a paper-signed letter. Although the email shows the sender's 
name, sometimes we can not confirm that the email was written by a person whose name 
shows the sender. It is not difficult to send using someone else's name. Therefore, we can 
not use email as evidence in the legal system because it is easy to falsify. 

So we usually use email only in work and personal relationships daily. Still, you 
cannot send it via email when there is a need for legal documentation (such as a contract, 
etc.). Original documents must be printed, signed, and send by post station. 

 

III. Email Privacy 
The laws of most countries generally protect the confidentiality 

of letters sent by post. No one, not even the government itself, has the 
right to read private letters sent from one city to another, from one 
company to another, or even to listen to telephone conversations. 
Police can only do so with the permission of a judge to investigate a 
crime. The same rules apply to email. No one can read emails sent by 
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any citizen or by any private company without the permission of a judge. 

Emails are usually password-protected. We can not read someone else's email unless 
we know their password, and others cannot access our email unless we tell them our 
password. 

 

IV. How to speak in email 
Email is a means of communication using real words. Because we can not use 

phrasing phrases to connect our emotions to the message or the recipient, all this information 
will be in the phonetic tone of the email. The problem is that emails can be written as quickly 
and sparsely as letters, and sometimes the sentences are not clearly defined, leading the 
recipient to misunderstand that the email is rude—a lack of respect for them. 

When writing emails, we must always be careful and respectful, especially when 
discussing any important issues that could make the reader feel personally. 

Email is not much different from the mail. The important thing is that we must 
understand how we should introduce ourselves to the recipient. We should use the same 
respect as we used in the letter sent to the same person: the official form is "Respectfully 
yours ..." and the informal form (for friends) is "Hello ..." Phonics and endings of text should 
be the same. 

 

V. Multiple Email Recipients 
Emails can be sent to one or more people at once. For each recipient, the sender can 

email them with a direct address to (To) or who will be copying the information (Cc). Once 
they receive what they received, the recipient may see all of the recipient's email addresses, 
including the one assigned to "To" or the "Cc" copy. 

The sender may also secretly copy an email to a recipient without the other person 
seeing the recipient's address. Such a copy is called a secret copy (Bcc). 

For communication within the company, different sections will also be informed of 
what happened by copying the email to those involved, even if they are not the main 
recipients. However, this is done to make the flow of information smooth or transparent in 
the company to make it more efficient in the work and reduce the problems that occur due 
to wrong communication. 

 

 

 

VI. Part of Email 
The email has three parts:  

• The address of the person to whom the email will be sent (to, cc and bbc);  
• The subject of the email is a brief description of what the email will display To the 

recipient 
• The body, where it will be written, including the salutation, the content, and the 

signature. 
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VII. Effective communication via email 
Here are some rules and steps you should follow when writing an email. 

ü If you are writing to more than one person, you should decide who is the direct 
recipient and who is the recipient. Enter the correct email address. 

ü Write a short but meaningful topic. Once someone gets something, they will preview 
the email subject based on this topic. They will decide whether to read this email 
immediately or leave it for later. Meaningful topics help to make them aware of the 
purpose of the email and how to organize their work. 

ü Do not write too long an email. Write too long unless the work is important. It is 
understood that long emails are difficult to read and most of them are not read at once 
because it takes too much time for the reader. 

ü Emails written fast are also read fast ... and most of their content and phonetics are 
misunderstood. Before writing a reply to someone's email, especially if you think 
that the content of the email is rude, you must carefully read the original email before 
you write a reply, analyzing your purpose. Also, write. Try to see if there is a 
difference between what you understand now and what you first understood. 

ü When replying to someone's message, ensure you have entered enough information 
to let the recipient know what you are replying to. This is usually done by copying 
some text from the message we received and then writing a reply immediately below 
it. The email Manager usually copies the entire message received when we reply to 
that message. You do not have to copy all the original messages you received. Copy 
the relevant parts to the response. In this case, you should delete parts that are not 
relevant to your response to avoid writing emails too long. 

ü Please read and review your email, thinking about the tone and mood of your readers 
as they read what you wrote. Ask yourself if what you have written is negative. 
Remember that what you read is considered rude. It will make you respond more 
politely and may damage your relationship. 

ü Check for spelling errors. Emails with too many spelling mistakes can make readers 
think negatively about your professionalism. Then start sending it. 

VIII. Web Mail and Mail-Client 
There are two ways to read, write and manage your email. The first way is to use a 

web browser. In this case, all your mail is stored on the Internet, not on the computer you 
are working with. After using the email address (username) and confirmation password to 
access the email account you created, you can see the subject of all the emails you have 
received (emails sent). You) and can read any email you want to read. You can also compose 
a new message, reply to an email you received, or organize an email to a new folder to update 
your inbox. You are in the right order. Using email in this way is called Webmail. It is 
especially interesting for those who do not have a personal computer and want to use their 
email in a different place where they can access it from any computer as long as that 
computer is connected to the Internet. 

The disadvantage of Webmail is that you can only use it if your computer is 
connected to the Internet. If you do not have your computer connected to the Internet, you 
will not be able to view any information. 
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In general, the free email provided by Yahoo or Google email service providers is 
called online mail, and their business model is also advertised to you when you are reading 
your mail. You. 

Another way to manage your email or email is by using an email client. The email 
program is a computer program that allows users to download all their messages to a 
computer and organize their email without having to connect to the Internet (except when 
sending and receiving emails). 

Using an email client in this way is a common way for those who work in one place 
with a single-user computer or laptop but do not need an internet connection all the time. In 
this case, they can go anywhere with an internet connection to receive and send mail. Still, 
they can read and write mail anywhere without needing the Internet and can send emails 
back once they have connected their computer to the Internet again. 

Using an email client is usually faster than using Webmail (Gmail or Yahoo) because 
all the information is already on the computer and does not need to be downloaded every 
time we want to read a message. The downside is that we can not read email in a different 
location from our computer. We can also combine both email forms. Users can download a 
copy of all emails to the email program and keep a copy on the Internet, which can be 
accessed online when needed. 

 

IX. Email attachments 
It is not uncommon for sending an email to the Post station to include other 

documents in the envelope, such as invoices, leaflets, photographs, or CDs. The same can 
be done with email, but all the files we can send must be electronic. 

Inserting a file in an email is called attaching the file. It is most commonly used to 
attach files via email, which can be done easily, quickly, and for free, or at the lowest cost 
for sending files to other users, including files, typewriters, pictures, and sounds (music). ) 
Etc. The email manager (email or online email program) has buttons that allow you to select 
the files you want to attach via email while you are writing the email. When this function is 
used, the selected file will be sent to the recipient with an email. 

The file size limit is the size of the attached file. Most email systems determine the 
file size, and internet speed allows us to send large files. Large music or video files can be 
difficult to send because they are too large. 

X. Spam and viruses 
Along with its advantages, the 

email also has its drawbacks. The first 
problem is that it is a free, low-cost, and 
easy-to-use service that sends emails to 
millions of users. Some companies 
specialize in doing this. Sometimes they 
capture the email addresses of as many 
people as they can find and then use these 
addresses to send advertisements or try to 
plot fraudulently or not directly with users. 
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This type of bulk message is called spam, and it has become a problem on the Internet, with 
emails sending as much as 30% of all our emails.  

Most users receive more spam than regular messages, sometimes up to 20 or more, 
each of which they receive from someone they know. Spamming is illegal in many countries, 
but since it is made from various sources on the Internet, it isn't easy to stop. 

The second problem with email is that it is used to distribute computer viruses. A 
computer virus is a small program that installs itself into a user's computer, destroying it and 
stealing user information. Computer viruses are transmitted from one computer to another 
through email or various types of media, such as removable media, USB drives, etc. 

When sending an email, the virus associated with the email is sent to the user. The 
virus only affects the recipient's computer if the recipient opens a program or file associated 
with the email. An infected email is sometimes received from a friend who uses that friend's 
name to trick the user into opening the virus and affecting the user's computer. To do this, 
the sender of the virus hijacked the user's email address (by stealing their password first) and 
then sent an email to all those in the contact list using your name in the address book. They 
have stolen that. Email users should be careful before opening any attachments that come 
with the received email unless they are sure it was sent by someone they know for a specific 
purpose. 

The virus only affects computers running Microsoft operating systems such as 
Windows. Computers running Linux or Mac OS / x will not have to worry about computer 
viruses. 

For Windows computers, you can also buy anti-virus software that protects your 
computer from the effects of viruses. These programs are called anti-virus programs that can 
remove viruses from a computer affected by the virus and repair the damaged parts using 
the program. It is important to have this anti-virus software if your computer is running 
Windows. Currently, most infections are not caused by email but by USB removable storage 
devices that can transmit the virus by connecting (plugging) the device with a computer. 
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• Email (also known as email) is a means of communication using computers 
connected to the Internet to send messages to each other. 

• When writing emails, we must always be careful and respectful, especially when 
discussing important issues that could make the reader feel personal. 

• Emails can be sent to one or more people at once. For each recipient, the sender 
can email them with a direct address to (To) or who will be copying the 
information (Cc). Once they receive what they received, the recipient may see all 
of the recipient's email addresses, including the one assigned to "To" or the "Cc" 
copy. 

o The email has three parts:  
o The address of the person to whom the email will be sent (to, cc and 

bbc);  
o The subject of the email is a brief description of what the email will 

display to the recipient 
o The body, where it will be written, including the salutation, the 

content, and the signature. 
• Webmail is stored on the Internet, not on the computer you are working with. 
• Email client, all the information is already on the computer and does not need to 

be downloaded whenever we want to read a message. 
• Spam is any unwanted, unsolicited digital communication sent out in bulk.  

Summary 

1. What are the advantages of email? 
2. Why speaking in email not the same as using real words? 
3. How many parts of the email? 
4. What is the difference between Web-mail and Mail-Client? 
5. What are Spam and Virus? 

Questions 
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Introduction: 
There is a wealth of content and information on the Internet. We can know something with just 
one click. But need to learn the dangers of using the Internet. It can be a virus and a threat. At the 
end of this lesson, you will be able to: 

ü Understanding to Characteristics of the internet 
ü Understanding of viruses and a threat on the Internet 
ü Use the Internet with safety and privacy 

When you have learned this lesson, you learn: 

I. Internet 
II. Social media 

III. Safety and Privacy 

Internet, social media safety and privacy 

Lesson 35 
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Lesson 35 Internet, social media safety and privacy 
I. Internet 

The internet is a network that connects computers around the world. It uses a 
language common to all computers online called TCP/IP (Transmission Control 
Protocol/Internet Protocol). This is where the term IP address comes from. The device 
address that the information you access is sent. This common computer language divides 
information and data into small chunks (called packets), is sent through data lines, and 
reassembles for the person accessing them. 

 

 

1. Characteristics of the internet 

The internet is constantly changing and being updated. It gives users seemingly 
infinite choices when they search for information. Users have instant access to a huge pool 
of data, which is empowering. No official authority controls the internet, meaning 
individuals and organizations are responsible for the information they post online. On the 
one hand, this results in a lack of protection for users, but on the other hand, it means the 
internet fosters freedom of speech on a global scale. Since there is no editorial control on the 
internet, there are also a lot of rumors, half-truths, and lies that may look like accurate 
information at first sight. In addition to these kinds of disinformation, the internet is home 
to hate speech, pornography, racism, and incitement to violence. Despite a good deal of 
harmful content, the internet allows individuals, minorities, and special interest groups to 
voice their opinions. It can connect people with similar interests or experiences around the 
globe. 

The information on the internet is stored on servers and hard drives worldwide. That 
is why it is almost impossible to delete information from the internet, although it can be 
difficult to find. The fact that “the internet never forgets” may be worth considering before 
posting compromising information or pictures. 

No one owns the internet itself because it is a “network of networks”. Individual 
companies and organizations own networks connected to millions of other networks to form 
the internet. 

 

2. The internet’s global players 

Although no single person or organization controls the entire internet, some key 
players and companies are very influential online. They include companies like Microsoft, 
Apple, Facebook, Amazon, and Google from the United States and JD.com and Alibaba 
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from China. They all have agendas and motives (e.g., to make money, collect data about 
users, etc.) Other powerful players are involved in the internet’s many different aspects. 
Some offer services like internet providers, hardware, and software developers and 
producers. Others play key roles in web security, commerce, and communications. 

 

3. Web 2.0 

Web 2.0 refers to the second stage in the development of the internet. It became a 
reality in the first decade of the 21st century. Before that, in the early days of the internet, 
users mainly used the net to read information online. That’s because the internet was slow, 
data lines were limited, and it wasn’t easy to put content on the internet without knowing 
how to program in a computer language called HTML. This was too complicated or time-
consuming for most people. But around the turn of the millennium, technological 
developments made it possible for anyone to post information in the form of stories, 
comments, pictures, or videos with just a few clicks of a mouse button. Over the next few 
years, this made the creation of social media like Facebook, YouTube, Instagram, and 
Wikipedia possible. Today, we take it for granted that everyone can generate and share 
content and read it. But this so-called participatory web hasn’t been around that long. Web 
2.0, which erased the line between content consumers and content creators, has only been 
around for the last ten or fifteen years. 

 

II. Social media 
Social media refers to websites and applications that allow users to create and share 

content with a network of other users in a virtual community. Users create personalized 
profiles and can interact with each other and communicate differently. They can share photos 
and videos, chat online, and create groups that connect people with similar interests. In many 
countries, social media like Facebook have become people’s most important information 
source. That’s why social media have also become important distribution channels for 
traditional media like newspapers, radio, and TV. Today, many consumers access media 
content through social media rather than going directly to a media outlet’s website or buying 
a newspaper. 

Examples of popular social media sites include Facebook, YouTube, WhatsApp, 
Twitter, Snapchat, TikTok, and Instagram. They are the market leaders almost everywhere. 
But some social media are not accessible in some parts of the world. For instance, Facebook, 
Instagram, and most Google services are banned in China. China has its social media 
platforms: WeChat can be compared to Facebook or WhatsApp; Weibo is reminiscent of 
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Twitter, and QQ is another Chinese instant messaging app. In other regions and countries, 
different social media platforms have become popular. People in Russia and some former 
Soviet Republics, for instance, like to use VKontakte and Odnoklassniki in addition to 
Twitter, Facebook, and Instagram. 

 

1. Advantage of Social media  

Social media sites are designed to be easy to use and are usually free of charge. Users 
do not need particular skills to create a profile and start posting content and interacting with 
other users. Social media makes it easy to keep in touch and find other users with similar 
interests. Because these sites encourage you to make connections, they can be used to find 
useful contacts and sources. Social media has great potential to make the internet a more 
dynamic and democratic place. Ordinary people, who are not professional journalists, have 
a channel where they can tell their stories and discuss what is on their minds. Social media 
also helps citizens become more engaged with the media and developments in society 
because we can all post comments and links about the information we see online. 

Social media sites are potentially valuable spaces for political activity. These sites 
enable direct communication between politicians and voters and allow voters to keep close 
track of the activities of politicians online. Reactions, debates, and conversations can take 
place quickly online. Social media can also be useful for informing, connecting, and 
organizing large groups of people fast. People can organize protests and demonstrations 
through social media and bring about change. That is why some governments dislike social 
media’s potential to challenge the status quo. But social media also enables governments to 
monitor citizens closely. It enables those in power to spread messages quickly, which in 
some cases includes propaganda and lies. 

2. Impact of social media on society 

Social media sites have been blamed for a loss of privacy. People often share more 
information about themselves online than they would feel comfortable doing offline. Some 
people are concerned that human interaction has shifted online, which could negatively 
affect communication. Since when communicating online, people are usually not physically 
present with those they are communicating with, social cues can be missed or social norms 
ignored. That means online discourse can be more negative and aggressive than in person. 
In addition, users often share rumors and lies without checking them beforehand. This can 
lead to disinformation spreading rapidly and becoming an avalanche of lies and hatred, 
which can severely impact society. However, social media also enables instant 
communication worldwide and have brought many people together who would not otherwise 
have been able to interact. The fact that anyone can access and create online content has the 
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potential to create democratic spaces online that foster freedom of speech and freedom of 
information. 

 

III. Safety and privacy 
1. Risks of social media 

A big risk connected to social media is the spread of disinformation. Social media 
users can easily be fooled into thinking that the information they see on the platforms is 
accurate. But since anyone can publish anything on social media, false information such as 
lies, rumors, and hoaxes is very common. Worse yet: much of this false information is 
deliberately created and spread to stir emotions like hatred, fear, or resentment of others, be 
they minorities, people with other political convictions, religious beliefs, or members of 
different ethnic groups. Social media works by getting users to share information, but since 
the platforms are public spaces, others can access this information. This means we must 
carefully consider the information we post about ourselves. If someone you do not know 
sees something personal you have posted about yourself, it can feel like an invasion of your 
privacy. Sometimes employers check the profiles of their employees or job applicants to see 
what kind of image they are presenting online. Other risks include posting when you go on 
holiday, which can make your home easy prey for burglars. Since it is easy to post things 
anonymously on the internet, cyberbullies and hackers can easily post insults or threats, 
gather information, or create fake profiles. The main risks here involve safety and privacy. 
Posting or entering information about yourself online can put you at risk of being hacked, 
which is when others gain access to your data without your permission. 

 

2. What is sexting? 

Sexting is intentionally 
sharing sexually explicit texts, 
images, or videos between 
individuals. This is often done by 
mutual consent. Sending intimate 
pictures or videos has become 
fairly common among teenagers 
or couples in many societies. 
People take sexually explicit 
photos or videos of themselves 
with their smartphones and send 
them to their partners. However, this comes with risks. If people send explicit content 
without having the prior consent of the person they are sending it to, this can be considered 
sexual harassment. Some people also share their partner’s explicit content without that 
person’s consent to show off in front of friends or groups they want to impress. This is a 
serious violation of trust. There are also many cases where someone shares intimate content 
after a romance has ended to hurt the former partner (“revenge porn”). When people share 
such intimate photos, texts, or videos to groups or publicly on social media without consent, 
the damage can be incalculable. The person in the picture or video whose trust was broken 
will feel violated and ashamed. Sexting can damage a person’s reputation and lead to 
discrimination or cyberbullying. The victims often develop anxiety or depression.  
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Sexting can even be a criminal offense, especially if minors are involved and if that 
sexually explicit material is shared with others. In most countries, it is a crime to possess 
sexually explicit material that depicts a minor. People can be prosecuted if they forward or 
share such pictures or videos within a social media group. People who receive such material 
and do not report or delete it also commit crimes. The role of educators is to sensitize social 
media users, especially minors, so that they can protect themselves. They should not share 
sexual material with others, not even their partners. The relationship could end, but the 
sensitive photos and videos will remain online forever. Once people share anything online, 
they lose control over it. It is out in the world indefinitely, and they cannot reign it back in. 
One day, their parents could see it as their boss, siblings, friends, or neighbors. This could 
be tomorrow or in ten or twenty years. So, if the content is the kind people would not want 
just anyone to see, they should not let it out of their hands. 

 

 

3. What is cyberbullying? 

Cyberbullying is a form of 
bullying and harassment through 
electronic means. Examples include 
spreading lies about someone on 
social media, sending hateful text 
messages, or threatening someone 
with phone calls. Cyberbullies 
target individuals. They attack their 
victim repeatedly to harm. 
Sometimes bullies act alone, and 
sometimes groups of people gang 
up on a victim.  

Cyberbullying can go hand in hand with offline bullying, for example, in school or 
at the workplace. It has a destructive effect. Targeted people feel under attack 24 hours a 
day, wherever they are. They feel powerless, scared, and ashamed. In many cases, shame 
prevents them from speaking up or seeking help. While cyberbullying is hard on the victims, 
it is relatively easy for perpetrators to launch an attack and keep it going. Sometimes they 
bully just for their amusement or to trigger a reaction. Sometimes, when a group of bullies 
targets a victim, everyone tries to outdo the other by striking repeated, harder blows. Even 
if each of these insults is relatively small, the cumulative effect can devastate the targeted 
person. 

To prevent cyberbullying, educators need to sensitize young people about the harm 
it can do, about ethical behavior on the internet, and about communicating respectfully and 
responsibly. Unethical behavior online influences how we behave towards each other 
offline. It can poison our relationships and erode trust. It is essential to understand that 
everyone plays a role in stopping cyberbullying. Victims should speak up as soon as the 
bullying starts before things spin out of control.  

They should take screenshots to secure evidence or save offensive e-mails. The 
offenders must reflect and understand that their behavior is harmful and may even be liable 
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for prosecution. Bystanders and observers should know that they should step in and clarify 
that cyberbullying is unacceptable. 

 

4. What is hate speech? 

While cyberbullying 
targets individuals, hate speech is 
often aimed at groups and 
members of groups minorities, 
who generally have less power in 
society. Hate speech attacks 
people based on attributes like 
race, religion, ethnic origin, 
national origin, gender identity, 
sexual orientation, or disability. It 
uses different expressions, including insults, defamation, degradation, and threats.  

The definition of “hate speech” and its laws vary from country to country. Hate 
speech occurs both off- and online. Online, it is conveyed through text, images, memes, 
audio, or videos.  

Hate speech is problematic both for individuals and for societies. Being a victim of 
hate speech is stressful, traumatic, and can be a blow to one’s self-esteem. Victims of hate 
speech sometimes withdraw completely from public forums because they feel marginalized. 
Hate speech looks for scapegoats, creates social divisions, and wipes out empathy. So, in 
addition to making the lives of minority groups difficult or even destroying individual lives, 
hate speech can erode a society from within by creating a climate of fear and hatred. While 
some haters voice their anger loudly, people who disagree with them often remain silent out 
of fear of becoming victims themselves. The more people remain silent, the higher the 
danger that the haters influence public opinion and, ultimately, the political agenda. Hate 
speech can lead to a polarized society where respectful dialogue is no longer possible.  

The first step to countering hate speech is exposing it as such, scrutinizing hateful 
arguments, and unmasking the intentions of the hater. Educators can train others on how to 
promote respect on- and offline. They can encourage toned-down, unemotional language, 
facts, humor, or counter-arguments to tackle hate speech. And they can train others how to 
create and promote a climate of tolerance and respect. 

 

5. Online disinhibition effect? 

The online disinhibition effect suggests that people’s online behavior is often 
different than when dealing with someone face-to-face. Some people do not feel ashamed 
when behaving immorally or violating common rules of decency, politeness, courtesy, and 
respect online. This disinhibition can happen quickly on social media because people can 
often be anonymous or hide behind technology. Humiliating pictures or memes about others 
can be posted with a few clicks. It is easy to insult someone publicly on their timeline, use 
emotionally charged, hostile language, or even bully or threaten a person online. There seem 
to be few consequences. Very often, actions cannot even be linked directly to a perpetrator. 
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Being invisible, not having eye contact with the target of their hostility, and not being 
confronted directly with others’ reactions can bring out exceedingly unethical behavior. 

 

6. Digital footprint 

 It is saved as digital data when you type something on your 
computer or take a picture with your phone. Digital data can be 
stored, transmitted, and processed repeatedly without losing 
quality. In addition to the digital data, for example, the photo, your 
online actions also generate so-called metadata. This is data about 
your data. In the case of a digital photograph, the metadata could 
include when and where you took the picture and with what shutter 
speed and aperture. This information is automatically generated 
and stored.  

When you use a computer or cell phone, you leave data 
tracks. They can include your phone number, your computer’s 
serial number, the country you live in, the language you use, your 
browser history, your fingerprint, or the location where you access 
a Wi-Fi network and the internet. Some smartphone apps and 
social media platforms also record when you use them and for how 
long. In addition, some of them store your address, your e-mail 

address, your contact list, your photos and videos with all their metadata, your list of friends 
and groups, your likes, shares, and messages. They store it to tailor their services to your 
preferences, but they may also sell this metadata to advertisers, governments, or interest 
groups.  

Data and metadata say a lot about you. The technology you use makes it possible to 
trace or identify you. This data may also reveal some things you might rather keep private. 
Your Facebook likes, for instance, can often reveal private beliefs and personality traits or 
identify your political viewpoint or sexual orientation. These data traces are easy to tap into. 
Ultimately, your life becomes more and more transparent to those who store, buy, or even 
steal your data. 

 

7. What role does my data play in social media’s business model?  

Social media platforms are businesses. They face the same risks as other businesses 
and have operating costs to cover. They must pay their employees, like developers, 
programmers, and web designers. So how can they cover these costs if their services are 
free? And what role does your data play in all of this?  

When you agree to a social media platform’s terms of service, you also agree to its 
privacy policy, which describes how the platform will use your data. Most social media 
platforms monetize your data. Whoever is interested in your likes, dislikes, opinions, and 
interests can pay to get your data. There is no way for you to know who buys this data. But 
many businesses, advertisers, institutions, insurance companies, political parties, 
governments, secret services, and law enforcement agencies find the data interesting enough 
to pay good money.  
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Another way that social media companies make money is through advertising. These 
platforms have millions of users, so millions of pairs of eyes see their content. This attention 
is capital that social media platforms can market. They generate income by allowing 
companies to advertise on their site, and the advertisers hope to profit from getting all those 
views. Algorithms tailor what advertisements are shown to different users. These algorithms 
scrutinize users’ data and metadata to identify which products or lifestyles appeal to these 
individuals or which ideologies they follow or show a possible interest in. 

 

8. What is cyber security? 

Security means being free from danger or external threats. Cyber security, or digital 
security, means being safe on the internet: your data, your accounts (social media accounts, 
online banking), and devices (smartphone, computer, etc.) are protected against criminal 
activities and other external threats. You can stay more digitally secure by using special 
software or activating certain website features. For example, you can use anti-virus software, 
set up firewalls, and install protection against spyware. You can increase the security of your 
smartphone by adding a secure mechanism to unlock it: a pin, a pattern, or your fingerprint. 
Social media platforms feature adjustable settings that can improve account and data 
security. The default settings are often the most convenient, but they are usually also the 
least secure. For instance, you can log in to Facebook with your name and password. But a 
safer method is to use two-factor authentication. 

 

9. What is cyber safety? 

While security relates to outside threats, safety refers to yourself and how you can 
prevent harm or accidents. It refers to your capacity to protect yourself and, at the same time, 
not cause harm to others. 

Cyber safety refers to accident prevention being protected on the internet and social 
media. Safety risks include online bullying, scams, unintentional viewing of explicit or 
violent content, or online dating pitfalls. To stay safe on social media, you should 
communicate respectfully and act responsibly when sharing information. Another part of 
cyber safety is knowing about your digital rights, such as the right to control the commercial 
use of your name, likeness, image, or other factors that can identify you. These rights are 
known as personality and publicity rights. Safety also involves respecting your privacy and 
the privacy of others. 

 

10. Privacy 

When something is private to you, it usually means that it is special to you in some 
way or that you regard it as a sensitive subject that you do not want everyone else to know 
about. The boundaries and the content of what is considered private vary among cultures 
and individuals, but there are areas that many people consider private. You may want to keep 
sensitive issues to yourselves, such as whom you love, aspects of your sexuality, what you 
fear, or other secrets. You may also not want everybody to know where you lived, when you 
were born, and how much money you earned. Privacy is a person’s ability to conceal parts 
of himself or herself from others, and that includes information that he or she would rather 
others not know about. Privacy issues arise on social media, not only when adjusting your 



Lesson 35 Internet, social media safety and privacy Part 3: ICT Ethic 

335 

privacy settings but in every interaction you have. The more information you post on social 
media, the more time you spend on it, the less private you are, and the more data about 
yourself you give away. Your data will be stored and shared; you can’t control what 
businesses, governments, and secret service agencies use that data for. Even if you think you 
have nothing to worry about today, remember that sometimes circumstances change. But 
your data will be stored forever, and you have no control over what is done with it and no 
way to erase it. 

 

If people took privacy seriously, they would have to stop using social media 
altogether. But that would kill the fun of participating in the online world. If you want to 
enjoy social media and benefit from the opportunities the internet offers, you must be active 
and disclose some information. The privacy paradox describes the trade-off between privacy 
and self-disclosure. On the one hand, you want privacy and to protect your personal 
information, but at the same time, you would like to enjoy the benefits of social media. For 
instance, if you want to connect with old friends, you have to make your profile searchable 
by providing your real name or a recognizable picture of your face. Are you willing to give 
up that part of your private information? All social media users have to make these kinds of 
decisions all the time: what degree of openness are you comfortable with, and what 
information would you rather keep private? Remember, whatever private information about 
you is out there forever. The internet never forgets. 

 

11. How can you stay safe online? 

Always think carefully about what you share online. Many social networks will allow 
you to adjust your privacy settings to restrict the number of people who can see what you 
post. There are also blocking functions that allow you to block certain users. Make sure you 
use strong passwords with at least eight characters, a mix of upper and lower-case letters, 
numbers, and symbols, and always keep them secret. If you don’t, you risk getting hacked, 
and someone else can post on your page pretending to be you. If you are targeted online or 
see another user being targeted, take a screenshot and report the incident to the social 
network or website. 
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1. Password 

Password is a secret word or expression used by authorized persons to prove their 
right to access, information, etc., a word or other string of characters, sometimes kept secret 
or confidential, a user must supply that to gain full or partial access to a computer, computer 
system, or electronic device. 

Hackers and computer intruders use automated software to submit hundreds of 
guesses per minute to user accounts and attempt to gain access. These tools use lists of 
dictionary words to guess the password sequentially. Some tools add common symbols, 
numbers, or signs that may be added to the password to make it more complicated. 

Dictionary hacking tools that use an English dictionary list easily find words in that 
dictionary. If the simple word doesn’t give access to an account, the device modifies the 
submission and tries other iterations of the same word. 

For example, a Dictionary hacking tool would attempt these iterations of the word 
Dog: 

Dog   Dogs  Dogcatcher  Dogcatchers 

Dogberry  Dogberries Dogma   Dogmatic 

Dogmatized  Dog1  Dog2   Dog3Dog 

Password-guessing tools submit hundreds or thousands of words per minute. If a password 
is anything close to a dictionary word, it’s incredibly insecure. When a password does not 
resemble any regular word patterns, it takes longer for the repetition tool to guess it. 
Passwords with personal information, such as your birthdate or street address, are easy 
targets for hackers. 

To keep your accounts secure, make a hard guess password and store it in a password 
manager so you won’t forget. A strong password is more resistant to guessing, so it’s 
unlikely to be found in a brute-force dictionary hack. 

The best way to create a secure password is to start with a simple password and turn 
it into a complex one. 

The table below shows examples of a simple password progressively made more 
complex. The first column lists simple words that are easy to remember and are found in the 
dictionary. The second column is a modification of the first column. The last column shows 
how the simple password is converted into one that is harder to figure out. 

Weak Password Better Password Strong Password 
kitty 1Kitty 1Ki77y 
susan Susan53 .Susan53 
jellyfish jelly22fish jelly22fi$h 
smellycat sm3llycat $m3llycat 
allblacks a11Blacks a11Black$ 
usher !usher !ush3r 
ebay44 ebay.44 &ebay.44 
deltagamma deltagamm@ d3ltagamm@ 
ilovemypiano !LoveMyPiano !Lov3MyPiano 
Sterling SterlingGmal2015 SterlingGmail20.15 
BankLogin BankLogin13 BankLogin!3 
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Here are other examples of password variations that purposely avoid using complete 
English word patterns: 

Dog.lov3r   dOG.lov3r   i7ovemydog!!   

sn00pdoggyd0G  Karm@beatsDogm@  C@ts-and-Dogs-Living-together 

d0gsaremybestfr13nds 

By injecting numbers and special characters instead of letters, these passwords take 
exponentially longer for a dictionary program to guess. 

 

2. Safety Privacy settings on social media 

To keep your safety and privacy on social media, you should know some points about 
privacy settings on your social account. Here is some question you should answer  

Settings 

ü Security settings: How do I log in and out securely and keep other people from logging into 
my account?  

ü Privacy settings and tools:  Who can see my stuff? Who can contact me? Who can find me? 
Timeline and tagging: Who can add things to my timeline? How can I manage tags?  

ü Blocking: How can I block certain users or their invitations?  
ü Reporting: How can I report other users to Facebook? 

Information 

ü Friends: How do I divide friends into groups? What rights do they get? 
ü Pages and feeds: How can I find information via pages and feeds? 

Creating 

ü Pictures: What pictures can I share? What about the other people in the images? 
ü Pages: How can I create a page, and what can I do with a page? 
ü Events: How can I create an event, and how do I manage this event? 
ü Groups: How do I create a group and control who has access to it? 
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• The information on the internet is stored on servers and hard drives worldwide. 
That is why it is almost impossible to delete information from the internet, 
although it can be difficult to find. The fact that “the internet never forgets” may 
be worth considering before posting compromising information or pictures. 

• Web 2.0 refers to the second stage in the development of the internet. It became 
a reality in the first decade of the 21st century. 

• Social media refers to websites and applications that allow users to create and 
share content with a network of other users in a virtual community. 

• A big risk connected to social media is the spread of disinformation. Social 
media users can easily be fooled into thinking that the information they see on 
the platforms is accurate. 

• Sexting is intentionally sharing sexually explicit texts, images, or videos 
between individuals.  

• Cyberbullying is a form of bullying and harassment through electronic means. 
Examples include spreading lies about someone on social media, sending 
hateful text messages, or threatening someone with phone calls. 

• Hate speech is often aimed at groups and members of groups minorities, who 
generally have less power in society. Hate speech attacks people based on 
attributes like race, religion, ethnic origin, national origin, gender identity, 
sexual orientation, or disability. It uses different expressions, including insults, 
defamation, degradation, and threats. 

• Digital footprint refers to one’s unique set of traceable digital activities, actions, 
contributions, and communications on the internet or digital devices. 

• Cyber safety refers to accident prevention being protected on the internet and 
social media. 

Summary 

1. What is Web 2.0? Until nowadays, how many versions of the web? 
2. What is social media, and what is its advantage? 
3. How does social media impact society? 
4. What is cyberbullying? 
5. What is cybersecurity? 
6. What is a strong password? Describe how to make strong passwords. 

Questions 
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Introduction: 
Online resources are all sourced from the original owners. Some resources are free to use, and 
some are paid. It is illegal to copy and edit without the original owner's permission. At the end of 
this lesson, you will be able to: 

ü Understanding of Copyright, licenses, and Digital Piracy 
ü Understanding of the Type of licenses 
ü Understanding of digital piracy 

When you have learned this lesson, you learn: 

I. Software license 
II. CC Licence 

III. Digital Piracy 

Copyright, licenses, and Digital Piracy 

Lesson 36 
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Lesson 36 Copyright, licenses, and Digital Piracy 
I. Software Licenses 

In studying or teaching knowledge of information technology and communication 

related to computers, one should study what kind of computer programs should be studied 

to benefit society and not affect the morality of life. 

 

There are two types of computer software for use: 

• Close Source or License: If you want to use these programs, you have to spend 

money to buy a license from the manufacturer to install and use on your computer. 

No distribution without the permission of the owner or original owner. E.g., 

Microsoft (Microsoft) computer programs such as MS Windows and MS Office, ... 

When you install, you need to have a code (Serial keys) to install this program.  

• Open-Source Software: A program of volunteer communities worldwide designed 

to be distributed to all users for free, legal, and free use. 

Example: Linux operating system, Office software, OpenOffice. Etc. Today, in 

Cambodia, we have also developed many Khmer language programs using Khmer Unicode, 

translating many open-source programs such as Khmer operating system (OpenSUSE, 

Ubuntu Linux), Office (OpenOffice), Internet Explorer (Firefox), Email Thunder 

(Thunderbird) and many other Khmer language software in Linux and Windows operating 

systems. You can download those programs through the website www.khmeros.info or the 

Ministry of Education, Youth and Sports website www.moeys.gov.kh. 

II. CC Licenses 

Creative Commons licenses give everyone, from individual creators to large 

institutions, a standardized way to grant the public permission to use their creative work 

under copyright law. From the reuser’s perspective, the presence of a Creative Commons 

license on a copyrighted work answers the question, “What can I do with this work?” 
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1. The Creative Commons License Options 

There are six different license types, listed from most to least permissive here: 

•  CC BY: This license allows reusers to distribute, remix, adapt, and 

build upon the material in any medium or format, so long as attribution is given 

to the creator. The license allows for commercial use.  

CC BY includes the following elements:  

BY  – Credit must be given to the creator 

•  CC BY-SA: This license allows reusers to distribute, remix, adapt, and 

build upon the material in any medium or format, so long as attribution is given 

to the creator. The license allows for commercial use. If you remix, adapt or 

build upon the material, you must license the modified material under identical 

terms. 

CC BY-SA includes the following elements: 

BY  – Credit must be given to the creator 

SA  – Adaptations must be shared under the same terms 

•  CC BY-NC: This license allows reusers to distribute, remix, adapt, and 

build upon the material in any medium or format for non-commercial purposes 

only, only so long as attribution is given to the creator.  It includes the following 

elements: 

BY  – Credit must be given to the creator 

NC  – Only non-commercial uses of the work are permitted 

•  CC BY-NC-SA: This license allows reusers to distribute, remix, 

adapt, and build upon the material in any medium or format for non-commercial 

purposes only, and only so long as attribution is given to the creator. If you 

remix, adapt or build upon the material, you must license the modified material 

under identical terms.  
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CC BY-NC-SA includes the following elements: 

BY  – Credit must be given to the creator 

NC  – Only non-commercial uses of the work are permitted 

SA  – Adaptations must be shared under the same terms 

•  CC BY-ND: This license allows reusers to copy and distribute the 

material in any medium or format in unadapted form only so long as attribution 

is given to the creator. The license allows for commercial use.  

CC BY-ND includes the following elements: 

BY  – Credit must be given to the creator 

ND  – No derivatives or adaptations of the work are permitted 

•  CC BY-NC-ND: This license allows reusers to copy and distribute 

the material in any medium or format in unadapted form only, for non-

commercial purposes, and only so long as attribution is given to the creator.  

CC BY-NC-ND includes the following elements: 

BY  – Credit must be given to the creator 

NC  – Only non-commercial uses of the work are permitted 

ND  – No derivatives or adaptations of the work are permitted 

 

2. The Creative Commons Public Domain Dedication  

 CC0 (aka CC Zero) is a public dedication tool that allows creators to give 

up their copyright and put their works into the worldwide public domain. CC0 allows 

reusers to distribute, remix, adapt, and build upon the material in any medium or format 

with no conditions. 

III. Digital Piracy 

Digital content can be expensive, especially in high-end software packages. 
Sometimes this content costs several thousand dollars. But not everyone can afford these 
prices. If you have spent time on the internet, you have heard of digital piracy. Digital piracy 
is a form of copyright infringement. However, piracy is not limited to just software. Piracy 
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can include movies, music, books, and games as well. There are many consequences of 
digital piracy. 

Digital piracy is downloading and/or distributing copyrighted material and 
intellectual property without paying for it. And it is most certainly an illegal act. Digital 
piracy is a violation of federal copyright laws. It can result in steep fines and imprisonment. 
Think of digital piracy as a form of digital theft. Digital piracy costs companies billions of 
dollars each year. However, it is not just about financial loss. 

1. Why Does Piracy Exist? 

Not everyone who uses the internet is a computer pirate. Most people abide by the 
laws and pay for the content and software they use. However, some users believe software, 
movies, music, and games should be freely available. Others do so out of financial hardship. 
But it is not always just about the money. 

• The most common reason for digital piracy is the unwillingness to pay. People want 
things for free. Torrent websites and P2P sharing make it easier than ever to 
download. You can obtain everything from software to movies and books. And in 
many cases, it can take only a few minutes to download them. 

• In many cases, people download illegally due to financial hardship. They cannot 
afford to buy it. Many people do not have the finances available to purchase legally. 

• Another common reason is the belief that companies have enough money already. 
They may believe they have the right to freely distribute to the less fortunate and 
allow everyone to enjoy or use it. 

• Some people do it for financial gain. Hackers download pirated content to resell it, 
making a profit. 

• Hackers and social engineers use pirated content to spread malware and infect a 
user’s system. 

• One-time use is another excuse for pirating copyrighted content. Users may want to 
see if a movie is good before watching it at the theatre. Similarly, one may want to 
download software to run a singular task. After using it one time, they delete it or 
uninstall the software. 

• Some people do not see digital piracy as theft. They do not view digital content the 
same as they do something physical. 

2. The Consequences of Digital Piracy 

The consequences of digital piracy can be high. Imagine, for a moment, that you are 
an aspiring songwriter and musician. You invest an entire year writing your first album. 
Your new album is finally produced and hits the market. You begin making a modest amount 
of money. However, you discover that your album has been copied and distributed for free 
over the internet. Now you begin losing money. Due to this financial loss, you cannot afford 
to write a second album. 

Additionally, you discover someone selling your album for a reduced price. As a 
result, not only are you losing money, but someone else is profiting from your work. Without 
copyright laws, you would have no legal recourse. 

Aside from legal trouble, digital piracy can also have implications for cybersecurity. 
As stated above, hackers can use pirated content to spread malware, trojans, and viruses. 
Companies that use pirated software open themselves up to copyright violation and 
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infringement. They also expose their networks to potential malware or virus infection. 
Hackers then use these infected systems to launch an attack or to mine cryptocurrency. 

Torrent downloading comes with its own risk. Because those who download are also 
distributed, IP addresses are public and can be easily tracked. Because pirated software 
cannot be updated, this opens the system to attack through vulnerabilities. Security patches 
are not installed because the update server cannot validate the software. Pirated operating 
systems can have critical services disabled. Firewalls and updates can be disabled, resulting 
in open vulnerabilities and less security. 

 

3. Protecting Yourself 

It can be tempting to pirate digital content. But the risks often outweigh the 
benefits. You can get into serious legal trouble if caught, resulting in jail time and serious 
fines. But legal trouble is not the only threat from digital piracy. Malware and 
vulnerabilities can put systems at serious risk of attack. While it may seem harmless, 
piracy costs billions yearly in damages and loss. As a result, that cost impacts consumers 
through increased prices. 

The only way to protect yourself from piracy is not to download illegally. Only use 
trusted software from trusted sites. Do not accept copies from friends or unfamiliar 
sources. If you cannot afford it, look into trial versions or free software. Open-source 
software is a great free alternative to piracy. Use streaming services to listen to music and 
watch movies. Subscriptions are becoming more affordable as time passes. These steps can 
spare you much trouble in the end. The consequences of digital piracy are very real. Only 
you can protect yourself from the dangers. 
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• Close Source or License: If you want to use these programs, you have to spend money 

to buy a license from the manufacturer to install and use on your computer. No 

distribution without the permission of the owner or original owner. E.g., Microsoft 

(Microsoft) computer programs such as MS Windows and MS Office,... When you 

install, you need to have a code (Serial keys) to install this program.  

• Open-Source Software: A program of volunteer communities worldwide designed to be 

distributed to all users for free, legal, and free use. 

• Creative Commons licenses give everyone, from individual creators to large 

institutions, a standardized way to grant the public permission to use their creative 

work under copyright law. From the reuser’s perspective, the presence of a 

Creative Commons license on a copyrighted work answers the question, “What 

can I do with this work?” 

• Digital piracy is downloading and/or distributing copyrighted material and 

intellectual property without paying for it. And it is most certainly an illegal act. 

Digital piracy is a violation of federal copyright laws. It can result in steep fines 

and imprisonment. Think of digital piracy as a form of digital theft. Digital piracy 

costs companies billions of dollars each year. However, it is not just about 

financial loss. 

Summary 

1. How many types of software licenses? Describe it. 
2. What is a CC license? 
3. What is a logo mean?  
4. What is a logo mean?  
5. What is Digital piracy? Describe how to protect yourself. 

Questions 
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Introduction: 
This lesson introduces you to computers and their role in daily life, and defines what  
it means to be computer literate. The lesson also focuses on the tyes of a computer. At the 
end of this lesson you will be able to: 

ü Understading to computer and type of computer 
ü Classify type of computer 
ü Understanding main 4 Computer Architecture layer 

In this lesson you will learn: 
I. Computer 

II. 4 Computer Architecture layer 
III. Information processing cycle (IPOS) 

Introduction to Computer 

Lesson 37 
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Lesson 37 Introduction to Computer 
I. Computer 

1. What is Computer? 

Computers are everywhere. During a typical day, you might use your phone to message 

a friend about meeting for lunch and listening to music as you walk to class. Although you 

might not realize it, you also use a computer to withdraw cash from an automated teller machine 

(ATM), change the temperature setting on a home thermostat, and turn on cruise control while 

driving a car. 

Depending on your job, you probably use computers to take a diner’s order at a 

restaurant, process a sale, or control a robot on a factory floor. 

A Computer is an electronic device that receives data (input), processes data,  

stores data and produces a result (output). Data is a collection of raw, unprocessed facts, 

including text, numbers, sound, images, and video. To perform tasks, a computer receives data 

through an input device such as a keyboard, processes the data, produces information on an 

output device such as a monitor, and stores the information on a storage device. When data is 

processed into a meaningful form, it becomes information. 

             
 

2. Type of Computer 

Although thousands of models of computers are available today, they can all be 

organized into three categories: Personal computers, Embedded computers, and Server 

computers. 

 

A. Personal computers 

A personal computer is a computing device that can perform activities independently 

and is designed to be used by one person at a time. Two types of PC are Desktops, Laptops, 

tablets, and smartphones. 
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B. Desktop computer 

A desktop computer is a computer that fits on or next to a desk, is designed to be 

stationary, and runs on power from a wall outlet. With a traditional desktop computer, the 

system unit, monitor, keyboard, and pointing devices are separate pieces of hardware. The 

system unit containing the processing components is called a tower, which usually stands 

vertically on the floor. Some cases are designed to sit horizontally on a desktop, under the 

monitor. The traditional desktop computer has been popular in offices, schools, and homes 

because it is economical and durable. 

 
 

C. Laptop computer 

A laptop computer (sometimes called a notebook) is a lightweight mobile computer 

about the size of a paper notebook that includes the system components, keyboard, pointing 

device, and display screen in a single unit. Laptops use a battery as a power source, but you can 

also plug them into a wall output to recharge the battery and power the computer. Many personal 

computer users prefer laptops to desktop computers because laptops are easy to carry and move, 

use less energy, and can fit almost anywhere, including on a user’s lap. In addition, you can use 

laptops without cables for power or peripheral devices, which reduces clutter. Laptops are 

especially popular with students and mobile workers, such as salespeople who can take their 

computers to classes, the library, meetings, and other out-of-office activities. 

 
 

D. Tablet Computers 
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A Tablet Computer is a one-piece handheld computer that typically includes a 

touchscreen. Like laptops, tablets run on battery power and can be plugged into a wall outlet. 

True tablets use a slate design; they are rigid and do not fold. Convertible tablets use a hybrid 

design that includes a swivel screen or removable keyboard so you can use the computer as a 

laptop or tablet. 

 
 

E. Smartphones 

Recall that a smartphone is a cell phone that includes many features of a computer, 

allowing it to run general-purpose computing applications. Smartphones connect wirelessly to 

the Internet; include built-in cameras, music players, and global positioning systems (GPSs); 

and let you send and receive phone calls, e-mail messages, and text messages. 

Many smartphones have touchscreens, though some include a small keyboard  

below the display screen or one that slides out from behind the display screen. 

 The main advantage smartphones offer over other mobile computing devices is 

communication. As a type of cell phone, the smartphone was originally designed for making 

and receiving voice calls—tools and features on a smartphone support phone calls. For 

example, smartphones include a small microphone and speaker for voice calls and a camera for 

video calls. 
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F. Embedded computer 

An embedded computer is a processor built into a household appliance or devices such 

as an ATM, navigation system, refrigerator, television, or other consumer electronics. The 

appeal and strength of an embedded computer are that it adds computing power to a device 

without needing intervention from a user. For example, a washing machine with an embedded 

computer can use power and water more efficiently than one without an embedded computer. 

Cars use many embedded computers. Features such as sensing when your car moves out of its 

lane or when a person or object is blocking your path as you back up are controlled by embedded 

computers. 

 
 

3. Understanding Servers and Other Large Computers 

You indirectly encounter other types of large computers in your daily life, including 

mainframes and supercomputers. For example, people who work for banks use mainframe 

computers to process financial transactions, including those for credit card purchases you make 

at stores and online. To bring you up-to-date weather forecasts, meteorologists access 

information provided by supercomputers.  

Servers, mainframes, and supercomputers are large computers because they are 

designed for more than one person, up to tens of thousands of people in many cases. Large 

computers need much more processing power, memory, and storage capacity to support that 

matter than personal computers. 

 

A. Servers Computer 

A Servers Computer a server is a computer that provides network services such as e-

mail to client computers. Some servers look similar to the tower used with desktop computers, 

while others look like racks containing cases of storage media. 

Servers are dedicated to handling data with minimal user interaction. They do not 

include optical storage drives, speakers, high-end graphics displays, or other peripherals that 
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make computers entertaining. Most include system components with no monitor, keyboard, or 

other peripherals for users to provide input.  

A server is usually dedicated to a single type of task. A Web server handles the 

exchange of information across the Internet. For example, an Internet service provider (ISP) is 

a company that uses Web servers to provide Internet access to subscribers for activities such as 

viewing Web pages, sending and receiving e-mail, and transferring files. Large corporations 

use enterprise servers to provide employees access to special software used to run the 

company’s business. Smaller businesses use file servers to share files and programs among 

employees.  

 
 

B. Mainframes Computer 

A Mainframes computer is a powerful computer designed to simultaneously process 

huge amounts of data for hundreds or thousands of users. Mainframe computers are larger and 

more expensive than servers and are typically located in climate-controlled, secure data centers 

to keep the processing components cool and the data safe. 

Typical tasks for a mainframe computer include processing payroll and billing 

operations for a large corporation, handling millions of credit card transactions for a bank, 

gathering and tabulating census information for the U.S. government, and scheduling flights 

for an airline. 

Although both servers and mainframes can process data for thousands of users, these 

types of computers differ in design and usage. Mainframes are designed to handle large volumes 

of data on their own, while servers transfer data around a network, responding to requests from 

client computers to retrieve, send, and store data. In fact, mainframes can store hundreds to 

thousands of times as much data as a server and access it much more quickly. Large 

organizations rely on mainframes to process and store records of data that are too large for other 
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computers. In contrast, organizations use servers to share data and provide services to other 

computers, especially for communication. 

 
 

C. Super Computers 

A supercomputer is also a very powerful computer distinguished by its processing 

capacity, especially its calculation speed. To be classified as a supercomputer, a computer must 

be one of the fastest computers in the world. 

Rather than using the quad-core processors that personal computers use, 

supercomputers have processors with a million or more cores. The extraordinary power of 

supercomputers is used primarily for scientific applications that need to perform complex 

calculations very rapidly, such as launching astronauts or robots into space. 

 
 

II. Four Computer Architecture layer  

A computer can be cut into four main layers, hardware, operating system, software, 

and users.  

The hardware layer is made up of the physical components of a computer. These are 

objects you can physically hold in your hand. Laptops, phones, monitors, keyboards, you get 



Lesson 37 Introduction to Computer Part 4 Computer Fundamental and Maintaining 

351 

the idea. In the next lesson, you'll learn all the computer components and how they work. You'll 

even be able to build your computer by the end of this module.  

The Operating system layer allows hardware to communicate with the system. Many 

different manufacturers create hardware. The operating system allows them to be used with our 

system, regardless of where they came from.  

The software layer is how we, as humans interact with our computers. When you use 

a computer, you're given a vast amount of software you interact with, whether a mobile app, a 

web browser, a word processor, or the operating system itself.  

The last layer may not seem like part of the system, but it's an essential layer of the 

computer architecture, the user layer. The user interacts with the computer, and she can do 

more than that. Users can operate, maintain, and even program the computer. 

 

III. Information processing cycle (IPOS) 

To perform tasks, a computer receives data through an input device such as a keyboard, 

processes the data, produces information on an output device such as a monitor, and stores the 

information on a storage device. The input and output devices connected to the computer, such 

as keyboards and monitors, are also peripherals. When data is processed into a meaningful 

form, it becomes information.  

 
If you work as a clerk in a store, you might use a computer to complete a sale for a customer as 

follows:  

• Input data: As you scan an item with a barcode reader, the computer records the name 

and code of the item.  

• Process data: The computer uses software instructions to process the data, the item 

name, and the code by looking up the price.  

• Output information: The computer displays the information, the name, and the item’s 

price on a screen and then prints it on a receipt.  
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• Store data and information: The computer temporarily stores the item name and code 

as it looks up the price and then permanently stores information about the sale on a hard 

disk, which is hardware for storing data.  

This series of steps in input, processing, output, and storage (IPOS) is often called the 

information processing cycle. You, the computer user, perform the input step first, and then 

the computer takes over to process the data. The computer often stores the data temporarily, 

displays the output, and then stores the information during the same stage in the cycle. 

 
 

 
 
 

• A Computer is an electronic device that receives data (input), processes data, stores 

data, and produces a result (output). 

• They can all be organized into three categories: Personal computers, Embedded 

computers, and Server computers. 

• A computer can be cut into four main layers, hardware, operating system, 

software, and users. 

• Series of steps of input, processing, output, and storage (IPOS) is often referred to 

as the information processing cycle. 

Summary 

1. What is a computer? How many types? Describe it. 

2. What are the four computer architecture layers? Describe it. 

3. What is the Full meaning of IPOS? Describe it. 

Questions 



1 

 

 

 

 

 

 

 

 

 
Introduction: 
To be able to troubleshoot and set up a computer, you must first know the essential 
components of a computer. At the end of this lesson you will able to: 

ü Understanding to Computer component 
ü Understanding to fucntion of each component 
ü Assembly a desktop computer 

In this lesson you will learn: 
I. Type of Hardware 

II. Processing Device 
III. Storage Device 
IV. Motherboard 
V. Power Supply 

VI. Cooling system 
VII. Computer Case 

VIII. Computer Assembly 

Computer Hardware 

Lesson 38 
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Lesson 38 Computer Hardware 
I. Types of hardware 

Computer hardware refers to the physical parts of a computer and related devices. The 

internal hardware parts of a computer are often referred to as components, and the external 

hardware devices are usually called peripherals. 

In this unit, you will learn more about the types of hardware found in a computer. These 

are: 

• Input 

• Output 

• Storage 

• Processing 

II. Input device 

1. Keyboard 

The keyboard is the most common input device for entering text and numbers into a 

computer. Keyboards can be built into the computer, as they are in mobile computers, attached 

using a cable plugged into a USB port or connected using a wireless connection. Figure 5.7 

shows a typical keyboard for a desktop computer, which includes special-purpose keys in 

addition to those for typing text and numbers. 

 
Like most keyboards, the one shown in Figure 2.6 arranges keys into groups. In the center 

are the standard alphabetic and numeric keys. Along the top are media keys, which you use to 

control media settings such as speaker volume. Below the media keys are function keys, which 

the software uses for special purposes. For example, most applications display Help information 

when you press the F1 key. To the right is the numeric keypad, which arranges keys so you can 

enter numbers quickly. In addition, the keyboard has modifier keys, such as the Alt key, which 

you hold as you press other keys to perform a task; navigation keys, which move the insertion 

point on the screen; and toggle keys, which can be on or off. For example, the Caps Lock key 
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is a toggle key. You press to type in all uppercase letters and then press it again to return to 

lowercase typing. 

Mobile computers have more limited keyboards that only provide essential keys for input 

tasks. This is because the keyboards on mobile computers are built into the system unit and 

therefore need to be compact. For example, the keyboard shown in Figure 2.7 does not include 

media keys or a numeric keypad. Mobile computer users who want these extra keys can attach 

a desktop keyboard through a wireless or wired USB connection. 

 
While laptop keyboards are built into the computer, other mobile devices use clip-on or 

onscreen, also called virtual keyboards. If the device has a touchscreen, you can touch the screen 

directly to use the onscreen keyboard.  

 

2. Pointing Devices (Mouse) 

A pointing device, sometimes called a pointing tool, is a hardware input device that 

allows the user to move the mouse cursor in a computer program or GUI operating system. 

Using a pointing device, you can point at or manipulate any object or text on the screen. For 

example, you could point at and select an icon from a list of icons using a pointing device. 

 
A computer mouse is a handheld hardware input device that controls a cursor in a GUI 

(graphical user interface) for pointing, moving, and selecting the text, icons, files, and folders 

on your computer. In addition to these functions, a mouse can also be used to drag-and-drop 

objects and give you access to the right-click menu. 
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For desktop computers, the mouse is placed on a flat surface (e.g., mouse pad or desk) 

in front of your computer. The picture is an example of a Logitech desktop computer mouse 

with two primary buttons and a wheel. 

Below is a list of all the computer mouse functions and options to give you an idea of 

all the mouse capabilities. 

§ Move the mouse cursor - The primary function is to move the mouse pointer on the 

screen. 

§ Point - Once the mouse is moved, you can point something out for another user or point 

to a digital object. For example, in a game, you can use the mouse to point a gun in the 

direction to shoot. 

§ Open or execute a program - Once you've moved the pointer to an icon, folder, or 

another object clicking or double-clicking that object opens the document or executes 

the program. Some programs even support triple-clicking. See our click page for further 

information on mouse clicking. 

§ Select - A mouse also lets you select text or a file or highlight and select multiple files 

at once. 

§ How to select or highlight multiple files and folders. 

§ Drag-and-drop - Once something is selected, it can be moved using the drag-and-drop 

method. 

§ Hover - Moving the mouse cursor over objects with hover information helps discover 

each object's function. For example, hover the mouse over the "hover" link to see an 

example. 

§ Scroll - When working with a long document or viewing a long web page, you may 

need to scroll up or down. To scroll, rotate the mouse wheel or click and drag the scroll 

bar. The mouse wheel can also be used as a button. See the IntelliMouse page for further 

information and functions of the mouse wheel. 

§ Perform other functions - Many desktop mice also have buttons that can be 

programmed to perform any function. For example, many mice have two side buttons 

on the thumb portion of the mouse. The button closest to the palm can be programmed 

to return to a browser’s previously viewed web page. 

 

3. Touchscreens 

Many mobile computers, especially tablets and smartphones, use touchscreens, which have 

a touch-sensitive surface that overlays the screen display and responds to the electrical impulses 

in your fingertips. In addition, computers provided at kiosks in public places, such as an airport, 
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have touchscreens to make it easy for users to enter data and select options. See Figure 2.13. 

Touchscreens are popular because they let you interact with a computer without using an external 

input device. 

 
 

4. Touchpads 

A touchpad (also called a trackpad) is a touch-sensitive surface that can convert the motion 

and position of your fingers to a relative position on the screen. Touchpads are usually 

rectangular and include left and right buttons that serve the same function as mouse buttons. 

Most laptop computers include a touchpad, so you can use the computer without attaching a 

mouse. Portable media players such as iPods include circular touchpads for selecting songs and 

other media. Touchpads are also available as separate devices for desktop computer users. Some 

touchpads accept the same motions you make on a touchscreen, such as sliding a finger to drag 

an onscreen object. Figure ## shows a variety of touchpads. 

 
 

5. Digital Pens devices 

Many mobile and desktop computers accept input from a stylus, a pen-like writing 

instrument that works with touchscreens. See Figure ##. You use a stylus for precise touch input 

by writing, drawing, or tapping on a screen. You often use a stylus to provide an electronic 

signature on a touch-sensitive pad in a retail location. 
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Other digital pens are devices you use to write or draw on any surface, though some require 

special paper. The digital pen captures your notes or sketches so you can transfer them to a 

computer. 

6. Game controllers 

The joystick and wheel are pointing devices you use when playing games or as adaptive 

equipment when you need an alternative to a mouse, requiring expert fine motor skills. A joystick 

consists of a plastic or metal rod mounted on a base. You can move the rod in any direction. 

Some joysticks have switches or buttons that you can manipulate to enter data or select options. 

A wheel is similar to a steering wheel; you use it to simulate driving a vehicle. See Figure ## 

Most wheels also include foot pedals for braking and acceleration. 

 
Other input devices used with games include musical instruments such as guitars and motion-

sensitive controllers such as dance pads and balance boards. 

 

7. Audio input device 

Audio input is sound entered into a computer and includes speech, sound effects, and music. 

Examples of audio input devices are microphones, portable music players, radios, and other 

hardware, such as electronic piano keyboards. Voice or speech input is a category of audio input. 

With the appropriate software, you can use voice-recognition devices such as built-in or external 

microphones to speak commands into the computer and enter text. External microphones are 

typically part of a headset, which includes one or two headphones for audio output and a 

microphone for audio input. See Figure ##. Mobile phones and hands-free navigation systems in 

motor vehicles use voice-recognition systems, as do devices that accept voice commands to 

control wheelchairs and other objects that increase mobility. 
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8. Video Input device 

When you capture still or moving images with a digital camera, they are stored digitally in 

the camera as the video input to the device. The images can also be used as the video input to a 

computer. After transferring the images to the computer, you can view and edit them with photo-

editing or video-editing software. Most tablets and smartphones include digital cameras, so you 

can skip the transferring step and take photos directly with your mobile device.   

A PC video camera or Webcam is a type of digital video (DV) camera you can use to send 

live images over the Internet, participate in video telephone calls, and send e-mail messages with 

video attachments. Most computers include built-in Webcams, though they are also available 

separately.  

 
Besides capturing images, you can use the cameras built into mobile devices to conduct 

video phone calls that allow you and your contact to see each other while you speak. See Figure 

##. 

 
 

9. Scanner 
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Scanners are devices that can change images into codes that the computer accepts as input. 

The quality of a scanner is measured by pixels per inch (ppi)—the higher the ppi number, the 

better the input image. Scanners are available in various sizes and types, including the following.  

§ Flat-bed scanner These devices convert printed documents and images into electronic 

objects you can store in a computer’s memory. You can then manipulate the documents 

and images. Flat-bed scanners resemble copy machines, with a glass surface where you 

place the material you want to scan. The text you scan is stored as a single object, which 

means you cannot edit it. 

 
§ Bar code scanners—A bar code is a matrix or series of lines with varying widths and 

heights representing letters and numbers. Figure 2.18 shows the type of scanner that reads 

bar codes printed on products, such as at a grocery store. Many mobile phones can also 

scan and read bar codes, especially Quick Response (QR) codes, configured as squares 

rather than lines. You might scan a QR code in a print ad with your mobile phone to 

display a product’s Web site. 

 
 

10. Biometric devices 

Consider the following scenario: You are going on a two-week vacation overseas— you are 

packed and ready to go, but you don’t need a wallet or credit card. You use your fingerprint as 

an input device to pay for your expenses. Such technology is called biometrics. 

Biometrics is a security technique using automated methods of recognizing a person based 

on a physical characteristic. Biometric devices consist of scanning hardware and software that 

converts the scanned physical information into a digital format. Additional software compares 
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the scanned information to a collection of stored biometric data. For example, if your fingerprint 

matches a stored image, you can use a computer or complete a transaction.  

Figure 2.19 shows a keyboard with a built-in fingerprint scanner, which you can use to 

identify yourself by swiping a fingertip over the scanner instead of entering a password, for 

example. 

 
In addition to identifying people based on fingerprints, biometric technology can identify 

people based on face, handwriting, or voice recognition. Other less common techniques use the 

retina (analysis of the capillary vessels located at the back of the eye), iris (analysis of the colored 

ring surrounding the eye’s pupil), hand geometry (analysis of the shape of the hand and length 

of the fingers), or vein (analysis of the pattern of veins on the back of the hand and the wrist). 

See Figure ##. 

 
 

III. Output Device 

An output device is any device that takes data stored on a computer and makes it available 

to the user in an easy-to-understand way. This data may be made available using pictures (such 

as on a monitor or printed to a page) or sounds (such as with speakers and earphones). The 

output devices can be divided into the following: 

• display devices – monitors (LCD, LED) 

• printers (Inkjet, Ink tank, Laser, 3-D) 

• data projectors (HDMI, VGA) 

• Audio Output device. 
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1. Display device 

A. Monitors 

All computer software is built around a visual representation of data, therefore                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                  

the monitor is one of the most important output devices for any computer. To check the quality 

of a monitor, we need to look at some important characteristics. 

These are: 

§ Number of pixels: Each pixel can be seen as a tiny dot of color on the monitor. Pixels 

are put together to create the picture we see on the monitor. The more pixels there are, 

the more detailed a picture can be. A good monitor is a full HD monitor with 1 920 

pixels across the monitor’s width by 1 080 pixels across the monitor's height. Some 

modern monitors can have up to 3 840 × 2 160 pixels (called 4K). 

§ Screen size: The size of a monitor is measured diagonally (that is, from the top left 

corner to the bottom right corner), and the size is given in inches. 

§ Refresh rate: The refresh rate of a monitor determines how quickly the image on the 

monitor can be updated with the newest information. Most monitors have a refresh rate 

of 60 Hz. 

§ Contrast ratio: A measure of the number of shades the monitor can show between its 

blackest black and brightest white. The higher the number of shades, the clearer and 

sharper the images will be, and the brighter and truer to life the colors will be. 

§ Aspect ratio: This is the screen's basic shape based on the width ratio to the height 

measured in inches. For example, if a screen is 16 inches (40,6 cm) wide and 10 inches 

(25,4 cm) tall, the aspect ratio is 16:10. 

§ Brightness: Brightness is the perception of how intense or bright the light coming from 

a screen is. The brighter the light, the more power will be drawn from the computer. 

 
 

B. Projectors 

Projectors use a bright light to project the content displayed on a computer monitor onto 

any flat surface. One example of where projectors are used is at the cinema. They use large, 
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high-quality projectors to display the movie on the screen in front of you. However, projectors 

can also be connected to computers at home or in office settings to display your computer’s 

screen on a wall or screen. 

 

There are two types of cables connecting video output devices: 

§ VGA – an analog video-only connection. 

 
 

§ HDMI – a digital video audio connection. 

 

Projectors provide the following advantages: 

§ they are easy to carry around 

§ they display the content from your computer at a large size. 

However, projectors also have disadvantages: 
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§ replacing the lamps is expensive 

§ low-quality projectors can show washed-out or faded images 

§ low-brightness projectors need to be placed close to the screen, decreasing the size of 

the image 

§ low-brightness projectors may require a dark room. 

The quality of a projector can be measured using three main factors: 

§ Lumens, which measure the brightness of the projector. 

§ Resolution, which determines how many pixels can be displayed. 

§ Contrast ratio, which measures the difference between the darkest and lightest parts of 

the image (that is, the contrast). 

 

2. Audio Output Devices 

Speakers are another type of output device. Speakers, headphones, and earbuds generate 

sounds, such as music or speech. Most computers have an internal speaker that produces low-

quality sound, which is adequate for the beeps, chimes, and other sounds software uses to alert 

you to software events, such as the appearance of a warning dialog box. You can attach speakers 

to a computer to produce high-quality sound, especially if you are playing games or watching 

movies. 

  

You use headphones or earbuds to hear music, voice, and other audio output privately. 

Headphones cover the ear, while earbuds rest inside the ear canal. When you plug a pair of 

headphones or earbuds into the computer, the internal or attached speakers are muted 

automatically. 

 

3. Printer 

A printer allows a computer to use data and output it to paper. There are three main types 

of printers. These are: 
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§ Dot-matrix printers: These printers use a series of small pins to strike a ribbon coated 

with ink, causing the ink to transfer to the paper at the point of impact. Dot-matrix 

printers are mostly outdated as personal printers are still used in banks and 

manufacturing businesses where it is necessary to use carbon paper to produce 

multiple copies of a document. 

§ Ink-jet printers: An inkjet printer operates by painting an image using a spray. This is 

done by hundreds of tiny nozzles that spray drops of ink directly onto the paper while 

moving across it. There are two types of ink-jet printers: continuous printers, usually 

used for commercial purposes, and on-demand printers. It is a good, all-around printer 

that is most commonly used for smaller jobs. They are, however, slightly less reliable. 

§ Laser printers: A laser printer is a popular printer for personal use. These printers 

use electrostatic technology. To start the process, the drum is given a positive electrical 

charge. While it rotates, the printer shines a narrow laser beam over its surface, drawing 

or projecting the letters and images to be printed as a pattern of electrical charges onto 

the surface of the drum. When the pattern is set, the drum is rolled in toner, which sticks 

to certain parts of the drum, that is, the image. When rolled over a piece of paper, this 

image is ‘burned’ into the paper with heat and pressure. When the printing is done, the 

electrical charge is removed from the drum, and the excess toner is collected. Laser 

printers are used for mass production printing because they are generally faster and more 

reliable but with worse quality prints. 

§ Ink-tank printer: These printers have print heads built into the printer and use an 

integrated bulk ink system. This means that ink is supplied continuously to the print 

head from an ink tank within the printer itself, and no expensive cartridges are needed. 

When the ink is finished, it can be refilled from an ink bottle. Because of this, printing 

costs are much lower. They produce low-cost, high-volume printing. 

§ 3D printers: 3D printing makes three-dimensional solid objects from a digital file. A 

3D-printed object is created by laying down successive layers of material until the object 

is created. Each of these layers can be seen as a thinly sliced horizontal cross-section of 

the eventual object, e.g., prosthetics and movie props. 

When evaluating printers, it is important to know what the printer will be used for because 

different printers are good at different things. 

Factors to consider when looking for a printer are whether it is black and white and/or color, 

how quickly it can print, and how much it costs to print a page. 
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Other factors to consider include the following: 

§ Dots per inch (DPI) measures how many dots a printer can print in one inch (or 2.54 

cm). The higher the DPI, the more detailed the prints. 

§ Pages per minute (PPM) measures how many pages of black text a printer can print in 

a minute. The higher the PPM, the faster the printer can print. 

 
IV. Processing Derive 

Processing devices are responsible for carrying out instructions and performing calculations. 

In this section, you will learn about the most important processing devices: 

§ central processing unit (CPU) 

§ graphics processing unit (GPU). 

  

1. Central processing unit (CPU) 

The central processing unit (CPU) is located inside the computer case on the motherboard. 

It is the part of a computer responsible for receiving and carrying out computer instructions 

(processing). 

Each CPU comprises multiple cores and independent processing units that can complete 

tasks independently (multithreading vs. multiprocessing). By adding multiple cores to a CPU, 

the processing power available to the computer can increase dramatically, with little heat gain. 

These types of processors are called multi-core processors. 

The CPU contains a control unit (CU) that coordinates all activities in the CPU and an 

arithmetic logic unit (ALU) where the logic operations and arithmetic calculations are carried 

out. 
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2. Graphics Processing Unit (GPU) 

The graphics processing unit (GPU) is located on plug-in cards on the motherboard or in the 

same chip as the CPU. It is responsible for creating and doing the calculations needed to display 

images on the screen.           

 

  
 

 

V. Storage device 

Storage devices all serve the same general purpose: to store data. Because of the 

differences in storage capacity, portability, and speed, different storage devices are generally 

used for different reasons. 

When evaluating any storage device, there are certain things that you must take into 

consideration. These are: 

• function – that determines whether you need an SSD or an HDD. 

• storage capacity determines how much information you can save on the device. 

• portability determines how easily it can be carried around and moved from one 

computer to another. 

• use – that determines what the storage device will most likely be used for. This includes 

transferring files and running applications. 

• volatility – determining if the device will lose the data when turned off. You do not 

want a device that will lose all data in case of a power outage. 

• reliability and durability – that determines how likely the device is to break down. 

In the following section, you will learn more about the differences between storage devices. 
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1. Types of storage devices 

A. Hard Disk Drive (Hdd) 

A computer hard disk drive is a secondary storage device consisting of magnetic disks 

or platters that rotate at high speed. Its main function is to store data permanently by controlling 

data’s positioning, reading, and writing onto the hard disk. 

Currently, modern hard drives can have huge storage space and are either internal 

(fixed) or external (portable). 

 

Of all types of computer storage devices, hard drives are the most popular for storing 

data because of their speed, capacity, and cost. Access times range from 6–11 ms, whereas a 

CD takes up to 500 ms to retrieve data. Computer ads often note the hard drive speed as 

revolutions per minute (rpm), which refers to how fast the platters spin when the read/write 

head is accessing data. The higher the rpm, the faster the read/write heads can locate specific 

data. Ads always mention the storage capacity of a hard drive, as this factor directly affects the 

computer’s price. Hard drives typically range from hundreds of gigabytes to a few terabytes of 

storage capacity. Current hard drives store data for pennies per gigabyte. 

B. Solid-State Drive 

Solid-state drives (or SSDs) are storage devices that, unlike hard drives, do not have any 

moving parts. Instead, SSDs use special floating gate transistors to store data electronically. 

Solid-state drives (SSDs) are generally faster than normal hard drives. Since SSDs have no 

moving parts, they are much quieter, more reliable, and more robust than HDDs. They also 

generate less heat, thus increasing their life span, and use less power than an HDD, which means 

they are more suitable for mobile devices. 
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C. External Hard Drives 

To increase the storage capacity of your computer, you can use an external hard drive, 

a separate, freestanding high-capacity storage device that you attach to a computer, usually 

using a USB port. Physical sizes and storage capacities vary, ranging from small portable 

devices designed to hold songs, photos, and other personal files, to larger desktop units designed 

to store copies of an entire computer system. External hard drives can use magnetic or solid-

state technology. 

 

 

D. Portable Storage Drives 

In addition to external hard drives, you can attach other types of drives to a computer 

and use them to store data. These removable drives are ideal for transporting data from one 

computer to another, adding storage capacity, and securing data away from a computer. 

Removable drives use the same solid-state technology as internal SSDs do. The smallest types 

are collectively called memory cards, frequently used with cameras, smartphones, portable 

media players, and other similar electronics. Figure 2.29 shows three types of memory cards, 

including a microSD card, which you insert into an adapter and then plug into a USB port or 
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memory card slot. You insert larger memory cards into a slot on a computer or mobile device, 

which usually accepts more than one type of memory card. 

 

Popular USB flash drives are another type of solid-state storage media. This small 

removable data storage device uses a USB connector to plug into your computer’s USB port or 

another electronic device. USB flash drives are also known as thumb drives, jump drives, flash 

drives, and USB sticks. Storage capacities of removable solid-state drives vary from a few too 

many gigabytes, which is usually enough to transfer documents, photos, music, and video files. 

If you use a USB flash drive with your computer, you should not remove it while the drive is 

in use. Disconnecting a USB flash drive while it is storing data can damage the files on the 

device. Windows and other operating systems provide an option to remove or eject removable 

storage devices safely. 

E. Optical Storage Devices 

Optical storage devices use lasers to read and write data on plastic platters that contain 

a metal layer, which reflects the laser light back to a sensor in an optical drive.  Desktop and 

laptop computers often have optical drives. See Figure 2.30. 

 

Optical media such as compact discs (CDs) and DVDs are called discs. The technology 

for storing data on CDs and DVDs is similar, though DVDs have much higher storage 
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capacities. CDs were popularized as media for sound recordings, whereas DVDs are often used 

for software, video games, and movies. A more recent type of optical storage media is the Blu-

ray disc (BD), which provides more than five times the storage capacity of a traditional DVD. 

CDs, DVDs, and BDs are available in read-only memory (ROM), recordable (R), and 

rewritable (RW) formats. For example, a rewritable CD is noted as a CD-RW. In addition, CDs 

are produced in a digital audio (DA) format, also known as audio CDs, which are used for music 

publishing and distribution. You can only use optical discs in the RW format to store (or write) 

data multiple times. After the information is written on an audio CD or any optical disc in the 

ROM or R format, it cannot be changed. 

 

VI. Motherboard 

The motherboard is the foundation that holds our computers together. It lets us expand 

our computer's functionality by adding expansion cards. It routes power from the power supply 

and allows the different parts of the computer to communicate. In short, it's a total boss.  

Every motherboard has a few key characteristics. First is the chipset, which decides how 

components talk to each other on our machine. The chipset on motherboards is made up of two 

chips. One is called the Northbridge, which interconnects stuff like RAM and video cards. The 

other chip is the Southbridge which maintains our IO or input/output controllers, like hard 

drives and USB devices that input and output data. In some modern CPUs, the Northbridge has 

been directly integrated into the CPU, so there isn't a separate Northbridge chipset. A chipset is 

a key component of our motherboard that allows us to manage data between our CPU, RAM, 

and peripherals. Peripherals are the external devices we connect to our computers, like a mouse, 

keyboard, and monitor.  

In addition to the chipsets, motherboards have another key characteristic that allows the 

use of expansion slots. Expansion slots also give us the ability to increase the functionality of 

our computers. If you want to upgrade your graphics card, purchase one and install it on your 

motherboard through the expansion slot. The PCI Express or Peripheral Component 

Interconnect Express is today's standard for an expansion slot. A PCIe bus looks like a slot on 

the motherboard, and a PCIe base expansion card looks like a smaller circuit board. The last 

component of motherboards that we'll discuss is the form factor.  

There are different sizes of motherboards that are available today. These sizes of form 

factors determine the amount of stuff we can put in it and the amount of space we'll have. The 

most common form factor for motherboards is ATX which stands for Advanced Technology 

eXtended. ATX comes in different sizes too. In desktops, you'll commonly see full-sized 



Lesson 38 Computer Hardware Part 4 Computer Fundamental and Maintaining 

371 

ATX's. If you don't want to use an ATX form factor, you could use an ITX or Information 

Technology eXtended form factor. These are much smaller than ATX boards. For example, the 

Intel NUC uses a variation of the ITX board, which comes in three board sizes; mini-ITX, nano-

ITX, and pico-ITX.  

When building your computer, you must consider what type of form factor you want. 

Do you want to build something small that can't handle as much workload? Or do you want a 

powerhouse workstation to which you can add many functionalities? The form factor will also 

play a role in what expansion slots you want to use.  

Understanding motherboards and their characteristics can be a big plus when fixing 

hardware issues since things like the type of RAM module or processor socket are dependent 

on the kind of motherboard they need to fit into. Let's say you're responding to a ticket for a 

user with video problems; you want to make it to their desk only to realize the graphics card 

you brought as a replacement doesn't fit the motherboard of their computer uses. Now, make 

sure that your motherboard can fit any replacement or upgrade that you want to implement. 

 
The functions of the motherboard are to: 

• provide a place for other devices or interfaces to be connected to (such as more memory 

or other graphics cards) 

• distribute power to the various components 

• act as a communication hub as the components send and receive information through 

the motherboard. 

1. RAM 

Let's talk about RAM, our computers' short-term memory. We use RAM to store data 

that we want to access quickly. This data changes all the time, so it isn't permanent. Almost all 

RAM is volatile, so once we power off our machines, the data stored in RAM is cleared.  

Remember that our computer is comprised of programs. To run a program, we need to 

make a copy of it in RAM so our CPU can process it. When you see a new phone or laptop that 

says it has 16 gigs of RAM, it can run up to 16 gigs of programs, meaning you can run lots of 
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programs simultaneously. When you type in a document, you're using RAM. If you've ever had 

the misfortune of working on an important paper presentation and losing power, you know the 

feeling you get when all your work is lost. It's a total bummer. This happens to anything with 

RAM, even video games. Have you ever gone on a long campaign without saving, then right 

as you get to a safe point, the power goes off on the console, and all the progress you've made 

is lost forever? It's not fun at all.  

You spend the next hour or so deciding whether or not just to rage quit the game 

completely and start all over from scratch. Not that this happened to me or anything, that was 

just a friend. Anyway, all of this happens because RAM clears its data.  

There are lots of types of RAM. And the one commonly found in computers is DRAM or 

dynamic random-access memory. Where a one or zero is sent to DRAM, it stores each bit in a 

microscopic capacitor. This is either the charge or discharge represented by one or zero. These 

semiconductors are put into chips on the RAM and store our data.  

There are also different types of memory sticks that DRAM chips can be put on. The 

more modern DIMM sticks, which usually stands for Dual Inline Memory Module, have 

different sizes of pins on them. We don't buy RAM based on the number of DRAM chips they 

have. They are labeled by the RAM capacity on a stake, like an 8 gig stick of RAM.  

After DRAM was created, RAM manufacturers built something called SDRAM, which 

stands for Synchronous DRAM. This type of RAM is synchronized to our systems' clock speed, 

allowing quicker data processing. Today’s system uses another type of RAM called double data 

rate SDRAM, or DDR SDRAM for short. Most people refer to this RAM as DDR, even shorter. 

There were lots of iterations of DDR, from DDR1, DDR2, DDR3, and now, DDR4. DDR is 

faster, takes up less power, and has a larger capacity than earlier SDRAM versions.  

The latest version, DDR4, is the fastest type of short-term memory available for your 

computer. And faster RAM means that programs can run faster and more programs can run 

simultaneously. Remember that any RAM sticks you use need a compatible motherboard with 

a different number of pins aligned with the motherboard RAM slots. Like with the CPU, ensure 

your motherboard is compatible with any RAM sticks you buy. Up next, we'll take a deep dive 

into motherboards. 
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VI. Power supply 

To get our computer to work, let's give it some power. Computers have a power supply 

that converts electricity from your wall to something usable. There are two types of electricity, 

DC, or direct current, which flows in one direction, and AC, or alternating current, which 

changes directions constantly. Our computers use DC voltage, so we have to have a way to 

convert the AC voltage from our power company to something we can use. That's what our 

power supply does. It converts the AC we get from the wall into low-voltage DC power that we 

can use and transmit throughout our computers. 

So most power supply units have a fan. They also have voltage information just 

normally listed underneath or on the side, cables to power your motherboard, and,  

To understand electricity, we must use the example of water pipes. Our sinks have a 

faucet that's connected to a pressurized water tank. When we turn on the faucet, water comes 

out. This is like how electricity works. Electricity flows when we plug an appliance into a wall 

outlet and turn it on. If we added more pressure to our water tank, would more water come out 

of it? The higher the pressure, the more water there will be. When it comes to electricity, we 

refer to the pressure as voltage. If you plugged that 120-volt appliance into a 220-volt outlet, 

the power came busting through and fried your charger. If it was the other way around, and a 

220-volt appliance was plugged into a 120-volt outlet, you wouldn't have seen the same 

outcome. You'll still be able to get electricity, but slowly. This would be similar to a water tank 

that is only half pressurized; it will draw water slowly. In some cases, though, this can 

deteriorate the performance of the device and cause damage in the long term.  

As a general rule, use the proper voltage for your electronics. We refer to the amount of 

electricity coming out as current or amperage, and it's measured in amps. We can think of amps 

as pulling electricity, as opposed to voltage, which pushes electricity. Amps will pull as much 

electricity as needed, but the voltage will give you everything. Look on the back of one of your 

device charges; you might see something like 1 or 2.1A. A device with 2.1 amps will charge a 

device faster because it can put current from a 2.1 amp than a 1 amp charger. Finally, the other 

important part of electricity that you will need to know is the wattage. Wattage is the number 

of volts and amps that a device needs. If your power supply has too low of wattage, you won't 

be able to power your computer, so make sure you have enough. This means you’ll only 

overpower your computer if you have a large power supply. Power supplies just give you the 

amount that your system needs. It's best to an error on the side of large power supplies. You 

can power most basic desktops with a 500-watt power supply. Still, suppose you're doing 

something more demanding on your computer, like playing a high-resolution video game or 
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doing a lot of video production and rendering. In that case, you'll likely need a bigger power 

supply for your computer. On the other hand, if you’re just browsing the Web, the power supply 

that comes with your computer should be fine. A bad power supply causes all kinds of issues. 

Sometimes the computer doesn't even turn on at all. Since power supplies can fail for lots of 

reasons like burnouts, power surges, or even lightning strikes, knowing how to diagnose power 

issues and replace a failed power supply is a skill every IT support specialist should have in 

their toolbox. 

  
 

 

VII. Cooling System 

Computer cooling systems are similar to car engine systems. A computer is an electronic 

device that performs millions of operations per second. This means the electronic components 

generate a lot of heat. Electronic components like transistors, diodes, and others require a 

certain temperature for optimum operation. 

The processor (CPU) of the computer generates heat from the operation it is carrying 

out. The heat is dissipated to a heat sink mostly made of aluminum. When the heat is on the 

sink, a fan blows fresh cool air to cool it down. 

There are 2 main types of computer cooling systems air and liquid. The cooling system 

is used to ensure that the heat generated by computer components is removed and a cooler 

environment is maintained. 

§ Air cooling system: These are the most common type of cooling systems in most PCs. 

They are also the cheapest. They have a heat sink to dissipate heat and a fan to blow 

fresh cool air into them. These types of systems make noise due to fan rotation.  

o Heat sink: is made up of high heat conductor material such as copper or 

aluminum. They have a large surface area and fins to absorb more heat to add 

even more surface. They soak the heat away from the processor.  
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o Cooling fans: after the heat has reached the sink surface, the fan blows away 

hot heat from away and brings in fresh cool air. In most air cooling systems, 

there are 2 fans near the processor and another on the power supply. 

 
 

Liquid cooling system: They are mostly used for high-end computers like gaming which carry 

out many operations. They are better at cooling and have less noise than the air type but are 

bulky in size and expensive. 

 
There are 4 functions of the Cooling system. 

§ Prevent overheating: the main work of a cooling system is to remove heat from system 

components to prevent overheating.  

§ To help achieve a high processing speed: the cooler the system is, the high chances of 

having a high speed. This is because the computer will be working to its optimum 

capacity. 

§ Reduce hardware breakdown: different components have a different threshold of how 

much heat they can bare. The cooler system ensures that all hardware components don’t 

break down. 

§ Prevent random computer shutdown: when the computer starts overheating, the 

sensor activates the fan, and the cooling system starts. If the cooling system doesn’t 

function well, the computer is set to shut down to prevent components breakdown. 

VIII. Computer Case 

The computer case is a metal and plastic box containing the computer's main 

components, including the motherboard, central processing unit (CPU), and power supply. The 

front of the case usually has an On/Off button and one or more optical drives. 
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Computer case form factors outline the type of motherboard that will fit in the case and 

the number of components that can be added to the system. Bigger cases can host bigger 

motherboards and accommodate more components such as disk drives, graphics cards, and 

more powerful cooling systems. 

There are two main categories of computer cases: desktop and tower. The desktop case 

is a singular form factor, while tower cases branch into different sub-categories: full tower, mid-

tower, and mini-tower. Full tower cases can host full-sized motherboards and are compatible 

with smaller ones. Mid-tower and mini-tower cases do not fit full-sized motherboards. Still, 

they can fit motherboards in mini and micro categories, such as mini-ATX and micro-ATX 

motherboards. 

 
IX. Computer Assembly 

Step1: choosing Component 

ü Processor (CPU) — Acts as the "brain" of your computer. In most builds, the CPU is 

usually the most expensive component. 

ü Motherboard — Serves as an interface between all of your computer's components and 

the processor. 

ü RAM — Random Access Memory. More RAM will provide more "workspace" to 

increase your computer's performance. Think about the RAM as a table: more RAM 

gives you more room for doing things on that table. Less RAM is like having a smaller 

table! 

ü Storage Drive — Stores data. You can buy a traditional hard disk drive (HDD) or opt 

for a more expensive solid-state drive (SSD) if you want an exceptionally fast drive. 

ü Power supply — Powers all of your computer's individual components. The power 

supply is also the interface between your computer and the wall socket you plug into. 

ü Case — Necessary for storing and cooling your components. 
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ü Graphics card — Used to render images on your computer. While most processors 

have a built-in graphics processing unit (GPU), you can buy a dedicated graphics card 

if you plan on gaming or using your computer for intensive editing. 

ü Cooling system — This includes case fans and coolers for specific parts and keeps the 

inside of your case at a safe temperature. Only necessary for gaming and editing PCs—

regular PCs should be fine with a stock cooler. 

 

Step2: Choose Tools for Installing 

ü A Philips head screwdriver (though a set of screwdrivers is preferable) 

ü anti-static wrist wrap 
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• Computer hardware refers to the physical parts of a computer and related devices. 
The internal hardware parts of a computer are often referred to as components, and 
the external hardware devices are usually called peripherals. 

• types of hardware found in a computer. 
o Input device 
o Output device 
o Storage device 
o Processing device 

• The motherboard, the foundation that holds our computer together. It lets us 
expand our computer's functionality by adding expansion cards. It routes power 
from the power supply and allows the different parts of the computer to 
communicate. 

• Computers have a power supply that converts electricity from your wall to 
something usable. 

• computer cooling systems are similar to a car engine system. A computer is an 
electronic device that performs millions of operations per second. This means the 
electronic components generate a lot of heat. Electronic components like 
transistors, diodes, and others require a certain temperature for optimum operation. 

• The computer case is the metal and plastic box containing the computer's main 
components, including the motherboard, central processing unit (CPU), and power 
supply. 

Summary 

1. How many types of hardware?  

2. What are the Input devices and Output devices? 

3. What is CPU?  

4. How many types of storage devices? 

5. What is a motherboard? 

6. When you turn off your computer, is data stored on RAM lost? 

Questions 



1 

Introduction: 
In order for all computers to communicate, software is required. This lesson will explain the 
types of software and how to install them. At the end of this lesson you will able to: 

ü Understanding to software 
ü Classify type of software 
ü Install and Uninstall software 

In this lesson you will learn: 
I. Type of software 

II. Type of Operating system 
III. Operating system task 
IV. Installing Operatng system 

Software and Operating system 

Lesson 39 
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Lesson 39 Software and Operating system 
I. Types of Software 

Suppose you shop for a computer at a retail store. In that case, the salesperson emphasizes 

hardware details, such as how quickly the data is processed into information (referred to as pro- 

cessing speed) and how much information can be stored (storage capacity.) However, hardware 

does not make a computer use the software installed on it. A computer is only a collection of 

electronic components in a case without software. 

 
The software provides the means to interact with the computer’s hardware by entering and 

receiving information through the user interface. The software on most personal computers has 

a graphical user interface (GUI), which displays pictures called icons and other visual 

elements that allow you to interact with data and execute commands. For example, to print a 

document created and stored on a computer, you might select an icon of a printer on the 

computer screen. The software on the computer sends the information necessary to print the 

document to a printer attached to the computer.  

Some software uses a command-line interface, which requires you to type text commands 

to interact with the computer.  

Although command-line interfaces require you to remember and type complex commands 

and allow little room for error, many advanced computer users prefer them because they offer 

precise control over system details. 

In contrast to command-line interfaces, graphical user interfaces are visually inviting and 

easy for novices to use with only basic training. However, they rarely let users directly access 

detailed technical settings as command-line interfaces do. 

A computer relies on two main types of software, application software, and system 

software.  

System software is the software that runs a computer and includes the operating system 

and utility programs. An operating system is a software that coordinates the resources and 
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activities on a computer. A utility program helps the operating system set up, maintain, and 

protect a computer. For example, you use a utility program when you connect your computer 

to the Internet, a worldwide system of linked computers. 

 
As you use a computer, system software works in the background to manage hardware and 

run other software,  

Called application software, which you use most directly to complete a specific task or to 

create something electronically. You can use application software to perform tasks such as 

writing a report, creating a video, viewing a Web page, or sending photos to a friend. In general, 

a computer runs system software to perform computer tasks, while you run application software 

to carry out your work or personal tasks. 

 
The table below compares operating systems and application software. 

 Operating System Application System 

Purpose 

Operates and controls 

computer hardware and runs 

application software 

Provides services and 

information directly to users 

Role in a computer system 

Coordinates the activities of 

users, application software, 

and hardware 

Performs tasks based on user 

input 

Typical tasks 

Monitors hardware Manages 

resources Controls input and 

output 

Processes data 

Creates documents such as 

reports and charts. Provides 

entertainment Displays 

photos 



Lesson 39 Software and Operating system Part 4 Computer Fundamental and Maintaining 

381 

Examples 

Windows 11  

Mac OS X  

Android 

IOS 

Microsoft Word (word 

processing) 

Adobe Photoshop (graphics 

editing) 

Mozilla Firefox (Web 

browser) 

 

II. Types of Operating Systems 

Operating systems fall into four categories that depend on the type of device for which they 

are designed: personal computers, mobile computing devices, servers, and devices other than 

computers. When you purchase a personal computer or mobile device, the operating system is 

already installed, so your preference for an operating system often determines the computers 

you can consider purchasing. 

 

1. Personal Computer Operating Systems 

Operating systems installed on a single computer are personal or desktop. These are 

considered single-user operating systems because one user interacts with the operating system 

at a time. They also multitask operating systems because they let you work with multiple 

programs simultaneously. For example, you can look up definitions on the Internet as you write 

a report and receive an e-mail on your laptop.  

Windows, Mac OS, and Linux are the three most popular personal computer operating 

systems. Currently, Microsoft Windows runs on more personal computers worldwide than any 

other operating system. For many years, the most widely used version of Windows was 

Windows XP, released in 2001. Windows 7, released in 2009, recently surpassed Windows XP 

in popularity. Windows 11, the most recent major version of Windows, was released in 2020.  

Windows became widespread because it ran on inexpensive personal computers created 

by various computer manufacturers. It retained its popularity because it is easy to use and 

personalize and runs more types of applications than other operating systems.  

In contrast, Mac OS runs only on Apple Macintosh computers. The current version of 

the operating system is called Mac OS X, where the X is the Roman numeral 10. Releases of 

Mac OS X up to 10.8 are named after big cats, such as Snow Leopard and Mountain Lions. 

Figure ## shows a Macintosh computer running Mac OS X Mountain Lion. Mac OS X version 

10.9 is called Mavericks, which marks the beginning of a change in the naming scheme from 

big cats to places in California. (Mavericks is a surfing location in northern California.)  
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Mac OS sets the standard for GUI operating systems. Mac OS X has developed a 

reputation among its users as being a very secure, reliable, and easy-to-maintain operating 

system.  

Linux is a personal computer operating system related to UNIX, an operating system 

first developed in the 1960s for large, special-purpose computers that scientists and 

programmers frequently use. Unlike Windows and Mac OS, which are proprietary operating 

systems, meaning they are owned and updated solely by their companies, Linux is released to 

the public as open-source software, meaning anyone can use, modify, and distribute it. 

Programmers around the world have collaborated on improving Linux and developing utilities, 

applications, and enhancements.  

Linux is available in versions called distributions, including commercial distributions 

such as Fedora, OpenSUSE, Ubuntu, and Mandriva. Distributions offered by noncommercial 

Linux communities include Debian, Slackware, and Gentoo. Figure ## shows Ubuntu (named 

after the African philosophy that encourages humanity toward others), which includes features 

similar to Windows and Mac OS.  

 
Some distributions of Linux, such as BSD, have command-line interfaces. All 

distributions offer the advantages of running on any hardware, providing excellent security, and 

being free to install and use.  

2. Mobile Operating Systems 

A mobile operating system is designed for small handheld computing devices such as 

smartphones or tablets. A mobile operating system includes features similar to a personal 
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operating system but is simpler and significantly smaller. A smartphone is a cell phone that 

includes many features of a computer, allowing it to run general-purpose computing 

applications. Larger than smartphones, tablets are one-piece mobile computers that typically 

include a touchscreen, a screen you touch to interact with the GUI. Mobile operating systems 

are designed to fit into the limited memory of mobile devices and work well with mobile 

hardware and features such as touchscreens, navigation systems, and speech recognition.  

Four popular mobile operating systems include iOS, and Android, which are designed 

for smartphones and tablets. iOS is a version of Mac OS X written for Apple’s mobile devices, 

including iPhones and iPads. Google developed Android as an open-source operating system 

designed to run on many smartphones and tablets. Android is derived from Linux.  

 

3. Embedded Operating Systems 

Mobile operating systems are embedded operating systems that run devices such as 

ATMs, navigation systems, portable media players, digital video recorders, and other consumer 

electronics. An embedded operating system is included in the hardware of a standalone device. 

Unlike mobile operating systems, however, embedded operating systems are designed to meet 

a specific purpose and perform a single type of task, such as providing maps and directions. In 

addition, an embedded operating system runs with little or no intervention from you or other 

users. You provide a specific type of input, such as a destination, and the embedded operating 

system provides the output, such as directions.  

Many embedded operating systems are specialized versions of their more fully featured 

counterparts, such as Linux and Windows. For example, computerized cash registers, or point-

of-sale devices, use an embedded version of Windows to manage sales transactions and keep 

them secure. Household electronics such as microwave ovens and digital video recorders use 

embedded versions of Linux to perform their tasks. The iPod has an embedded version of iOS 

that lets you select and play songs. 
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4. Server Operating Systems 

A server operating system resides on a server and is used to manage a network, a group of 

two or more computers linked together. A server is a computer that provides network services 

such as e-mail to other computers or clients. Because of their purpose, server operating systems 

are sometimes called network operating systems.  

 
Each client computer on a network has its operating system, while the server runs a 

server operating system to manage the requests for services from the client computers. For 

example, if a user on the network wants to print a document, the server operating system handles 

the request and sends the print job to the printer, which lines up with other print jobs in a certain 

order. That way, the printer isn’t overloaded with print jobs from dozens of other users on the 

network. An expert, the network administrator, uses the server operating system to manage the 

network and its users.  

Server operating systems are multiuser because they let many users run programs and 

simultaneously take advantage of the server’s resources. One important task a server operating 

system performs is balancing user needs so that everyone can access the services and resources 

they request and that a problem with one user doesn't affect all users.  

Windows Server is the server version of Windows, and Mac OS X Server is the server 

version of Mac OS. Versions and distributions of UNIX and Linux are also servers operating 

systems. Many servers that handle e-mail and Internet access use UNIX because it is a powerful, 

flexible multiuser operating system.  

 

III. Operating System Tasks 

The operating system controls your computer from soon after you turn on the power until 

you turn it off. During that time, the operating system takes care of technical tasks so that you 

can focus on completing a school project, listening to music, or communicating with others, for 

example. An operating system’s technical tasks include completing start-up steps, managing 

memory, processing input and output, controlling hardware, and ending a computer session.  

1. Completing Start-Up Steps 
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You turn on the power to the computer to start an operating system. The boot process is a series 

of steps the operating system must complete before you can interact with the operating system. 

The figure below illustrates the boot process.  

 
1. The computer receives and distributes electrical power to its circuits so the system 

components can run.  

2. When a system component called the ROM chip receives power, it starts a utility 

program called the BIOS, which stands for basic input/output system. The BIOS 

contains instructions for starting the system before the operating system is loaded.  

3. The BIOS performs the power-on self-test (POST) to check critical system components 

and ensure they are running properly. During this step, your computer might beep and 

flash messages on the screen.  

4. If the system components are running properly, the BIOS looks for devices connected 

to the computer and checks their settings. If the BIOS finds an error, the computer might 

beep again and display error messages describing the problem.  

5. If Steps 3–4 are successful and error-free, the BIOS searches for the system files the 

computer needs to run the operating system and then loads them into random access 

memory (RAM), which is the memory the computer uses to store instructions and data 

temporarily. Next, the BIOS loads the kernel, or core, of the operating system into 

RAM. The kernel takes over control of the computer from the BIOS.  

6. The operating system completes setup tasks, such as requesting your username and 

password, starts and runs utility software and other programs in the background, and 

then displays the main user interface screen.  

 

2. Managing Memory 

After starting up, one of the main tasks an operating system performs is managing 

computer resources. In a computer system, a resource is any component the system requires to 
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do work. The main resources are memory, processing components, storage space, and 

peripherals.  

An operating system manages memory so that it uses RAM efficiently. RAM is a critical 

resource because computers have only a limited amount, and every program—applications, 

utility programs, even the operating system itself—needs space in RAM to run. When you start 

an application, the operating system allocates RAM for that application. When you close an 

application, the operating system reclaims the RAM to assign it to another program.  

The computer can run out of RAM if you run multiple applications simultaneously. In 

that case, the operating system might close an application or shut down the computer 

unexpectedly (this is called a crash). To prevent crashes and gain memory, operating systems 

take advantage of virtual memory, which is part of a computer’s hard disk that can work as 

additional RAM. For example, suppose you have five applications running and then start the 

sixth application. Windows might have enough RAM to display the user interface for the 

application but not enough to allow you to complete any tasks in the application. To gain 

memory to start the sixth application, Windows moves data from one of the other running 

applications out of RAM and into virtual memory. This processing is called swapping and 

continues until you close one of the open applications.  

 

In general, as the operating system runs out of RAM for programs, it swaps pages of data from 

RAM to virtual memory. (A page is the amount of data and instructions the operating system 

can swap at one time.) The part of a computer’s storage space dedicated to virtual memory is 

called the page or swap file.  
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Although virtual memory means the operating system can access more than is available in 

RAM, swapping is slower than using RAM alone. If you notice an application responding more 

slowly than usual to your commands, the operating system is probably using virtual-memory.  

 

3. Processing Input and Output 

Another major task for the operating system is processing input and output. When you type text 

on the keyboard to provide input to a software application, the operating system accepts and 

processes the data so the computer can display the text as an output on the monitor.  

Often, the operating system must handle many input and output tasks simultaneously, such as 

when you click buttons and enter text to create a document or when you have more than one 

application running simultaneously. The operating system sets a sequence for processing input 

and output tasks to keep your computer running smoothly. For example, the printer must receive 

the entire document before printing if you want to print a large document containing text and 

graphics. Instead of waiting for the printer and slowing down processing, the operating system 

places the document data into a buffer, part of memory or storage where data waits until it can 

be transferred to a device. In the meantime, you can continue working with the computer 

without interruption. When the printer has received the entire document, the operating system 

removes the data from the buffer—sending print data to a buffer before printing is called 

spooling.  

 
 

4. Controlling Hardware 

The operating system considers every hardware device connected to the computer as an input 

or output resource. For example, a microphone is an input resource, and a speaker is an output 

resource for audio data such as music and spoken words. To control a hardware resource, the 

operating system communicates with a driver, also called a device driver, which is a small 
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program that enables the operating system to interact with the device. Each device must have a 

driver, which is typically provided by the device manufacturer. One of the operating system’s 

setup tasks is to activate the driver for each device connected to the computer, so the device 

works as you expect it to work.  

If you install new hardware, such as speakers that plug into your computer, the operating system 

usually recognizes the device immediately, or the next time you start the computer. Because 

the operating system includes drivers for common devices, it searches for the correct driver on 

the computer and then installs it so you can use the new hardware right away. This feature is 

called Plug and Play. If the operating system can’t find the right driver on the computer, it 

typically displays instructions for acquiring and installing the driver software.  

 

5. Ending a Computer Session 

A personal operating system needs to know when you’re finished working with a computer to 

protect itself and other software and keep your information private while you are away. 

Although you select an option to end a session, the operating system takes care of the tasks, 

which range from shutting down to restarting, signing out (also called logging off), switching 

users, and locking the computer. The options for signing out and switching users apply only if 

a computer has more than one user. Shutting down is the only option that turns off the power 

to the computer. To work with the computer again, you turn on the power and wait for the 

computer to complete the boot process. So that you can avoid this delay while the computer 

reboots, operating systems provide alternatives to shutting down, such as sleep and hibernate. 

These are low-power states that the operating system triggers automatically and lets you quickly 

resume work without rebooting. The table below summarizes the ways to end a computer 

session.  
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As with the boot process during startup, an operating system follows a procedure to shut down 

completely. It completes the following steps to ensure all users have saved their data, all 

applications and system software are stable, and the operating system has not developed a 

problem.  

1. Checks users: If the computer has more than one user, the operating system checks 

whether others are signed in to use the computer. If they are, they might be required to 

end their sessions before the operating system can shut down.  

2. Closes application: The operating system sends a shutdown signal to each running 

application. If you have not saved data in an application, the operating system allows 

you to save it before it sends a shutdown signal to the next application. The operating 

system also clears application data from virtual memory and swaps it to RAM.  

3. Closes system software—The operating system ends the running programs and 

processes that are part of the system software, making sure they close properly. If the 

operating system detects a problem, it displays a message now or during the next startup. 

The operating system also clears data from RAM and buffers.  

4. Turns off the power—The operating system signals the computer’s power management 

hardware to turn off the power.  
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VI. Installation of Operating System 

There are many instances where you might need to reinstall your operating system or 

get a new one entirely. For example, you’d need to reinstall Windows if you encountered a 

serious error, your hard drive became damaged or corrupted, or you’re upgrading/downgrading 

your system.  

When planning to reinstall or install a Windows operating system on your PC, you need 

to have the necessary installation files beforehand. This will allow you to boot and install the 

system.   

Because CDs and DVDs are becoming less practical, many computers and laptops no 

longer come with a drive to read and write physical disks. This makes it impossible for you to 

create or use an installation media unless it’s on a bootable USB drive. While this may sound 

impractical initially, USB sticks have a huge advantage over disks.  

USBs are incredibly accessible, given the fact that almost every computer has a USB 

port that you can use to connect external devices. It’s the easiest and most streamlined method 

of installing an operating system. Nowadays, you can create a bootable USB to install various 

versions of Windows. 

 

1. Create a Windows bootable USB with the Media Creation Tool 

Before installing Windows using a USB, you need to create the installation media itself. 

Your computer will read this once the USB flash drive is connected, allowing it to boot from 

USB. Below are the steps to create this bootable USB flash drive using the Media Creation Tool 

issued by Microsoft. 

1. Download the appropriate installation media from Microsoft: Download Windows 10 

 
2. Follow the steps to download the Windows version you want. Some versions may 

require you to provide your Windows product key to verify your eligibility to 

download disc images. 
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3. Save the Media Creation Tool to your computer. Launch the file and click Accept when 

prompted to agree to the software license terms when the download is finished. 

 
4. Select Create installation media (USB flash drive, DVD, or ISO file) for another 

PC and click the Next button. 

 
5. Follow any on-screen instructions to set your preferred language, Windows edition, and 

System Architecture. If unsure, check the Use the recommended options for this 

PC option and proceed. 
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6. Choose the USB flash drive and select your USB from the list. The Windows 

installation files will start to download to your USB drive. 

 

 
7. Note that the download may take a long time, depending on your internet connection. 

Ensure not to disrupt the process until the bootable USB drive is created. 

 

Here's a summary to boot from a USB.  

You first need to create the USB itself, which will be read by your computer and used to 

boot up. You can find the guidelines on creating a bootable USB using the Media Creation Tool 

issued by Microsoft. 

1. Open the Microsoft Download Windows page in your web browser and click on 

the Download tool now button. 

2. Save the tool to your computer. Launch the media creation tool when the download is 

finished and click Accept when prompted to agree to the launch. 



Lesson 39 Software and Operating system Part 4 Computer Fundamental and Maintaining 

393 

3. Select Create installation media (USB flash drive, DVD, or ISO file) for another 

PC and click the Next button. 

4. Set your preferred Language, Windows 10 Edition, and System Architecture. If you 

can’t change the settings, place a checkmark next to the Use the recommended options 

for this PC option and proceed. 

5. Choose the USB flash drive, then hit the Next button and select your USB drive from 

the list. The Windows installation files will start to download to your USB drive. 

6. The download may take a long time, depending on your internet speed. Ensure not to 

disrupt the process until the creation tool has been created. 

 

2. Change your computer's boot order 

After creating an installation media, you must know how to boot from USB. This is 

needed to install Windows from the bootable USB.  

The trick is: you need to change your computer’s boot order. Doing so will place the 

USB flash drive at the top of the boot order priority list, meaning that your computer will read 

the files on it first. This will prompt your computer to load the installation media instead of the 

already installed system.  

You need to change the boot order in your computer’s BIOS to boot from USB. After 

completing this step, during the next start-up sequence, your system will immediately boot from 

USB and use the installation media you created, starting the Windows installation process. 

 
With your computer’s boot order successfully changed to load up from a USB device 

first, you can now crack on with installing Windows using your USB’s installation file.  

Note: Make sure you’ve backed up all your files before installing them to ensure you don’t lose 

any valuable data. 

3. Step to Install 

1. Plug your USB device into your computer’s USB port, and start up the computer. You 

may be asked to press a key to boot from the USB. 

2. Choose your preferred language, timezone, currency, and keyboard settings. Once 

you’re happy with customizing these settings, click Next. (Note that these settings can 
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be changed in the future after the Windows 10 installation is complete.). 

 
3. Click Install Now and select the Windows 10 edition you’ve purchased. Now 

click Next to start the installation process. 

 

 
4. Choose your installation type. You can either choose Upgrade, which will allow 

keeping your current files, settings, and apps, or do a fresh, clean installation by 

picking Custom. In this example, we’ll be choosing custom to do a fresh Windows 

installation. 

 
5. To install Windows, you need a partition on your hard drive for storing system files; 

this will become the main C: drive. You can either pick an existing partition and format 

it or delete everything and create new partitions. 

• Note: If you haven’t yet backed up your hard drive, you may want to stop 

now, back everything up, and start over. Once you’ve deleted a partition, you 

won’t be able to recover the data previously stored on it. 
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You can either use one of the existing partitions on your hard drive by 

formatting it, or you can delete the ones there and create new ones from fresh 

instead: 

• To use one of the existing partitions, select it and click Format. 

 
• To delete the existing partitions, select each one and click Delete, then OK. 

 
6. If you’ve deleted all the existing partitions, your hard drive’s space will be unallocated, 

and you’ll need to create new partitions. If you just formatted an existing partition, then 

skip to Step 7 now. To create new partitions: 

• Click Drive options (advanced). 
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• Now click New and choose the size for your new partition, then click Next. 

 
• Windows will now create a new partition for storing system files. 

Click OK to accept. 

 
• Repeat this process if you wish to create more partitions. 

Once you’ve finished creating all the partitions you want, format each one 

except for the partition you want to store your Windows system files, select 
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the partitions one by one, and click Format, then OK when prompted. 

 
7. Now select the partition where you want to install Windows and click Next. The 

Windows 10 installation will begin. Your computer may reboot a few times during the 

process. This is normal. 

 

 
8. After the installation is complete, your computer will automatically restart one last time. 

When it starts up again for the first time, you’ll be able to choose more of your settings 

or use express settings recommended by Microsoft. 
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9. Finally, sign in to your Microsoft account to use some of the new features with Windows 

10, such as password recovery, and to access One Drive. If you don’t want to sign in 

with your Microsoft account, click Skip this step and follow the instructions to create 

a local user account instead. 
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• Software provides the means for you to interact with the computer’s hardware by 
entering and receiving information through the user interface. 

• A computer relies on two main types of software, application software, and system 

software.  

• System software is the software that runs a computer and includes the operating 
system and utility programs. An operating system is a software that coordinates the 
resources and activities on a computer. 

• Application software is the software you use most directly to complete a specific 
task or to create something electronically. 

• There are 4 types of Operating systems: 
o Personal computer OS: Operating systems installed on a single computer 

are called personal or desktop operating systems. 
o Mobile OS:  A mobile operating system is designed for a small handheld 

computing device such as a smartphone or tablet. 
o Emended OS: An embedded operating system is included in the hardware 

of a standalone device. 
o Server OS: resides on a server and is used to manage a network, which is a 

group of two or more computers linked together. 
• The technical tasks an operating system performs include completing start-up steps, 

managing memory, processing input, and output, controlling hardware, and ending 

a computer session.  

 

Summary 

1. What is Software? How many types? Describe it. 

2. What is an Operating system? 

3. What is the difference between a Personal Operating system and a Server 

Operating system? 

4. Describe the task of the operating system. 

5. What do you need before installing the Operating system? 

Questions 
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Introduction: 
In this lesson, you learn about installing application software, utility programs, 
and operating systems on various types of computing devices, including desktop 
computers and mobile computers. 
after completion of this lesson, you should be able to:  

ü Describe how to install various types of software. 
ü Identify the tasks a setup program performs during installation.  
ü Explain when and how to uninstall software. 
ü Describe how to reinstall software, including operating systems.  
ü Identify types of software licenses.  

In this lesson you will learn: 
I. Installing software 

II. Uninstalling software 
III. Reinstalling software 
IV. Reinstalling Operating system 

Software Management 

Lesson 40 
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Lesson 40 Software Management 
I. Installing Software 

When you purchase a personal computer, it already contains software such as the operating 

system, utility programs, and some basic applications, so you can use the computer as soon as 

you turn it on. Eventually, you may want to install other software to perform productivity tasks, 

enjoy games and other entertainment, and add tools that enhance the operating system or 

improve system performance. Recall from Lesson 2 that when you install software, you move 

a copy of the software from its distribution location to your computer. A setup program is 

included with the software to guide you through the installation steps and prepare the software 

so you can use it on your computer.  

The method you use to install software varies depending on the type of personal 

computer you are using, the type of software you are installing, and how it is distributed. You 

typically install four types of software: desktop applications, Windows 8 apps, mobile apps, 

and utility programs such as drivers and system tools. Recall that a desktop application is a 

program that opens and runs in a window on the desktop. The term usually applies to Windows 

applications but includes those for Mac and Linux applications. You install desktop applications 

on desktop computers and laptops.  

As you know, a Windows 8 app is one you start from the Start screen; it then takes up 

the entire screen instead of opening in a window on the desktop. You can install and run 

Windows 8 apps on a desktop computer, laptop, or tablet with Windows 8 installed.  

A mobile app is specifically designed for a handheld computer, such as a tablet or smartphone. 

For example, applications developed for Windows RT are mobile apps, as are those created for 

the Apple iPad and Android phones.  

 

1. Overview of Installation Steps 

You can install software using one of three distribution methods: a CD or DVD, a compressed 

file on a Web site, or a store app, such as an Apple App Store app or a Windows Store app. If 

you receive software on a CD or DVD, you insert the disc in a CD/DVD drive on your computer 

and wait for the setup program to start. If the setup program does not start automatically, display 

the files on the disc using a file manager such as File Explorer, and then double-click the setup 

program file, which usually has a name similar to setup.exe. See Figure ##. 
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The setup program guides you through the steps to install the software, including choosing the 

components you want to install and selecting a folder for the software. See Figure ##. 

 
Another way to install software is from a Web site, such as one provided by a software 

developer or publisher. In this case, the software and a setup program are contained in a single 

compressed file available on the Web site. To install software using this distribution method, 

you select options on a Web page, such as the operating system you are using and the language 

for the software, and then click a link or button to download and save the compressed file on 

your hard disk. See Figure ##.  
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Usually, the setup program starts as soon as the file is downloaded. If it does not, you use a file 

manager to extract the files from the compressed file and then double-click the setup.exe file to 

start the setup program. If the compressed file is not too large, you can bypass saving and 

extracting the files by running the setup program immediately instead. Figure ## illustrates the 

process of installing a mouse driver from a compressed file on a Web site to a computer running 

Windows 8. 

 
Store apps such as the Windows Store, the Apple App Store, and the Google Play Store provide 

access to apps designed for a particular operating system. For example, you use the Windows 

Store app to display apps available for Windows 8 and Windows RT. On an iPhone or iPad, 

you select the App Store icon to visit the Apple App Store and display apps available for iOS. 

See Figure ##.  
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When you find an app you want to install, you use a button or link to purchase it, if necessary, 

and then download and install it automatically. See Figure ##. 

  
 

2. Installation Tasks 

Depending on the size of the files, installation can take from a few seconds to several minutes 

if you are installing a desktop application, mobile app, or utility program. Installing an operating 

system takes longer, sometimes up to an hour, and requires you to restart your computer one or 

more times.  

If you are installing software on a personal computer, the setup program typically performs 

the following tasks:  
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§ Copies files—The setup program copies files from the distribution location to your hard 

disk and then creates a log to indicate where it stores files during installation.  

§ Extracts files—If the files are stored in a compressed file, the setup program extracts 

them so they can all be used in the installation. The setup program might also create 

folders and subfolders for the files, usually in a folder in the root directory named 

Program Files or Program Files (x86). For example, Microsoft Office has stored in 

subfolders of the Program Files ▶ Microsoft Office folder. This program folder 

contains most of the files the application needs to run. (The setup program also stores a 

few files in system folders.) The program folder is different from the folder where you 

download the files and where the setup program extracts them. If the files in the program 

folder are corrupted, you can use the extracted files to reinstall the software. 

§ Checks for existing versions of the software—The setup program scans for other 

versions of the software. If it finds an earlier version, it might need to uninstall it first, 

or it might be able to use files already installed on your computer. If it finds the current 

version of the software and all the files are up to date, the setup program stops and 

displays a message indicating the software is already installed.  

§ Verifies system requirements—The setup program checks system components, such as 

RAM and the hard drive, to ensure they have enough capacity to run and store the 

software. If your computer does not meet the minimum system requirements, the setup 

program stops and displays a message describing the problem.  

§ Finds drivers and other system files—If you are installing application software, the 

setup program looks for and activates drivers the software uses, such as printer drivers. 

It also looks for system files it might need to provide services such as Internet access.  

§ Updates system files—The setup program provides configuration data to the operating 

system so it can run the software. On a Windows computer, this information is stored 

in the Windows registry, a database of information about your computer’s 

configuration.  

§ Provides a way to start the software—The setup program adds a button, icon, or tile to 

the graphical user interface so you can start the software. For example, it adds a tile to 

the Windows 8 Start screen or an icon to the iPad home screen.  

 

II. Uninstalling Software 

You can uninstall almost any software installed on your computer, including applications, 

utility programs, and operating systems. You typically uninstall an application if you no longer 

use it. Doing so frees up space on your hard disk, sometimes a significant amount of space, 
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depending on the software. To uninstall a desktop application from a Windows computer, you 

use an uninstaller, which is a tool similar to a setup program. Uninstallers are provided with 

installed software so you can completely remove the software from your computer. Suppose 

you delete the program folder of a Windows desktop application. In that case, system files still 

contain configuration settings and other data that can slow system performance or prevent the 

operating system from loading correctly. In addition, most Windows applications store files in 

more than one folder, and you need the uninstaller to track them down. You use a Control Panel 

tool called Programs and Features to start an uninstaller that completely removes a desktop 

application from your computer.  

In most cases, you can uninstall a desktop application from a Mac by dragging the 

application’s icon to the Trash, a Mac OS X tool similar to the Windows Recycle Bin. Mac OS 

X performs a few clean-up tasks behind the scenes. Larger applications or those that interact 

with other applications, such as Microsoft Office for Mac, pro- vide an uninstaller that you use 

to remove an application thoroughly.  

To uninstall a Windows 8 app, right-click the app’s tile on the Start screen or Apps 

screen, and then click the Uninstall button on the Apps bar. See Figure ##.  The app’s 

uninstaller takes care of completely removing the software from your computer. 

 
To uninstall a mobile app from an Android tablet or smartphone, you use the Application 

manager on the Settings menu. The Application manager lists all the apps installed on the 

device. You select the app you want to uninstall and then tap the Uninstall button. Uninstalling 

is even more straightforward on an iPhone, iPad, or iPod Touch: you press and hold the app’s 

icon until the icon begins to shake and a circled X appears on the icon, and then you tap the X 

to uninstall the app. See Figure ##.  
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You can also uninstall a driver or utility program if you are having trouble with a device or no 

longer use the program. In addition, a hardware manufacturer might instruct you to uninstall a 

driver if you upgrade to new hardware, such as a monitor or video card. In all cases, you should 

use an uninstaller to uninstall the driver or utility program from your computer so you can 

remove the files as safe as possible. Uninstallers for some system tools are listed in the 

Programs and Features window that you access from the Control Panel. Others are included 

with the tool itself. For example, as you learned in Lesson 5, you can open the Properties dialog 

box for a device, click the Driver tab, and then click the Uninstall button to uninstall the driver.  

Uninstalling an operating system means deleting it from your computer. If you don’t 

immediately replace the deleted operating system with a new one, your computer won’t run. 

You might want to uninstall the operating system when you are preparing to recycle a computer 

and need to remove any personal information, such as passwords, stored in system files. In that 

case, you should first back up and then thoroughly remove all of your data. You can use a 

system tool called a disk wiper or disk eraser to uninstall the operating system and remove your 

data at the same time. If you are selling or donating your computer, you can wipe the disk and 

then reinstall an operating system from CDs or a DVD, so the new owner has an operating 

system to work with.  

 

1. Uninstalling Tasks 

If you are uninstalling software other than an operating system on a personal computer, the 

uninstaller typically performs the following tasks:  

§ Deletes files—The uninstaller refers to the log created by the setup program to locate 

and then delete the software’s files.  
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§ Restores system settings—If the setup program changes system settings, the uninstaller 

restores them to their original settings. On a Windows computer, this includes registry 

entries. The uninstaller refers to the setup log again and reverses the changes to the 

registry.  

§ Restores the graphical user interface—The uninstaller removes the button, icon, or tile 

for starting the software from the graphical user interface.  

 

III. Reinstalling Software 

If you’ve installed software, but it’s not running properly, you can reinstall it. For example, if 

you install a desktop application, Windows 8 app, or mobile app, try to start the software as 

usual, and then discover that the application doesn’t start, you can uninstall the software and 

try installing it again on the same computer. Reinstalling can replace files that might have 

become corrupted during or shortly after installation. In fact, corrupt or missing files are the 

most common cause of software problems, and uninstalling and then reinstalling is the easiest 

way to solve it.  

To reinstall a desktop application, Windows 8 app, or mobile app on the same device as the 

original software, you can complete the following general steps:  

1. Uninstall the software as described in the “Uninstalling Software” section of this lesson.  

2. Restart the computer. This resets the computer and frees system resources, greatly 

reducing the possibility of corrupting a file. 

3. Install the software as described in the “Installing Software” section of this lesson. If 

possible, select a Web site or store app as the distribution location so you can install a 

recent version of the software.  

4. If the setup program prompts you to check for and install updates, choose the option to 

do so. In most cases, it’s best to install the most recent version available.  

Developers of system software don’t usually require you to uninstall programs such as 

drivers before reinstalling the software. If you received the software on a CD or DVD, which 

might be the case with drivers for the hardware you purchased, you can insert the disc in a 

CD/DVD drive and wait for the setup program to start or double-click the setup.exe file in File 

Explorer to start it yourself. If updates have been installed for the drivers, the software on the 

disc is probably older than the software currently installed on your computer. In this case, 

reinstalling the software replaces the most current drivers with older drivers that might not be 

compatible with new hardware.  
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IV. Reinstalling an Operating System 

If an electrical storm, power surge, virus, or another threat causes system problems severe 

enough to prevent your operating system from running normally, you can reinstall it. Most set-

up programs or the operating systems themselves provide an option to install a fresh copy of 

the operating system while retaining your data and settings. Some also retain your application 

software. For example, you can reinstall Windows 8 using a Refresh option that retains your 

original Windows 8 apps, though not your desktop applications. You’ll learn how to refresh 

Windows 8 next. You can reinstall other operating systems as follows:  

§ Mac OS X—You can reinstall Mac OS X by choosing the Restart command on the 

Apple menu and then holding down the Command+R keys as the computer restarts. 

When an option to reinstall Mac OS X appears on the screen, click it to download and 

install the software from an Apple server. (You must be connected to the Internet to 

reinstall.) Follow the on-screen instructions to complete the reinstallation. Reinstalling 

keeps your data files and settings intact.  

§ Linux—The method to reinstall varies depending on the Linux distribution. For most 

distributions, you reinstall using your original installation media, which overwrites all 

the files except your data files. However, you can back up the files containing your 

settings and then restore the files to your fresh installation of Linux.  

§ iOS—You can reinstall or update iOS by connecting your smartphone or tablet to the 

Internet or to a computer where iTunes software is installed. (iTunes is the software you 

use to play, download, and organize digital media files on a personal computer.) With 

the first method, you use the General category in the Settings app to select the Software 

Update command and then follow the on-screen instructions. To use iTunes, you 

connect your smartphone or tablet to a desktop or laptop computer running iTunes. On 

the iTunes menu, click Check for Updates and then follow the on-screen instructions to 

reinstall iOS.  

§ Android—You can reinstall or update Android by using the Settings app. Select a 

command called About Tablet or something similar, and then choose System Updates 

to check for an update or reinstall Android. Manufacturers of Android smartphones and 

tablets also send notices about updates to their firmware when it’s available. (Recall that 

firmware consists of instructions stored on a ROM chip, so it is a combination of 

hardware and software.) To reinstall firmware on your own, however, you need to 

contact the manufacturer directly and then send the device to them for reinstallation.  

Windows 8 includes the Refresh tool, which installs a fresh copy of Windows on your 

computer and retains your data, settings, and original Windows 8 apps, but not desktop 
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applications. The Refresh tool is designed to reinstall Windows 8 if your system is unstable; 

that is, you can start the computer and run applications but receive error messages or have 

trouble opening and using system tools. If you are having problems even starting Windows, 

you can use the Reset tool to remove all of your files and applications, reinstall Windows, and 

then change all of your system settings to their defaults. The Reset tool is also ideal if you are 

disposing of your computer or giving it away because it removes all of your data and personal 

information.  

While using the Refresh or Reset tool, Windows needs to access setup files stored on its 

installation or recovery medium. You could use the original installation medium (such as the 

USB drive or DVD containing the setup program and files) or a system recovery disk if you 

made one during the original installation of the operating system.  

 

 
• When you install software, you use a setup program to guide you through the steps 

of copying the software from its distribution location to your computer and then 

preparing the software so you can use it.  

• The method you use to install software varies depending on the type of personal 

computer you are using, the type of software you are installing, and how you access 

it. You typically install four types of software: desktop applications, Windows 8 

apps, mobile apps, and utility programs such as drivers. You obtain the software one 

of three ways: CD or DVD, a compressed file on a Web site, or a store app.  

• To install software, a setup program copies and extracts files, checks for existing 

versions of the software, verify system requirements, finds drivers and other system 

files, updates system files, and provides a way to start the software. To uninstall a 

desktop application from a Windows computer, you use an uninstaller, which is a 

tool similar to a setup pro- gram that completely removes software from your system. 

To uninstall a Windows 8 app or mobile app, you use an Uninstall command.  

• You might need to uninstall a driver if a hardware manufacturer instructs you to do 

so. You can also uninstall utility programs if you no longer use them. In these cases, 

you should use an uninstaller provided by the software to uninstall the software from 

your computer so you can remove the files as safe as possible. 

 

Summary 
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• You rarely need to uninstall an operating system, though you might want to uninstall 

one when you are preparing to recycle a computer and need to remove any personal 

information, such as passwords stored in system files.  

• When you use an uninstaller, it deletes the software’s files, restores system settings, 

and restores the graphical user interface.  

• If you’ve installed software, but it’s not running properly, you can reinstall it. 

Reinstalling can replace files that might have become corrupted during or shortly 

after installation.  

• If a threat such as an electrical storm causes problems severe enough to prevent your 

operating system from running normally, you can reinstall the operating system. In 

most cases, you can use an option to install a fresh copy of the operating system 

while retaining your data and settings.  

• To reinstall an operating system, the computer needs to access setup files stored on 

the installation or recovery medium. Most desktop operating systems let you create 

a system recovery disk, which contains tools and files to help restore a computer if 

a serious system error occurs.  

1. What are the three factors that determine the method you use to install software? 

2. How do you install software provided in a compressed file on a Web site? 

3. What are the seven tasks a setup program typically performs to install software? 

4. After you download and install a Windows desktop application such as Free Alarm 

Clock, how can you verify it has been installed successfully? 

5. What are two reasons to uninstall application software? 

6. How do you start an uninstaller to uninstall the software from a Windows 

computer? 

7. What types of situations might you want to reinstall an operating system? 

Questions 
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Introduction: 
In this lesson, you learn about the purpose and use of application software, 
including word-processing applications, presentation software, spreadsheets, and 
databases. You also examine applications for desktop publishing, entertainment, 
and media editing. Finally, you explore typical utility programs, including those 
that compress files, manage disks, and scan for malware. 
after completion of this lesson, you should be able to:  

ü Define productivity software.  

ü Describe word-processing, desktop publishing, and presentation software.  

ü Compare spreadsheet and database software.  

ü Describe entertainment and media-editing software.  

ü Use typical software tools for maintaining a computer.  

 
In this lesson you will learn: 

I. Using software 
II. Using Software tool 

 

Software Usage 

Lesson 41 
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Lesson 41 Software Usage 

I. Using Application Software 

The range of application software covers nearly every task you might need to perform, 

including producing documents and other types of work, exchanging electronic messages, 

accessing Web pages, watching movies, and playing games. In this lesson, you explore three 

types of applications: productivity, entertainment, and media-editing applications. You use 

productivity applications to perform work and other activities effectively. Productivity 

applications include word processing, spreadsheet, database, desktop publishing, and 

presentation software. Entertainment software is designed for viewing or playing music, videos, 

and photos, while media-editing software is designed for creating and modifying graphics, 

animations, videos, music, and other media.  

Related applications are often packaged together and distributed in a software suite. For 

example, Microsoft Office, Apple iWork, Google Docs, and Apache OpenOffice are considered 

office suites because they typically include word-processing, spreadsheet, and presentation 

applications that are useful in a professional or business setting. Many office suites also include 

a database or an e-mail application. Media-editing applications can also be provided in suites 

such as Adobe Creative Suite and CorelDRAW Graphics Suite, which include software for 

editing photos, creating graphics, and developing animations.  

Software suites offer some advantages over installing individual applications. The cost 

of a software suite is usually less than the cost of buying each application separately. The 

software in a suite uses the same interface, so you can apply the skills you learn in one 

application to the other applications. Suite software is also designed to work together, often by 

sharing content. For example, in an office suite, you can copy a chart created in a spreadsheet 

and paste it into a word-processing document. A disadvantage is that many people use one or 

two suite applications most of the time while rarely using the others, so the disk space consumed 

by the suite overall could be used more efficiently.  

 

1. Word-Processing Software 

You use word-processing software such as Microsoft Word, Apple Pages, Google Documents, 

and Corel WordPerfect to produce written documents such as reports, letters, memos, research 

papers, and flyers. As you are working on a document, you can enter and reorganize text, correct 

errors, insert graphics, and format the document before producing a final version.  
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A typical word-processing application such as Microsoft Word, shown in Figure ##, displays 

a work area where you create and edit a document and controls for viewing, formatting, and 

managing the document. 

 
 

2. Spreadsheet Software 

A spreadsheet is an arrangement of text and numbers in a rectangular grid or table. You use 

spreadsheet software such as Microsoft Excel, Open Office Calc, or LibreOffice Calc to 

organize numeric data in such a way that you can calculate, analyze, interpret, and present it. 

This type of software is ideal for tasks such as preparing budgets, balancing checkbooks, 

forecasting loan payments, and maintaining grade books.  

A typical spreadsheet application such as Microsoft Excel, shown in Figure ##, displays a grid 

of columns and rows that can contain text, numbers, and formulas. Excel calls this grid a 

worksheet or a sheet for short. 
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3. Presentation Software 

You use presentation software, such as Microsoft PowerPoint, iWork Keynote, LibreOffice 

Impress, and Prezi, to organize and present text, graphics, and other media as a slide show. To 

guide you in creating a slide show with visual appeal, presentation software provides layouts, 

which are pre-set arrangements for slide content, including text and graphics. Layouts provide 

placeholders in which you can enter and edit the text in formats that audiences can view and 

read easily, including headings and bulleted and numbered lists. You can also use placeholders 

to insert tables, charts, pictures, and videos. Figure ## shows an example of a slide show created 

in presentation software. 
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4. Entertainment Software 

Entertainment software includes applications that let you download and listen to music or the 

radio, watch movies and television shows, and play games. Some applications, such as Apple 

iTunes, provide access to more than one type of digital media, including songs, movies, TV 

shows, and radio stations. Other software, such as music players, radio applications, and video 

players, concentrate on a single type of media.  

 

A. Music and Video Applications 

You use music applications such as Windows Media Player and iTunes to build a collection of 

digital music and arrange it into playlists, which are lists of songs or pieces of music organized 

in sequence, though you can also shuffle the order. You can play the music files on a computer 

or transfer them to a handheld device such as a portable media player. Mobile music apps such 

as Google Play Music and iTunes for iOS are especially popular because they are designed for 

listening to music on the go. Video player software includes QuickTime, RealPlayer, and the 

VLC media player; all of these applications also play music. You use the applications to play 

videos in a variety of file formats, organize videos into playlists, and set preferences such as 

displaying or hiding subtitles. 
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B. Game Software 

Game software for personal computers is one of the most popular types of software that people 

use today. Some game applications are electronic versions of physical games, such as Solitaire 

or Scrabble, that have rules that are familiar or easy to grasp and can be played for short periods 

of time. They are sometimes called casual games because they require little time commitment 

to learn and play.  

 

5. Desktop Publishing Software 

Desktop publishing (DTP) software is similar to word-processing software because you use it 

to create documents containing text and graphics. However, DTP software includes more 

sophisticated features that enable you to use a personal computer to arrange text and graphics 

on a page to create and print high-quality documents such as brochures, magazines, newspapers, 

and books typically produced by professional typographers. Adobe InDesign, QuarkXPress, 

and Microsoft Publisher are examples of DTP software. 
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6. Media-Editing Software 

If you acquire digital media such as music, video, and image files, you often need to edit them 

to suit your purposes. For example, suppose you want to make a short video demonstrating how 

to make sushi. You could use a digital video camera to record yourself making the sushi, select 

a music file to play at the beginning of the video, and take photos of the finished product to 

display at the end of the video. To fine-tune each component, you use graphics software to 

correct any flaws in the photos, music-editing software to play only a short segment of a song, 

and video-editing software to edit the video recording and produce it with the photos and music.  

 

A. Graphics Software 

You use graphics software such as Microsoft Paint, Adobe Photoshop, and CorelDRAW to 

create, edit, and print graphics, including pictures, drawings, photographs, icons, and other 

images. The three major types of graphics software are paint, photo editing, and drawing 

software. Paint software such as Microsoft Paint provides tools for painting the screen, which 

involves manipulating pixels by filling them with color. You can use paint software if you need 

to create a graphic on a Web page, for example, or any other object displayed on a computer 

screen.  

 
Unlike paint software, drawing software approaches a graphic as a set of geometric 

objects, including lines and closed shapes. Because of this approach, graphics created with 

drawing software can be resized without reducing the quality of the image, which is not the 

case with paint software. 3-D graphics software also uses mathematics to represent 3-D objects 

and allows users to rotate and view them from many angles. A special type of 3-D graphics 

software is computer-aided design (CAD) software, which professional designers use to create 

models of products, buildings, and other objects; engineering and technical drawings; and 

blueprints for architectural projects.  
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B. Video-Editing Software 

When you use video-editing software such as Windows Movie Maker, Apple iMovie, or 

Camtasia Studio, you work with video segments called clips. You arrange the clips in sequence 

on a timeline or storyboard, add transitions between clips, insert titles, and zoom in and out to 

direct the viewer’s attention.  

 
 

C. Music-Editing Software 

Music-editing applications such as Apple Garage Band, Music Maker Jam, and Finale are 

designed for people who want to record and edit their own music. You can use these 

applications to compose and record songs; change the volume, speed, and sound quality of 

recordings; add sound effects, and mix voices and instruments. 
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8. Database Software 

A database is a collection of data organized into tables, such as a collection of baseball cards, 

an inventory of movie and TV show DVDs, or an address book of contacts. You use database 

software such as Microsoft Access, FileMaker Pro, or MySQL (pronounced “my sequel”) to 

enter, organize, update, retrieve, and produce reports on the electronic data in a database.  

All data in a database is stored in one or more tables composed of rows and columns, similar to 

spreadsheets. 

 
II. Using Software Tools 

Utility programs are tools you use to maintain your data files, software, and hardware File 

utilities include software that helps you manage files, convert files from one format to another, 

and thoroughly delete files. Disk management utilities include software that helps the operating 

system store files efficiently on a disk and removes unnecessary files. Software utilities include 

software updating tools, virus, and other malware scanners, and system monitors. 

  

1. File Compression Software 

File compression software is a type of file utility that reduces the size of a file by removing 

redundant data. You compress files before attaching them to an e-mail message, for example, 

so they can be transferred more quickly. When you receive a compressed file, you use the file 

compression software again to expand the file to its original size. Although operating systems 

provide file compression software, you can install separate utilities that perform the same tasks 

and include additional features such as encrypting the compressed files for extra security. 

Figure ## shows WinZip, a popular file compression utility for iOS. 

File compression software determines which redundant data to remove according to 

sophisticated algorithms, which are sets of rules a program follows in calculations or other 
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problem-solving steps. The algorithm for compressing a text file identifies patterns in the text, 

including certain characters or words that often appear together, such as “the” or “is the.” The 

file compression software keeps track of this pattern in a log and substitutes the text for code. 

For example, instead of storing the words “is the” 25 times in a file, the software uses “1” as 

the code for “is the,” which stores only one character instead of six. When the file is extracted, 

the software reverses the operation and substitutes “is the” for each code of “1.” This type of 

compression is called lossless compression because it reconstructs the original file without 

losing any data. Lossless file compression methods can reduce text files by 50 percent or more.  

Files containing graphics or music do not include many redundant data, so file compression 

software does not use this kind of algorithm for compressing media files. Instead, it uses a lossy 

compression method, which removes data identified as unnecessary in the file. For example, 

suppose you want to compress a graphic with a white background. Although the background 

seems to be the same shade of white at normal size, when you use graphics-editing software to 

zoom into the background, you’ll see that each pixel is a slightly different shade of white. 

Instead of retaining thousands of shades of white, file compression software changes the color 

value of some pixels, so the background is composed of only hundreds or dozens of shades, 

reducing the size of the file significantly. However, when you extract the graphic, the lost colors 

are not restored, meaning the graphic is not exactly the same as the original file because some 

data has been lost. You are unlikely to notice the difference in a graphics file, which is why 

these programs use lossy compression methods for graphics. 

  

2. Disk Management Software 

You use disk management software to maintain your hard disk by keeping it free of problems 

that could prevent you from accessing your data. A hard disk failure can be an inconvenience 

if you have backups of your data and a disaster if you don’t. Disk management software helps 

you prevent disk failure from occurring in the first place by removing corrupted files and 

unnecessary files, blocking access to damaged parts of the disk, and arranging data for efficient 

retrieval.  

You should use three disk management utilities regularly. One is a disk cleaner, which 

identifies files you can safely delete to free up disk space. Another is a disk scanner, or error-

checking tool, which scans for disk errors, such as parts of corrupted files and damaged sections 

on the disk, and then repairs them. The third tool is a defragmenter, which can optimize the 

way files are stored on the disk. Desktop operating systems provide these utilities by default; 

you can download and install apps that perform these tasks on mobile operating systems.  



Lesson 41 Software Usage Part 4 Computer Fundamental and Maintaining 

420 

In addition to cleaning, scanning, and defragmenting a disk, you can use compress it, which is 

similar to compressing files. A disk compression utility increases the amount of data you can 

store on a hard disk by compressing all of its files. Instead of selecting files to compress, as you 

do with a file compression utility, a disk compression utility works in the background whenever 

you store files on the hard disk.  

In Windows 8, the disk cleaner utility is called Disk Cleanup, which you use in Step-

by-Step 8.2. When you start Disk Cleanup, it searches your hard disk for unnecessary files, such 

as temporary Internet files and those in your Recycle Bin, and then lists the types of files. You 

can select each type of file to learn its purpose and determine whether you want to permanently 

delete those files from your hard disk. 

To understand how an error-checking tool and a defragmenter work, recall that the 

surface of a hard disk contains concentric circles called tracks. Tracks are divided into blocks 

of 512 bytes, and each block is called a sector of the disk. The operating system assigns the file 

to one or more sectors to save a file on a disk. Each part of a file stored in a sector is called a 

cluster of data. Because most files are larger than 512 bytes (the size of one sector), the data in 

a file is usually divided among several clusters. A file system error known as a lost cluster 

occurs if the operating system loses track of which clusters contain the data that belong to a 

particular file. An error-checking tool identifies file system errors and can repair them if 

necessary. In addition, it can scan for and repair physical errors on the hard disk itself, including 

bad sectors, which are areas of the disk that do not record data reliably. 

After correcting any errors on your hard disk, you can run a defragmenter to improve 

the disk’s performance so that applications start and files open more quickly. (Most operating 

systems run a defragmenter according to a schedule, so you can also wait and let the operating 

system start the defragmenter for you.) When an operating system breaks a file into clusters, it 

attempts to place the data in adjoining sectors and usually does so successfully on a relatively 

new hard disk. When you delete a file, the operating system frees the sectors that contain the 

file’s data. The next time you save a file, the operating system searches for the first available 

sector, stores a cluster of data, and then searches for the next available sector, which might not 

be next to the first one. The more files you save and delete, the more scattered the clusters for 

a file become. A disk that contains files whose clusters are not contiguous or next to each other 

is said to be fragmented. See Figure ##.  
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The more fragmented the disk, the longer the operating system takes to retrieve the file, and the 

more likely you are to have problems with the file. When an application tries to access a file on 

a fragmented disk, file retrieval takes longer than necessary because the application must locate 

clusters that aren’t adjacent. Defragmenting rearranges the clusters on the disk, so each file’s 

clusters are adjacent to one another. When a disk is in this state, it is said to be optimized.  

3. Malware and Antivirus Software 

When you connect to the Internet, receive an e-mail message, or share your computer or files 

with others, your computer is vulnerable to harm from people who might attempt to access 

confidential information or damage your files. They can do so through malware, which is short 

for malicious software. Malware includes computer viruses, worms, Trojans, bots, and spyware. 

By copying itself and triggering computer code, a virus can infect your computer and damage 

your files and system settings. Viruses are often transmitted through e-mail attachments or 

downloaded files, but they don’t spread until you open the infected attachment or file.  

In contrast, a worm is harmful computer code that spreads without your interaction. A worm 

slips from one network connection to another, replicating itself on computers. As it does, a 

worm consumes network resources and overwhelms computers until they become slow or 

unresponsive.  

Another type of malware is a Trojan, also called a Trojan horse, which is malware that 

hides inside another program, such as a browser toolbar you download from the Web. When 

you install the toolbar, the Trojan infects the operating system, allowing a hacker to access your 

computer. If attackers access your system through a Trojan, they might install a bot, short for 

robot, which is a program that runs repetitive tasks. Bots can control your computer without 
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your knowledge to perform illegal activities such as sending massive amounts of spam 

(electronic junk mail).  

Spyware can also install itself or run on your computer without your consent or control. 

As its name suggests, the spyware monitors your computing actions, usually while you are 

online, to collect information about you. Sometimes, spyware passes information about your 

Web browsing habits to advertisers, who use it to improve their products or Web sites. Other 

times, a special type of spyware called adware changes your browser settings to open pop-up 

ads, which are windows that appear while you are viewing a Web page and advertise a product 

or service. Pop-up ads interrupt your online activities and can be difficult to close; they can also 

be vehicles for additional spyware or other types of malware.  

Common symptoms of malware are when your computer runs much slower than normal, 

messages appear unexpectedly, programs start or close on their own, or the operating system 

shuts down suddenly.  

To defend against malware, you should install and run antivirus software on your 

computer and then keep it up to date because new malware is released frequently. Antivirus 

software blocks potential malware, scans your computer and safely removes viruses, worms, 

Trojans, and bots. Some antivirus software also scans for spyware. Table ## lists some popular 

antivirus software for Windows, Mac OS X, iOS, and Android. Mobile operating systems are 

well protected against malware because they exclusively use online stores to distribute apps, 

and developers can tightly control the software offered at online stores. 
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• You use productivity applications to perform work and other activities effectively. 

Productivity applications are often bundled together in a software suite.  

• You use word-processing software to produce written documents such as reports, 

letters, memos, research papers, and flyers. Features in word-processing software 

help you reduce the number of errors in a document and improve the quality of your 

writing. They also provide formatting features so you can make documents look 

professional and appealing, and include collaboration features for working with 

other users.  

• Desktop publishing software is similar to word-processing software because you use 

it to arrange text and graphics on a page. In addition, it includes tools for producing 

and printing typographic-quality documents and for sending files to a commercial 

printer.  

• You use presentation software to organize and present text, graphics, and other 

media as a slide show. Layouts in presentation software guide you to arrange text 

and graphics on a slide. Presentation software also includes features to engage the 

audience and clarify ideas during a slide show, such as slide transitions and 

animations.  

 

Summary 
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• You use spreadsheet software to organize numeric data so that you can calculate, 

analyze, interpret, and present it. You insert a formula to display the results of a 

calculation. If you use cell references in a formula, recalculation is automatic when 

data changes. The ability to update automatically makes spreadsheets especially 

useful when you need to perform what-if analysis.  

• To help you visualize numeric data, spreadsheet software includes tools for creating 

charts (also called graphs). Charts show trends or relationships in data that you might 

not notice when examining columns or rows of numbers.  

• You use database software to enter, organize, update, retrieve, and produce reports 

on the electronic data in a database. All of the data in a database is stored in one or 

more tables, which are composed of rows and columns, similar to spreadsheets. Each 

column in the table represents a field, and each row represents a record.  

• A database file can contain objects, including tables, forms, queries, and reports. 

You use a form to enter data into a table. You use a query to request specific 

information that meets set criteria from the database. A report provides data as a 

formatted printout or display.  

• Both spreadsheets and databases are designed for organizing, managing, and 

tracking data that is stored in columns and rows. If your focus is on using numerical 

data to make calculations or a quick analysis, create a spreadsheet. If your focus is 

on storing other types of data for the long term and manipulating it efficiently, create 

a database. 

• Entertainment software includes applications that let you download and listen to 

music or the radio, watch movies and television shows, and play games. 

• You use media-editing software to edit digital media such as photos and other 

pictures, music, and videos. 

• You use graphics software to create, edit, and print graphics, including pictures, 

drawings, photographs, clip art, icons, and other images. The three major types of 

graphics software are paint, photo editing, and drawing software. 

• Music-editing applications are designed for people who want to record and edit their 

own music. Video-editing applications are designed for people who want to create 

and edit videos. You import and then organize video clips, music clips, and other 

media clips and then publish them together in one video file. 
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• Utility programs are tools you use to maintain your data files, software, and 

hardware. File utilities include software that helps you manage files, convert files 

from one format to another, and thoroughly delete files. Disk management utilities 

include software that helps the operating system store files efficiently on a disk and 

removes unnecessary files. 

• To defend against malware, you should install and run antivirus software on your 

computer and then keep it up to date because new malware is released frequently. 

Antivirus software blocks potential malware, scans your computer and safely 

removes viruses, worms, Trojans, and bots. Some antivirus software also scans for 

spyware. 



1 

Introduction: 
In this lesson, you learn how to solve computer problems by following common 
troubleshooting steps, and then apply those steps to software and hardware 
problems. You use troubleshooting tools to identify and solve operating system 
and application software problems, and learn about resources for troubleshooting 
problems with computer components and peripheral devices. 
after completion of this lesson, you should be able to:  

ü Describe typical software problems. 

ü Use troubleshooting tools provided by an operating system. 

ü Get help from online resources. n Describe symptoms of problems with 

hardware components. Identify common solutions to problems with 

peripheral devices. 

 
In this lesson you will learn: 

I. Approaches to Troubleshooting 
II. Troubleshooting Software 

III. Troubleshooting  Hardware 
IV. Troubleshooting  peripheral Device 

Computer Troubleshooting 

Lesson 42 
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Lesson 42 Computer Troubleshooting 
I. Approaches to Troubleshooting 

Suppose you are using your computer to complete a major project, and the deadline is fast 

approaching. As you work on the project, you’re creating content in word processing, 

spreadsheet, and graphics applications and then combining the content into a presentation. As 

you copy and paste a chart onto the last slide, the presentation application closes suddenly. 

When you open the application again, a message appears indicating that the presentation you 

were working on is corrupt and cannot be recovered. Now, what do you do? If you are 

experiencing a computer problem like this example, you need to troubleshoot to solve the 

problem. Troubleshooting means taking a logical, systematic approach to identifying the source 

or cause of the problem and then applying a solution so that the computer normally works again. 

Troubleshooting typically involves the following four steps: 

ü Define the problem: Describe the trouble that you are having, being as specific as 

possible. For example, to define the presentation problem, you should note the name 

and version of the presentation application, the type of content you were trying to paste 

onto a slide, and the source of that content. Also, note the other applications you were 

running at the time the problem occurred and any system tasks the computer might have 

been running in the background. 

ü Identify possible causes: Consider obvious causes first, such as the original 

presentation file being damaged. Next, determine the last time you successfully 

performed the same steps with the software. Have you installed or uninstalled any 

software since then? If so, those actions are also possible causes. 

ü Determine the most likely cause: Work through a process of elimination to determine 

the most likely cause. Test each cause. For example, does the presentation software 

close unexpectedly each time you try to paste a chart from the spreadsheet software? If 

not, eliminate pasting a chart as the cause of the problem. If the presentation software 

does close each time, however, you have found the most likely cause. 

ü Apply solutions: As you test causes, keep track of possible solutions, and then apply 

each solution systematically. If pasting a chart from a spreadsheet application caused 

the problem, does updating one of the applications solve the problem? What about 

updating both applications? Try your task again to confirm that the solution restores the 

software to a reliable working state. 

When you define the problem in Step 1 of the troubleshooting steps, you determine whether 

you are trying to solve a software or hardware problem. If the problem seems to involve only 

applications or the operating system, troubleshoot the software. If the problem occurs as the 
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computer starts, troubleshoot the operating system first. For other computer problems and those 

where software troubleshooting does not solve the problem, troubleshoot the hardware and 

peripheral devices. 

 

1. Getting Help from Online resources 

When you have any computer problem, you can find valuable troubleshooting information 

on the Web. The best sources are knowledge bases and online forums. A knowledge base is a 

collection of articles, videos, and other sources containing information about a product or topic. 

Software developers and hardware manufacturers provide knowledge bases to their users to 

help them solve problems. Typically, a technical support professional writes a knowledge base 

article to answer common questions or to explain how to work around a known flaw in the 

software. Knowledge base articles are often part of or linked to software Help topics. They are 

also available online at the support Web site of a software developer or hardware manufacturer. 

For example, to access the Microsoft knowledge base, you visit support.microsoft.com/kb. To 

access the Apple knowledge base, you visit kbase.info.apple.com. On the knowledge base Web 

site, your search for a topic by keyword the same way you search for any information on the 

Internet. Operating system knowledge bases include information about third-party software and 

their own software.  

An online forum is a Web site where people conduct conversations by posting messages 

about a specific topic. Software developers and hardware manufacturers often host online 

forums where users can post questions or report problems they are having with the product. 

Other users or technical support people working for the software developer or hardware 

manufacturer answer the questions or help to troubleshoot the problem. The original message 

and all the responses to it are grouped together sequentially by topic. This group of related 

messages is called a thread. Threads are saved in an archive that you can search to determine if 

your problem has already been solved before you post a new message.  

The Apple online forum is called the Apple Support Communities, which you can access 

from the Apple Web site. In Windows Help and Support, you can click the Microsoft 

Community website link to display the online forum for Microsoft software. See Figure ## 
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As you work through the four troubleshooting steps to define and solve computer problems, 

take advantage of online resources so you can learn from the experience of other users and from 

support professionals. 

 

II. Troubleshooting Software 

Software trouble ranges from minor difficulties, such as a feature that doesn’t work as it should, 

to major problems, such as the operating system failing to start. Table ## describes the most 

common general software problems, their possible causes, and suggested solutions. 

 
The following sections describe other solutions you can try when you are troubleshooting more 

specific software problems. 
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1. Using Troubleshooting Tools 

Operating systems include diagnostic tools that help you troubleshoot software 

problems, including those with the operating system itself. If a Windows application starts but 

runs slowly or fails to respond to your commands, you can troubleshoot the problem with Task 

Manager. You can also troubleshoot Windows software problems using the Action Center, a 

Control Panel tool that helps you manage security and maintenance settings. 

 

A. Managing Application Resources 

You have already learned to use Task Manager to track the system resources (including CPU 

and memory) that applications, background processes, and Windows processes consume. You 

can also use this information to troubleshoot application problems. For example, suppose five 

applications are open and running on your computer, including Internet Explorer, Microsoft 

Excel, Microsoft PowerPoint, Microsoft Word, and File Explorer (shown as “Windows 

Explorer”). As you edit and format text in Word, the changes are very slow to appear in the 

document. To find the possible cause of this problem, open Task Manager, which might appear 

as in Figure ##, which shows the resource usage of the running applications on the Processes 

tab. 

 
Total memory is 96%, which is very high, indicating that the open applications are using 

almost all of the available RAM. To free RAM for Word, close the application using the most 

RAM, which is Internet Explorer in this case. If Word is still running slowly, close the other 

applications until Word can access the RAM it needs to work more efficiently. 

You also use Task Manager to close an application that does not respond to any of your 

actions, including clicking the Close button (or equivalent command) to close the application. 

In such a case, you can open Task Manager and then check the Status column, which might 

display a status of “Not responding.” Select the unresponsive application, and then click the 
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End task button to close the application. Unfortunately, with this method, you lose any work 

you completed since the last time you saved the open files in the application. 

 

2. Using Problem-Reporting Tools 

Operating systems also keep track of software errors, often in logs, which are text files stored 

in a system folder. When you have a serious software problem, such as an application closing 

without warning, Windows display a dialog box asking if you want to send a problem report to 

Microsoft. A problem report is a copy of the error data, which includes details about the 

problem, such as the name and version of the application, when the error occurred, and technical 

information about the state of the system at that time. If you agree to send a problem report, the 

operating system submits the information to help diagnose or solve the problem. These 

solutions are often provided to you in software updates or patches. 

Windows also checks for solutions when an application fails to respond or closes 

unexpectedly. In those situations, a dialog box might open, similar to the one in Figure ##, 

indicating that Windows is checking for a solution to the problem. 

 
 

3. Removing Malware 

Malware, such as viruses and spyware, can infect your computer any time you visit a Web site 

or open an e-mail attachment. Because malware can download, install, and run on your 

computer without your knowledge or consent, it’s often difficult to know if it is infecting your 

computer. 

Your best protection against malware is to use the current version of your antivirus and 

antispyware software to scan e-mail messages, attachments, and other files on your computer 

for viruses, worms, and other types of malware. Antivirus software locates a virus by comparing 

identifying characteristics of the files on your computer to the characteristics of a list of known 

viruses, which are called virus definitions. When it finds malware, antivirus software notifies 

you and takes action to protect your computer from harm. Because new malware is being 
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released daily, you need to keep the virus definitions up to date through the antivirus software’s 

update feature. The same is true of antispyware software, though it refers to a list of known 

spyware as spyware definitions. 

Windows include antivirus software among its operating system tools, though you can 

install antivirus software from other developers (called third-party applications) such as Norton 

Antivirus and McAfee Antivirus. Windows computers come with Windows Defender. On 

either type of computer, if you install a third-party antivirus application, you should disable 

Windows Defender because multiple antivirus applications running simultaneously can conflict 

with each other. Only one antivirus application should be running on your computer at any time. 

You can use Windows Defender to scan for both viruses and spyware. (If an application 

scans for both viruses and spyware, it is sometimes called an antimalware application.) You 

can run a quick scan, a full-system scan, or a custom scan. A quick scan checks the locations 

on your computer that viruses and spyware are most likely to infect. With a custom scan, you 

select the locations you want Windows Defender to check. In the following steps, you perform 

a quick scan. 

 
If antivirus or antispyware software finds suspicious files when it scans your computer, 

it usually places them in quarantine, which means it moves the files to another location to 

segregate them from other files safely. Quarantined files cannot run, so they cannot harm your 

computer. Most antivirus and antispyware software allow you to delete or restore quarantined 

files. If the quarantined files are safe, your computer needs to keep the files in quarantine for a 

few days. If you don’t have any computer problems since the files were quarantined, you can 

remove them to free disk space. If you continue to have computer problems, research the 

filenames of the quarantined files online to determine whether they are safe to restore. 
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4. Using Safe Mode 

If the operating system doesn’t normally start when you turn on your computer, it might restart 

in Safe mode so you can resolve or troubleshoot the startup problem. A safe mode is a 

troubleshooting option for operating systems that starts your computer with only basic services 

and functionality. If the computer doesn’t automatically restart in Safe mode, you can start it in 

Safe mode manually.  

On a Windows computer, you start in Safe mode by performing the following steps:  

1. Display the Charms bar, click the Settings charm, and then click Change PC settings to 

display the PC settings screen.  

2. Click Update and recovery in the left pane to display options for updating and 

recovering the operating system, and then click the Recovery category in the left pane.  

3. In the Advanced startup section in the right pane, click the Restart now button to display 

the Choose an option screen.  

4. Click the Troubleshoot button to display the Troubleshoot screen, and then click 

Advanced options to display the Advanced options screen.  

5. Click the Startup Settings button to display the Startup Settings screen.  

6. Click the Restart button to restart the computer and display the Startup Settings screen 

instead of the usual screen that appears when you start the computer.  

7. Press the 4 key to select Enable Safe Mode, and then enter your password if prompted 

to display the desktop in Safe mode, shown in Figure 9–13. Windows Help and Support 

opens to display the Safe mode Help topic in case you need help with Safe mode.  

 
Because Safe mode uses only the most basic settings and drivers, the screen appears in 

its lowest resolution with no background image, the computer is not connected to the Internet, 
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and peripheral devices such as speakers are disabled. “Safe Mode” also appears in the four 

corners of the screen to indicate that Windows is in Safe mode. 

Often, starting in Safe mode alone resolves a startup problem, which might be the result 

of a background program not loading correctly. Try restarting the computer immediately after 

starting Safe mode to see if the problem recurs.  

If the problem recurs in normal mode but not in Safe mode, you can eliminate the default 

settings and basic device drivers as possible causes. Next, start each application you normally 

use to see if it opens in Safe mode. On a Windows computer, start Task Manager and then click 

the Startup tab to display a list of software that starts and runs in the background after Windows 

loads. Start as many of these programs as possible. If an application does not open in Safe mode, 

reinstall it to see if that solves the problem.  

If you have recently installed software on a Windows computer, the software might not 

be compatible with your version of Windows or might introduce other problems that are 

difficult to track. You can restore your computer to an earlier point using the System Restore 

feature. This system utility helps you restore system files to an earlier state, usually one during 

which the startup problem did not occur. You use System Restore to undo system changes 

without affecting your data files.  

If you have recently installed new hardware, the driver might be incompatible with the 

operating system on your computer. Try uninstalling the hardware and restarting the computer. 

If it starts normally, the new hardware was most likely the cause of the problem. Check the 

device manufacturer’s Web site to make sure the device is compatible with your version of your 

operating system. If it is, reinstall the device, and then use the operating system’s update tool, 

such as Windows Update, to check for and install the most recent driver.  

After resolving a problem in Safe mode, you must restart your computer to return to normal 

operations. 

  

1. Troubleshooting Hardware 

Problems with a computer’s internal hardware affect the computer’s ability to start and run, so 

they are major problems that need to be addressed as soon as you notice them. Symptoms of 

internal hardware trouble include the following: 

§ Beeps during POST—Recall that when you start a computer, it performs the power-on 

self-test (POST) to check critical system components and make sure they are running 

properly. These components include the processor, RAM, and video card. Some 

computers beep if these components are working normally or do not beep at all. Other 

computers use flashlights on the keyboard instead of using beeps. Search the computer 
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manufacturer’s Web site to learn what these codes or their absence signal. An error 

during POST usually means one of the critical system components is damaged or failing 

and needs to be replaced. After a POST error, the operating system might start in Safe 

mode or display a message indicating you should start in Safe mode so you can 

troubleshoot the problem.  

§ Hard drive makes unusual sounds—If you use your computer often, you are probably 

aware of the normal sounds it makes as it saves files on the hard drive, which might 

include whirring or spinning sounds. If a mechanical hard drive makes an unusual 

sound, such as grinding, clicking, or prolonged spinning, it might have a problem that 

will eventually cause it to fail. If it suddenly takes a long time to save files, your hard 

drive is on the brink of failure. Back up your data (see Lesson 10 for instructions), use 

a disk-checking utility to scan the drive for errors, and plan to replace the drive soon.  

§ Display screen is blank, garbled, or includes blank areas—These are all symptoms of 

a damaged video card, which can be affected by power surges. A power surge or spike 

is a boost to the electrical charge that powers the computer and can occur during 

lightning storms, power outages, short circuits, and other disruptions to a computer’s 

power source. Power surges can also damage hard drives and RAM. You can test for 

video card failure by attaching a different monitor to your computer. If the new monitor 

does not display information correctly, replace the video card.  

§ Frequent software crashes, unusual messages, or deteriorating performance—If the 

operating system crashes or displays messages that don’t seem to relate to your current 

activities, suspect a problem with RAM. Also, suspect RAM failure if the computer 

performs a task normally shortly after starting but takes much more time to perform the 

same task later in the session. Use tools such as Task Manager to track how much 

memory is installed on the computer. If the tool reports less RAM than was originally 

installed, you need to replace a memory module.  

§ Computer does not start at all—If the computer does not even complete POST or fails 

shortly after POST, the power supply, processor, or motherboard might need to be 

replaced. Considering that the processor is the most expensive component in your 

computer, you might consider replacing the entire computer in this case.  

All of the troubleshooting methods you can use with software also apply to hardware, including 

operating system options such as troubleshooters, Safe mode, knowledge base articles, and 

online forums. In addition, on a Windows computer, you can use Device Manager to check the 

status of hardware, uninstall and reinstall drivers, disable and enable the device, and scan for 

hardware changes.  
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5. Checking Cables and Connections 

Before replacing any internal components or the computer itself, follow the troubleshooting 

steps to try the easiest fixes. For example, if your computer doesn’t start or stops running 

suddenly, check the power cords leading to your computer, especially if you recently moved 

the computer or bumped it, which could have loosened connections. If the display screen is 

blank on a desktop computer, first make sure the cable from the monitor is securely attached to 

the system unit. If you are using a mobile computer, make sure the battery has enough charge 

to run the computer. As you recharge the battery, check the power adapter cable and its 

connection to the device to ensure it is securely connected to the device and to the power outlet.  

If you decide to work with a PC specialist to repair a computer, ask the specialist to 

check the internal cables and connections before replacing the components. Because system 

components are connected to the internal circuitry and depend on each other for basic 

operations, reseating or reconnecting a component such as the CPU, ROM, or memory module 

might solve a seemingly serious problem. See Figure ## 

 
 

III. Troubleshooting Peripheral Devices 

In some ways, problems with peripheral devices are easier to troubleshoot than problems with 

internal computer hardware because you can access the devices more easily. However, 

peripheral devices can experience a wider range of problems than internal components, so it 

can take longer to find the right solution. In general, check the following information as you 

troubleshoot any peripheral device:  

§ Cables and connections—As with internal components, make sure peripheral devices 

are properly and securely connected to your computer. The operating system might not 

recognize a device if it is loosely connected to a port on the computer.  
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§ Compatibility—Determine whether the device is designed to run with the version and 

operating system installed on your computer. Compatibility information is included on 

the packaging of a device and on the Web site of a device manufacturer. If you are using 

the most recent version of Windows and try to install a device designed only for 

Windows XP and earlier, the device probably will not work correctly.  

§ Drivers—The operating system needs a compatible driver to interact with a peripheral 

device. Recall that in most cases, drivers are provided with operating systems and are 

updated as necessary. If a peripheral device is not working correctly, you can try 

updating the driver yourself from an optical disc provided with the device or from the 

manufacturer’s Web site.  

§ Firmware—To update firmware for a peripheral device, you typically connect the 

device to your computer and then connect the computer to the Internet, if necessary. 

Visit the Web site of the device manufacturer, navigate to the support page for your 

device, check the model number, and then follow the instructions for updating the 

firmware.  
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• Troubleshooting means taking a logical, systematic approach to identifying the 

source or cause of the problem and then applying a solution so that the computer 

normally works again.  

• Troubleshooting typically involves the following four steps: define the problem, 

identify possible causes, determine the most likely cause, and apply solutions.  

• When you have any type of computer problem, you can find valuable 

troubleshooting information in knowledge bases and online forums. A knowledge 

base is a collection of articles, videos, and other sources containing information 

about a product or topic. At an online forum, users and technical experts conduct 

conversations to solve computer problems.  

• Common problems with the software include not starting, not running, and causing 

problems with other software. These problems can be solved by reinstalling the 

software, restarting the computer, and updating the software.  

• Operating systems include diagnostic tools that help you troubleshoot software 

problems, including those with the operating system itself. These tools include Task 

Manager or Activity Monitor, problem reports, and automated troubleshooters.  

Summary 
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•  Operating systems keep track of software errors in logs, which are text files stored 

in a system folder. When you have a serious software problem, you can send a 

problem report to Apple or Microsoft. The problem report contains a copy of the 

error data, including details about the problem, such as the name and version of the 

application, when the error occurred, and technical information about the state of the 

system at that time.  

• Solutions to Windows and application problems include links to Help articles, files 

to download, and steps to perform. When a solution is available, Microsoft sends a 

message to the Action Center on your computer so you can access the information.  

• For some software and hardware problems, operating systems offer automated 

troubleshooters, which take you through a series of dialog boxes to check settings 

and then change them as necessary so you can perform certain tasks. 

• Your best protection against malware is using updated versions of antivirus and 

antispyware software to scan your computer for malware and then remove or 

quarantine it. This type of software locates malware by comparing identifying 

characteristics of the files on your computer to the characteristics of known malware, 

which are called virus definitions and spyware definitions.  

• If antivirus or antispyware software finds suspicious files when it scans your 

computer, it usually places them in quarantine, segregating the suspicious files from 

the rest of your file system. Quarantined files cannot run, so they cannot harm your 

computer.  

• Safe mode is a troubleshooting option for operating systems that starts your 

computer with only basic services and functionality. If the operating system doesn’t 

normally start when you turn on or restart your computer, it might start in Safe mode 

automatically. You can also start in Safe mode manually to resolve or troubleshoot 

the startup problem.  

• Problems with a computer’s internal hardware affect the computer’s ability to start 

and run, so they are major problems that need to be addressed as soon as you notice 

them. Symptoms of internal hardware trouble include beeps and flashing lights 

during POST, unusual sounds from the hard drive, blank areas on the display screen, 

frequent crashes, and failure to start.  
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• For hardware problems involving smartphones and tablets, check the manufacturer’s 

Web site for firmware updates, which are often issued to fix bugs. The firmware in 

peripheral devices might also need to be updated to resolve compatibility errors.  

• To troubleshoot problems with peripheral devices, start by checking cables and 

connections to make sure the device is properly and securely connected to your 

computer. Determine whether the driver is compatible with your operating system 

and that you have the most recent driver installed.   

1. Describe the four steps typically included in the troubleshooting process. 

2. If an operating system does not start or starts and then freezes, what are the 

possible solutions? 

3. What is the downside of using Task Manager to close an unresponsive application?  

4. What is the easiest way to solve the problem of an unsuccessful software update? 

What should you do if you suspect the updating tool itself is damaged?  

5. How does Windows handle incompatible applications?  

6. How does antivirus software identify potential viruses?  

7. What is Safe mode, and when should you use it?  

8. What should you do if the hard drive makes an unusual grinding sound and 

suddenly takes a long time to save files?  

9. Why should you ask a PC specialist to check internal cables and connections 

before replacing components 

Questions 



1 

Introduction: 
In this lesson, you learn about backing up and restoring files. You examine the 
types of backups and explore your options for how to create and where to store 
backups. You investigate two methods for backing up files, and learn the 
importance of following a backup plan. Besides using backups to protect data, you 
also learn about ways to protect computer hardware. 
after completion of this lesson, you should be able to:  

ü Understand types of backups. 
ü Select a backup method. 
ü Determine a schedule for backing up data. 
ü Backup and restore files and folders. 
ü Protect a computer from theft and physical damage.  

In this lesson you will learn: 
I. Backing Up and restoring file 

II. Pretecting hardware 

Data and Hardware Protection 

Lesson 43 
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Lesson 43 Data and Hardware Protection 

I. Backing Up and Restoring Files 

If you have inadvertently deleted a file or folder, overwritten a version of a file you meant to 

save, or lost data after a hard drive crashed or a virus-corrupted file, you know how important 

it is to back up your computer files. A backup is a duplicate copy of a file that you use if the 

original file is lost, damaged, or destroyed. (When written as two words, backup means to create 

a copy of a file.) To use a backup copy of a file, you first need to restore it, which means 

copying the file to its original location on your computer.  

Before you back up files, you need to make two major decisions: the type of backup to create 

and which backup method to use. Depending on which backup method you choose, you might 

also need to determine where to create and store the backup and how often to back it up. Each 

of these decisions is discussed in the following sections.  

 

1. Understanding Types of Backups 

The four most common types of backups for individual computer users are full system backups, 

differential backups, incremental backups, and selective backups. As shown in Figure ##, a 

full system backup (also called a system image or a disk mirror) is an exact duplication of the 

hard drive, including data files, system files and settings, application files, and the operating 

system. If your hard drive is destroyed, you could remove it, install a new hard drive, and then 

restore your files from the full system backup to have the same setup on the new hard drive as 

you had when you created the backup. 

 
As you add and modify files on the hard drive, you also need to back them up. Instead 

of creating another full system backup to include those files, you can perform a differential 

backup or an incremental backup. A differential backup contains copies of the files that have 

changed since the last full system backup. An incremental backup contains copies of the files 
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that have changed since the last full system backup or the last incremental backup. See Figure 

##.  

 
When you perform a selective backup (also called a partial backup), you select the 

folders and files you want to back up. Typically, these include the folders containing the 

documents, pictures, financial records, and other data files you have created or saved. You can 

also back up data that would be difficult or time-consuming to restore, such as contact records, 

which might be stored in an e-mail application, and browser favorites or bookmarks. Figure ## 

shows a selective backup.  

 
You can perform incremental backups to keep a selective backup current. For example, 

if you create a selective backup of your Documents folder on Monday, you can perform an 

incremental backup on Tuesday to include any new or modified files from the Documents folder 

in the backup.  

Each of the backup types has advantages and disadvantages, which are summarized in Table 

##. 
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As Table ## indicates, incremental backups require careful organization so you can use 

them to restore a computer. Creating a full system backup and updating it with incremental 

backups means you need the full system backup and all the incremental backups to restore a 

computer. In addition, you must restore the incremental backups in the same order they were 

created, so you need to identify the incremental backups correctly to keep track of their 

sequence. If you create only one full system backup and update it indefinitely with incremental 

backups, restoring could take a very long time. To make it easier to restore a computer, you can 

create full system backups periodically, such as every Friday evening, and then per- form 

incremental backups from Saturday to Thursday. To restore the computer, you would need the 

most recent full system backup and only six incremental backups. 

For Windows computers, the terms “system recovery disk,” “system repair disk,” and 

“system image” are often confused. You use a system recovery disk to restore the computer to 

its factory settings, the state it was in when you purchased it. 

A system image produces a similar result, except that you can use it to restore the 

computer to the state it was in when you created the system image. If the computer doesn’t 

start, you can use a system repair disk to load the essential files Windows needs to start, and 

then use the system recovery disk or the system image to restore your computer. 

2. Selecting a Backup Method 

To create a backup, you can use software installed on your computer, or you can use an online 

backup service provider. Most experienced computer users employ a combination of these 

methods to make sure they have backups that can reliably restore their files.  
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Using Backup Software 

To create any type of backup, you can use backup software, which is a set of system utilities 

for creating and updating backups and for restoring files from a backup. Operating systems, 

third-party software developers, and manufacturers of backup media such as external hard 

drives provide backup software. Backup software compresses all the files selected for a backup 

into a single large file; along with the compressed files, backup software stores an index of file 

details, including their original locations, to restore the files when necessary.  

Windows 11 provides the following backup and restore software:  

§ File History—Makes incremental backups of files that have changed in specified 

folders. Instead of writing over versions of the same file, File History keeps copies of 

each saved version of a file, so if you need a chart you painstakingly created in a 

document two hours ago but accidentally deleted the last time you saved and closed the 

document, you can restore the earlier version of the document containing the chart. File 

History does not create full system backups.  

§ System Image Backup—Creates a full system backup. 

§ Recovery—Restores files from a system image backup.  

When you select a location for backups, be sure to select one other than your hard drive so you 

can access the backup files in case of a hard drive failure or other major computer problems. 

You typically can choose one of the following locations for creating backup files:  

§ External hard drive—Because of its portability, capacity, and ease of use, an external 

hard drive is where most experienced computer users create backups. Small external 

hard drives have a few hundred gigabytes of storage capacity, making them suitable for 

selective backups. In contrast, larger external hard drives with at least 1 TB of storage 

space are ideal for maintaining full system backups.  

§ USB flash drive—If you are creating a selective backup of a limited amount of data, 

you can use a USB flash drive, which is inexpensive and convenient for backing up 

documents and other personal files. However, a single USB flash drive does not have 

enough capacity to store a full system backup and its updates.  

§ Optical disc—You can use recordable CDs, DVDs, and Blu-ray discs as backup media. 

Selecting a type of disc that can be read many times but recorded only once is an 

advantage because it does not allow the data to be changed after it is backed up. 

However, that means you need a new optical disc for each backup you create. If you 

want to back up more data than a single optical disc can hold, as you would for a full 

system backup, most backup software can extend the backup across multiple optical 

discs. The disadvantage of optical discs is that they are slow to save and access data, so 



Lesson 43 Data and Hardware Protection Part 4 Computer Fundamental and Maintaining 

444 

backing up and restoring large files from optical discs takes longer than using an 

external hard drive.  

§ Network folder—If your computer is on a network, you can create backups to a network 

folder. You need to have permission to save files in the folder and set sharing options 

so that unauthorized users cannot access the backup. The network administrator also 

needs to provide enough storage space for the backups, which might not be practical for 

large full-system backups.  

After creating backups using media attached to your computer—one of the first three 

options—you can store the medium close to the computer, which is considered a local backup, 

or takes it to an off-site location for safekeeping. Creating and storing a backup on a network 

folder is also considered a local backup if you are using a local area network, which is a network 

that links computers within a building or group of adjacent buildings.  

In addition to setting schedules and selecting locations, backup software usually allows you to 

select the following options:  

§ Backup type—You can choose whether to perform a full system, differential, or 

incremental backup. To create a selective backup, you can select the folders and files to 

store in a new backup file.  

§ Encryption—Encryption is a security method that encodes data so that only authorized 

people can access it. Some backup software can encrypt the files in a backup and then 

decrypt or reverse the encryption when it restores the files.  

§ Media spanning—If the backup file grows very large, this feature allows you to use 

more than one drive to store the backup file. The backup software keeps track of the 

files stored on each drive and requests the correct drive when you restore selected 

folders and files.  

§ Verification—After backing up the files, backup software compares every file in the 

backup location to the corresponding file on your hard drive to make sure it did not skip 

a file. In addition, you should restore a file or two after creating a full system backup to 

make sure the restore process works correctly.  

3. Synchronizing Files 

You can use software and online services to synchronize your files stored in the cloud with the 

version of those files stored on your computer’s hard drive by comparing files on the two drives 

and then updating files as necessary, so the drives contain the same versions of the files. Some 

cloud storage services, such as Google Drive, synchronize more than one computer with the 

files you store in a cloud folder. For example, suppose you work on a project on your home 

computer and then save the project files in your cloud folder. You use a school computer to 
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download the files and continue working on the project, and then save the updated project files 

in your cloud folder. Now the files in the cloud folder contain more recent data than the files 

on your home computer. When you arrive home and connect to the Internet, the cloud storage 

service provider synchronizes the files so that you have the most recent versions on your home 

computer.  

Although synchronizing is a convenient way to keep copies of files in various locations up 

to date, it is not the same as backing up files and is not recommended as an alternative to 

creating backups. You can perform both actions—synchronizing and backing up on the same 

files, though you do so for different reasons. If you want to use files in two locations, such as a 

laptop and a handheld device, you synchronize the files. For example, you synchronize the 

music files on a laptop and portable music player so you can listen to the same music on either 

device. On the other hand, you back up files when you want to store a copy of the files as a 

safeguard in case something goes wrong. You usually access the backup files only if you need 

to restore them to their original location.  

II. Protecting Hardware 

Backups are the best protection for digital data, and software tools such as antivirus software 

are designed to protect your operating system and other files. You also need to consider 

protecting your hardware—the computer and its peripherals—from theft and physical harm. 

Protecting computer data, software, and hardware is part of your responsibility as a computer 

owner.  

1. Protecting Against Environmental Damage 

Computers and peripheral devices can be harmed by environmental hazards, including 

temperature extremes, humidity, electrical fields, and power fluctuations. Apply the following 

guidelines to protect your computer against environmental hazards in the places where you use 

the computer:  

§ Temperature—Computer components work best in a temperature range of 68 to 75 

degrees (F). If the temperature in a room exceeds 85 degrees, internal computer 

components can overheat, which can make a computer unstable. Set the heating and 

cooling system to maintain a temperature in the optimal range for computers.  

§ Humidity—High humidity can damage internal computer components. If water vapor 

penetrates a system unit, it can collect and eventually cause a short circuit, which could 

destroy electronic components. Extreme dryness can also cause problems, especially 

those related to static electricity. A static charge to an open system unit can zap an entire 

motherboard. Take precautions to keep the humidity between 30 and 50 percent. 
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§ Water and other liquids—Water or other liquids in the system unit or any other 

hardware receiving power can cause a short circuit, which is why you should not keep 

beverages near your computer. Suppose a computer is turned off and water seeps into 

the system, such as during a flood. In that case, you have a good chance of salvaging 

the computer by taking it to a repair professional who can open the case and dry 

everything before restoring power.  

§ Physical damage—Current mobile computers are designed to withstand shock from 

moderate drops and bumps. (A desktop computer has less shock-absorbing material.) 

The most likely component to be affected by physical jarring is the hard drive, and 

recovering a hard drive is time-consuming, even if you have a full system backup—

transport mobile computers with care, such as in padded cases. 

§ Power fluctuations—Lesson 9 described the hazards of power surges and failures. To 

protect against fluctuations in power, you can plug a computer into a surge protector 

(also called a surge suppressor) when the computer is running on power from a wall 

outlet. A surge suppressor traps short, fast bursts of power before they can harm a 

computer. To protect against loss of power to a desktop computer or a recharging mobile 

computer, you can use an uninterruptible power supply (UPS), which contains a battery 

that provides power if the normal current is interrupted. As with a surge protector, you 

plug a computer’s power cord or a power adapter cord into the UPS and plug the UPS 

into a power outlet. Figure ## shows a surge protector and a UPS.  

 
 

2. Protecting Against Theft 

Because computer equipment and the data stored on it are valuable, they are vulnerable to theft. 

Basic precautions such as locking doors, especially in rooms containing computers, can be a 
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deterrent. You can also use a cable lock to secure a mobile computer to a desk or table, as shown 

in Figure ##, or attach an alarm that sounds when a computer or drive is unplugged.  

Installing tracking software increases the chances of recovering a stolen computer. You can 

trigger the tracking software remotely, so it sends its location and identifying information to 

another specified computer. For example, Apple provides tracking software for its mobile 

computers; the one for the iPhone is called Find My iPhone. If the iPhone is turned on and 

connected to the Internet, you can use another computer to track the location of the iPhone using 

GPS technology. If you’ve lost your iPhone, you can use Find My iPhone to beep and display 

a phone number where you can be reached along with a message such as “This iPhone has been 

lost. Please call me.” Find My iPhone also locks the device so no one can access your data. 

Other features to look for in computer tracking software include the following:  

§ Alarm—An alarm feature repeatedly plays an urgent sound to help locate a device or 

alert others that an unauthorized person has your device.  

§ Data removal—Besides locking the device, this feature lets you erase your data 

remotely. This option is the most useful if you have backed up your data first.  

§ Unauthorized user notification—If your computer includes a camera, this feature lets 

you set the camera to take a photo of anyone who enters an incorrect password three 

times. You can also have the computer send you an e-mail message displaying the photo 

and location of the unauthorized user.  

§ Battery control—After using GPS to find a lost mobile device, you can use the battery 

control feature to turn off GPS to conserve battery power.  
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• A backup is a duplicate copy of a file that you use if the original file is lost, damaged, 

or destroyed. To use a backup copy of a file, you first need to restore it, which means 

copying the file to its original location on your computer.  

• The four most common types of backups for individual computer users are full 

system backups, differential backups, incremental backups, and selective backups. 

Each of these types has advantages and disadvantages.  

• A full system backup (also called a system image or a disk mirror) is an exact 

duplication of the hard drive, including data files, system files and settings, 

application files, and the operating system.  

• A differential backup contains copies of the files that have changed since the last 

full system backup. In contrast, an incremental backup contains copies of the files 

that have changed since the last full system backup or the last incremental backup.  

• When you perform a selective backup, you select the folders and files you want to 

back up.  

• To create a backup, you can use backup software installed on your computer. 

• Backup software is a set of system utilities for creating and updating backups and 

restoring files from a backup. Operating systems, third-party software developers, 

and manufacturers of backup media provide backup software. Backup software 

compresses all the files selected for a backup into a single large file, and stores an 

index of file details, including their original locations, to restore the files.  

• After installing backup software, you set a schedule and select a location for the 

backups. The backup software follows the schedule to create backups in the 

background. Backup locations typically include an external hard drive, USB flash 

drive, optical disc, or network folder.  

• Backup software features include backup type options, encryption, media spanning, 

and data verification.  

• An online backup service automatically creates backups on a secure server. When 

you create a backup on a server, you are creating an online backup or a remote 

backup.  

Summary 
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• You can use software and online services to synchronize your files stored in the 

cloud with the version of those files stored on your computer’s hard drive by 

comparing files on the two drives and then updating files as necessary, so the drives 

contain the same versions of the files. Synchronizing is not the same as backing up 

files and is not recommended as an alternative to creating backups. 

• Environmental hazards, including temperature extremes, humidity, electrical fields, 

and power fluctuations, can harm computers and peripheral devices. It would be best 

if you took precautions to prevent damage from these environmental factors. 

• To protect computer hardware from theft, you can use locks, alarms, and computer 

tracking software. 

1. What two major decisions do you need to make before creating backups? 

2. What is the difference between a full system backup and a selective backup? 

3. What is a backup plan? 

4. What is the difference between a differential and incremental backup? 

5. How can extremes in humidity harm a computer? 

6. What is the purpose of computer tracking software? How does it work? 

Questions 
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